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Introduction

¢ Introduction to Analyzer

e Provisioning and Adding SonicWall Appliances
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This chapter provides an overview of SonicWall™ Analyzer and information about the user interface. See the

1

Introduction to Analyzer

following sections:

About this Guide on page 7

Overview of Analyzer on page 7

Deployment Requirements on page 12

SonicWall Analyzer Installation on page 15

Accessing the Correct Management Interface on page 16
Log In to Analyzer on page 17

Navigating the Analyzer User Interface on page 18
Analyzer Views and Status on page 22

Understanding Analyzer Icons on page 23

Using the Analyzer TreeControl Menu on page 23

About this Guide

This guide provides the information you need to configure and use SonicWall Analyzer for monitoring SonicWall

network security and other appliances. SonicWall Analyzer creates dynamic, Web-based network reports

showing all activity on monitored appliances.

Overview of Analyzer

This section contains the following subsections:

What is Analyzer? on page 8

Key Features in Analyzer 8.3 on page 8
Key Features in Analyzer 8.2 on page 8
Key Features in Analyzer 8.1 on page 9
Key Features in Analyzer 8.0 on page 10

Key Features in Analyzer 7.2 on page 11
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What is Analyzer?

Monitoring critical network events and activity, such as security threats, inappropriate Web use, and bandwidth
levels, is an essential component of network security. SonicWall Analyzer Reporting complements SonicWall's
network security offerings by providing detailed and comprehensive reports of network activity.

The Analyzer Reporting Module is a software application that creates dynamic, Web-based network reports. The
Analyzer Reporting Module generates both real-time and historical reports to offer a complete view of all
activity through SonicWall network security appliances. With Analyzer Reporting, you can monitor network
access, enhance security, and anticipate future bandwidth needs. The Analyzer Reporting Module:

e Displays bandwidth use by IP address and service
e |dentifies inappropriate Web use

e Provides detailed reports of attacks

e Collects and aggregates system and network errors
e Shows VPN events and problems

e Presents visitor traffic to your Web site

e Provides detailed daily logs to analyze specific events.

Key Features in Analyzer 8.3

This section describes the SonicOS enhancements included in the Analyzer 8.3 release:

e Provides SonicOS 6.2.7 support — SonicOS Enhanced versions 6.2.7 and above are supported.

Key Features in Analyzer 8.2

This section describes the SonicOS enhancements included in the Analyzer 8.2 release:

e Provides SonicOS 6.2.6 support — SonicOS Enhanced versions 6.2.6 and above are supported, including
SonicPoint enhancements like Capture ATP policy configuration.

SonicOS 6.2.6.0 includes an important new feature that are supported by Analyzer 8.2:
e Capture Advanced Threat Protection (Capture ATP)

e About Capture ATP — Capture Advanced Threat Protection (ATP) is an add-on security service to the
firewall, similar to Gateway Anti-Virus (GAV). Capture ATP helps a firewall identify whether a file contains
a zero-day virus by transmitting a suspicious file to the Cloud where the Capture ATP service analyzes the
file to determine if it contains a virus. Capture ATP then sends the results to the firewall. This is done in
real time while the file is being processed by the firewall.

The Capture ATP > Status page displays a graph chart that shows the percentages of benign and
malicious files discovered, as well as the total number of files analyzed. It also displays a log table that
shows the results of individual files submitted for analysis.

Capture ATP can also analyze files that you upload for analysis from the Capture ATP > Status page. After
the files are analyzed they are listed in the table on the Status page. You can click on any file in the log
table on the Status page and see the results from the detailed analysis of that file.
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Note that Capture ATP is only supported on the following appliances. The smaller TZ appliances and the
SOHO wireless appliance do not support Capture ATP.

Table 1.
e SuperMassive 9600 e NSA 6600 e TZ600
e SuperMassive 9400 e NSA 5600 e TZ500 and TZ500 Wireless
e SuperMassive 9200 e NSA 4600
e NSA 3600
e NSA 2600

Key Features in Analyzer 8.1

This section describes the SonicOS enhancements included in the Analyzer 8.1 release:

e Provides SonicOS 6.2.4 and 6.2.4.3 and above support — New features in SonicOS 6.2.4, 6.2.4.3 and
above are supported.

e Log > Settings enhancements — New fields added including: “Syslog ID,” “E-mail Format,” and
“Include All Log Information.”

e Inthe Syslog ID box, enter the Syslog ID that you want. A Syslog ID field is included in all
generated Syslog messages, prefixed by “id=". Thus, for the default value, firewall, all
Syslog messages include “id=firewall.” The ID can be set to a string consisting of 0 to 32
alphanumeric and underscore characters.

@ NOTE: The Syslog ID field is fixed to firewall when the Override Syslog Settings with
Reporting Software Settings option is enabled, and therefore, cannot be modified.

e Email Format — Select whether log emails will be sent in Plain Text, CSV Attachment, or
HTML format from the drop-down menu.

e Include All Log Information — Select to have all information included in the log report.

e Solera Capture Stack — Solera Networks makes a series of appliances of varying capacities
and speeds designed to capture, archive, and regenerate network traffic. The Solera
Networks Network Packet Capture System (NPCS) provides utilities that allow the captured
data to be accessed in time sequenced playback, that is, analysis of captured data can be
performed on a live network via NPCS while the device is actively capturing and archiving
data.

e Firewall Action — Changes to the report database, table structure, and associated reports in the Ul.
Report can now include the firewall action for all events relating to the traffic that is traversing or being
blocked by the firewall.

e Reporting Database — Infobright with Postgres — The Analyzer 8.1 upgrade replaces the Infobright with
MySQL database formerly used in earlier versions with Infobright with Postgres. The installer will ask if
you want to perform the data migration to the new database.

e Analyzer 8.1 Installation and Deployment Requirements — The license to distribute Infobright with
MySQL, the reporting database used in Analyzer 8.0, expires on Dec 31, 2015. Infobright is replacing it
with Infobright running the PostgresSQL engine instead. The basic premise for the changes is the
restrictions and difficulties in negotiating the licensing agreements with Oracle MySQL.

Support for InfoBright with MySQL will continue and customers who have deployments as of Dec 31,
2015 will continue to receive upgrades, patches, and hot fixes until Dec 31, 2018. They will also be able to
add new Agents to the existing deployments.

e Backup and Restore Performance enhancements — Added two new fields to the UMH System >
Backup/Restore screen to include “Free disk space required,” and “Auto disk space management.”
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“Free disk space required” — Indicates the space required to perform the backup, and how much
space is available for use on the resource. If available disk space is less than the estimated free
disk space required, the backup process will not start. However, if the auto disk space
management feature is enabled, the backup process deletes the previous backup files to free the
disk space required for the backup process to begin.

“Auto disk space management” — Select to allow Analyzer to manage the disk space and backup
requirements. Auto disk space management is a configurable option provided for you to
automate recovering disk space by deleting previous backup files in case of a disk space shortage
for the backup process. If there is sufficient disk space for the backup process to run, this feature
does not have any impact.

Key Features in Analyzer 8.0

This section describes the SonicOS enhancements included in the Analyzer 8.0 release:

e Provides SonicOS 6.2.4 support — Analyzer 8.0 supports the following SonicWall network security
platforms for reporting:

TZ300 and TZ300 Wireless
TZ400 and TZ400 Wireless
TZ500 and TZ500 Wireless
TZ600 and TZ600 Wireless
SOHO and SOHO Wireless*

* The TZ appliances run SonicOS 6.2.3.1 or higher, while the SOHO runs SonicOS 5.9.1.3 or higher.
Appliances running firmware newer than the SonicOS 6.2.3.1 or 5.9.1.3 releases can still have reports
generated by Analyzer 7.2.

e Java Applet Replacement — The TreeControl application (that displays all managed appliances) and the
User Management application (Console > Management > Users) have now been replaced with non-Java
versions. All Java applets in the front-end have been removed, except for NetMonitor and the “Login to
Unit” feature from TreeControl.

e SonicOS Support — New features in SonicOS 6.2 are supported.

e Portuguese Support — The Login screen now includes version information and indicates Brazilian
Portuguese support.

e Reporting

Report Database Rebuild Utility — The Reporting Database Rebuild Utility allows you to submit a
request to rebuild any specific month's report table if it were to become corrupt.

Report Data Optimization — In previous versions, report data optimization exported sorted
report data into a file and reloaded that data back to the report database. In Analyzer 8.0, instead
of using a file to upload the data, a temporary table is created that exports and reimports that
data, leading to better performance.

Botnet Reports — Botnet reporting is added to the Reports panel and includes four report types:
Attempts, Targets, Initiators, and Timeline.

Geo-IP Reports — Geo-IP reports contain information on blocked traffic that is based on the
traffic's country of origin or destination. Geo-IP Reporting is added to the Reports panel and
includes four report types: Attempts, Targets, Initiators, and Timeline.

MAC Address in Reporting — This feature shows the Media Access Control (MAC) address on the
report page. This adds detail to the current device-specific information in the report panel and
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the PDF report. New columns “Initiator MAC” and “Responder MAC” are added to the following
reports:

e Data Usage > Initiators

e Data Usage > Responders
e Data Usage > Details

e User Activity > Details

e Web Activity > Initiators

e Enhanced Reporting Database — The Reporting Database has been upgraded to a newer version
that offers better performance and higher reliability.

e Distributed Universal Scheduled Report — PDF report generation and uses an engine that can
make better use of your CPU and RAM resources, resulting in faster delivery of scheduled reports
with larger volumes and more rows of data.

e Enhanced USR Template Manager — In addition to the PCl Report template, HIPAA and SOX templates
are added to Universal Scheduled Reports as an aid for compliance audits.

e USR-Customizing Sorting Option in PDF — Provides additional sorting options for Scheduled PDF reports

e Log Analyzer — The Firewall > Reports > Analyzers > Log Analyzer page has been updated with an
out-of-the-box default view.

e Packet Data View for Signature Alerts

e The disabling of default Syslog filters is allowed

e Comments Possible for Syslog Filters

e Number of Syslog messages per file configurable through Ul

e All Windows Modules of Analyzer 8.0 are now 64-bit — Provides better usage of system resources and
better performance.

e High-level User Interface Changes
e Secure Remote Access (SRA) has been renamed to Secure Mobile Access (SMA).
e The CDP tab is removed.

e SMA (formally SRA) tabs are no longer shown by default, but can be activated on Console >
Management > Settings.

Key Features in Analyzer 7.2

The following features were key to Analyzer 7.2:
e |Pv6 Support — IPv6 is supported in Analyzer 7.2, allowing you to:

e [nstall Analyzer in an IPv6 network environment. Analyzer can now access various Network
Elements using IPv6 addresses, such as: Firewalls, SMTP servers, RADIUS/LDAP Authentication
Servers, SNMP Managers, WebServices, and so on.

e Access Analyzer web interfaces on an IPv6 network.
e Generate IPv6 based reports.

e Scheduled Reports Permission Management — In 7.1, scheduled reports created by an end user can
only be viewed and configured by the creator and Administrator. 7.2 gives the scheduled report creator
the ability to manage permissions of the scheduled reports so other users in the deployment can view
and configure the report.
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Intrusion Reporting Enhancements — Two new reports are added at root level to the Intrusion reports:
e Reports > Intrusions > Details
e Reports > Intrusions > Alerts

Syslogs Sent by Appliances that are not under Reporting or Management — Some of the units which
are no longer managed by Analyzer send syslogs that create NMM files which impact performance. In
7.2, you are notified if this occurs and they can make the unit stop sending syslog messages.

Application Level Data Archiving and Aging — In 7.1 data was not deleted from the application table
such as logs and meta data tables, causing the number of rows to grow quickly in the tables, affecting
overall performance of the application. In 7.2 the console logs and application meta data tables are aged
and archived to fix this issue.

Localization — Support for the Korean language is included in 7.2.
Disable Archiving of Syslogs to File System — Added the option to disable storing of archived syslogs.

Reverse DNS Support — This feature enhances the quality of data by performing a reverse lookup on the
private IP addresses (LAN Side) with a missing hostname sent by the firewall. The reverse lookup is
performed by logging into the DNS server on the LAN side of the firewall. This functionality requires the
Analyzer to be installed on the LAN side of the firewall, to be able to access the DNS Server.

Log Analyzer Enhancements — The Log Analyzer interface is customizable to allow expansion and easy
distribution of columns for ease of navigation.

Deployment Requirements

SonicWall Analyzer does not require any additional node licenses.

@l NOTE: Analyzer is not supported on laptops or tablets.

Topics:

Operating System Requirements on page 12

Hardware Requirements for Windows Server on page 13
SonicWall Analyzer Virtual Appliance Requirements on page 13
Virtual Appliance Deployment Considerations on page 13
MySQL Requirements on page 14

Browser Requirements on page 14

Network Requirements on page 14

SonicWall Appliance and Firmware Support on page 15

Operating System Requirements

SonicWall Analyzer supports the following Microsoft Windows operating systems:

Windows Server 2012 Standard 64-bit

Windows Server 2012 R2 Standard 64-bit (English and Japanese language versions)
Windows Server 2012 R2 Datacenter

Windows 8.1 64-bit
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e Windows 7 64-bit

These Windows systems can either run in physical standalone hardware platforms, or as a virtual machine under
Windows Server 2012 Hyper-V or VMware ESXi.

@ TIP: For best performance and scalability, it is recommended to use a 64-bit Windows operating system.
Bundled databases run in 64-bit mode on 64-bit Windows operating systems. All listed operating systems
are supported in both virtualized and non-virtualized environments. In a Hyper-V virtualized environment,
Windows Server is a guest operating system running on Hyper-V. Analyzer is then installed on the
Windows Server virtual machine that is layered over Hyper-V.

@ NOTE: Analyzer is not supported on MS-Windows Server virtual machines running in cloud services, such
as Microsoft Azure and Amazon Web Services EC2.

Hardware Requirements for Windows Server

Use the Capacity Calculator 2 to determine the hardware requirements for your deployment.

®

NOTE: A Windows 64-bit operating system with a RAM of at least 16GB of RAM is highly recommended for
better performance of reporting modules.

SonicWall Analyzer Virtual Appliance Requirements

The elements of basic VMware structure must be implemented prior to deploying the SonicWall Analyzer
Virtual Appliance. SonicWall Analyzer Virtual Appliance runs on the following VMware platforms:

e ESXi6.0and5.5
Use the following client applications to import the image and configure the virtual settings:

e VMware vSphere — Provides infrastructure and application services in a graphical user interface for ESXi,
included with ESXi. Allows you to specify Thin or Thick (Flat) provisioning when deploying the Virtual
Appliance.

e VMware vCenter Server — Centrally manages multiple VMware ESXi environments. Provides Thick
provisioning when deploying the Virtual Appliance.

Virtual Appliance Deployment Considerations

Consider the following before deploying the SonicWall Analyzer Virtual Appliance:
e SonicWall Analyzer management is not supported on Apple MacOS.
e All modules are 64-bit.
Use the Capacity Calculator 2 to determine the hardware requirements for your deployment.

e The performance of SonicWall Analyzer Virtual Appliance depends on the underlying hardware. It is
highly recommended to dedicate all the resources that are allocated to the Virtual Appliance, especially
the hard-disk (datastore). In environments with high volumes of syslogs, you need to dedicate local
datastores to the Analyzer Virtual Appliance.

e The 64-bit Virtual Appliances take advantage of the additional RAM available to it. A minimum of 8GB
RAM is required. However, at least 16GB of RAM is highly recommended for better performance of
reporting modules.

e When using Thick or Flat provisioning as the storage type option, the entire amount of disk space is
allocated when you import and deploy the SonicWall Analyzer Virtual Appliance file. When using Thin
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provisioning, the initial size is very small and grows dynamically as more disk space is needed by the
SonicWall Analyzer Virtual Appliance application, until the maximum size is reached. After being
allocated, the size does not shrink if the application space requirements are subsequently reduced.

Additional disk space provided to the SonicWall Analyzer Virtual Appliance in the virtual environment,
beyond the respective limits of 250 GB or 950 GB, is not utilized.

MySQL Requirements

Previously, SonicWall Analyzer automatically installed MySQL as part of the base installation package. The
SonicWall Analyzer 8.1 upgrade replaces the Infobright with MySQL database formerly used in earlier versions
with Infobright with Postgres (IB-PG). The installer will ask if you want to perform the data migration to the new
database. Separately installed instances of MySQL are not supported with the SonicWall Analyzer Virtual
Appliance.

Browser Requirements

SonicWall Analyzer uses advanced browser technologies such as HTML5, which are supported in most recent
browsers. SonicWall recommends using the latest Chrome, Firefox, Internet Explorer, or Safari browsers for
administration of the SonicWall Analyzer.

This release supports the following Web browsers:
e Chrome 42.0 and higher (recommended browser for dashboard real-time graphics display)
e Firefox 37.0 and higher

e Internet Explorer 10.0 and higher (do not use compatibility mode)

@ | NOTE: Internet Explorer version 10.0 in Metro interfaces of Windows 8 is not currently supported.

@ NOTE: Turn off Compatibility Mode when accessing Analyzer sites with Internet Explorer. For more
information, see the Knowledge Base article located at:
https://support.sonicwall.com/sonicwall-gms/kb/sw14003

Network Requirements

To complete the Analyzer deployment process documented in this guide, the following network requirements
must be met:

e The SonicWall Analyzer server must have access to the Internet
e The SonicWall Analyzer server must have a static IP address

e The SonicWall Analyzer server’s network connection must be able to accommodate at least 1 KB/s for
each device under management. For example, if Global Management System is monitoring 100
SonicWall appliances, the connection must support at least 100 KB/s.

NOTE: Depending on the configuration of SonicWall log settings and the amount of traffic handled by each
device, the network traffic can vary dramatically. The 1 KB/s for each device is a general recommendation.
Your installation requirements could vary.
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SonicWall Appliance and Firmware Support

SonicWall Analyzer supports the following SonicWall appliances and firmware versions:

Component requirements

SonicWall Platforms SonicWall Firmware Version

Network Security Appliance

SuperMassive 10000 Series SonicOS 6.0 or newer

e NOTE: Only partial reporting support is currently available.
Contact your SonicWall Sales representative through
https://support.software.dell.com/ for more information.

SuperMassive 9000 Series SonicOS 6.1 or newer
NSA Series SonicOS 5.0 or newer
TZ and TZ Wireless Series SonicOS 5.0 or newer
SonicWall SOHO and SOHO SonicO0S 6.2.5 or newer
Wireless

Secure Mobile Access

SMA 100 Series (SMA 200/400) SMA 8.1 or newer
SRA/SSL-VPN Series SSL-VPN 2.0 or newer (management)

SSL-VPN 2.1 or newer (management and reporting)
E-Class SRA Series E-Class SRA 9.0 or newer

SMA 1000 Series (SMA 6200/7200) SMA 10.7.2 or newer

Email Security/Anti-Spam

Email Security Series Email Security 7.2 or newer (management only)

@ NOTE: Appliances running firmware newer than this SonicWall Analyzer release can still generate reports.
However, the new features in the firmware release will be supported in an upcoming release of Analyzer.

@ NOTE: Legacy SonicWall XPRS/XPRS2, SonicWall SOHO2, SonicWall Tele2, and SonicWall Pro/Pro-VX
models are not supported for SonicWall Analyzer reporting. Appliances running SonicWall legacy firmware
including SonicOS Standard 1.x and SonicWall legacy firmware 6.x.x.x are not supported for SonicWall
Analyzer reporting.

@ NOTE: SonicWall Analyzer can be connected to SSL-VPN 2000 and 4000 appliances. Use the Log > View
Log page to set up the Analyzer connection (in addition to the configuration changes made on the
Analyzer). In SonicWall SRA SSL-VPN 5.5 or later firmware versions, a Log > Analyzer page is provided for
configuration of Analyzer settings.

SonicWall Analyzer Installation

Analyzer 8.3 can be installed as a fresh install or as an upgrade from Analyzer 8.2. If you wish to perform a fresh
install of Analyzer 8.3, refer to the SonicWall Analyzer Getting Started Guide that relates to your Analyzer
deployment.

Previously, Analyzer automatically installed MySQL as part of the base installation package. The Analyzer 8.3
upgrade replaces the Infobright with MySQL database formerly used in earlier versions with Infobright with
Postgres (IB-PG). The installer will ask if you want to perform the data migration to the new database. Separately
installed instances of MySQL are not supported with Analyzer.
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All software components related to SonicWall Analyzer and SonicWall Global Management System (GMS),
including the executable binary files for all services, and other necessary files, are installed using the Universal
Management Suite (UMS) single-binary installer. All SonicWall Analyzer and SonicWall GMS files are installed as
part of the Universal Management Suite, but no distinction is made between SonicWall Analyzer and SonicWall
GMS during the installation. The initial installation phase takes just a few minutes for any type of installation,
such as a SonicWall Analyzer server, a SonicWall GMS server, a database server, or any other role.

To install the Universal Management Suite from the single binary installer, refer to the SonicWall Analyzer
Getting Started Guide.

License and Registration Requirements

SonicWall Analyzer is registered and licensed from the Windows server on which it is installed. SonicWall
Analyzer registration is performed using the SonicWall Universal Management Host system interface.

Refer to the SonicWall Analyzer Getting Started Guide for detailed instructions on registering and licensing
Analyzer on your system.

On SonicWall appliances that send reporting data to the Analyzer, SonicWall Analyzer is licensed and activated
separately from the SonicWall appliances. MySonicWall provides a way to associate SonicWall appliances with
the Analyzer instance installed on the Windows system. Licensing your SonicWall Analyzer application on a
SonicWall appliance requires:

e A MySonicWall account. A MySonicWall account allows you to manage your SonicWall products and
purchase licenses for various services. Creating a MySonicWall account is fast, simple, and free. Simply
complete an online registration form directly from your SonicWall security appliance management
interface. Your MySonicWall account is also accessible at <https://www.mysonicwall.com> from any
Internet connection with a Web browser. After you have an account, you can purchase SonicWall
Analyzer and other licenses for your registered SonicWall security appliances.

e Aregistered SonicWall security appliance with active Internet connection. You need to register your
SonicWall security appliance to activate SonicWall Analyzer. Registering your SonicWall security
appliance is a simple procedure done directly from the management interface. After your SonicWall
security appliance is registered, you can activate SonicWall Analyzer by using an activation key or by
synchronizing with mysonicwall.com.

Accessing the Correct Management Interface

SonicWall Analyzer includes two separate management interfaces:

e SonicWall Universal Management Host (UMH) System Management Interface — Used for system
management of the host server, including registration and licensing, setting the admin password,
creating backups, restarting the system, configuring network settings, selecting the deployment role, and
configuring other system settings.

Access the system management interface with the URL:
http://<1P_address>:<port_number>/appliance/

If you are using the standard HTTP port, 80, it is not necessary to append the port number to the IP
address. If you are accessing the interface from the same system on which it is installed, use the
following URL:

http://localhost/appliance/

e SonicWall Analyzer Management Interface — Used to access the SonicWall Analyzer application that runs
on the system. This interface is used to configure and view SonicWall Analyzer reporting on SonicWall
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appliances and for configuring Analyzer administrative settings. Access the SonicWall Analyzer
management interface with one of the following URLs:

http://<1Paddress>:<port_number>/sgms/
http://localhost/sgms/

Switching Between Management Interfaces

You can easily switch between the SonicWall UMH system management interface and the SonicWall Analyzer
application management interface.

One method is to change the URL by adding /sgms for the Analyzer application interface or adding /appliance
for the UMH interface.

A second method involves clicking the Switch icon. While logged into either interface, you can switch to the

@

login page of the other interface by clicking Switch =**<" in the top right corner of the page.

Log In to Analyzer

After registering your SonicWall Analyzer product, to log in into the SonicWall Analyzer management interface,
either double-click on the SonicWall Analyzer icon on your desktop, or from a remote system, access the
following URL from a web browser:

http://<I1P_address>:<port_number>

The Analyzer login page appears by default in English. To change the language setting, click your language of
choice at the bottom of the login page. The available language choices for SonicWall Analyzer include English,
Japanese, Simplified Chinese, Traditional Chinese, Korean, and Portuguese.

SonicWALL J Analyzer Login

ﬁl\ Please login

User |

Password |

English | B38| EfAd 3 | R | 2t=9| | Portugués

To login to Analyzer,

1 Enter the SonicWall user ID (default: admin) and password (default: password). Select Local Domain as
the domain (default).
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Click Submit. The SonicWall Analyzer management interface displays.

NOTE: For more information on installation, login procedures, and registration of your SonicWall
Analyzer installation, refer to the appropriate Getting Started Guide, available at:
https://support.sonicwall.com/sonicwall-analyzer/analyzer/technical-documents

Navigating the Analyzer User Interface

This section describes the Firewall, SMA, and Console panels in the SonicWall Analyzer user interface. For
information about the Dashboard panel, see the Using the Universal Scheduled Reports Application on page 31.

Firewall Panel

The Firewall Panel is an essential component of network security that is used to view and schedule reports
about critical network events and activity, such as security threats, inappropriate Web use, and bandwidth
levels. To open the Firewall Panel, click the Firewall tab at the top of the Analyzer user interface.

SonicWALL | Analyzer — . @@ e e

<&

& B GlohalView - Stimenary Uker: admingilocalDomain | Admishtraton

il

2 GlobalView {LocalDomain) - » General - =
© 121k b ]

2 AddunitTest . Summay - -

B oM - a2 » Applications i L e

3 CsM - 4358 » Wb Activity

© 3500 - 7C30.123 » Wobs Filter 5 =1

© E5000 - 6DB4,121 | » von Usage i ==

© Jackson City » Threats

S NewUnitLTM TO1

© NSA 220 4050.128

B NSA 220W FE30.129

3 NGA 240 - SAD9.124 ’

- = — “+ 10000000,000 @ I Conestons

© NSA 2400 - FFAC 127 ﬁxg i _ :_x‘?:g F W Tnosfered

£ NSA 6600 - (32152 1,100,000 =

2 PRO 1260 - 4260.101 [

© PRO 4060 - 0110102 &

© pRO 5060 - 4500103

& Sy Jose mm Connections Transferred v

© San Jotir At} 1 NSA 6600 - 432,152 1,286,001 [

2 San Jose Add_cheomel Mad) Total 1,286,001 9468

3 5an Jose Add_FireFoximed)

= SFO_Mod

S Shailas Deskiop

©3 SM 5600 DI76.153

© S G400 CEG6.151

© Sysiogabidator]

B TZ 215W D404 34 X

3 NSA JH00MYX - 4678126

|| Data Usage Data Usage Sommary i Oct 13, 2016 0000 to Oct 13, 2016 13:5%

b 1,400,000 T
r 1,350,000 T 11,500,000,000
» Real-Time Viewer E - 11,000,000,000

£ 1,300,000 B
¥ Configucation 1,250,000

From the Firewall Panel, you can view the following for connected SonicWall appliances:

View general unit status, license status, and syslog settings.

View the SonicWall security dashboard. Dashboard reports display an overview of bandwidth, uptime,
intrusions and attacks, and alerts for connected SonicWall firewall appliances. The Security Dashboard
report provides data about worldwide security threats that can affect your network. The Dashboard also
displays data about threats blocked by the SonicWall security appliance.

View custom reports of Internet activity or Website filtering at the unit level. Custom reports filter raw
syslog data and you can specify start and end dates or a date range such as “Week to date.” You can filter
by user, domain, protocol, traffic, and full URL categories, depending on the type of custom report. The
search template can be saved for use again later with the same appliance.

View general bandwidth usage. These reports include a daily bandwidth summary report, a top users of
bandwidth report, and over-time summary and top users reports.

View a services report. This report includes information about events and usage of protocols and
megabytes.
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View Web bandwidth usage. These reports include a daily bandwidth summary report, a top visited sites
report, a top users of Web bandwidth report, a report that contains the top sites of each user, and a
weekly summary report.

View the number of attempts that users made to access blocked websites. These reports include a daily
summary report, a top blocked sites report, a top users report, a report that contains the top blocked
sites of each user, and a weekly summary report.

View file transfer protocol (FTP) bandwidth usage. These reports include a daily FTP bandwidth summary
report, a top users of FTP bandwidth report, and a weekly summary report.

View mail bandwidth usage. These reports include a daily mail summary report, a top users of mail
report, and a weekly summary report.

View VPN usage. These reports include a daily VPN summary report, a top users of VPN bandwidth
report, and a weekly summary report.

View reports on attempted attacks and errors. The attack reports include a daily attack summary report,
an attack by category report, a top sources of attacks report, and a weekly attack summary report. The
error reports include a daily error summary report and a weekly error summary report.

View reports on attempted virus attacks. Virus attacks reports are available for appliances that are
licensed for SonicWall Gateway Anti-Virus. These reports include the most frequent virus attack
attempts, virus attacks by top destinations, virus attacks over time, virus attacks over a period of time,
and virus attacks by top destinations over time.

View reports on attempted spyware attacks. Anti-spyware reports are available for appliances that are
licensed for SonicWall Anti-Spyware. These reports include spyware attacks by category, spyware attacks
over time, and spyware attacks by category over time.

View reports on attempted intrusion attacks. Intrusion prevention reports are available for appliances
that are licensed for SonicWall Intrusion Prevention Service. These reports include intrusion attacks by
source IP address, intrusion attacks by category, intrusion attacks over time, and intrusion attacks by
category over time.

View reports on traffic triggering Application Firewall policies. Application Firewall reports are available
for SonicWall firewall appliances that are licensed for SonicWall Application Firewall. These reports
include summary, over time, top applications, top users, and top policies.

View successful and unsuccessful user and administrator authentication attempts. These reports include
a user authentication report, an administrator authentication report, and a failed authentication report.

View detailed logging information. The detailed logging information contains each transaction that
occurred on the SonicWall appliance.

View current alerts and access alert settings.
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SMA Panel

The SMA panel provides access to SSL VPN appliances and is similar to the Firewall panel. It is used to view and
schedule reports about critical network events and activity, such as security threats, inappropriate Web use, and
bandwidth levels. To open the SMA Panel, click the SMA tab at the top of the Analyzer user interface.

SonicWALL | Analyzer > @ @ ®
- Dashboard Firowall ISR  Console b wetch | g Jie
sladlala 5] SURA 200 Timweliong Vs aciminn @i ¢ sormai) | Administyators
33 b
I » General % R
%m:m] v Dt th Timeline | May 20, 2015 0000 to May 20, 2015 2359 | Mm =
-1 Teneline. -
S 3800 o + 3 % L [ cusompepot- [+
» User Activity I
¥ Access Mitlsl Timeling Bimm |

* Aathentication

* Custon Riports No Matching Records Found.

* Analyzers Possible reason(s):

» Configuration * Sysiog servers may not have been ensbied on the applance.

From the SMA Panel, you can view the following for connected SonicWall SSL VPN appliances:
e View general unit status, license status, and syslog settings.

e View general bandwidth usage. These reports include a daily bandwidth summary report, a top users of
bandwidth report, and over-time summary and top users reports.

e View custom reports of custom reports of resource activity at the unit level. Custom reports filter raw
syslog data and you can specify start and end dates or a date range such as “Week to date.” You can filter
by user, protocol, destination IP, and source IP categories. The search template can be saved for use again
later with the same appliance.

e View a resources report. This report includes information about connections and the resource used to
connect, such as HTTPS or NetExtender.

e View successful and unsuccessful user authentication attempts. These reports include a user
authentication report and a failed authentication report.

e View detailed logging information. The detailed logging information contains each transaction that
occurred on the SonicWall appliance.
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Console Panel

The Console Panel is used to configure SonicWall Analyzer settings, view pending tasks, view the log, manage
licenses, and configure alerts. To open the Console Panel, click the Console tab at the top of the SonicWall
Analyzer user interface.

SonicWALL | Analyzer L ~ @ @ @
Dashboard Firewall \ Switch | Help | Logout
Configuration User; admin@LocalDomaln | Administrators

* Log

Confiquration Delete Analyzer Log Messages

View Log Logs help track activities In this system. These activities are assoclated either diractly or indirectly to user Initiatad actions, or
* Management based on system initiated actions. These logs are important for audit trailing and compliance purposes, as well as for
» Reports troubleshooting system operation.
» Diagnostics Logs, that no longer require to be stored in the system can be delsted manually. This is a one-time action and will be executed

based on the date selected for deletion.

» Events ; |
» User Seltings Delete Logs Older Than: September ¥ | [ 12 Y| [ 2016 ¥ |
» Help

Update

Archive Analyzer Log Messages.

Logs that no longer require to be stored in the system can be exported in CSV/HTML frrmat and be offfoaded from the
database. The archive process will first archive the data to archivedLogs directory as per "Archive Log Schedule” and the data
will then be deleted from the database,

Note: For non-window deployments: To offload the archived log files to the local drive, navigate to the Appliance > Systems >

File Manager screen.
#| Enable Archive
Archive Analyzer Log Messages for: -12___!' | months -
Maximum Log Message Files: 127
Delete Data Every: Y| oat (17 ¥ 0|
Archive Format: ) HTML

From the Console Panel, you can do the following:

Change the Analyzer password, adjust the amount of inactive time before you are automatically logged
out of Analyzer, and set the maximum number of rows displayed on paginated screens.

Configure Web sites and Web users that are excluded from Web usage reports.

View the Analyzer log and delete old log messages. The Analyzer log contains information on alert
notifications, failed Analyzer login attempts, and other events that apply to SonicWall Analyzer.

Manage SMTP settings, system email addresses, archive report settings, debug level for logs, and
password security settings. You can set the schedule and server settings, and the email alert recipient
schedule and preferred format.

Manage login sessions. You can view the status of user sessions and, if necessary, end them.

Configure report settings for sort options and maximum units with Log Viewer enabled. Enabling Log
Viewer allows custom reports for the system, but is resource intensive.

Control summarizer settings, syslog and summarized data deletion schedules, and host name resolution
settings.

Configure email archive settings and search settings for scheduled reports, and manage data archiving.
View summarizer diagnostics, useful for capacity planning.

Configure granular event management report settings, including threshold, schedule, and alert settings.
Configure Web services deployment settings and view Web services status.

View the version number, serial number, and database information for SonicWall Analyzer, and access
links to all available tips and video tutorials.
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Analyzer Views and Status

SonicWall Analyzer allows you to view status and reports for all appliances at once using GlobalView, or for a
single unit at a time with the Unit view. Analyzer provides status information on the General > Status page of
the Firewall or SMA panel.

GlobalView is a grouping of all the appliances you are monitoring with Analyzer. From the GlobalView of the
Firewall or SMA panel, Summary and Over Time reports are available for all SonicWall appliances monitored by
SonicWall Analyzer.

To open the My Reports view, click the GlobalView icon at the top of the left pane. To display the global status
page, navigate to General > Status.

e & _-:,_._ 55 E£ GlobalView ;: Status
¥ @ GlobalView (LocalDomain) - ¥ General |

S 121-bir Status Global Node: GlobalView Info

© AddUnitTest » Data Usage Firewalls in the System: 35

O CSM - 4352 » Applications

© cSM - 4358 > Wb Activity Analyzer License Status

S £3500 - TE30 420 » Web Filter Firewall Status

© ES000 - 6D84.121 » VPN Usage NSA 6600 - 0432.152 Licensed

© Jackson City » Thiits 121-bir Mat Licensed

© NewUnitUTM To1 S AddUnitTest Not Licensed

o o » Intrusions C5M - 4352 Mot Licensed
NSA 220 4050.128 » Real-Time Viewer CSM - 4358 Not Licensed

© NSA 220W F530.129 E3500 - 7C30.123 Mot Licensed

© NSA 240 - 5A09.124 » Configuration ES?;?E{;SE?;‘S'ZL :ﬁ:t‘gzﬁ

3 NSA 2400 - FFAC.127 NewUnitUTM To1 Mot Licensed

From the Unit view, reports contain detailed data for the selected SonicWall appliance. To specify the unit view,
click any unit in the left pane. To display the unit status page, navigate to General > Status on the Firewall or
SMA panel.

A R A B NSA 240 - 5409.124 :: Status User; ocalbomaln | A
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© ES000 - 6084121 » VPN Usz

o Bekon Chy » Intrusions Syslog Servers
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@ NSA 220 4050128 _ 1P Address Port
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3 NSA 220W F530.129

© NSA 240 - SAD9.124 » Caplure ATP

© NSA 2400 - FFAC127 * Gateway Viruses ./ Snchronize Settings With Appl And License Inf
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Note: Status information is updated every 24 hours. To refresh the information, click

S PRO 1260 - 4280.101 » Authentication on the link above. To change these settings, you must log into the appliance and

© PRO 4060 - 0110.102 » Custom Reports update them manually.

© PRO S060 - 450C.103 » Analyzers

S san Jose ¥ Conflguration
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Understanding Analyzer Icons

This section describes the meaning of icons that appear next to managed appliances listed in the left pane of the
Analyzer management interface.

Icon meaning

Appliance Status  Description

(= | One blue box indicates that the appliance is operating normally. The appliance is
accessible from SonicWall Analyzer, and no tasks are pending or scheduled.

@ Three blue boxes indicate that all appliances in the global group of this type
(Firewall/SMA) are operating normally.

Using the Analyzer TreeControl Menu

This section describes the content of the TreeControl menu within the SonicWall Analyzer user interface.

You can control the display of the TreeControl pane by selecting one of the appliance tabs at the top of the main
window. For example, when you click the Firewall tab, the TreeControl pane displays all the connected
SonicWall firewall appliance units. The two appliance tabs can display the following appliance types when
Analyzer is monitoring these device types:

e SonicWall firewall appliances
e SMA and EX-Series SMA appliances

You can hide the entire TreeControl pane by clicking the sideways arrow icon, and redisplay the pane by clicking
it again. This is helpful when viewing some reports or other extra-wide screens.

'2 Globalview ¥ |Hide TreeControl Panel |
= 3500 Skatus

3 ESO00 - 6054, 121
O3 WS4 240 - S9F1.125
O HSAZ400
3 Test 240

¢ Data Usage
¢ Applications
F User Activity

To open a TreeControl appliance menu, right-click GlobalView or a Unit icon.

e | @] D 20| e5| @) &)
D GlobalView (LocalDomain) = ~ = GlobalView (1 nealfamain) =
€3 Aarons NSA-250M || Gorog
O Aarons TZ-210 J ® Aar an; [[# Expand Al
= —— -
D E3500 (i, Refresh © pasog B4 Find.
D E4500 g 03 E5000 ) Refresh
© Es000| E5 Add Unit., @NAZ L
© NSA 2i|dfle Rename Unit... oAy & k.
D NSAZ ) ' ' @ NSA 2 &% Delete
© NsA 2¢ €% Delete 2 NSA 2900 FrAC L 2T H
3 NSa 2 & Modify Unit.. & NSA 2400MX - 4678.126
O NSA 2
ot = LogintoUnit b
© Prasad Desk TZ-500 ri|

The following options are available in the right-click menu:
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Find — Opens a Find dialog box that allows you to search for units.

Refresh — Refreshes the Analyzer Ul display.

Add Unit — Add a new unit to the Analyzer view. Requires unit IP and login information.
Rename Unit — (unit view only) Renames the selected SonicWall appliance.

Delete — Delete the selected unit

Modify Unit — (unit view only) Change basic settings for the selected unit, including unit name, IP and
login information, and serial number.

Login to Unit — (unit view only) Log in to the selected unit using HTTPS protocols.

SonicWall Analyzer 8.3 Administration Guide 2



Provisioning and Adding SonicWall
Appliances

This chapter describes how to provision and add SonicWall appliances to SonicWall Analyzer. All SonicWall
appliances must be provisioned before adding them to SonicWall Analyzer.

This chapter contains the following sections:
e Provisioning SonicWall Appliances on page 25
e Provisioning a SonicWall SMA SMB Appliance on page 25
e Provisioning a SonicWall E-Class SRA Series Appliance on page 26
e Adding SonicWall Appliances on page 26
e Modifying SonicWall Appliance Settings on page 28

e Deleting SonicWall Appliances from Analyzer on page 28

Provisioning SonicWall Appliances

This section describes how to configure SonicWall appliances to support SonicWall Analyzer.

NOTE: Prior to adding a unit to Analyzer, the provisioned SonicWall appliance needs to be registered with
License Manager. And during registration, make sure the provisioned SonicWall appliance has a valid
Analyzer license—one Analyzer license for each SonicWall appliance.

Provisioning a SonicWall Firewall Appliance

To provision a SonicWall firewall appliance for SonicWall Analyzer, complete the following steps:
1 Login to the firewall appliance. Navigate to the Log > Syslog page.
2 In Syslog Servers, click Add.

3 Enter the Analyzer IP address to start sending syslogs. The Analyzer service should be activated. Set the
log in UTC format and log category.

4 Navigate to the System > Time page, and enable Display UTC in logs (instead of local time).

Provisioning a SonicWall SMA SMB Appliance

To provision a SonicWall SMA SMB appliance for SonicWall Analyzer, complete the following steps:
1 Login to the SMA SMB appliance. Navigate to the Log > Analyzer page.
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2 In Analyzer Settings, click Enable Analyzer.
3 Click Add to add the Analyzer IP address, this starts sending syslogs.

4 Navigate to the System > Time page, and enable Display UTC in logs (instead of local time).

Provisioning a SonicWall E-Class SRA Series Appliance

Currently there is no Analyzer settings implementation in SonicWall E-Class SRA series appliances. To add
Analyzer reporting support, use the Additional ViewPoint settings in the General > Configure Centralized
Management screen, and enter the Analyzer IP address and port number to start sending syslog.

Adding SonicWall Appliances to Analyzer

SonicWall Analyzer checks with the SonicWall licensing server when you add an appliance, so it is important that
SonicWall Analyzer has Internet access to the server.

SonicWall Analyzer communicates with SonicWall appliances using HTTPS protocol.

@ NOTE: A SonicWall appliance might already be registered to a different MySonicWall account, in this case
the “Register to MySonicWall.com” task cannot be executed, and remain in the scheduled tasks queue. To
take full advantage of Analyzer managed appliances, it is important that either the managed appliance is
not registered when it is added into Analyzer, or it is registered to the same MySonicWall.com account as
the Analyzer system that is managing the appliance.

For information on adding, modifying, and deleting units, refer to the following sections:
e Adding SonicWall Appliances on page 26
e Modifying SonicWall Appliance Settings on page 28

e Deleting SonicWall Appliances from Analyzer on page 28

Adding SonicWall Appliances

To add a SonicWall appliance using the SonicWall Analyzer management interface, complete the
following steps:

1 Click the appliance tab that corresponds to the type of appliance that you want to add:
e Firewall
e SMA

2 Expand the SonicWall Analyzer tree and select the group to which you want to add the SonicWall
appliance. Then, right-click the group and select Add Unit from the pop-up menu. To not specify a group,
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right-click an open area in the left pane (TreeControl pane) of the SonicWall Analyzer management
interface and select Add Unit or click the Add Unit icon in the tool bar.

D NSA 240N - ECAC 197 T TR
O N/ QQ find P User Activity

= nd...
- ) » Web Activity

% @) Refresh » Web Filter

© PRC @5 Add Unit... VPN lisage
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The Add Unit dialog box appears:

Add Unit X|

Unit Name: "IZ 180 W - 39EC.22 ‘

Serial Number: ‘ 0017C51E39EC |

IP Address:

Login Name: | admin ‘
Password: |

Access Mode: Use Secure login (HTTPS)

Management Port: | 443

nr

{f

3 Enter a descriptive name for the SonicWall appliance in the Unit Name field. Do not enter the single
quote character (‘) in the Unit Name field.

Enter the serial number of the SonicWall appliance in the Serial Number field.
Enter the IP address of the SonicWall appliance in the IP Address field.

Enter the administrator login name for the SonicWall appliance in the Login Name field.

N o b

Enter the password used to access the SonicWall appliance in the Password field.

For Access Mode, select from the following:
1 The SonicWall appliances are connected with HTTPS by default.

2 Enter the port used to connect to the SonicWall appliance in the Management Port field (default port for
is HTTPS: 443).

3 Click OK. The new SonicWall appliance appears in the Analyzer management interface. It has a yellow
icon that indicates it has not yet been successfully acquired.
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4 Analyzer then attempts to set up an HTTPS connection to access the appliance. Analyzer then reads the
appliance configuration and acquires the SonicWall appliance for reporting. This takes a few minutes.

NOTE: After the SonicWall appliance is successfully acquired, its icon turns blue, its configuration settings
are displayed at the unit level, and its settings are saved to the database.

®

Modifying SonicWall Appliance Settings

If you make a mistake or need to change the settings of an added SonicWall appliance, you can manually modify
its settings or how it is managed.

To modify a SonicWall appliance, complete the following steps:
1 Right-click the appliance name in the left pane of the Analyzer Ul and select Modify Unit from the
pop-up menu. The Modify Unit dialog box appears.

2 The Modify Unit dialog box contains the same options as the Add Unit dialog box. For descriptions of the
fields, see Adding SonicWall Appliances to Analyzer on page 26.

3 When you have finished modifying options, click OK. The SonicWall appliance settings are modified.

Deleting SonicWall Appliances from Analyzer

To delete a SonicWall appliance from SonicWall Analyzer, complete the following steps:
1 Right-click on a SonicWall appliance in the left pane and select Delete from the pop-up menu.

2 Inthe message that displays, click Yes. The SonicWall appliance is deleted from SonicWall Analyzer.

@ NOTE: After deleting the SonicWall appliance from Analyzer, unprovision the unit as a best practice. To
unprovision the unit, log in to the SonicWall appliance and disable Analyzer management to avoid sending

unnecessary syslogs to the Analyzer host.
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Dashboard

e Using the Dashboard Panel
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Using the Dashboard Panel

This chapter provides an overview of the SonicWall Analyzer Dashboard.
See the following sections:
e Using the Universal Scheduled Reports Application on page 31

The Dashboard control bar provides top-of-the page menu items for customizing the settings of this page. When
the Dashboard loads after SonicWall Analyzer login, the control bar is displayed and then becomes hidden until
you place your mouse cursor at the top of the page. You can lock the control bar by clicking on the “pin the
control bar” icon.

SonicWALL | Analyzer ~ o @ ‘ @ ‘ *

Firewall Console \

User; admin@LocalDomaln | Administrators

kil

Use wizards basad Universal Scheduled Report application to create. modify, delete report templates, report schedules and also be abls to reschednle, monitor the existmg
schedule for all appl mider i and reporting with in the Analyzer deployment.

== =

Manage Bmplates Add a Scheduled Report Manage Scheduled Reports

LILS

The Dashboard control bar provides the following components:
e Universal Scheduled Reports — Includes Universal Scheduled Reports Wizard to create report templates.
e Switch to Full Screen — The four arrows in four corners icon enables the page into full-screen mode.

e Pin Control Bar — The pin icon allows you to keep the Dashboard control bar always on.
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Using the Universal Scheduled Reports
Application

Scheduled Reporting has been an essential reporting component since the initial release of the SonicWall
Analyzer product. It provides management interfaces to let you setup schedules and configure reports to be
exported in a periodic fashion and in various report formats. A typical scheduled report configuration is broken
down by functionality and by nodes. Users need to navigate to separate tabs to configure scheduled reports for
different nodes. The Universal Scheduled Reporting application streamlines the configuration processes to unify
and enhance the existing functionality to the system-wide usage patterns. This allows you to collect report data
from multiple appliances and create a single global report.

| Universal Scheduled Repart

Use wazards basad Universal Scheduled Repont application to ereate. modfy, dalate raport templates report sehodules and alao be able to reschadule, momtor the exstmge
schedule for all applisnces mder management and reporfing wath in the Analvzer deplovment
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=i

Z
-

[ Manage Bmplates | AddaScheduledReport Manage Scheduled Reports

To configure the Universal Scheduled Reports application, refer to the following sections:
e Using the Manage Templates Component on page 31
e Adding a Scheduled Report Component on page 37

e Managing the Scheduled Reports Component on page 49

Using the Manage Templates Component

Manage Templates are used to create a template that makes up the list of reports at group level or unit level.
The list of available reports for each of the product types are abstract, so all the available reports in system are
presented here. The report list contains the appliance firmware and shows all the available reports in SonicWall
Analyzer for the appliance. This decision on which report is applicable to a particular firmware version (for
example, Application Intelligence is for SonicOS 5.8 or higher) is made at run time when the scheduled report
engine is ready to create the report. The schedule report creation and the template usage is detailed in this
section.
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Adding a Template

To add a template using the Template Manager, complete the following steps:

1 Navigate to the Universal Scheduled Report > Manage Templates page.

| :.‘...l' Universal Scheduled Report - Template Manager (= 4
| Add Terpiate | @ for unk O for group Q| [ clar |
f:l Name Level Owner ‘ Last Update
[] HIPAA Terplate (Default) Unit admin 2015-05-20 09:38:08 i |
[] PcT Repoits Tenplate (Default) Lnit admin 2015-05-20 09;38:08 |
] sox Template (Default) Unit admin 2015-05-20 00:38:08 i |

2 Choose the tab for the appliance to which you wish to add a template.

3 Select the option for either a unit or group template.
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4 Click Add Template.

. Add Template

Name: |

' : Policies

[] select Al

[_] pata usage
[] Timelne
[[] 1nitiators
[] Responders
[] services

[] Applications
[] pata Usage
[] petected

[T alrcad

Add

] [ Cancel

5 Enter a name for your template.

(03}

allows the end users to view list of all the report templates at a read-only level.

O 0

Click Add.

Select the check box next to the Reports you wish to use for this template.

Select the check box next to the Policies you wish to use for this template.

The configured template is now populated in the Template Manager list.

Visible To Non-Administrators is disabled by default, select the check box to enable this option. This

[ Universal Scheduled Report - Template Manager

: S |_ ===

Add Tenplate | & for unit O for group

L] name | Level
[] usr tenplate Unit
| HIPAA Termplate (Default) Uit

| PCI Reports Tenplate (Default) Uindt

[] sox Tenplate (Defaulr) Uit

admin

admin

admin

admin

Owner Last Update
“ 2015-05-20 17:51:39
2015-05-20 09:38:08
2015-05-20 09:38:08

201 5-05-20 09: 38:08

ux&
[ [ clear |
/0
P |
Pl
Pl

Editing an Existing Template

This section details the configuration procedures for editing an existing template. The Universal Scheduled
Report > Manage Templates allows you to filter the template list by Name, Level, Owner, and Last Update.
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To use the search option to find and edit an existing template, complete the following steps:

Searching for an Existing Template

1 Navigate to the Universal Scheduled Reports > Manage Templates page.

2 Click the search text field, then enter your search criteria.

A drop-down appears under the search text field.

3 Select a filter for your search criteria by clicking Name, Level, Owner, or Last Update from the search
drop-down list. In this example, we are entering “unit” for the search criteria and filtering the search

results by level.

.. Universal Scheduled Report - Template Manager

ST ghh
@ for uit O for group

[ Name Level
] usr terplate Unit
] HiPAA Terplate (Default) Unit
| PCT Reports Template (Default) Unit
[_] 50X Terplate (Default) Unlit

admin

admin

admin

admin

O un

Onmri l.wal:"unl:'.'"

Clear

| Ovmer: "unit"
| Last Update:"unit"

EUT U O O

2015-05-20 09:38:08

2015-05-20 09:38:08

1]
y
i
i |
P |

The Template Manager window displays the latest search results. Notice the template list now only

shows report templates for level: units.

II [ Universal Scheduled Report - Template Manager

| Feewan | Shia
@ for unt © for group

] name | Level
[] usr tenplate Unit
|J HIPAA Template (Default) Unit
[] PCE Reports Template (Default) Uinit
[_] sox Tenplate (Default Uit

admin
admin
aidmin

admin

Last Update
-2015~05A201?:51:39 Pl |
2015-05-20 09:38:08 Pl
2015-05-20 09:38:08 i
2015-05-20 09:38:08 |

@ | NOTE: To clear your search results and return the reports template list back to default, click Clear.

Editing an Existing Template

Now that you found an existing template using the search filter, it is time to use the edit option.

Al WARNING: Editing an existing template also changes the associated scheduled reports (if applicable).
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To edit an existing template, complete the following steps:

1 Click the Edit icon for the report you wish to edit.

| .".1.'!’ Universal Scheduled Report - Template Manager

Add Tenplate | (&) for unit O for group &% Clear
[] Name | Level Owner I Last Update
[ usr tenplate Unit admin 2015-05-20 17:51:30 i
[_] HIPAA Tenyplate (Default) Unit admin 2015-05-20 D9:38:08 P |
(] PCI Reparts Template (Default) Linit admin 2015-05-20 09:38:08 f ﬁ
|| s0x Terglste (Default) Unit admin 2015-05-20 09:38:08 P |
The Edit Template window displays.
Edit Template X

Name: [Usr template

‘ [] select All

[] pata usage
[ Timeline
E Initiators
[ Responders
Iz Services

[] Applications
[] pata Usage
[] Detected

71 Blarkad

[ Update ][ Cancel

—_—

2 Edit the name for your template.

3 Visible To Non-Administrators is disabled by default, select the check box to enable this option. This
allows the end users to view list of all the report templates at a read-only level.

4 Select the check box next to the Reports you wish to use for this template.

5 Select the check box next to the Polices you wish to use for this template.
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6 Click Update.

The configured template is now populated in the Template Manager list.

[\ Universal Scheduled Report - Template Manager

“’ : SMA
(Rairmots ] © onk Ot

] Name | Level
[ usr template Unit
| HIPAA Termplate (Default) Unit

| PCI Reports Tenplate {Default) Unit

Linit

admin

admin

admin

admin

Owner Last Update

2015-05-20 17:51:39

2015-05-20 09:38:08

A015-05-20 09:38:08

2015-05-20 06:38:08

Deleting a Template

The Template Manager offers three different ways to delete a template: deleting a single template, deleting
multiple templates, or deleting all templates. Use the section Searching for an Existing Template on page 34 to

search for templates to delete.

To delete a Universal Scheduled Report Template(s), complete the following steps:

WARNING: Deleting a template(s) creates a cascading task to remove it from the Scheduled Reports that

are using this template.

Deleting a Single Template

1 Navigate to the Universal Scheduled Reports > Manage Templates page.

2 Click the Trash icon for the template you wish to delete from the Template Manager list.

i . Universal Scheduled Report - Template Manager

| ew | SMA

@ for unt O for group
' [[] Mame Level
[ Ust tenplate Unit
|1 HIPAA Tenplate (Default) Unit
[] PCI Reparts Template (Default) Unit
|1 sox Tenplate (Default) Unit

admin

admin

admin

admin

Owner Last Update
2015-05-20 17:51:39
2015-05-20 D9:38:08
2015-05-20 09:38:08

2015-05-20 09:38:08

Clear

";

Pl
£ 0
£ 0

Deleting Multiple Templates

1 Navigate to the Universal Scheduled Reports > Manage Templates page.

2 Click the check boxes for the templates you wish to delete.
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3 Click Delete Selected. This button is grayed out by default until a check box is selected.

[ Universal Scheduled Report - Template Manager Ox

(®) for unit ) for group = | | [ Clear

o1

[ Name a Level Owner Last Update

[ PCI Reports Template (Default) .l_lnit .admin 2011-11-30 12:51:00 . S 0
[¥] Test Template 1 Unit gmsdoc 2011-11-16 17:51:00 |
|:| Test Template 2 Group gmsdoc 2011-11-17 11:09:00 ri ﬁ
[¥] Test Template 3 Group gmsdoc 2011-11-18 10:22:00 |
[] Test Template 4 Unit gmsdoc 2011-11-18 10:22:00 S 0O

[T

[oossoeced ] |

Deleting all Templates
1 Navigate to the Universal Scheduled Reports > Manage Templates page.
2 Select the Name check box, this selects all templates in the list.

3 Click Delete Selected. This button is grayed out by default until a check box is selected.

]

[«]

I~ Universal Scheduled Report - Template Manag o ox
SRA P ]
Add Template | (®) for unit () for group A\ | | [ Clear

¥ Name A Level Owner Last Update

] PCI Reports Template (Default) Unit admin 2011-11-30 12:51:00 L 0O

[¥] Test Template 1 Uit gmsdoc 2011-11-16 17:51:00 £ O

[¥] Test Template 2 Group gmsdoc 2011-11-17 11:02:00 L 0

[¥] Test Template 3 Group gmsdoc 2011-11-18 10:22:00 Vi

[¥] Test Template 4 Unit gmsdoc 2011-11-18 10:22:00 Pallil
===

Adding a Scheduled Report Component

Using Universal Scheduled Reports gives you the ability to schedule reporting for multiple appliances at once,
combined into a single report. The Scheduled Reporting is a wizard based tool that guides you through the steps
for creating a scheduled report by manually selecting reports from the report listing or picking a template
created in the section Using the Manage Templates Component on page 31, selecting a theme (cover logos, font
colors, title, sub title), reporting properties (out put format, language), scheduling a type (weekly, monthly), and
choosing a destination (up to five email addresses can be added for a single report). This section contains the
following subsections:

e Searching for a Group or Device on page 38

e Creating a Universal Scheduled Report on page 40
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Searching for a Group or Device

The Search option allows you to filter the Group/Device list by manually entering a device in the search text field
and selecting it from the search drop-down list. You can further filter the Group/Device list by clicking the View
drop-down and selecting a view type. The following example guides you through the Device List search process,
detailing the versatility of the Universal Scheduled Reports > Configuration Manager search options.

Example

In this example we are using the Configuration Manager search options to find a SonicWall TZ 210 wireless-N
device in the Device List.

1 Navigate to Universal Scheduled Reports > Add A Scheduled Report.
@ | NOTE: The Monitor tab is only available for SonicWall GMS.

T‘:‘ Universal Scheduled Report - Configuration Manager

Select Reports

Device List - Firewall

<¥| | (77 [Gobavew [~

4 I Firewsall ] | [
Group/Device Serial No Model D;"

@ Aarons NSA-250M 0040100C1891 I
@ Aarons TZ-210 0040100C1111

@ Aarons TZ-215 004010001112

@ C5M- 4358 000681184358

@ E3500 - 7C30.123 0017C5107C30 NSA 3500

@ E4500-1E7C.122 0017C5101E7C NSA 4500

e A e i R et AR TIOC A ASTIYA RRC A T

2 Select the Firewall tab, located at the top of the Configuration Manager window.

3 Click the View drop-down, then select a view type from the list. In this example, we are selecting
ModelView (GlobalView is selected by default), because we are searching for an exact appliance model.
You can also filter the Device List by FirmwareView, or GlobalView.
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The Device List now displays all the appliance models.

| “_': Universal Scheduled Report - Configuration Manager

Select Reports

Device List - Firewall

Al ] 7 (odetaen__[ <]
[ Firewan | | &l
Group/Device

Serial No ‘ Model

Model: TZ 190 Wireless Enhanced
@ Model: TZ 200 wireless-N
i Model: TZ 205

I Model: TZ 210

[ Model: 72 210 vireless | (¥

™ LG
@ Model: TZ 215 \.'dlreless-}il"H I

= waodob T rnn

4 Select the Model: TZ 210 wireless-N.
A list of devices for that appliance model displays.

@ NOTE: Notice that the search history bar populates each time you filter the list. You can use this to
navigate back to previous search results.

[~ Universal Scheduled Report - Configuration Manager

Select Reports

( - | — )

Device List - Firewall ‘

Q[ ] T [ ModeMew |~ |

| Frenal [ Modet TZ210 wite... | | |

Group/Device Serial No i Model

@ TZ210W - BiB1.28 0017C32081B1 TZ 210 wireless-N
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You can also click Search (if you know the exact name of the device), then manually enter the device

name or select the device from the drop-down list.

T

; I':I Universal Sched uled Report - Configuration Manager

Select Reports

G = | =

Device List - Firewall

a; E3500 - 7C30.123
1
| E4500 - 1E7C.122 !
| L

0047C53081B1 TZ 210 wirelass-N

All | T [ ModeMew [~ ]
M |4
| Aarons T2-210 —lnire. .. |.|
| Aarons TZ-215
r Serial No | Model
| CSM - 4358 ! |

5 Click the Arrow icon to schedule a report for that appliance. Refer to Creating a Universal Scheduled

Report on page 40 for configuration procedures.

:
| T Universal Scheduled Report - Configuration Manager

Select Reports

G - ™

Device List - Firewall

a | | 77 [ ModeNew

| Frewal | Modek z210wie... |~ |

Group/Device Serial No Model

@ TZ210W- 81B1.28 [+ DO17C52D8181 TZ 210 wireless-N

Creating a Universal Scheduled Report

The Universal Scheduled Report - Configuration Manager allows you to create a single report for multiple
appliance models/devices at a group and unit level. The following example guides you through the report

configuration process, including: Selecting Reports, General Information, and Theme Information, detailing the
versatility of Universal Scheduled Reporting.

In this example we are using the Configuration Manager to schedule a single report for a Firewall appliance

model (group level) and SMA devices (unit level).
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Selecting Reports

1 Navigate to Dashboard > Universal Scheduled Report > Add a Scheduled Report.
@ | NOTE: The Monitor tab is only available for SonicWall GMS.

| E_]' Universal Scheduled Report - Configuration Manager

Select Reports
SHA )
Device List - Firewall
A T [rodeview |~ ]
1| Fieval | b
Group/Device

Serial No Model

Madel: TZ 200 wireless-N
{3 Model: TZ 205
Madel: TZ 210

Model: TZ 210 wireless-N b

5 Model; TZ 215 wireless-N @
]
2 Select the Firewall tab, located at the top of the Configuration Manager window.
3 Search for the TZ 210 wireless-N model group. Refer to steps 1-3 in the section Searching for a Group or
Device on page 38.
4

Click the Arrow icon for the Model: TZ 210 wireless-N.
The Reports tab displays in the Reports List.

E: | Scheduled Report - Confi

Select Reports

i |

] |» | Selscted Reports

| ReportList - Model: T2 210 wirelass-N

v Frewall

Use Templates... v [Group] Model: TZ 210 wireless N

Data Uisage - Summary
[] select Al

Applications - Summary
[#] pata Usage
[ summary
[ applications
] summary
[] web Activity
] summary

[ web Filter

T T T T J‘
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5 Click the Reports tab, then select the check boxes for reports you wish to include or click the Use
Templates link to choose a template you created.

@ NOTE: When you select reports in the Reports and Policies tabs, they populate in the list of
Selected Reports located on the right side of the Configuration Manager page. The Selected
Reports panel allows you to organize the list by dragging and dropping reports/devices, collapse
the reports lists for each device (clicking the arrow next to the device name), and add a note to a

report/device.

6 Click the Policies tab, then select the check boxes for the policies you wish to include or click the Use
Templates link to choose a template you created.

[ select All
[#] Subscriptions
[ Exprrg
[ Exping (Fres Tral)
[ Expred

."_‘-' | Scheduled R t - Config: o A x
Select Reports
O T I S ) 13 setected Reports B
Report List - Model: T2 210 wireless.N ¥ Firevall
Use Templates... v  [Group] Model: TZ 210 wireless-N

Data Usage - Summary

Applications - Summary

Subscriptions - Expiring

Subscriptions - Expiring (Free Trial)

Subscriptions - Expired

T T

4

The reports for the Firewall model group are now selected, next is choosing the reports for the SMA

device.

7 Select the SMA tab.

The SMA models display in the Device List.

Select Reports

‘_‘ Universal Scheduled Report - Configuration Manager

[ Firewall

|

Device List - SMA

b

I SMA I Model: Unknown

Group/Device

@ SMA 4200

(0 SMA 4800

Serial No Model

0017C552F35C

0017C552F3B80D

8 Click the Model: SMA 4800.
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The Device List displays all the SMA 4800 devices.

Select Reports

| f Universal Scheduled Report - Configuration Manager

Device List - SMA

( Elical L s

U

Y 77 [Modemew | -]
[ swa | model: nicoum | =] |
Group/Device Serial No | Model
@ SMA 4200 0017C552F35C .
@ SMA 4800 =} 0017C552F3BD

9 Click the Arrow icon for the SMA 4800.

The Reports window displays in the Reports List.

10 Select the check boxes for the reports you wish to include or click the Use Templates link to choose a

created template.

@ | NOTE: The SMA only offers a Reports tab (no Policies tab).

Select Reports

Report List - SMA 4800 (0017C552F380)

==

] select Al

[¥] Data Usage
[ Tmeine
[ users

[[] Access Method
L] summary
[ users

[] Authentication

Use Terngplates...

( Ereval s ) () sekected Raports

¥  Firewsll

»  [Group] Model: TZ 210 wireless-N

+

v [Unit] TZ 210W - 81B81.28 (0017C52D81B1)

Data Usage - Timeline
[Drata Usage - Initiators
Data Usage - Responders
Data Usage - Services
Applications - Data Usage
Applications - Detected

Annllrabnne - Alardad

[ Beck |[ mext ][ rFiosn

11 Click Next.
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General Information

The General Information page displays.

NOTE: The settings entered in the Task Info, Format/Settings, and Email/Archive Info sections, populate in
the Configurations panel located on the right side of the General Information page.

|_: Universal Scheduled Report - Configuration Manager Oox

General Information

Task Info

[»]

Configurations

r Task Name: Example Report 1
Task Name # | Example Report 1

o Report Type: Daily
Task Description | This is an example for configuring a Universal Scheduled Report
Report Format: PDF
Report Language: English
Report Rows Display: 20

Disable the Report: No

Zip the Report: No

PDF Password Protect Mo
Format/Settings

Delivery Type: [ Email [ Archive
Report Type #* (%) Daily @] Weekly =) Monthly
Report Format * (8 ppE () amL

Report Language ¥ [English |V]

Report Rows Display [ 20 | - ]

Disable the Report O Yes ® No

Zip the Report O Yes ® Mo
PDF Password Protect ) Yes ® Mo

| Email/Archive Info

[ Email
[ archive
<] | [»

Back || mMext |[ cancel |.:£

<1l

12 Enter the following in the Task Info panel:
e Task Name: Example Report 1
e Task Description: This is an example for configuring a Universal Scheduled Report
13 Select the following in the Format/Settings panel:
e Report Type: Daily, Weekly, or Monthly
e Report Format: PDF or XML
If XML is selected, the following changes to the management interface occur:

e The Single XML per Report radio buttons display. If you select the Yes radio button, one
XML file per report is generated. In this scenario, the number of XML files created is equal
to the number of reports chosen.

Format/Settings

Report Type #  (®) Daily @ Weekly @] Monthly
Report Format # () POF () ¥ML

Single ¥ML per Report ® ves D Mo
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e The ZIP Password Protection option is grayed out.

e Report Language: English, Japanese, Chinese (Simplified), Chinese (Traditional), Korean, Spanish,
or Portuguese

e Report Rows Display: 5, 10, 20, 50, 100, 250, 500, 750, 1000, 1500, or 2000
e Disable the Report: Yes or No
e Zip the Report: Yes or No

e PDF Password Protect: Yes or No (If Yes is selected, a pop-up window appears and prompts you to
enter the Password)

14 Click the archive check box to save a PDF report to a new folder.

15 Complete the following in the Email / Archive Info panel:

Email/Archive Info

[ Email
[ archive

16 Click the E-mail check box to send a PDF report to an email account or alias.

The Email configuration options display.

Email /Archive Info
[+ Email

E-Mail Destination * [CaAghcellser | =| Add I

£-Mail Subject = Jlfff"mr_afo" Y

e 22 ve 28 ..-.
E-Mall Body ";

17 Click the E-Mail Destination drop-down, then select an Administrator or Adhoc User.

18 Click Add after each selected destination.

The E-Mail Destination populates in the list.

Email/Archive Info
[ Email
E-Mail Destination Adhoc User | ,] [ Add
Admin Administrator o
Appliance User Appliance User ii]
Adhoc Emall Addresses (semicolon separated) ii]

® | NOTE: Multiple destinations can be sent in a single E-mail.

19 Enter the E-mail Subject: Weekly Firewall and SMA Report
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20 Enter the E-Mail Body: This Universal Scheduled Report contains the SonicWall TZ 210 wireless-N group
and SMA 4800 unit

E Ermail
E-Mail Dastination su[ Administrator [.] I Add ]
Destination Details |
Adhoc |E|ndi| Mddresses (semilcolon separated) | ﬁ
Admin Administrator i

E-Mail Subrject % | Weekly Frewall and SMA Report

E-Mail Body | This Universal Scheduled Report contains the SonicWALL TZ 240
wireless-N group and SMA 4800 unit.

21 Click the Archive check box to save a PDF report to a new folder.

22 Archive Folder: Test Archive Folder 1

E-Mail Subject = | Weeldp' Firewall and SMA ﬁeport

E-Mall Body | This Universal Scheduled Report contains the SonicWALL TZ 210
wireless-M group and SMA 4800 i,

[ Archive

Archive Folder im I
(If path is mvalid, default path is [GMSVP directory [/ Viewpoint/reports. )

23 Click Next.
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Theme Information

The Theme Information page displays. If XML is selected from the General Information page, the Theme
Information page is NOT displayed.

@ | NOTE: The settings entered in the Cover Page and Report Page panels automatically update in the
image located on the right side of the Theme Information page. To preview the cover / report
pages, select the Cover Page or Report Page tab.

|_1 = 1 Scheduled Report - Confi ion 1 o x

Theme Information

Cover Page Report Page ]
oerlose @ sectaiono [covrbsost ||
() Upload alogo | Browse and Preview
SOMICWALL™

Cover Title | |

L
Foreground: IEI Background:

Cover Subtile | |

Foreground: IEI Background:

Report Page

Report Tite  Foreground: IEI Background;
Report Description  Foreground: IEI Background:

Faport Dat foe Quicber 32, 2001

Cmatin en Cokbar 34, 30 3540 Paad B e

> : 1 >

e | o J[ oo

24 Select / Enter the following in the Cover Page panel:

e Cover Logo: Select a logo (click the drop-down and select a cover logo image) or Upload a logo
(click Browse and Preview to upload a logo)

e Cover Title: Enter a name (Weekly Data Usage Report) for your Universal Scheduled Report, then
select or enter the foreground and background colors

e Cover Subtitle: Enter a subtitle (U.S Engineering Department) for your Universal Scheduled
Report, then select or enter the foreground and background colors

Cover Page

Coverloge (2 selectalogo | cover logo.qif -
© Upload a logo

!Weeldy Data Usage Report |

Foreground: lEl Background:

Cover Subtitle !U.S Engineering Department |

Foreground: IE‘ Background:

Cover Title
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25 Select or enter the following in the Report Page panel:
e Report Title: Foreground and Background colors

e Report Description: Foreground and Background colors

Report Page

Report Tite  Foreground: lE Background:
Report Description  Foreground: IEI Background:

26 Click the Cover Page and Report Page tabs to preview your Universal Scheduled Report.

[ coverpage | reportrage | | coverpage

I Bandwidth - Summary for 2011-06-29

SONICWALL> —
Weekly Data Usage Report T A e
U.s. Eng iI'IeEI'i ng Depal'tl'l'lel'lt 7 u\‘llg il & il FAA07 KR nanaan

T 5 T0251 KD [IERT T
aen

Report Date for December 01, 2011
CR T RENI KK [STETS
0108

DY LTI [ECLH T
s

R T T (EET
0510

Foanmn a2 ] [TETE

CRIT LT 1 UEHH [T
nzem

SHAmN Wl EEGTE] UEa000
8 5

[T [EeTEm

1 75T KA [ERTE
i

[
2

T ETOAT ([T T
]

12 113011 BT KB usngam
1200

OB MR

Creates oo Deremier D1, 2011 0345 P Fonere B s TR

27 Click Next to manage permissions. Continue to the next step.
OR
Click Finish to complete the report. The report is now scheduled and can be found in the Universal
Scheduled Reports > Manage Scheduled Reports page.

NOTE: When the Universal Scheduled Report PDF is exported, a table of contents is created. This
allows you to quickly browse through your scheduled reports.

28 In the Users panel, select users that you want to give permission to resend or manage this scheduled
report. The selected users populate in the Selected Users panel.

@ NOTE: Only the Schedule Report Creator can assign permission resend and manage privileges to
other users.—If the Scheduled Report contains reports for multiple units and multiple reports, then
the grantee should have permissions to the units and reports which are included for the scheduled
report.—Users under the Administrators group have access to all the schedule reports.

29 In the Action Permissions panel, click the check box for the type of permissions to give the selected user:

e Resend — users with permissions to resend can only run the report.
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e Manage Scheduled Report — users with manage permissions can run and edit (manage) the

report.
i [ universal Scheduled Report - Confi o x
I Permission Management
Users | Action Permissions Selected Users
i 2+ |
¥ @ Localbomain [ Resend p  LocalDomain
% Administrators Lk [¥] Manage Scheduled Report |
v % End Users
B, enduser
| |
[ Back || wext |[ pPosn || caned | |

30 Click Finish to complete the report. The report is now scheduled and can be found in the Universal

Scheduled Reports > Manage Scheduled Reports page.

Managing the Scheduled Reports Component

Managing Scheduled Reports is used to manage the scheduled report task inventory by resending, Emailing /

archiving now, editing, and deleting scheduled reports.
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Resending a Scheduled Report

To resend a scheduled report, complete the following steps:

1 Navigate to the Universal Scheduled Reports > Manage Scheduled Reports page.

Lj Universal Scheduled Report - Report Manager 0ox
Viewpoint Schedul " @
Schedules in the system: ; k MNext Scheduled Email/Archive Time: Nov 22, 2011 Tue [02:55 AM]
Weekly Schedules Last Attempted: HNov 21, 2011 Mon [02:55 AM] Mext Weekly Reports Time: Nov 28, 2011 Mon [02:55 AM]
Monthly Schedules Last Attempted: HNov 6, 2011 Sun [06:55 PM] Mext Monthly Reports Time: Dec 6, 2011 Tue [06:55 PM]
Scheduled Report Manag Ty
Name contains | ! Error containg 1 | Schedule Type [ All | - | Status [ All | - | Owner | | - |
D [ Hame Type Format Owner Status Last Run Time  Last Run Error
15 [#] Example Report 1 (1 Dally PDF gmsdoc B Nov2i,2011Mo... P
—
[ Defete selected ||| Resend for Date Range || Emai/archive Now | §

2 Use the filter options to search for a report in the Scheduled Report Management list, select the check

box of the report you wish to resend.
3 Click Resend for Data Range.

The Select Data Range pop-up window displays.

Select Date Range X

Start Date:
End Date: I:I

4 Enter the Start / End dates by clicking the Calender icon and selecting the dates.

5 Click Re-send.

The Info pop-up window displays, confirming the schedule resend is complete.

Info

Selected Schedules set successfully for immediate

processing

6 Click OK.
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Emailing/Archiving Now

To Email/Archive a Universal Scheduled Report before its scheduled sending date, complete the
following steps:

1 Navigate to the Universal Scheduled Reports > Manage Scheduled Reports page.

|_‘; Universal Scheduled Report - Report Manager ox
Viewpoint Scheduk y @
Schedules in the system: 1 Mext Scheduled Email /Archive Time: Nov 22, 2011 Tue [02:55 AM]
Weelly Schedules Last Attempted: MNov 21, 2011 Mon [02:55 AM] Mext Weekly Reports Time: Mov 28, 2011 Mon [02:55 AM]
Monthly Schedules Last Attempted: Nov 6, 2011 Sun [06:55 PH] MNext Monthly Reports Time: Dec 6, 2011 Tue [06:55 PM]
Scheduled Report M +
Mame contains | Errar contains Schedule Type [ All | - | Status [ All ‘ - | Owner [ All | - |
I E Hame Type Format  Owner Status Last Run Time | Last Run Error
15 E Example Report 1 I.7) Daily PDF gmsdoc B Mov 21, 2011Mo... |
[ Delete Selected ] [ Resend for Date Range ”[ Email{Archive Now I | e

2 Use the filter options to search for a report to Email /Archive in the Scheduled Report Management list.

3 Select the check box next to the report name.
4  Click Email/Archive Now.

The Info pop-up window displays, confirming the immediate processing of Email / Archive.

Info

Selected Schedules set successfully for immediate

processing

5 Click OK.

Your Scheduled report is now Emailed and Archived.
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Editing a Scheduled Report

To edit an existing scheduled report, complete the following steps:

1 Navigate to the Universal Scheduled Reports > Manage Scheduled Reports page.

Vi Schedukb ¥ @
Schedules in the system: i Mext Scheduled Emailfarchive Time: Nov 1, 2011 Tue [03:55 AM]
Weekly Schedules Last Aftempted:  Oct 30, 2011 Sun [08:55 PM] Mext Weekly Reports Time: Nov 6, 2011 Sun [08:55 PM]
Monthly Schedules Last Attempted: Oct 7, 2011 Fri [03:55 AM] Mext Monthly Reports Time: Nov 7, 2011 Mon [03:55 AM]
nnnnn Report M +
Name contains |:| Error contains ’—| Schedule Type [ All | > | Status [ Al ‘ - | Owner [ all | - ‘
18] Dlanle Type | Format = Owner Status. Last Run Time | Last Rum Error |
. 12 . [] TechPubs Test Repart @ ; Daily " PCF .gmsdoc . | | .Oct 31, 2011 Mo... . m

l Delete Selected | I Resend for Date Range | | Ermnail{Archive Nav |

2 Use the filter options to search for a report in the Scheduled Report Management list, click the Edit icon
for that Report.

3 To edit the Scheduled Report, use the same configuration procedure shown in Creating a Universal
Scheduled Report on page 40.

Disabling a Scheduled Report

To disable a scheduled report, complete the following steps:

1 Navigate to the Dashboard > Universal Scheduled Report > Manage Scheduled Reports page.
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2 Click on the Edit icon for the report you wish to disable.

The Universal Scheduled Reports - Configuration Manager window displays.

" Unerer chadund Report -

Select Reports

L Feewa

] \w| Selacted Reports

Report List - TZ 210W - 8181.28 (0017C5208181)

Use Templates...

¥ Frewall
B [Unit] Prasad Desk TZ-500 (COEAE4AFGO...

¥ [Unit] TZ 210W - B161.28 (00170S2081081)

[] select All I Data Usage - Timeline
¥ Data Usage
] Tenehie Data Usage - Initistoss
[ 1nistors Data UUsage - Responders
[¥] Responders
¥ services Data Usage - Services
E Applications Apgilications - Data Usage
E Dtz Usage
Applications - Detected
(=
Annliiatinne - Blarkad
[ meck |[ et ][ Fmsh J[ cancel ] .
3 Click Next.
The General Information Page displays.
L-r = I Scheduled Report - C on o x
General Information
Format/Settings .‘.‘. Configurations
. Task Mame: Example Report 1 |4]
Report Type # (%) Daily (] Weekly o Monthly
R t Type: Dail
ReportFormat # (%) poF 2 ML RS "y
Report Language [ English |v] | | ReportFormat: PDF
Report Rows Display [ 20 | = I Report Language: English
Disable the Report | ®) Yes | ) No Report Rows Display: 20
Zip the Report () Yes (®) No Disable the Report: Yes
PDF Password Protect () Yes ® No Zip the Report: Mo
PDF Password Protect No
=

4 Inthe Format/Settings panel, navigate to the Disable the Report option and click Yes.

@ | NOTE: To enable the scheduled report, repeat steps 1-3, then click No.
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Deleting a Scheduled Report

To delete an existing Universal Scheduled Report, complete the following steps:

1 Navigate to the Universal Scheduled Report > Manage Scheduled Reports page.

| universal scheduled Report - Report Manager i
s Fiaatiil v @
Schedules in the system: 1 Mext Scheduled Emailfarchive Time: Mov 1, 2011 Tue [03:55 AM]
Weeklly Schedules Last Attempted:  Oct 30, 2011 Sun [08:55 PM] Mext Weeldy Reports Time: Mov &, 2011 Sun [08:55 PM]
Monthly Schedules Last Attermpted: Oct 7, 2011 Fri [03:55 AM] MNext Monthly Reports Time: Mov 7, 2011 Mon [03:55 AM]

Scheduled Report Management

Name contains ‘ Error contains E Schedule Type [;\j] | - ] Status [ All | vl Qwner [ All | v]
1D |:| Name Type Format  Owner Status Last Run Time Last Run Error
12 [] TechPubs Test Report \2) Daily PDF gmsdoc B Oct31, 2011 Mo.., Fa
H Delete Selectad m Resend for Date Rangs | | Email {Archive MNow | 4

2 Use the filter options to search for a report in the Scheduled Report Management list, select the check
boxes for the reports you want to delete.

3 Click Delete Selected.

The selected reports are now deleted.

® | NOTE: You can also use the Trash icon to delete a specific Scheduled Report.
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Reporting

e Overview of Reporting
e Managing Firewall Reports

e Viewing SMA Reports
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Overview of Reporting

This chapter describes how to use SonicWall Analyzer reporting, including the type of information that can
appear in reports. A description of the available features in the user interface is provided.

This chapter includes the following sections:
e SonicWall Analyzer Reporting Overview on page 56
e Navigating SonicWall Analyzer Reporting on page 59
e Report Data Container on page 71
e (Custom Reports on page 78

e Managing Analyzer Reports on the Console tab on page 79

SonicWall Analyzer Reporting Overview

An essential component of network security is monitoring critical network events and activity, such as security
threats, inappropriate Web use, and bandwidth levels. SonicWall Analyzer Reporting complements SonicWall's
Internet security offerings by providing detailed and comprehensive reports of network activity.

The SonicWall Analyzer Reporting Module creates dynamic, Web-based network reports from the reporting
database.

The Analyzer software application generates both real-time and historical reports to offer a complete view of all
activity through SonicWall Internet security appliances. With Analyzer Reporting, you can monitor network
access, enhance security, and anticipate future bandwidth needs.

You can create Custom reports by using the report filter bar, available in most report screens in the Analyzer
user interface. The report Filter Bar provides filters to allow customized reporting, including pre-populated quick
settings for some filter fields. A Date Selector allows paging forward and backward in time, or selecting a
particular time period for viewing, through a drop-down calendar. The search operator field offers a
comprehensive list of search operators that varies depending on the search field, which can be either text-based
or numeric. See Layout of Reports Display on page 62 to see these items in the context of the Report page.

You can search all columns of report data except columns that contain computed values, such as %, Cost, or
Browse Time. SonicWall Analyzer waits until you click Go before it begins building the new report.

The SonicWall Analyzer Reporting Module provides an interactive interface that:
e Displays bandwidth use by IP address and service
e |dentifies inappropriate Web use
e Provides detailed reports of attacks
e (Collects and aggregates system and network errors
e Shows VPN events and problems
e Tracks Web usage by users and by Web sites visited

e Provides detailed daily firewall logs to analyze specific events.
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Viewing Reports

The Analyzer Reports view under the Firewall and SMA tabs is divided into three panes: the TreeControl Pane,
the middle pane with the Policies and Reports tabs, and the Reports pane.

e TreeControl Pane: A list of individual units referred to as the TreeControl. In the left pane, you can select
the top level view or a unit to display reports that apply to the selected view or unit. The top level view is
GlobalView.

e List of Reports: The middle pane provides two tabs: Policies and Reports. The Reports tab contains a list
of available reports that changes according to your selection in the TreeControl pane: GlobalView
provides a general summary of various functions, and unit view provides specific details. The reports are
divided into categories. You can click on the top level report in a category to expand it to view the list of
reports in that category, then click on an individual report name to view that report. To keep a category
in expanded view, click on the category while pressing the Ctrl key. Otherwise, the expanded entry
collapses when the next entry is expanded.

e The Reports Pane: The right pane displays the report that you selected in the middle pane for the view or
unit that you selected in the TreeControl. For most reports, a search bar is provided at the top of the
pane. Above the search bar, a time bar is provided. You can view the report for a particular time by
clicking right and left arrows, or clicking on the center field to get a drop-down menu with more options.
Click onicons in the upper left corner to send the report to a PDF or UDP file. These files can then be
printed for reference. A quick link to the Universal Scheduled Reports menu is also provided, allowing
you to set up scheduling and other functions.

Data Usage Summary Date Selec’(or—* Dec 02, 2011 00:00 to Dec 02,2011 23:59 | | Export Results —d[" B | E

-+: Filter Bar [EXE r! -LadCustnm Report- |+

Save Report Button cystom Report Buttdh

SO0E,000,000 Reload Data
1,500,000,000 Chart/Graph View
Buttans

350,000 ¢
300,000
250,000
200,000
150,000 i
e

100,000
& & <V

[LITepee cemectons [ata Container et

1,000,000,000

Connections
W Transferred

Transferred

~L 500,000,000

Connections

0

i)

MNSA 240 55F1.125 331,899 i

Test 240 16,794 1.21GB
Test-210W Desk 2,413 34.51MB
ES000 6D84.121 q D h Vi eW 33.37MB
TZ 210 1C0OD.27 :@ 5. 7ME
TZ 200 W FDCO.29 1,557 6.05MB
E3500 7C30.123 4,534 | 4.16 MB
TZ 210W 81B1.28 175 2.22MB
MNSA 2400MX - 4678, 126 332 1.49 MB
10 NSA 2400 - FFAC. 127 17l 1.35MB
117TZ 180 B3AC.23 315 974.6 KB
12PRO 1260 4280.101 248 857.53 KB
13TZ 150 W 29B1.25 287 664,36 KB
14TZ 180 W 39F8.21 148 318.05 KB
15 MNSA 240 SAD9.124 230.18 KB
16 TZ 220 - 4370 8.91KB

Total 2.75 GB

5
24
3
4
5
3
T8
8

o
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The SonicWall Analyzer reporting module provides the following configurable reports under the Firewall and

SMA tabs:

Firewall Reports

Feature

Description

Data Usage*

Provides an overall data usage report.

User Activity Reports

Produces a Detail report of user activity.

Applications*

Provides information on application access and firewall reports

Web Activity* Provides Web usage reports, including initiators and sites.

Web Filter* Provides web filter event reports, including by initiators, by sites, and by
category.

VPN Usage* Provides VPN usage reports on policies, services, and initiators.

Threats (Summary Only)

Access attempts by appliance.

Intrusions Provides event reports about intrusion prevention, targets, initiators, as well as
detailed timelines.

GAV Provides reporting on virus attacks blocked.

Anti-Spyware Provides reporting on attempts to install spyware.

Attacks Provides event reports about attacks, targets, and initiators,

Authentication

Provides login reports.

Analyzers

Provides a detailed analysis of logs or activities.

Configuration

Configures settings for Summarizer and Log Analyzers.

Events

Creates, configures, and displays alerts.

Custom Report

Provides Internet Activity and Website Filtering reports with details from raw
data.

Custom Reports are only available at the unit level.

* Multi-Unit Report Available Provides a high-level activity summary for multiple units.

NOTE: All reports that are displayed in the Firewall > Reports tab are also available in the Universal
Scheduled Reports. However, the By Initiator and By Site reports related to Web Activity are available only
as Scheduled Reports and are not displayed in the Firewall > Reports tab.

SMA Reports

Feature

Description

General

Provides general unit and license status.

Data Usage*

Provides an overall data usage report.

User Activity Reports

Produces a detailed report of user activity.

Access Method

Provides information on application access and firewall reports

Authentication

Provides login reports.

WAF*

Provides Web Application Usage (WAF) usage reports.

Connections*

Provides web filter event reports.

Analyzers

Provides a detailed analysis of logs or activities.

Events

Used to configure and view Alerts.

Custom Report

Provides Internet Activity and Website Filtering reports with details from raw
data.

Custom Reports are only available at the unit level.

* Multi-Unit Report Available

Provides a high-level activity summary for multiple units.
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Navigating SonicWall Analyzer Reporting

SonicWall Analyzer Reporting is a robust and powerful tool you can use to view detailed reports for individual
SonicWall appliances.

This section describes each view and what to consider when making changes. It also describes the Search Bar
and display options for interactive reports, as well as other enhancements provided in SonicWall Analyzer. See
the following sections:

e Global Views on page 59

e Unit View on page 60

e Layout of Reports Display on page 62

e The Date Selector on page 64

e Export Results on page 67

e The Filter Bar on page 68

e Adding Filters on page 68

e Scheduling Reports on page 71

e Layout of the Data Container on page 71
e Viewing Syslog Data of Generated Reports on page 73
e Drilling Down on page 73

e Troubleshooting Reports on page 78

Global Views

From the Global view of the Firewall Panel, Summary reports are available for all SonicWall appliances
connected to SonicWall Analyzer. The Summary provides a high level report for all appliances. More detail is
available from the Unit view.

To open the Global view, click the My Reports view icon in the upper-left corner of the left pane.

Data Usage Summary 4 Dec14, 2011 00:00 to Dec 14, 2011 23:59 | =L AE]
1) !-E'i a3t [ | -Load Custom Report - |v |
Summary 5

1,000,000 i 36,000,000,000
000,
-+ 35,500,000,000
» 995,000 500,000, W
S 590,000 35,000000000 ¢
=3 " B
E 985,000 P S0, I0, 000 E Connections.
: 34,000,000,000 @
E 980,000 Qe = M Transferred
975,000 33,500,000,000
970,000 33,000,000,000
000 -
,;#‘
| Appliance Name Connections. | Transferred =
Total 985,183 31.93 GB

» Report generated for timezone; Padfic Standard Time
= Report owrer @l ocalDomain
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Summary pages are available for the major functions on the middle pane. By default, they display both the
Chart View and Grid View. You can use the toggle buttons to the right to display either view, or both.

NOTE: The selected Chart of Grid view remains in effect only for the specified screen. Changing screens
defaults back to the Chart and Grid View.

Unit View

The Unit view provides a detailed report for the selected SonicWall appliance.

SonicWall Analyzer provides interactive reports that create a clear and visually pleasing display of information.
You can control the way the information is displayed by adjusting the settings through toggles that allow you to
display a graphical chart, a grid view containing the information in tabular format, or both (default). Reports are
scheduled and configured in the Universal Scheduled Reports settings. For more information, refer to Using the
Universal Scheduled Reports Application on page 31.

The Reports tab provides a list of available Reports. Click on the type of report to expand the list items and view
the available reports in that screen group.

@] TP: At times, you might wish to see multiple screen groups at the same time. Ctrl-click to keep a
previously-expanded topic from collapsing when you select a new report category. For example, you might
want to view Data Usage, Applications, and Intrusions simultaneously, to see what detail sections are
available. Control-click on these entries to see all the screen groups under these entries simultaneously.

» General

¥ Data Usage
Timeline
Initiakars
Responders
Services
Details

¥ Applications
Data Usage
Detected
Blocked
Zategories
Initiakars
Timeline

¥ User Ackivity
Details

* Web Activity
Zategories
Sites
Initiakars
Timeline
Details

» Web Filter

F ¥YPN Usage

b Intrusions

b Gateway Yiruses

F Spyware

» Attacks

» Authentication

» Analyzers )

» Configuration @

The reports available are usually the reports that appear as sections in the Details view. The Details entry is a
shortcut to a view of all the available reports.
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To access the Reports, use the following steps:
1 Click on the desired tab at the top of the SonicWall Analyzer interface.
2 To open the Unit view, click on a device in the TreeControl pane.

3 Click on the desired report in the list of reports in the middle pane.

@ fvay 3| Tew 240 Thelie Lker | ad
Globalview |
= s Focneral Timeline 4 Jan 17,2012 00:00 to Jan 17, 2012 23:50
¥ Datallsage
O ESD00 - 608,121 S T 3
Timeine [ =
3 MSA 290 - S9F1 135 i + | 2 | sl [
= NSAZEND
5 Tesk 240 %@Mﬁ o
O Tes-2100W Desk Serries s
012105 Catalk
* Applications 7 5 " W ; - - 800,010,000
¥ User Activity i s
b Web Activity 2 g
» Web Filter g -5
» VPN Usage = E
b Intrusions 8
b Goteway Wiruses
b Spywnre
» Attacks
b Authenticati
3 e Time 4  Connechions | Transfeeeed
» ﬂl'ld’!tl’! - B i c
¥ Configuration 1 Jen LE 02 00500 24+ 1366208 |
¥ Custon Reports 2 lenid 2002 0100 254 ISO46E |
3 Jan L7 2Bl2 0z 247 1525568 |
+ 20l7 2012 0300 = 954318 |
5 i 2 60 65718 [
5 236 wed |
T 243 2023660 |
] 28 1eEnLiE |
2 ] 247 22904k |
10 J2n L7, 2012 09400 2,860 q1.7me |
1L =0 L7, 3002 i0i00 3,440 gassre |
12 Jen L7, 2009 1100 2,010 s0zare [T
19 Jen L7, 017 1700 14 ussare
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The default view of a root-level report always shows the chart and grid view of the report. The Sections
displayed in the Grid View depend on the Report item selected and the filters applied to it. Additional
information can be displayed by mousing over certain elements of the Report.

Data Usage 4 Dec14,201100:00 to Dec 14,2011 23:58 | E| B | £
+] 5% 8 [omommrge 1]
i ElL=E

[ HTTF - GUARDED

M Flash video (FLV) - GUARDED

M shockwave Flash (SWF) - LOW

I ssL-LOw

W Image -LOW

B Archive -LOW

M Document - LOW

[l Others

| Appli | Threat Level | 3 | Transferred v
1 HITP |ouARDED] 88,791 | 3 1oice Y
2 Flash video (FLV) |GuaRDED| 315 13168 ]
3 shockwave Flash (SWF) tow | 6143 | s211Me ||
4 580 ltow | 6933 | 493.24MB |]
5 Imsge fLow ] 44,421 ' i 449,12 MB I]
6 Archive lrow, | 187 405.03MB |
7 Document lrow 74 33428M8 ||
8 355H |ELEVATED| 96 | 333.77M8 ||
3 FIP |ouaRGED] 298 | 255.9M8 ||
10 Executable tovig] 64 245.36M8 ||
11 MP3 ltow | 43 | 234.01MB |]
12 MPEG-4 lrow 81 | 173.7MB |]
13 Gmail (Goodle Mai) |GuARDED| 48 | 93.23M8 |
14 Google Plus |GUARDED] 551 65.99M8 |
15 WebEx |suaRrDED] 623 | 62.61M8 |
16 Facebook |GuARDED| 3131 || 60.86MB |
17 Potential UltrasurfFreegate m 45 | 40.67 MB |]
18 I0M |GUARDED| 96 36.75 MB |]
Total 163,296 19.1 GB
» Report generated for timezone: Padific Standard Time

@ NOTE: As you navigate the Firewall panel with a single SonicWall appliance selected and apply filter
settings, your filter settings remain in effect throughout the session. To remove filter settings, click on the
search bar Remove Filters. (Refer to the graphic in Layout of Reports Display on page 62.)

Layout of Reports Display

The Report Display is comprised of the following areas:

e The Filter Bar area, which includes the Time Bar, Export, and Custom Reports buttons, and data filter
functions

e Report Data Container, containing the Chart and/or Grid Views
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The figure that follows shows the layout of the Report.

Data Usage Summary Date Selector _* Dec 02, 2011 00:00 to Dec 02,2011 23:59 | | Export Results
Filter Bar Y
Summary — 4
Save Report Button Custom Report Buttdn
350,000 ~i = 2,000,000,000 Reload Data
., 300,000 LWzl | 1500000000 T Chart/Graph View
5 250,000 4 5 Buttons
© 200,000 + 1,000,000,000 4
£ 150,000 § ' Connections
& 100,800 - 500,000,000 = W Transferred
50,000 0 e
0 T - — - t g ~t
P W o P
& é’@ «'5’@ & < <
™1 T I - — - - ) - wy
Appliance Name | Connections * Transferred v
B Data Container
1 NSA 240 59F1.125 331,899 1.44GB E
2 Test 240 15,734 rzce [
3 Test-210W Desk 2,413 34,51 M8 ﬂ
4 ES000 6D84.121 Gj,ﬁ,aoh V|eW 3z37m8 |
5 TZ210 1C0D.27 ) 67M8 |
6 TZ 200 W FDCO.29 1,557 6.05MB ||
7 E3500 7C30.123 4,594 416M8 |
& TZ210W 81B1.28 175 22m8 |
3 NSA 2400MX - 4673.126 332 148MB |
10 NSA 2400 - FFAC.127 171 135M8 |
117TZ 180 B3AC.23 315 974.6k8 |
12 PRO 1260 4280.101 248 857.53kB |
13TZ 150 W 2981.25 287 664.36K8 |
14 TZ 180 W 39F8.21 148 318.05k8 |
15 NSA 240 5A09.124 1,128 230.18k8 |
16 TZ 220 - 4370 117 8.91k8 |
Total 372,604 2.75GB
|
The Report contains the following areas:
e The Date Selector Bar
e The Filter Bar
+ | ; X
T Go Button T
Add Filter
Remaove Filters

e Export Options, including:
e Schedule Report button: brings up the Universal Scheduled Reports menus
e Export to CSV
e Export to PDF

e Save button

e Load Custom Report button

e Report Data Container. The Report Data Container consists of the Chart View and the Grid View, the
Show Chart, Show Grid, and Show Chart and Grid toggle buttons, and the Reload Data button.

@ | NOTE: The Chart view is clickable. You can drill down to Detail sections simply by clicking on areas of
interest in the bar-chart or pie-chart.
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The Date Selector

The Date Selector allows you to generate a report for only a specific date and time range. Use the right and left
quick-link arrows to move backward and forward in time, a day at a time. Clicking the time field on the Date
Selector brings up a drop-down menu that allows you to customize your time and date ranges.

Setting a Date or Date Range

By default, summary reports display only information for a single date. However, by using the Time Selector
drop-down menu, you can fine-tune the time, date, or range of times and dates you want to see. Over-time
reports display information over a date range.

Selecting a Date and Time

The Time Selector allows you to specify any time or date interval desired, whether by day, or in hour/minute
intervals. To select a single date for a report, either use the Date Selector bar and the left and right arrows to
page through reports by date, or click on the displayed date field in the Time Selector to display the drop-down
schedule menu.

4 Jun1i,201500:00 to Jun 11,2015 23:59 |

— | emt [

Todav

Interval (
Last 1 Hour
Start Date | st 6 hours

Jun 11, 204 Last 12 hours B m| o

End Date |Today

Jun 11, 204 Yesterday ]% it | 59 15 l
Last Week

Rows

E Custom

D Enable Server-side Sort (Connections, Events, Hits & Transferred)

WARNING: Selecting large date range and/or more number
of rows to display might affect report load performance.

[ ok || cancel |

You can select from:
e Last1 hour
e Last 6 hours
e Last 12 hours
e Today — 00:00 to 23:59
e Yesterday — 00:00 to 23:59
e Last Week — the previous 7 days, from 00:00 to 23:59
e Custom — a custom time and date range

In the drop-down schedule menu, you can specify a recent time snapshot, or click on Custom to select the
starting and ending dates and times. The Custom option allows you to select a specific time and date or range
from the Interval menu.
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1 To set up a custom time range, click in the Time Selector Bar. The Interval drop-down menu appears.

In the Interval menu, you can either set the date manually or by using the drop-down calendar. In the
calendar, you can set the month by clicking the desired dates. If no data is available for a specific date,
that date is not available (grayed out).

4 Jun1i,201500:00 to Jun 11, 201523:59 |

— Wi e
Interval [ Custom F1 £
Start Date !
Jun 11, 2015 | 4 June 2015 = » || O @‘
End Date

S M TWT F S

[« ]
Jun 11, 2015 1 2 3 4 5 6 ﬂ

Rows 7 8 9 1012 13
(20 [+] | 14 15 16 17 18810 20

21 22 23 24 25 26 27

[[] Enable Servi 28 29 30 Hits & Transferred)
WARNING: Seleci umber
of rows to display-w o nce.

oK || cancel ;

2 Set a specific start and ending time by specifying hours and minutes you want to monitor. The default for
a date is an interval starting at hour 0 minute 0 (midnight) and ending at 23:59 (11:59 PM).

3 The Interval menu also lets you set how many lines of information appears in the graph view. Click the
date, and when the Interval drop-down appears, specify the number of rows. Select 5, 10, 20, 50, or 100
from the Rows drop-down list to limit the display to a the specified number of lines, for easier viewing.

4 Click OK to generate the report.

Report data is sorted and ranked according to how many rows are displayed. By specifying a limited number of
rows to be displayed in the graph section of the Report, rankings apply only to the data in those rows. If you
reverse the sort order by clicking on the column bar, only the displayed items are re-sorted.

To re-sort according to all collected data in the database, click on the Enable Server Side Sort check box on the
drop-down menu. The ranking of the grid items then reflects all data from the total entries.

By default, Client-side Sort is used, which sorts only the currently viewable data, which was retrieved the first
time the data base was clicked on.
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For example, the image that follows shows data displayed only as it pertains to ten rows.

S S L=

W GAMING

B FILE-TYPESFTP

B EMAIL-APPS

[ MOBILE-APPS

B BUSINESS-APPS

W BACKUP-APPS

B WEB-CONFERENCING

[l Others

| Application Category | Events s | Transferred
1 GAMING E T
2 FLLE-TYPES-FTP 3500 1 3.08GB ‘:]
3 EMAIL-APPS w05 3L76KE |
4 MOBILE-APPS 111 250.54 KB |]
5 BUSINESS-APPS 387 | 975.55KB |]
6 BACKUP-APPS 1,014 [ | 3.14M8 |
7 WEB-CONFERENCING 1,273 | sz15Me ||
8 REMOTE-ACCESS Led s237M8 |
9 DOWNLOAD-APES 1574 | 158 |
10pzp zasl | 7868 |]
Total 8,909 3.22GB

If you re-rank the column to see the lowest number of hits, it ranks only the items displayed in the ten rows you
selected.

Categories 5] (w=E
B FILE-TYPESFTP
Bl MULTIMEDIA
[ PROTOCOLS
M FILE-TYPES-HTTP
W APP-UPDATE
B MISC-APPS
W SOCIAL-NETWORKING
B Others
 Application Category Events 4 Teansierred |
1 FILETYPESFTP 23 | sosce ]
2 WEB-COMNFERENCING 1278 | 82158 |
3 REMOTE-ACCESS 1,464 | 5237M8 |
4 WEBMAIL 6,466 | 51.59MB [|
5 APP-UPDATE 5,498 | 179.34m8 |
6 MULTIMEDIA 21,283 || 2.37GB 'I|
7 SOCIAL-NETWORKING 2502 || w7.46M8 ||
8 MISC-APPS 58,72 B 107.65 MB I
9 FILE-TYPESHTTE 113,489 . 1.32GB [|
10 PROTOCOLS sz | | 16268 ]
Total 765,235 8.97 GB

Use Enable Server Side Sort to sort data based on all underlying data records, not the client-side sort. Server
side Sort retrieves current data from the back end database. Client-side sort merely rearranges the data already
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retrieved. You can still constrain your display to 10 rows, but the display re-sorts based on the total data
collected in the back-end database, and not just the data previously displayed.

Categories (5] [ [=F=]

B APP-UPDATE

W BACKUP-APPS

B BROWSING-PRIVACY
8 BUSINESS-APPS

B DOWNLOAD-APPS

B EMAIL-APFS

B FILE-TYPESFTP

B COthers

| Application Category 4 Events Transferred
1 APPAPDATE 12,073 3mAsME [ |
3 BACKUP-APPS 1,786 B3EME | I|
3 BROWSING-PRIVACY 37,543 31.61MB || |
4 BUSINESS-APPS 833 Lsme | |
5 DOWMNLOAD-APRS 18,490 684MB | |
6 EMAIL-APPS 131 87.68K8 | I
7 FLLE-TYPES-FTP 2 3.12GB E I|
8 FILE-TYPES-HTTP 127,604 ssscs [ |
9 GAMING 1 0B |
101 24,393 3264ME | I
Total 292 883 7.42GB

Export Results

The Export to PDF and Export to CSV icons allow you to save a report in either PDF or Excel format.

=@®

These buttons provide the following export options:

e Export to PDF — This button allows you to save the displayed report data to a PDF file. The PDF can
export a maximum of 2500 rows.

e Export to CSV — This button allows you to send the report to a file in Microsoft Excel Comma Separated
Value (CSV) format. Excel can export a maximum of 10,000 rows.

@l TIP: To print a report, export it to PDF, using Export to PDF, then print out the PDF file.

If a very large Report file, such as a system log, is being exported, the number of lines that can be saved is
limited. When you click the icon, you see a message like the following:

@ Expart current screen

& Export all rows (max 2,500)

Select whether to print only the currently-displayed screen, or the maximum number of rows.
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The Filter Bar

The Filter Bar provides filtering functions to narrow search results, to view subsets of report data.
[+] ) [x]

? —

Add Filter

Remaove Filters

The Filter Bar is at the top of the Report. It contains Add Filter (+) for adding filters and a Go button to apply
filters, as well as the Clear Filter button to clear all filters.

Using the Filter Bar allows you to view subsets of the report data, based on a set of pre-defined filters.

Adding Filters

Filters can be added in two ways, either explicitly through the Filter Bar, or implicitly by clicking on the
hyperlinks in the grid sections of a displayed report. As hyperlinks are clicked, those link criteria are added to the
Filter bar as if it was added explicitly. Refer to Adding Filters Implicitly on page 70 for more information.

Use the Filter Bar to add pre-defined filters from a drop-down menu and to specify parameters for those filters.
Filter values are matched in the database during report generation.

Click Add Filter (+) on the left to display a drop-down menu, which can then be used to fine-tune the report data
by selecting categories.

Timeline 4 3un12,201500:00 to Jun 12,201523:59 | =L k..
'ﬂ @ x| H) |- LoadcustomReport- |+ ]
1 Add Fiter | [ i
ApplicatoTCatagory | E
Dst Tnterface
Inttiator Country i
i _ — : : 4,000,000 3
Initigtor IP 3,000,000 'g .
I MAC 2,000,000 5 o Connections
o aw | 1,000,000 & M Trencfored
50
o Lo

Filters can also be added by right-clicking on a column entry and selecting the Filter option from the drop-down
menu.

Filter criteria are context-dependant, meaning that SonicWall Analyzer finds the specific filter operators
applicable to the entry. Many filter operators are used in connection with a text string or numeric filter input
value that determines what data to include in the report. This control uses auto-complete to suggest a set of
candidate values, or you can manually enter a different value. Manually-entered values should be checked for
blanks, illegal characters and so on.
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Operators are specified by clicking on the default operator to bring up the drop-down menu of available

operators.

Timeline

Ol —

No Matching NOT IN und

» The licenst . emmmOrt cat
* Please check Register/Upgrade

A

IN

Depending on the selected field type, text string or numeric, several filter operators are available. The filter
operators are used with a filter input value to restrict the information displayed in the Detail report.

The operators are defined as shown in the Filter Operators table.

Filter Operators

Operator Definition

= Only data that exactly matches the filter input numerical value is included in the report

I= Data values that are not equal to the input numerical value are included in the report

> Data values that are greater than the input value are included in the report.

>= Data values that are greater than or equal to the input value are included in the report.

< Data values that are less than the input value are included in the report.

<= Data values that are less than or equal to the input value are included in the report.

IN Data values that are in the input value are included in the report.

NOT IN Data values that are not in the input value are included in the report.

LIKE Data values that are like the input value are included in the report.

NOT LIKE Data values that are not like the input value are included in the report.

IS Data values that are between the input values are included in the report. Separate the vales
by using a hyphen with a space on either side, such as “172.30.72.16 - 172.30.72.19.”

IN RANGE Subnet data that is in the specified range is included in the report.

NOT IN Subnet data that is not in the specified range is included in the report.

RANGE

You can also use wild-cards (*) in filters to match anything. For instance, you might want to match a User name.
You would select LIKE as the operator, and use * in connection with a string. For example, “joh*” would match
all users starting with “joh,” such as John, Johnny, Johan, and so on.

Using the

Filter Bar

Use the Filter Bar to manually (explicitly) add filters.
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To add a filter:

1 Click the Add Filter (+) menu and select a filter from the drop-down menu. Available Filter categories can
differ, depending on the report, and could require parameters.

@ NOTE: Some filter fields use operators with text or numeric values. Others might have pre-filled
values. For example, the Initiator Country filter displays a pull-down list, allowing you to display
results based on a selected country. You can create reports with filters on VLAN Interfaces by using
the Interface Filter (Source or Destination), and using the VLAN interface name with ‘.’ replaced by
‘' VLAN Interfaces typically are as follows: X8:V100, X0:V20, and so on. When VLAN interface
information is sent in the syslogs, the character *:’ is replaced with ‘-’. So, you must use values such
as X8-V100, X0-V20 in the Interface filters.

2 Click Go (right arrow) to add a filter Each filter must be applied by clicking Go before you can select and
apply the next filter. The filter bar shows all filters added, whether added from the menu bar or
drop-down menu.

As filters are added, items that have been filtered out disappear from the listings, reappearing only when
the associated filter, or all filters, are removed.

3 To remove a filter, click the + next to the filter in the menu bar and click Go (right arrow). To clear all
filters, click the Clear Filter (x) next to the filter fields.

Adding Filters Implicitly

SonicWall Analyzer also allows adding filters directly to a drillable (hypertext-linked) column to create a “criteria
control,” where you can set a value for the filter. Adding a filter to a column allows you to restrict the display to
view only the data related to the entry of interest.

In second-level reports with multiple subsections, filters can be added simply by clicking on the hyperlinked data
in the report section.

To add a filter to a “drillable” column containing hypertext links:
1 Right-click on a hypertext column cell and select Add Filter from the resulting drop-down context menu.

Because the filter is context-sensitive, it might suggest a set of candidate values, or you can manually
enter a different value. A new filter is automatically added to the filter bar, and the report is updated
accordingly.

After being added, the filter is added to the filter area of the Search Bar and no longer appears in the
drop-down list. The report displays only results restricted by that filter.

2 To remove the filter, click the x next to that filter, or clear all filters by clicking the red X button to the
right of the field.

Saving/Viewing a Filtered Report

The Save Report pop-up menu allows you to save the currently-displayed report with a specified name of no
more than 20 characters. You can also overwrite an already-saved report with the current report or overwrite
the report to show a new date range.

Saved reports, even if created for a specific unit, are available for all units of that appliance type. For example, if
a report for the X1 interface was created for a specific unit, this report is available from any unit: there is no
need to create a X1 report for different units.

@ NOTE: Custom Reports created by a specific user are viewable by that user, and no one else. Domain
Administrators can view all available reports.
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To save a report, along with its filter criteria:
1 Click Save Report.
2 Assign it a file name for later reference.

3 To view a saved Custom Report, click Custom Reports to bring up a menu that contains a list of all saved
Custom reports available for viewing. Selecting a Custom Report from this drop-down loads data for the
selected report into the Report Data Container.

4 You can also load a saved report from the Report tab on the middle bar menu. Click Custom Reports on
the Reports tab and select the desired report to load it into the Data Container.

5 Click on the appropriate Export Results icon to save a report to a PDF file or Excel spreadsheet. To print a
copy of the report, click on the PDF icon and save it to a file, then print the PDF file.

@l TIP: Saved Reports can be modified or deleted by clicking Custom > Manage Reports.

Scheduling Reports

You can schedule a report to be created and sent to you in email, using the Universal Scheduled Reports
function.

The Schedule Reports icon is located to the right side of the toolbar above Load Custom Reports.

Click this icon to bring up the Universal Scheduled Report Configuration Manager.

Schedule Custom Report {i | EI | E

_x. EJ ’—LoadCusi_nmR.eport— |v‘

When the Configuration Manager menu comes up, it is pre-filled with the information about the current
Reports page. Using this report, you can set up specific tasks, chose the format for the report, and other options.
For more information on using Universal Scheduled Reports, refer to the section: Universal Scheduled Reports.

Report Data Container

The Report Data Container is the screen space where the report data is displayed.

SonicWall Analyzer provides interactive reporting to create a clear and visually pleasing display of information in
the Report Data Container. The Root-level baseline report shows the Chart View, usually containing a timeline or
a pie chart and a Graph View.

You can control the way the information is displayed by adjusting the settings through toggles or by configuring
reports in the dashboard interface.

Reports have a Date Selector and Filter Bar at the top, with the Report Data Container below it.

Detail-level reports are available either by “drilling down” on hyperlinks in the Root-level view, or, for some
types of Reports, as a shortcut on the Report tab.

NOTE: Cell data in the report container can be copied by right-clicking the cell and selecting Copy Cell Data
from the drop-down menu.

Layout of the Data Container

The Report Data Container is comprised of a number of Sections. Sections are usually arranged vertically stacked
on top of each other. Each section has a “Title Bar” which contains the “Section” title on the left and a group of
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buttons on the right. The Report itself might contain one or more Sections of data, which are different facets of
the report data.

Categories [s]
B PROTOCOLS
[ B
B MULTIMEDIA
Wl FILE-TYPES-HTTP
W APP-UPDATE
B REMOTE-ACCESS
W WEBMAIL
B Othars
| Application Category | Events | Transferred
1 pROTOCOLS S o03,607 | i  35.04G8 !
2 M 9,756 | 6.28 GB [|
3 MULTIMEDIA 32,823 3.55GB []
4 FILE-TYPES-HTTP 136,892 | 1.65 GB ﬂ
5 APP-UPDATE 8,422 673,13 MB |]
6 REMOTE-ACCESS 1,971 332,67 MB ﬂ
7 WEBMAIL 4417 127.34 MB ||
8 SOCIAL-METWORKING 23,639 | 18.46M8 |
9 MISC-APPS 53,163 | sam2Me |
10 BROWSING-PRIVACY 23,640 23.48MB |
11 PROXY-ACCESS 4,330 | 17.26 MB [|
12 DOWNLOAD-APPS 3792 | 1w.07mB |
13 FILE-TYPES FTF g8 | 16.81MB |]
14 BUSINESS-APPS 538 5,14 MEB |]
15 BACKLP-APPS 613 | 4,13 MB ||
16 WEB-COMNFERENCING 393 | 1e5M8 |
17 [NFRASTRUCTURE 1,144 1,23 MB |
18 MOBILE-APFS 122 306.66 KB |

@ TIP: At times, you might wish to see multiple screen groups at the same time. Ctrl-click to keep a
previously-expanded topic from collapsing when you select a new report category. For example, you might
want to view Data Usage, Applications, and Intrusions simultaneously, to see what detail sections are
available. Control-click on these entries to see all the screen groups under these entries simultaneously.

@l NOTE: Root level reports available in the Reports panel usually contain only one section.

The Report Data Container sections either appear as a chart view, a grid view, or both.

The default display mode is Show Chart and Grid. In this mode, the data is available for viewing as both a ‘Chart’
and a ‘Grid’. This layout can be controlled by switching between three display mode options, any of which can
be turned on/off at any time, using the utility toggle button group on the Section Title Bar.

The display modes available on this layout are:

e Show Chart: In this mode only the chart is visible and takes up all the available space inside the section
container. Charts show a timeline or pie chart.

e Show Grid: In this mode only the Grid is visible. The Grid Display can contain more than one section.
e Show Chart and Grid: In this mode both the chart and the grid are visible and are vertically stacked.

Switching between these modes is handled through the utility toggle buttons.

E=[=]

Only one mode can be active at a time.
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[ ]
A ‘Reload Data’ button @ is present on the title bar in all the layouts described previously. Clicking this
button instructs the application to refresh the section data.

You can determine if you have reached the final section in a multi-section Grid View by checking if there
is a message about the relevant time-zone at the bottom left of the report. If this message is present,
there are no more Grid sections available.

Viewing Syslog Data of Generated Reports

Different types of section data are available under the root-level report. The section level reports are available
through the Details entry on the middle pane Reports tab, for some Reports. You can also drill down from the
root level report to the second level Detail views, containing multiple subsections, by right-clicking a hyperlink
and selecting “Drilldown” from the drop-down menu. The syslog fields corresponding to the applied filter comes
up.

Drilling Down

Sections in the Grid display might contain drillable columns, containing hypertext links to bring up a Detail
Report. A ‘drillable’ column appears as a column in the data grid, where the child values appear underlined and
in blue, and act as a hyperlink to additional information. Click on any of these values to drill down to another
report, using the value on which drill-down has been executed as a filter. When you click on a drillable link, this
filter is added to the Filter Bar.

Drilling down navigates to a new Detail report, filtered by the data on which the drill-down was executed.
Drillable reports can display multiple grid sections in the sub-reports, or bring up a System Analyzer view,
depending on the item selected.

The following example illustrates how you can drill down through the Data Usage Report by clicking on a
drillable entry to gain more information and filter the results.
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1 Click on an appliance, then click Data Usage on the Reports tab. You see a timeline showing connections.

Timeline 4 Jun12,201500:00 to Jun 12,2015 2359 | B e =

[+]

i

Connections
~u8E8EELS

- Time A O ctis Transferred - Cost |
1 lun 12, 2015 00:00 sz [ razme USD 0.01
2 1un 12,2015 01:00 sz ro7me i USD 0.01
3 Jun 12, 2015 02:00 3 | so3ve ] USD 0.04
4 wniz 20150300 333 rorme [l USD 0.01
5 Jun 12,2015 04:00 17 | rosme [ US0 0.01
6 wni2 20150500 33 [ ro7me [ USD 0.01
7 lun 12,2015 06:00 3 | rosme [ USD 0.01
8 wni2.20i507:00 254 [ s3z.7k8 [ USD 0.00
9 Jup 12, 2015 08:00 au 667.6668 [l S0 0.00
Cn 1220150000 245 [ soa.08k8 [l USD 0.00
122031000 2 2272 [ 72818 [ USD 0.00
12 Jun 12, 2015 11300 = [ oss.8k8 ] S0 0.00
13uniz.20151z00 26t [ sz Us0.0.00

2 Click on a hyperlinked Time to go to the Detail view of the Report. The Detail view contains multiple
sections, including Initiators, Responders, Service types, Initiator Countries, and Responder Countries.
Depending on the number of entries, you might need to scroll down to see all the sections.

NOTE: You can also apply a filter through the Filter Bar or by right-clicking the entry. Select the filter
and click Go. The Report shows the detail view applicable to that filter.
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Data Usage Details 4  Sep 28,2011 00:00 to Sep 28, 2011 23:59 | [ |@|E
+ 3 % |[E] | -LoadcustomReport- _
Tmelne B E=[]

6,000 120,000,000
100,000,000
= e | so000000 B
£ 4,000 &
E ' 5 5 = il 000 E || Connections
£ 3,000 4 , I 40,000,000
S A . 4 = Transferred
“ 2,000 L 20,000,000 B Transferre
1,000 1= _ -0
Q@ u‘-@ %‘& .U;@ ,,’fo@ ,9‘5@
Initators Bin=n
Initiator IP Initiator Host User Connections Transferred v
1 10.0.81.139 PRAVIN-PC admin 877 ] razve. ]
2 192,168.168.65 admin s63 | sootme ]
3 10.0.81.56 UGGEGH admin 7e. e93ME [
4 10.0.81.55 Wclelelers ooy [ 26.04M5 [
5 10.0.14.1 prasad.sv.us.sonicwall. com 9,764 ! 1l 17.12 MB H
Total 43,590 363.91 MB
| Service i i s 1 v
! o wos ) e ]
2 tmpihtip 255 | 5.55M8 |
3 tp/59160 8 | saame |
4 toplsmip 8z | 2.54M8 |
5 /636 185 | 845898 |
Total 67,875 381.81 MB

3 To further filter the output, to view only tcp/https usage, click on the tcp/https entry under Services. A
Detail report, filtered to show only usage of tcp/https, comes up. Notice that a Service entry has been
added to the Filter Bar.
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Data Usage Details

[+ jsovie = woms =

4

Sep 28, 2011 00:13 to Sep 28, 2011 23:13

» Report generated for fimezone: Padfic Standard Time
« Report owner: System @ ocalDomain

Timeline
100,000,000
| 80,000,000
£ g
_§ - 60000000 5 .
[ L 40000000 £ 1 Connections
E ©
el . | 20000000 & M Trensferred
£ e P i ]
7 7
& & & &
R 5
Initiator IP Initiator Host user | @ i Transferred v
1 10.0.81.139 PRAVIN-PC admin 8,531 Bresve [
7 197.168.168.65 admin 563 | sa.oimMe [T
3 10.0.81.5 UGGGEH admin 732 eg.8sMe ]
4 10.0.81.56 UGGGGH 16,036 s.41M8 [
5 10.0.14.1 prasad.sv.us.sonicwall.com 9,579 | 16.75 MB ﬂ
Total 42,061 362.79 MB
Services 5]
| Service | Connecti | Transferred v
Total 43,807 368.68 MB
| Responder 1P der Host | con | Transferred v
1 10.197.1.254 42,7535 B B 296.51MB I|
2 192.168.168.168 942 70.82MB .:|
3 204.212.170.143 108 1.36MB |
4 57.115.118.48 4 1908 |
Total 43,807 368.68 MB
Initiator Countries 5
1 4 PrivateIP 43,695 [ | 367.33MB m
2 BE United States 109 1M |
3 @ KoreaRepublic of 1 43B |]
4 Turkey 4 488 |
5 [+ Canada 1 48 |
Total 43,807 368.68 MB
| ponder Country ! G Transferred v
1 /A Private IP 43,695 | = 1 v
2 BE United States 112 | 136MB |
Total 43,807 368.68 MB

Notice that the Report now focuses on the filter constraint from the drilled-down column.

Because this report also contains drill-down areas, you can drill down even further to add additional

constraints to the results.
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Data Usage Details 4 Sep28,2011 11:00 to Sep 28, 2011 11:59 | |E]|E1|ng
|+|viﬁaborcomh\r - Russion Federation =] Service = tcpjads (%) Inifator = §9,178.118.136 % 5] % [Hl| |-LoadcustomReport- ||
: 160
1 ‘ il o
I I |
120 B
5 0 E
2 0 "E -
Connections
c 60 © Y
=1 40 F @ Transferred
1] I 20
a
T T T
A o
o o o
Initiators 5]
! _I_lliﬁatofIP :]:ibatnrﬂust | User I Connections : l'ransf?r_rul - - |
1 89.178.118.136 MOUNTAIN z | | sz [ l
2 89.178.118.136 1 | | w2 IR
Total 3 1448
Services 5
!_Serv'-_x_ | Connections | Transferred
s s 1 T v I
Total 3 1448

NOTE: Many report categories contain a Details item in the list of reports. This link provides a
shortcut directly to the Detail view of all sub-sections of the report. You can apply filters directly to
the Detail view to further constrain the displayed information.

The Log Analyzer provides the most detailed Report information.

4 To view the Log Analyzer, go to the Reports tab after you have drilled down to the desired level of detail
and click on Analyzers > Log Analyzer.

NOTE: Because Log Analyzer Reports can contain a very large amount of data, you might wish to
limit the amount of data displayed on the page. The amount of data in the report can also affect
the loading speed.

The Log Analyzer contains information about each connection, including port and interface information,
number of Bytes sent, and so on.

: E::r::a“ Log Analyzer 1 May 20, 2015 00:00 to May 20, 2015 23:59 | a "
» Applications = :
» User Activly + 3% H [ceedcimtomtepor- <]
* Web Activity
* Web Filter Log Analyzer
* VPN Usage
» Intrusions Time Initiator IP Initiator Host User sponder [P sponder Host uRL S¢ Ti Me
* Botnet 1 May 20, 2015 23:59:55
» Geo 1P
» Gateway Vinses 2 May 20, 2015 23:59:45 10.202.23.14 10.206.23.38 g G
*Spywaird 3 May 20, 2015 23:59:17  10.203.20.10 10.200,23.38 tend N/AC...
» Attacks
» Authentication 4 May 20, 2015 23:59:17 10.203.2316 10.206.23.38 e H/AC..,
¥ Costom Reports 5 May 20, 201523:59:16 102012016 10.206.23.38 Lo HAC...
¥ Analyzers
Log Analyzer 6 May 20, 201523:59:16 10.203.2016 10.206,22.38 L M/AC..,
» Configuration 7 May20,201523:50:14 103002116 admin 10.206,21.38 [
8 May20, 201523:59:14 102032116 admin 10.206.23.38 el A

You can drill down through the Log Analyzer Report as well. Clicking on a column item adds an additional filter
and narrows down your results, allowing you to zoom in on specific instances.

Some Log Analyzer reports can be reached as the final step of a drill-down process.
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Click on a row to expand the log, additional information can be viewed here:

Log Analyzer
| Time Initia Initia User SrcP SrcTi Resp DstP| DstTi Resp Sent Rece URL | Servi Sess Dural VPNF Cater Message
1 Nov 20, 2,.. fesoub Ly - ffo2::c 1,900 a 1] udpf19¢ Unhandled link-local or multicast IPv6 p... _
= Priority: 5 i
Eremr. e s oos mieoeeede |
= Priority: 3 |
3 Moy 20, 2. 0 0 0 0 Using LDAP without TLS - highly insecure ‘
= Priority: 1

The bottom bar of the Log Analyzer contains a page bar, which allows you to navigate through the report by
paging forward and backward, or going to the specific page of interest.

Custom Reports

Specific customized reports can be generated and saved by means of the Save icon. Click Save to bring up a
drop-down allowing you to save a custom report.

X E‘ﬁ'] ’ - Load Custom Report - | "J

]

Mame |Usage Details |

0, I:I Owverwrite existing

i
" Permissions: Use Console > Management
W sers to change default settings

i,

1,000,000 _—— g |

This menu is pre-filled with a name reflecting the report it was based on. If an earlier report with this name was
generated, you can choose to overwrite it or save a new copy, or assign it a different name.

The new Custom report is added to the drop-down menu accessed when you click Load Custom Report. It is also
added to the Reports Tab list under Custom. When a specific Custom report is selected on the Load Custom
Report drop-down menu, the button reflects the name of that report.

Custom Reports can also be accessed or deleted by going to Reports > Custom > Manage Reports.

Troubleshooting Reports

One of the most common reasons when a report does not display is that no data is available for the selected
appliance. There are several reasons why you might see this error. Analyzer displays the most likely reason(s)
and gives you instructions for ways to resolve the problem.

The most common examples are as follows:
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Appliance is in a Provisioned State:

Analyzer is waiting for a handshake response signal from the appliance. Generally, the TreeControl menu also
flags the appliance with a lightning bolt on a yellow background.

Report could not be generated.
Possible reason(s):
« The appliance is in provisioned state. Please wait until it is acquired.

Appliance is Down

Report could not be generated.
Possible reason(s):
« The appliance is down. Please check the System = Status page for more information.

No Matching Records Found

There might be no data available for a variety of reasons. The most common causes are listed in this message,
along with actions to take.

Mo Matching Records Found

Managing Analyzer Reports on the Console tab

There are management settings for the Analyzer Reporting Module on the Analyzer Console tab. A Reports
selection is available on the left menu bar, which allows you to set up certain tasks in the right Management
pane that contains limited configuration screens, used for managing scheduled email report configuration,
system debug-level logging, and show legacy reports.

In this pane, you can set Summarizer parameters and schedule emailing or archiving of reports.
Data deletion or storage specified in these menus takes place after completion of the current reports run.

Reports generated by pre 8.0 releases of SonicWall Analyzer can still be viewed, but require specific
configuration. See Managing Legacy Reports on page 155.
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Managing Firewall Reports

This chapter describes how to generate reports using the SonicWall Analyzer Reporting Module. The following
section describes how to configure the settings for viewing reports:

e Firewall Reporting Overview on page 80
e How to View Firewall Reports on page 85
e Viewing Capture ATP Status on page 92

e Custom Reports on page 108

e Using the Log Analyzer on page 108

e Configuration Settings on page 112

Firewall Reporting Overview

The Reports available under the Firewall tab provide specific information on data gathered by the SonicWall
Analyzer interface.

For a general introduction to reporting, see SonicWall Analyzer Reporting Overview on page 56.

The Firewall reports display either summary or unit views of connections, bandwidth, uptime, intrusions and
attacks, and SMA usage, displayed in a Data Container. Information can be viewed in either chart (timeline or pie
chart) form, or tabular (grid) format. The list of available reports allows you to navigate to a high-level or specific
view.

All of the reports in Analyzer report on data gathered on a specific date or range of dates. Data can be filtered by
time constraints and data filters.

Benefits of Firewall Reporting

Firewall Reports allow you to access both real-time and historical reports and view all activity on SonicWall
Internet security appliances. By monitoring network access, logins, and sites accessed, you can enhance system
security, monitor Internet usage, and anticipate future bandwidth needs.

You can gain more information from the display, simply by hovering the mouse pointer over certain sections.
Additionally, by clicking on selected sections of a pie chart or bar-graph timeline view, you can view more
information or view different aspects of the information presented.

Firewall Reports Tab

The Firewall tab gives you access to the Firewall’s reports section of the SonicWall Analyzer management
interface. Reporting supports both graph and non-graph reports, and allows you to filter data according to what
you wish to view. It supports multiple product-licensing models.
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Firewall Reports provide the following features:
e Clickable reports with drill-down support on data rows
e Report data filtering through the Search Bar
e Log Analyzer

You can view Reports either as Summary reports for all or selected units on the SonicWall Analyzer network, or
view detailed reports for individual units.

Viewing Available Firewall Report Types

To view the available types of reports for the Firewall appliances, complete the following steps:
1 Login to your Analyzer management console.
2 Click the Firewall tab.
3 Select an appliance or global view from the TreeControl.
4

Expand the desired selection on the Reports list and click on it.

@ | NOTE: All Reports show a one-day period unless another interval is specified in the Time Bar.

The following types of reports are available:

Global Level Reports:
e Data Usage
e Summary: connections, listed by appliance, for one day (default)
e Applications
e Summary: connections, listed by application, for one day (default)
e Web Activity
e Summary: hits, listed by appliance, for one day (default)
e Web Filter
e Summary: access attempts, listed by appliance, for one day (default)
e VPN Usage
e Summary: VPN connections, listed by appliance, for one day (default)
e Threats

e Summary: connection attempts, listed by appliance, for one day (default)

@ | NOTE: Summary Reports are not drillable and no Detail view is available.

e Real-Time Viewer

e Summary: Syslog

Unit Level Reports
Detail views are available for all Report items unless otherwise noted.
e Data Usage

e Timeline: connections for one day (default)
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Initiators: Top Initiators, listed by IP address, Initiator Host, Initiator MAC, User, Connections, and
total Transferred, displayed as a pie chart

Responders: Top Responders, listed by IP address, Responder Host, Responder MAC, Connections,
and total amount Transferred, displayed as a pie chart

Services: connections, listed by service protocol, displayed as a pie chart

Details: provides a shortcut to the Detail view normally reached by drilling down. Detail sections
include: Initiator IPs, Initiator Host, Initiator MAC, Users, Connections, total amount transferred,

Services, Responders, Initiator Countries, and Responder Countries. Additional filtering/drilldown
takes you to the Log Analyzer

e Applications

Data Usage connections, listed by application and threat level
Detected: events, listed by application and threat level
Blocked: blocked events, listed by application and threat level
Categories: types of applications attempting access

Initiators: events displayed by Initiator IP and Initiator host

Timeline: events over one day

e User Activity

Details: a detailed report of activity for the specified user

e Web Activity

Categories: hits and browse time listed by information category
Sites: sites visited by IP, name, and category, with hits and browse time

Initiators: Initiator IP, Initiator Host, Initiator MAC, with User, Browse Time, Hits, and total amount
transferred

Timeline: site hits with time of access and browse time

Details: provides a shortcut to an access timeline and Detail view normally reached by drilling
down. Detail sections include: Categories, Sites, and Initiators.

e Web Filter

Categories: hits and browse time listed by information category

Sites: sites visited by IP, name, and category, with hits and browse time
Initiators: Initiator host and IP with category and user

Timeline: site hits with time of access and browse time

Details: provides a shortcut to an access timeline and Detail view normally reached by drilling
down. Detail sections include: Categories, Sites, and Initiators.

e VPN Usage

Policies: lists connections by VPN Policy
Initiators: Initiator host and IP with category and user
Services: Top VPN Services by Service Protocol

Timeline: VPN connections over a 1 day period

e |ntrusions

Detected: number of intrusion events by category
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e Blocked: blocked intrusions and number of attempts at access
e Targets: number of intrusion events by target host and IP

e |[nitiators: Initiator host and IP with category and use

e Timeline: intrusions listed by time of day

e Details: provides a shortcut to an access timeline and Detail view normally reached by drilling
down. Detail sections include: Categories, Sites, and Initiators.

e Alerts: provides a list of intrusion alerts
Botnets
e |[nitiators: Initiator host and IP with category and use
e Responders:
e Attacks:
e Timeline: Intrusions listed by time of day
Geo-IP
e Responder Countries: Blocked traffic that is based on the traffic's country of origin or destination
e |nitiator Countries:
Capture ATP
e Status - files scanned in the last 30 days with applicable filters
e Summary
e Blocked - virus attacks blocked by Capture ATP and the number of attempts at access
Gateway Viruses
e Blocked: blocked virus attacks and number of attempts at access
e Targets: targeted hosts and IP addresses
e |[nitiators: initiating users, hosts, and IP addresses of the virus attack
e Timeline: times when the virus attempted to gain access, displayed over time

e Details: provides a shortcut to an access timeline and Detail view normally reached by drilling
down. Detail sections include: Categories, Sites, and Initiators.

e Alerts: provides a list of virus alerts
Spyware
e Detected: spyware detected by the firewall
e Blocked: spyware blocked by the firewall
e Targets: targeted hosts and IP addresses
e |[nitiators: initiating users, hosts, and IP addresses of spyware download
e Timeline: times when the spyware accessed the system, displayed over time

e Details: provides a shortcut to an access timeline and Detail view normally reached by drilling
down. Detail sections include: Categories, Sites, and Initiators.

e Alerts: provides a list of spyware alerts
Attacks

e Attempts: type of attack and times access was attempted
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e Targets: host and IP address, and number of times access was attempted
e |[nitiators: top attack initiators by IP and host
e Timeline: time and number of attempts at access, displayed over time
e Authentication: authenticated users, their IP addresses, and type of login/logout
e User Login
e Admin Login
e Failed Login
e Up/Down Status
e Timeline: provides a timeline of unit availability. No Detail sections are available.
e Custom Reports: allows access to saved custom reports
e Analyzers

e Log Analyzer: provides a detailed event-by event listing of all activity. The Log Analyzer is drillable,
but no Detail sections are available.

e Flow Activity
e Real-Time Viewer: real-time data displayed graphically.
e Top Flows Dashboard: displays top flows per report type.

e Flow Analytics: monitors applications, users, URLs, initiators, responders, threats, VolP, VPNs,
devices, and contents.

e Flow Reports: real-time reports displayed graphically.

Understanding the Data Container

The Report contains a filter bar at the top, plus the actual Data Container. The default Data Container contains
an interactive chart view that contains either a grid view, containing a text version of the information. One or
more sections might be present in the grid view. Toggle buttons allow you to display the Chart view, Grid view, or
Chart and Grid view.

Grid sections are arranged in columns. Columns can be rearranged to view them from the top down or bottom
up, by clicking the up and down arrows in the column headings. You can narrow results by applying a filter to a
column: right-click on a column heading and click Add Filter.

Hypertext-linked columns are drillable, meaning you can click on the hypertext entry to bring up a Detail view
with more information on the desired entry. Detail views might have multiple sections.

The Detail views are usually reflected in the sub-headings under the Reports list that provide a shortcut directly
to the Detail Report. To go to the full Detail view, click the Details entry in the Reports list. From the Detail view,
you can access the system logs, for event-by-event information, or further filter the results. For more

information on using the Log Analyzer to view and filter syslog reports, see Using the Log Analyzer on page 108.

Details views can contain multiple sections. To determine if you have reached the end of the list of sections,
check for the time zone message that indicates the end of the Detail View.

Reports with hyperlinked columns can be filtered on the column or by drilling down on the hyperlinked entry.

You can also get to a filtered Detail view by clicking the section representing the desired information in the pie
chart.

To save a filtered view for later viewing, click Save on the Filter Bar. The saved view now appears under Custom
Reports.
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To learn more about Custom reports, see Custom Reports on page 108.

How to View Firewall Reports

The Firewall Summary reports display an overview of bandwidth, uptime, intrusions and attacks, and SMA usage
for managed SonicWall Firewall appliances. The security summary report provides data about worldwide
security threats that can affect your network. The summaries also display data about threats blocked by the
SonicWall security appliance.

The sections contain the following information:
e Node information — Information on the firewall(s) is displayed at the global or unit level.
e Syslog Categories — The types of syslog data selected to be collected for the selected appliance.

e Syslog Servers — The IP address and Port number of the syslog servers configured to collect data from
the selected appliance.

e Synchronize Appliance Information with Analyzer — Click the Synchronize Appliance Information
Now link to refresh status data about the monitored appliances. This status information is
normally updated every 24 hours.

e Getting Started With Analyzer — Click the Open Getting Started Instructions In New Window link to
open the Analyzer installation and initial configuration instructions in a separate window.

Viewing Global Summary Reports

Summary reports for data usage, applications, web usage and filtering, VPN usage, and threats for managed
SonicWall appliances are available at the global level, through the TreeControl menu. Summary reports are
available for:

e Data Usage

e App Control
e Web Usage

e Web Filtering
e VPN Usage

e Threats

Group-level Summary reports provide an overview of information for all Firewalls under the group node for the
specified period. The report covers the connections and transfers by appliance for Data Usage, App Control, and
VPN Usage, For Web Usage and Web Filters, hits are also included. Web filters and Threats list attempts at
connection. Unless specified differently in the Date Selector, the Summary report covers a single day. Global
Summary reports are not drillable.

The Dashboard Summary report displays statistics, alerts, graphical summary reports, and a list of available
custom report templates. Displayed statistics can include total bandwidth, total attacks and other measurable
information. The alerts list is displayed when the configured threshold has been reached. A wide range of
graphical reports are also available for display.

You can configure the Dashboard > Summary report contents in the Firewall > Configuration > Settings page.

To view the Summary report, complete the following steps:
1 Click the Firewall tab.

2 Select the global icon.
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3 Click Data Usage > Summary.

The timelines at the top of the page display the totals, and the grid section sorts the information by appliance or
applications.

¥ General oy .
+ Data Usage Data Usage Summary ¢ May 21, 2015 00:00 to May 21, 2015 23:59 | | o=
Summary + S e
» Applications =]
» Wal Activity
» Web Filter Summary
» VPN Usage
» Thraats - 31,000,000
b Real-Time Viewer - — - 30,500,000
» Configuration 30,000,000 E
P —— 29,500,000 'E
- 29000000 § O Connedions
| 28500000 T W Transferced
qﬁ,
Appliance Name Connections Transferred r
1 Prasd Dek 72500 1753 now
Total 1,153 28.13 MB
Ty I

Unit level reports display status for an individual SonicWall appliance.

Viewing Unit Level Status Reports

Unit level reports display status for an individual SonicWall appliance. From this information, you can locate
trouble spots within your network, such as a SonicWall appliance that is having network connectivity issues
caused by the ISP. You can also monitor web usage, including attempts to reach filtered sites, as well as incoming
attacks on your network.

®

NOTE: Global reports are displayed in Analyzer’s timezone. Reports for individual SonicWall security
appliances are displayed in the individual appliance’s time zone.

Viewing Data Usage Reports

The default Data Usage report displays a timeline for hours that the selected SonicWall appliance was online and
functional during the time period with connections, transferred connections, and cost displayed.
To view data usage reports, complete the following steps:

1 Click the Firewall tab.

2 Select the global icon or a SonicWall appliance.
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3 Click Data Usage > Timeline. (This is the default view when the Firewall Report interface comes up.)

Timeline 4 May 21, 2015 00:00 to May 21, 2015 23:50 | S -

[+] ® =g

Timeline &) (=[5
-
g I Connections
= W Lwosfered

b‘é"

| Yime 4 | Connections: | Trensterred | | Cost |

1 Mav 21, 2015 00:00 w | rzwms [ US0 0.0

2 May21,201501:00 [ rozme USD 0.01

3 Maw 21 2015 02:00 s | same USD 0.04

4 May 21, 2015 03:00 303 | rosme USD 0.01

5 MayLzoseaon 35 | rosve [l USD 0.01

6 May 21, 2015 05:00 333 | rozme USD 0.01

7 May21, 2015 06:00 306 | ek USD 0.00

8 May 21, 2015 07:00 27 | am.ozke | USD 0.00

o May21201508:00 331 | R USD 0.01

10 Mz 21 2015.08:00 EST 1osme [ usD 0.01

11 May 21, 2015 10:00 e | rozve ] USD 0.01

12May21 20151100 30 [ tosme [ USD 0.01

13 May 21, 2015 12:00 33 | rosme  f USD 0.01

This report is drillable. Click on an Initiator IP entry to break the Timeline report down into its Detail View
report groups for the selected IP address. These groups also contain drillable hyperlinks that takes you to
more specific Detail View information. The columns can also be filtered.

Viewing Applications Reports

Applications Reports provide details on the applications detected and blocked by the firewall, and their
associated threat levels.

To view Application reports, complete the following steps:
1 Click the Firewall tab.

2 Select a SonicWall appliance.

3 Click Applications > Data Usage.
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The Applications Report displays a pie chart with the application and threat level it poses.

Applcations ELEE
W HTTP - GUARDED
M Flash Video (FLV) - GUARDED
B MP3-Low
B Image -LOW
B FTP - GUARDED
B Shodowave Flash (SWF) - LOW
W 55 -Low
B Others
| Appl . Connects (Transfered v
1 HITP 53,004 | 155268 [
2 Flash Video (FLV 18 | 589,39 MB I]
3 MP3 45 147.29M8 |
4 Image 14103 [ 147.25M8 |
5 FIP 19z | 127.46 MB |]
6 Shockwaive Flash (SWF) 150 | 117.88M8 |
7 550 3,329 |'__: 33,89 MB |]
8 Document 24 | 75.36 MB |]
9 MPEG-4 24 43.9MB |]
10 Archive LOW B 30.65MB |]
Total 72,393 16.86 GB

You can drill down for additional Details views on connections over time (Timeline view), Data Usage, Detected
applications, Blocked applications, Categories of applications, top initiators.

Viewing User Activity Logs

Web User Activity logs allow you to filter results to view only the activity of a specific user.

The User Activity Analyzer provides a detailed report listing activity filtered by user. If a user report has been
saved previously, bringing up the User Activity Analyzer displays a list of saved reports under the Filter Bar.

If you wish to create a new report, use the Filter Bar to create a new report.

To view User Activity Logs, complete the following steps:
1 Click the Firewall tab.
2 Select a SonicWall appliance.

3 Click on User Activity > Details to bring up the User Activity Analyzer. The User Activity Analyzer
generates a Detail report based on the user name.

bl User Activity Details { May 21, 20150000 ta May 20, 2015 2350+ 9%
* Applications -
v User Activity | ot = v e e 2] 3 % G [ tesdcustomepart-[-]
» Wb Activity Enter 2 sex rame n th
o

» Wl ity skt
* VPN Usage e tie thes report.
» Intrusions

t
» Botnel Py
¥ Geo 1P whicard chasnctes " to
» Gateway Vineses ok ki et
* Spywane
b Attacks
» Austhentication
* Cirstom Reports
b Analyzers
*» Configuration

If no user activity reports were saved, only the Filter Bar displays, with the User filter pre-selected. You
can enter a specific user name, or use the LIKE operator wildcards (*) to match multiple names.

4 Enter the name of the user into the field and click Go (arrow) to generate the report
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The customized User Activity Details report displays a timeline of events, Initiators, Responders, Services,
Applications, Sites visited, Blocked site access attempted, VPN access policy in use, user authentication,
Intrusions, Initiator Countries, and Responder Countries associated with that particular user.

Data for a particular user cannot be available for all of these categories.

Viewing Web Activity Reports
Web Activity Reports provide detailed reports on browsing history.

To view Web Activity Reports, complete the following steps:
1 Click the Firewall tab.
2 Select a SonicWall appliance.
3 Click Web Activity > Categories.

The Web Activity Report displays a pie chart with the Top Categories of type of access, total browse time,
and hits.

You can drill down for additional Details views on connections over time (Timeline view), Sites visited,
Categories of sites, and Top Initiators. A Details entry links directly to the details view of all entries.

Viewing Web Filter Reports

Web Filter Reports provide detailed reports on attempts to access blocked sites and content.

To view Web Filter Reports, complete the following steps:
1 Click the Firewall tab.
2 Select the global icon or a SonicWall appliance.
3 Click Web Filter > Categories.

The Web Filter Report displays a pie chart with the Top Categories of blocked access and total attempts
to access.

Folicies | Reports Top Categories 4 Decos, 2011 00:00 te Dec 05, 2011 2359 |
» Data Usage : ;
+ Applications [+ @ =E
* Uscr Activity
» Web Activity Categories
* Web Filter

Categaries

Stzs

Inihators

Tmelne

Distais
» VPN Usage
* Intrusions
» Gatewny Viruses
» Spyware
» Attacks
» Authentication | Cotegory | Attcmpts L4
» Analyzers 1 Earmograny 23
¥ Up/Down ] 2 AduttMeture Content
¥ Confiuiatin 3 Aduinetatve Custom Ustsetngs
» Events )
» Custom Reports 4 CuCeads

5 fudiem

Total

W Porrography

B AcultMeture Content

B Acminstratve Custom List eetings
B culrfocadt

W hodism

woe woa B

£

traeaone | Fadhe Dandard Time
@ oraDormin

You can drill down for additional Details views on connections over time (Timeline view), Sites visited,
Categories of sites, and Top initiators. A Details entry links directly to the details view of all entries.
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Viewing VPN Usage Reports

VPN usage reports provide details on the services and policies used by users of virtual private networks.

To view VPN Usage reports, complete the following steps:
1 Click the Firewall tab.
2 Select a SonicWall appliance.
3 Click VPN Usage > Policies.

The VPN Usage Report displays total connections for each VPN Policy item as a pie chart and tabular grid

view.
Top VPN Policies 4 Dec02, 2011 00:00 to Dec 08, 2011 23:58 [ =Lk
|T| )| [x) (] [-Losdcustomparort- H
VPN Policies 5
B Ian Puleston Home
M phalakrishnan-home-vpn
M Aria Home
I Maveenk-Home
M Eugene-Home-VPN
B Joey Salanga Home VPN
W Jason Saxe Home
l Cthers
| VPH Policy | Connections | Transferred v
1 Lan Puleston Home 117,950 2asove [T '
2 pbalakrishnan-home-vpn 17,592 _' 122.34MB l:|
3 Aria Home 246,133 oM [
4 Maveenk-Home 379 16.68ME |
5 Eugene-Home-VPN 2 14.01 MB
& Joey Salanga Home VPN 15 13.12M8 ||
7 Jason Saxe Home 3 6.23MB H
8 AN GroupVPN 600 42%MB |
9 VOIP-LAB-VPM 14 208%8 |
10 Joe Levy Home Mets 3 1.16KB I
Total 382,696 461.45 MB
= Report generated for timezne: Pacific Standard Time
= Report owner: System@LocalDomain

You can drill down for additional Details views on Service protocols and Top initiators.

Viewing Intrusions Reports

Intrusion Reports provide details on types of intrusions and blocked access attempts.

To view Intrusion Reports, complete the following steps:
1 Click the Firewall tab.
2 Select a SonicWall appliance.

3 Click Intrusions > Detected.
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The Attacks report provides a pie chart and a list of the initiating IP addresses, hosts, and users, with
number of attempts for each.

| Policies | | Reports | Top Intrusions Detected 4 Dec05,201100:00 to Dec 05,2011 23:50 | = m|
b Data Usage ' — =
b User Activity
b Web Activity Trtrusans &) ==
» Web Filter
» VPN Usage I Echa Reply - LOW
T [ Destination Unreachable (Port Unreachable) - LOW
Detected
Blocked B AR File HTTP Download - LOW

W Time-To-Live Exceeded in Transit - LOW
M VML File HTTP Download 1 -LOW

Targets
Initiatars
Timeline

W PING -LOW
b Gateway Viruses B Alaple ICMP Sweep Ping Inbound - LOW
b Gther ok =
b Authentication Intrusion Events ¥
» Analyzers 1 EchoReply Lo s
» Up/Down 2 Destination Unreachable (Port Unreachabile] Low 634 E
K- Corhoruration) 3 JAR File HTTP Download Low O |
b Evems 4 Time-To-live Exceeded in Transit Low 15 |]
» Custom Reports

5 VML File HTTP Download 1 Low 12 |

6 PING Low 5 |

7 llaple 1CMP Sweep Ping Inbound Low 4 |

8 Windows Media Player ActiveX Instantiation H'JW 2 H

9 PING with Null Pavioad Low 1|

Total 1,759

e: Padific Standard Time
2in

Drill down for additional Detail views of Intrusion Categories, Targets, Initiators, Ports affected, Target
Countries, and Initiator Countries.

Viewing Botnet Reports

Botnet reports provide details on the botnet attempts that were blocked when attempting to access the
firewall.
To view Botnet Reports, complete the following steps:

1 Click the Reports tab.

2 Select a SonicWall appliance.

3 Click Botnet > Initiators.

The top botnet attacks report appears. The Initiators report provides a pie chart and a list of the initiating
IP addresses, countries, hosts, and events, with number of attempts for each.

Drill down for additional detailed views of Attacks, Targets, Initiators, Ports affected, Initiator Countries,
and Target Countries.

Viewing Geo-IP Reports

Geo-IP reports provide details on the botnet attempts that were blocked when attempting to access the
firewall.
To view Geo-IP Reports, complete the following steps:

1 Click the Reports tab.

2 Select a SonicWall appliance.

3 Click Geo-IP > Initiator Countries.
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The top Geo-IP initiator report appears. The Initiators report provides a pie chart of threat initiator
countries blocked and events, with number of attempts for each.

Drill down for additional detailed views of Initiator IPs, Hosts, Initiator MACs, Users, and Events.

Viewing Capture ATP Status

The Capture Advance Threat Protection (ATP) reports provide details on whether a file is malicious or not by
transmitting the file to the cloud where the SonicWall Capture ATP service analyzes the file to determine if it
contains a virus or other malicious elements.

®

NOTE: A Capture ATP service license is required to use the Capture ATP features. Before you can enable
Capture ATP, the Gateway Anti-Virus and Cloud Anti-Virus Database services must be enabled in Analyzer.

Topics:
e Viewing the graph and log table on page 92

e Filtering the log table on page 95

Viewing the graph and log table

The Capture ATP > Status page displays a graph and a log table that provide information for each file that has
been scanned. Files can be uploaded to Capture ATP for scanning from this page by clicking the Upload a file
button.

SonicWALL Captare ATP! Status | Upload & file

Files scanned in the last 30 days

-}

% of malicious ties found

The graph shows the number of files scanned for each day. The X axis represents time and shows only the last 30
days. Each tick is one day. The Y axis represents the number of files scanned.

The percentage of malicious files found is represented by the color of each bar in the graph. The key shows the
percentage that each color represents. Zero means no malicious files were found.
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Below the graph, the log table shows information for each file that has been scanned. You can customize what is
displayed in the log table, by clicking the Add filter... link. The graph, log table, and filters are bound, and any
interactions on one will affect the others.

Viewing 1,859 files scanned.

No filters applied. Add Filter...

Status Filename Submitted by Src Dest

+ clean Jul 25 - 5:56pm FileZilla_Server-0_9 57 exe (uploaded) 127.0.01 127.0.01

+ clean Jul 24 - 10:08pm s jar 18B16902CEAC 10.217 58.100-80 192 168 168.9:3613
+ clean Jul 24 - 10:01pm stj zip 18B16902CEAC 10.217 58.100-80 192 168 168 9:2933
+ clean Jul 23 - 11-19am usjitdebugger exe 18B16902CEAC 10.217 58.100-80 192 168 165 948726
+ clean Jul 23 - 1:4%am vssadmin.exe 18B16902CEAC 10.217 58.100-80 192168 168.9.48727
+ clean Jul 23 - 1:4%am w32im exe 18B16902CEAC 10.217 58.100-80 192 168 168 946726
+ clean Jul 23 - 11:19am waifor exe 18B16902CEAC 10.217 58.100-80 192 168.168.9.48729
+ clean Jul 23 - 11:19am weculil exe 18B16902CEAC 10.217 58.100-80 192168 168 946730
+ clean Jul 23 - 11:19am wermgr exe 18B16902CEAC 10.217 58.100-80 192.168.168.9.48731
Jul 23 - 11:19am test2.zip 18B16902C6AC 10.217.58.100:80 192.168.168.9:48716
+ clean Jul 23 - 1:19am test3 zip 18B16902CEAC 10.217 58.100:80 192168 168.9:48717

When you hover over a bar, a popup shows the actual numbers of files scanned and malicious files found.

o
100

% of maflcious Ries found

Mar 24, 2018

48

malicious
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You can click on a single bar in the graph to set the filter for the log table to show the details of that bar only.

Files scanned in the last 30 days

1500 —

1431 8%

500 o files scanned malicious

O

% ofmalicious files found

T T T T T T T T T T T T T T T T T T T T
June/28 29 30 Julyt 2 3 4 5 B ¥ 8 9 0 1 12 13 14 15 16 17

Viewing 1,341 files of 1,859 total scanned.

| Date is 07/01/2016 % Add Filter

o~ - —
Jul 01 - 4:58pm 6.zip 18B16902C6AC
Jul 01 - 4:58pm 4.zip 18B16902C6AC
Jul 01 - 4:58pm 5.zip 18B16902C6AC
+ clean Jul 01 - 4:58pm 2level zip 18B16902C6AC
+ clean Jul 01 - 4:57pm stj.jar 18B16302C6AC
+ clean Jul 01 - 4:57pm sgmssched.jar 18B16902C6AC
+ clean Jul 01 - 4:57pm APKPure_v1.1.5_apkpure.com.apk 18B816902C6AC

Sre

10.217.58.100:80

10.217.58.100:80

10.217.58.100:80

10.217.58.100:80

10.196.149.28:80

10.196.149.28:80

10.196.149.28:80

Dest

192.168.168.111:56..
192.168.168.111:56....
192.168.168.111:56...
192.166.168.111:56...
192.166.168.111:36....
192.168.166.111:36...

192.168.168.111:36...

The log table allows you to scroll through the list of scanned files. If a scan fails, that row is dimmed. If a
malicious file is found, that row is bolded. Clicking on any row opens the threat report. For more information
about threat reports, see Viewing Threat Reports.

The heading for this page is dynamic and may appear in two states:
e When no filters are applied - Viewing n files scanned.
e When filters are applied - Viewing n files of n total scanned.
The columns for the log table are:
e The STATUS column displays these states:
e scan pending - the scan is still in progress
e clean - the scan has completed, but no judgment is confirmed yet
e scan failed - the scan has failed

e MALICIOUS - the scan has completed, and the judgment is malicious (the word MALICIOUS is
displayed in small caps in a red tag with a warning symbol)

e The Filename column displays the name of the file.
e The Date column displays the date that the file was scanned.

e The Submitted by column displays the serial number of the firewall that submitted the file to Capture
ATP.

e The Src column displays the source IP address where the file originated.

e The Dest column displays the destination IP address where the file was sent.
The columns can be sorted as follows:

e Currently, the Date column can be sorted in ascending or descending order.

e The default sort order is reverse chronological order with the most recent items on top.
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e The heading for a sorted column has a black background with an arrow indicating the direction of the
sort.

e Clicking the column heading sorts that column and toggles it in ascending or descending order.

e The selected sort order is persistent as filters are added or removed.

Filtering the log table

You can filter the entries in the log table by adding a filter that only displays certain criteria for a certain column,
such as the status, date, or src, and so on.
To add a filter to the log table:

1 On the Capture ATP > Status page, click the Add filter... link.

The filter builder bar appears.

Viewing 1,859 files scanned.

“ Status |v| | is |v| | malicious |v| x l

2 Select the criteria you want from the drop-down menus:

a From the first drop-down menu, select the column name, such as Status.

b From the second drop-down menu, select the operator: is or is not.

¢ From the third drop-down menu, select the appropriate criteria for the selected column.
3 Click Add.

The filter builder bar disappears, and a filter tag is created.

| Src IP contains 10.10.10.10 % | | Dateis Mar3,2016 X |

@ | NOTE: Only one type of filter can be applied to the log table at a time.

The Add Filter... link reappears after the filter is added and the table results are updated immediately.

If you press X, the filter tag disappears and the filter is not applied to the log table.

Uploading a file for analysis

You can upload files to be scanned using the Upload a File button on the Capture ATP > Status page.

To upload a file for scanning, complete the following steps:
1 Click the Firewall tab.
2 Select a SonicWall appliance.

3 Click Capture ATP > Status.
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The files scanned status report appears.

Capture ATP | Status “iiplond a i |
Files scanned in the last 30 days
-}
:ll_‘"-“
Lo
-0
n
e —
Ng?s W »n Seplr 7 E 4 s 6 T 8 L] " " 12 17 " " " 1w " " 20 n n n N ?‘! n n
Viewing 115 files scanned.
Mo filtars apyptiod. Aud Fiter
Sep 20 11:27am tochSuppon_2CB12E_8-12 i 127001 127004
Sep 13.5:22pm stjjar 10196149, 28.80 152,168 168 65331
Sep 13- 5:42pm sgrssched jar 10,196,149 2830 1952 168 16865330
Sep 13- 5:00pm. serdet jar 10.196.149.28.80 162 168 168 65330
Sep 13- 5:09m Spricta2000 jar 10,196,149 28.30 192 168 168 65330
Sep 13- 6:0%pm. APKPute_v1.1.5_apkpure com apk 1BB1G502C6AC 10,196,149 2680 152 168 168.65.330_
Sep 13- 5lpm APKPurn_1 15_apkpure com apk 18B16502C6RC 10.196,149.28:80 152 168 16865329
Sap 07 - 417pm widelayed axn ABB16502CEAC 10,796 149 28 80 152,168 168 65569,
Se0 07 - 4:970m SERACH G ABB1RSORCEAT 0196149 2880 152 168 168 65:569..

1 On the Capture ATP > Status page, click Upload a File.

The upload a file to be scanned dialog appears.

fa "

Upload a file to be scanned b

B | Browsa |

Supported file types: EXE, MS1, ZIP, APK appiications and PE
Maimum file size: SOMB

Ulpboied Carcel
L J

2 Click Browse, locate, and select the file you want to scan.

If the upload completes successfully, this message is shown:

Success ()

@ Processed file on the server

If upload fails, an error message is displayed. If it fails because of file size limitations, you will see an error
message similar to this:

Error ()

Maximum file size: 10MB.
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Viewing threat reports

When you click on any row in the logs table on the Capture ATP > Status page, the Capture ATP threat report
appears in a new browser window. The report format varies depending on whether a full analysis was
performed or the judgment was based on preprocessing.

Topics:
e Launching the threat report from the logs table on page 97
e Viewing the threat report header on page 97
e Viewing the threat report footer on page 98
e Viewing the static file information on page 98
e Viewing threat reports from preprocessing on page 98

e Viewing threat reports from a full analysis on page 102

Launching the threat report from the logs table

You can launch a threat report by clicking on any row in the logs table on the Capture ATP > Status page.
Hovering your mouse pointer over a row highlights it, and you can click anywhere in the row to launch the
threat report in a new browser window.

An exception exists for archives which do not contain any supported file types. In this case, no threat report is
launched.

Viewing the threat report header

The report header is very similar among the various threat reports. This section describes the header
components and variations.

Jul 19, 10:1pm

192.168.168.9 downloaded a malicious file. The endpoint may need to be cleaned.

Source SonicWALL Destination
— —
10.217.58.100:80 192.168.168.9:21010

Colored banner:

e The colored banner is red for a malicious file, and blue for a clean file.
e The top entry displays the date and time that the file was submitted to Capture ATP for analysis.

e Below the date and time, a summary of the result is displayed.

Lower banner:
e The lower part of the banner contains the connection information.

e On the leftis the IP address (IPv4) and port number of the connection source. This is the address from
which the file was sent.

e Inthe middle is the firewall identified by its serial number or friendly name.
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e Ontherightisthe IP address (IPv4) and port number of the connection destination. This is the address to
which the file is being sent.

Viewing the threat report footer

The report footer is very similar among the various threat reports.

File Identifiers

MD5: 18213ad3aie356c06406503d26006871 Saeral Number 1881691F5500
SHA1: c01Be4 04118642857 Te5b5a15cal 3d9b3660bS Capture ATP Version 0.1
BHA256: 91143d3dd282664dbe7df2ded dbbS5eSc5eaib24 5181 00cee562b0 765345041 Report Generated on 2016-07-21 T 02:56 UTC

The File Identifiers are displayed at the left side of the footer. The following file identifiers are displayed, one per
line:

e MD5
e SHA1L
e SHA256

On the right side of the footer, the following information is displayed:

e Serial Number - This is the serial number of the firewall that sent the file. This is not displayed if the file
was manually uploaded.

e Capture ATP Version - This is the software version number of the Capture ATP service running in the
cloud.

e Report Generated - This is the timestamp in UTC format of when the report was generated.

Viewing the static file information

The static file information is displayed on the left side of the threat report, and is similar across all types of
reports.

h 32kb
PE32 executable (GUI)
Intel 80386

filename_of_some_badthing73992.exe

The file information includes:
e File size in kilobits (kb)
e File type

e File name as it was intercepted by the firewall

Viewing threat reports from preprocessing

There are varying amounts of data on a preprocessor threat report, based on whether the file was found to be
malicious or clean.
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Preprocessor threat report for a malicious file:

Mar 30, 12:30am

172.17.0.148 downloaded a malicious file. The endpoint may need to be cleaned.

Saurca

Dostination
37.59.4372:80

= 172.17.0.146:60669

A 32kb - i
PE32 executable (GUI) “ Q o 1rlj\
Intel 80386 P}

flename_o!_soma_bacihingT3592 axe virus scanners wvendor reputation domain reputation embedded code
detected malware passed passed found

Analysis Summary #3 of 82 virus scanners detocted known mabware

This e wass supplied by  reputable vendor . » 3

on & repitabie domain.

Howiver ambedded code was detectad and
43 of tha B2 virus scannors identifiod f s

Vi Exgir e

Wings Exping Wind2 42

W32 it h " Wina2 Expiro Gon 3 Vinis Wind2 Expieo  1¥)
bl Wa2Espin &
. WE FamVT ExpboPC. PE W2 Expien NSt Win Trejan Expira- 1795 Wi Exgsire 3414
It was therafore judged malicious.
Vi Wini2 Expwo SF1 WIExpe G, Wird2 Expiro 80 PE_EXPIROAR
W3R Exgien AY Wira2: PE_EXPIRC.AR
W2 Exoira Gion ) WAExpiza W Wird2 Expare Gon 3 Wi xpire-5
Vieus Wini2 Expin Vieus | 0040131 ) Virus [ D040Md1 | PE Trojan Wind2 Exprio pH075386111
Vs WincE2 B e WiExgiea pan g BahirvistLin Winti2 Buiry je Wik Eapers AQ
W2 Expieo Gon 3 Views Wind2 fxouo £O Wi Wind2. Expirg, cinvwd Wz &
Eamen¥) Vs Wink2 Exin st Waz N F
File identifiors
MDS: 15213ad0a18355006408505026006071 Serial Number 1851681 F5800
HA Capture ATP Version 0.1
SHAzSE: 9f Roport Generated on 2018-07-21 T 02:86 UTC

The above threat report format is seen when the virus scans reveal malware in the file.

Preprocessor threat report for a clean file:

Mar 30, 12:30am

SonlcWall 18B1691F5900 submittad & file ko Caplure ATP for analysiz. N was not found to be malicious.

Sowce

arseqsz2ie0

Destination

= 172.17.0.146:50868

b 32kb
PES2 executable {BUI)
Iral 80386

filanams of_soma badthing?IBee oxe virus scanners wantior reputaiton damain reputation embedded code chack
prasad passed inconglusive paased

Analysin Summary

This il was suaphed oy Adede, & reputable

vongo:,

Sinca thore was alse no omibodded coda and
5 Mot Known makkare, [t was net udgod Bs

raboous.

Fili cwntifiers

MDS: 10213400218 35600880050 H2E0CET | Serial Numisar 1981891 F 500
SHAI- c0i Gaplura ATP Viegien 0.1

L w5 TaR ISl Foport Gongrziod on 20180721 70288 UTC

A clean threat report like the one shown above is seen in either of the following two cases:

Case one:
e Virus scans are inconclusive or all good.

e The file matches domain or vendor allow lists.
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Case two:
e Virus scans are inconclusive or all good.
e No embedded code is present in the file.

See the following topics for more information about preprocessor reports:
e Analysis summary and status boxes in preprocessor reports

e Malware names in preprocessor reports

Analysis summary and status boxes in preprocessor reports

Preprocessor threat reports contain an Analysis Summary section on the left side, which summarizes the
findings based on the four phases of analysis during preprocessing.

Analysis Summary

This file was supplied by a reputable vendor
on a reputable domain.

However embedded code was detected and
43 of the 82 virus scanners identified it as
known malware.

It was therefore judged malicious.

The results from the four phases of preprocessing are displayed in the status boxes.

K v v/ A

virus scanners vendor raputation domain reputation embedded coda
detectad malware passed passed found

62 & &

virus scanners vendor reputaiton domain reputation embedded code check
passed passed inconclusive passed

Each phase results in a true or false outcome. The following table shows what happens in the process depending
on the result of each phase of the preprocessing.

Four areas of preprocessor analysis

Preprocessor phase Virus scanners Vendor reputation - Domain reputation- Embedded code
result detect malware? on Allow list? on Allow list? found in the file?
True Malicious Non-malicious Non-malicious Continue analysis
False Continue analysis Continue analysis Continue analysis Non-malicious
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Some phase results trigger an immediate judgment of either Malicious or Non-malicious, as indicated in the
above table. Otherwise, that phase ends with the “Continue analysis” state.

If all phases of preprocessing result in the “Continue analysis” state, the file is sent to the cloud for full analysis
by Capture ATP.

NOTE: The vendor reputation filter is only applicable to PE files, and the domain reputation might not be
available for files delivered over SMTP. In these cases, the “Continue analysis” state is the phase result.

Malware names in preprocessor reports

If the virus scanners detect known malware in the file, all virus names are listed in the content area of the
report.

43 of 62 virus scanners detected known malware

Wind2 Expire. Gon.5 Wing2/Expiro Virus Wind2 Exgirs.o (v) Wing2 Expiee. Gon 3
Win32 Expiro. Gen.d Wind2ExpiroS. Gen VirssWind2 Explons Virug Expiro. Win32 42
Win32:Hpéat-A WaR/Expiro.ne Winaz Expira.Gan.d Virss Wind2, Exgiro.p (v)
W32 FamVT ExpiroPC. PE W32 Expiro. NF Win, Teojan Expirg-1795 Virua Expiro. 2414

Virus Windk2. Expino. SR WIHExpin. BG Wind2 Expir.80 PE_EXPIRC.AR
Wind2Expire AY Win32 Expiro, Gen3 (B) Wa2/Epin B PE_ENPIRO.AR
Wirn32. Expire. Gon 3 WI/Expiro. W Wird2. Expire. Gon 3 WaRExpiro-S

Virus Win32 Expir Virus { B040f4dc1 ) Virus { D040t § PE Trojan Win32 Expio bH075356111
Virtes Wind Exping,ne WI/Expir. gan,p BehavesLike Wird2 Salityjo Wind2Expiro AQ
Wind2 Explro. Gon 3 Virua Wini2/Expiro CD Virs Wind2 Expiro clmwd WINExpino. 0
Expiro.Y. Virus Win32 Expiro.ash Wz Xpiro. F
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Viewing threat reports from a full analysis

Full analysis threat reports provide the same set of information for both malicious and non-malicious files,
although the banner color is different.

Mar 30, 12:30am

172.17.0.146 downloaded a malicious file. The endpoint may need 1o ba cleanad.

Destemtion

™ 172.17.0.146:60660

bk 32kb
PE32 executable (GUI)
Intai BOZBE

Faauma_ol_soma_badihing7I092 exe virus scanners i ] ion engines live detonations
Why live detenations were nesded ‘Summary of acticns once datonated ‘Saa averything the angines saw
ol & kraown mahwas Engine Aipha e vades Mo mgeNier protosees  meAmmi  Anctions  comoction  dowred el detals
é.l Embedded code fourd mmm:pm. |30u‘ ] | $ I 8 a7 ‘ 1 I Inm O Secreensrots b PCAR
8 wincoma 7 1248 | 9 1 5 36 1 12| @ O Sowewros O POAS
Mot 0 kesorwns roptables vendor | |
Mot i knwrwm reputnble domain Engine Beta
P b reite Eie 12 Windows Fhone [ 1308 ] 9 [ m ] [ & [ Erg [ 1 [ 7. O L O Poas
aﬂ“wwf""”m“ © mndrold et ‘
Engina Gamma
mmxnm-lm" o | 73 | L | ar b 1 | T o o & poas
1 Windaws T 1288 | @ ] 1 5 ® ‘ 1 O O S

g % "V ¥

N, \ A i
L. % \ \
v

File idensifiers

MBS 19213ad5a 1 0355008408534 2800887 1 Serial Number 1801851FE400
BHAT: Capturn ATP Varsion 0.1
SHAZSE: ot Roport Generated on 2016-07-21 T 0266 UTC

This Threat Report format is used when the following conditions occur:
e Virus scans are inconclusive or all good.
e Embedded code is present in the file.
e The file does not match domain or vendor allow lists.
See the following topics for more information about full analysis reports:
e Why live detonations were needed
e Status boxes in a full analysis threat report

e Analysis engine results tables

Why live detonations were needed

The left side of the full analysis threat report displays a summary of the preprocessing results as an explanation
of why live detonations were needed. The term live detonations is used to indicate that one or more analysis
engines and multiple environments were used to analyze the file in the cloud servers.
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The set of preprocessing results which lead to full analysis of the file is shown below:

Why live detonations were needed

Mot a known malware

. Embedded code found

MU

Mot a known reputable vendor
Mot a known reputable domain

All other results inconclusive. File
sent to detonation engines for
further analysis.

Status boxes in a full analysis threat report

The status boxes in full analysis threat reports display status from preprocessing results as well as information

about the analysis performed in the cloud servers.

62 2 3 6

live detonations

virug scanners reputation databases detonation engines

Virus scanners:

e This is the number of Anti-Virus vendors used, regardless of the judgment from each.

e SonicWall Gateway Anti-Virus and Cloud Anti-Virus each count as one.

e Additional virus scanners from many AV products and online scan engines are included in the total.
Reputation databases:
e Oneis the vendors allowed list.

e Oneis the domains allowed list.

Detonation engines:

e This is the number of analysis engines used to analyze the file.

e One is the SonicWall analysis engine.

e Additional analysis engines from third-party vendors are included in the count.
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Live detonations:
e This is the total number of environments used across all analysis engines.

e The environment is comprised of the analysis engine and the operating system on which it was run.

Analysis engine results tables

Under the status boxes, the full analysis threat report displays multiple tables showing the results from each
analysis engine.

Summary of actions once detonated See everything the engines saw
Engine Alpha fime | libraries files g functi connection  download full details
) windows xp Pro | 130s 9 6 a7 1 7 | @ xmL @ Screenshots @ PCAP
I3 windows 7 124s | 9 } 1 5 36 1 12 | &M & Screenshois & PCAP
Engine Beta
12 Windows Phone | 130s | @ 73 6 a7 | 1 7 o o roar
0  Android timeout
Engine Gamma
) windows xP Pro | 130s g 73 6 a7 | 1 7 & on & rcar
Windows 7 124s 9 89 1 5 36 1 &8 xM & Screenshois

The engines are designated by names from the Greek alphabet, such as Alpha, Beta, Gamma, and so on.

Each row represents a separate environment, and indicates the operating system in which the engine was
executed.

The overall score from the analysis in each environment is displayed in a highlighted box to the left of the
operating system. The color of the box indicates whether the score triggered a malicious or non-malicious
judgment:

e Ascorein ared box indicates a malicious judgment
e Ascorein a grey box indicates a non-malicious judgment
For each environment, the columns provide the analysis duration and a summary of actions once detonated:

e Time - The time taken by the analysis, using 's' for seconds, 'm' for minutes, and timeout if the analysis
did not complete.

e Libraries - Cumulative count of malware libraries that were read during the analysis.

e Files - Cumulative count of files that were created, read, updated or deleted during the analysis.
e Registries - Cumulative count of OS registries that were read during the analysis.

e Processes - Cumulative count of processes that were created during the analysis.

e Mutexes - Cumulative count of mutual exclusion objects that were used during the analysis to lock a
resource for exclusive access.

e Functions - Cumulative count of functions executed during the analysis.
e Connection - Cumulative count of network connections that were created during the analysis.

You can click any cell in the Summary of actions table to jump to the full data available further down in the
report. Blank cells are not clickable.
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The last column provides access to the full details of the analysis by the different engines:

e XML - Clicking here lets you open or save an XML file which contains all the detailed data behind the
above counts.

e Screenshots - Clicking here lets you open or save a zip file of all the screenshots produced by the
analysis.

e PCAP - Clicking here lets you open or save a packet capture file in libpcap format with details about the
connections opened during the analysis.

Viewing Gateway Viruses Reports

The Gateway Viruses reports provide details on the Top Viruses that were blocked when attempting to access
the firewall.
To view Gateway Virus Reports, complete the following steps:
1 Click the Firewall tab.
2 Select a SonicWall appliance.
3 Click Gateway Viruses > Blocked.
The Top Viruses report appears.

The report provides details on the viruses blocked, the targets, initiators, and a timeline of when they
attempted access.

volicies | Reports Top Viruses Blocked ¢ Decos, #01100:00 Lo Dec 05, 2011 #3:59 | =Rr- k.
¥ Data llsage — ez =
¥ Applications + 3l | X ['m - Lond Custom Repart - | =
¥ User Activity
F Wk Attty Gateway Viruses HIMEE
» Web Filter
¥ VPN Usage
¥ Intrusions
v Gateway Viruses M Banker ARFZ_S {Trojan) - Blocked

Bodked B (Cloud Td: 16%3361) Agent.FL {Trojen) - Bocksd

Targets I Malhgent.E_274 (Tran) -Blocked

A W Frame.43473 (Trojan) - Bocksd

Timelnz
P s B (Cloud Td: 8614511) MalAgent.F (Tropn) - Blocked
» Attacks
» Authentication
» Analyzers Virus Action Evenls v
* Up/Doum Honeed :
+ Configuration Hloced 2 L
» Events Elocked :
¥ Custom Reports 7 a3 T

4 [Freme 43473 [Troje] Elocked i
5 (Clowd 1d: 86145111 Mal#gent,F (Tramn) Hoduwed 1 I
Tatal B
= feport generated
« Report oner | Svak

Drilling down provides a list of virus identity, Targets, Initiators, Target Countries, and Initiator Countries.

Viewing Spyware Reports

The Spyware report gives details of the spyware that was detected and/or blocked, the targets, initiators, and a
timeline of when they attempted access.
To view Spyware Reports, complete the following steps:

1 Click the Firewall tab.

2 Select a SonicWall appliance.
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3 Click Spyware > Detected.
The report provides details on the types of spyware detected and blocked, targets.

Drilling down provides a list of virus identity, Targets, Initiators, Target Countries, and Initiator
Countries.Drilling down lists countries of origin, and target countries.

Viewing Attacks Reports

The Attacks report lists attempts to gain access, target systems, initiators, and a timeline of when the attack
occurred.

To view Attacks Reports, complete the following steps:
1 Click the Firewall tab.
2 Select a SonicWall appliance.

3 Click Attacks > Attempts.

The Attacks report provides a pie chart and a list of the initiating IP addresses and hosts.

Top Attempts 4 Dec07,201100:00 to Dec 07, 2011 23:59 | =Lk
B RF -
Attacks 5]

@ TCP connection dropped

M Possible port scan detected
B Probable port scan detected
I Web access request dropped

B TF spoof dropped

ol i .
1 TCP connection dropped 5658 [ 2020 |
2 Posshle port scan detected 7,957 []
3 Probable port scan detected 1,433 [l
4 \Web access request dropped 1,071 H
5 [P spoof dropped Z "

Total 66,156

« Report generated for timezone: Padfic Standard Time
« Report owner: System@LocalDomain

Drill down for additional Detail views of Intrusion Categories, Targets, Initiators, Ports affected, Target
Countries, and Initiator Countries.

Viewing Authentication Reports

Authentication reports provide information on users attempting to access the Firewall.

To view Authentication Reports, complete the following steps:
1 Click the Firewall tab.
2 Select a SonicWall appliance.

3 Click Authentication > User Login.
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The Authentication report displays a list of authenticated users, their IP addresses, service, time they
were logged in, and type of login/logout. Additional Reports are available for Administrator logins and
failed login attempts.

b {
Dec 4, 2011 23:59:51
Dec 4, 2011 23:59:05
Dec 4, 2011 23:54:51
Dec 4, 2011 23:51:21
Dec 4, 2011 23:49:54
Dec 4, 2011 23:44:27
Dec 4, 2011 23:344956
Dec 4, 2011 23:33:06
9 Dec4, 2011 23:33:06
10 Dec 4, 2011 23:32:01
11 Dec 4, 2011 23:30:51
12 Dec 4, 2011 23:22:39
13 Dec 4, 2011 23:20:50
14Dec 4, 2011 23:19:57
15 Dec 4, 2011 23:18:07
16 Dec 4, 2011 23:15:38
17 Dec 4, 2011 23:07:06
13 Dec 4, 2011 22:55:20
19 Dec 4, 2011 22:45:20
20 Dec 4, 2011 22:45:12

[= I AT B S ot R

Authenticated User Logins

4

= | &
E|m|

b

4 Dec04, 2011 00:00 to Dec 04, 2011 23:59
Initiator IP | User | Initiator Host Duration  Service
10.50.128.149 SV\kbhaskar .
10.197.1,156  jlevy
10.0.37.158 lluong
10.0.81.126 SVpvoni
10.50.179.148 SW\cdinh adm sjcOevde0l.sv.us. sonicwall. con
10.0,11.241 SViakarlout
10.0.30.208  SW\iohnli
10,0.54.100  kewang
10.0.54.64 MAN1188Ynsvnc  man1188.sv.us.sonicwall.com
10.0.54.54 SWliharutyunow
10.50,128.149 SV\esuarez
10,197,1,205  svimanishk
10.0,204.72 jcai
71.59.21.196  sv'manishk €-71-59-21-196.hsd1.qa.comci
10.0.80.235  5V\dsounderra
10.0.95.21 SVibaruz beruz-013851.sv. us.sonicwall .«
10.50.128.149 SViKBruehl
10.0.15.155 ddesai
10.0.54.54 tharutyunow
10.0.63.105 SV'\pmak

[
)

Mcssa_ge
User logged out - logout detected by S50
User logged out
User logaed out - inactivi
User login from an internal zone allowed
User login from an internal zone allowed
User login from an internal zone allowed
User login from an internal zone allowed
User logaed out - inactivity timer expired
User logaed out - logout detected by S50
User login from an internal zone allowed
User logged out - logout detected by S50
User logged out
User logged out - inactivity timer expired
¥PN zone remote user login allowed
User login from an internal zone allowed
User login from an internal zone allowed
User logged out - logout detected by S50
User logged out - inactivity timer expired
User logaed out - inactivity timer expired
User login from an internal zone allowed

timer expired

14 [ 2 cfl?pagesi.zl l"__”

Clicking on hyperlinks provides additional filtering for the reports.

You can filter on the Service to view SMA and other appliances by drilling down to the syslog:

1 Go to the filter bar and click on the + and select Service from the drop-down menu. Click on the =
operator, and click on the field next to it to bring up the drop-down menu. Select SSLVPN from the

drop-down list.

Authenticated User Logins
| + | Service = |x|
User Logins L2TP Client
NetExtender
Time P
. Other =
1 Dec 14,2011 D
SSLVPN
2 Dec 14,2011 3
3 Dec 14,2011 VPN Client
4 Dec 14,2011 62058 L14252104.69
5 Dec 14,2011 16:18:14 10020450
6 Dec 14,2011 16:1529  10.0.15.71
7 Dec 14,2011 16:11:24  10.0.204.154
& Dec 14,2011 16:08:37 10020395
9 Dec 14,2011 16:07:59  10.0.54.64
10 Dec 14,2011 16:0547 1002521
11 Dec 14,2011 16:05:31  10.0.15.71

4 Dec14,2011 00:00 to Dec 14, 2011 23:59

User Initiator Host Duration

SVachiang

the

MANI 1 BER\Administ
fevy

g

SWilawek
SVihdesai

SW\kurs
Administrator
SViberuz

SWhsluwel

B

=

2/ | ¥ [5] | -Load Custom Repart- |

il

Message

User login from an internal zone allowed

User logged out - inactivity timer cxpired

User login from an internal zone allowed

VPN zone remote user login allowed

User logged out - i timer expired

User logged out - logout detected by S50

User login from an internal zone allowed

User login from an internal zone allowed

User logged out - i timer expired

User login from an internal zone allowed

User login from an internal zone allowed

2 Click Go to view a report for that service.

NOTE: For the Duration and Service categories to be present, the Firewall appliance firmware must
be at least version 5.6.0.
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Custom Reports

You can configure a report with customized filters, then save it for later viewing and analysis. Saving a Report
allows you to view it later, by loading it through the Custom Reports interface. Custom Reports can either be
saved directly, or configured through Universal Scheduled Reports. You can either load the report through the
Custom Report drop-down on the Search Bar, or click Reports > Custom and choose from the list of saved
Custom reports.

Regularly scheduled Custom Reports can be configured through the Universal Scheduled Reports interface,
accessible through the Custom Reports icon in the upper right corner. These reports can be set up to be emailed
to you on a regular schedule.

Custom Reports are available at the unit level for all appliances visible on the Firewall tab. The Log Analyzer
must be enabled for the appliance.

The Manage Reports screen (Custom Reports > Manage Reports) allows you to view what Custom Reports are
available and delete reports from the system.

For more information on configuring and scheduling custom Reports refer to the Universal Scheduled Reports
section.

Using the Log Analyzer

The Log Analyzer allows advanced users to examine raw data for status and troubleshooting. The Analyzer logs
contain detailed information from the system logs on each transaction that occurred on the specified SonicWall
appliance. These logs can be filtered or drilled down to further narrow the focus of the information, allowing
analysis of data about alerts, interfaces, bandwidth consumption, and so on. The Log Analyzer is only available
at the individual unit level.

Because of space constraints, some column items, particularly the log event messages, might not be fully visible
in the Reports pane. To view the full report, export the report to an Excel spreadsheet to view, sort, or organize
messages.

Log information can be saved for later analysis and reloaded from Custom Reports.

To load a report for viewing, either:
e (Click Load Custom Report and select from the drop-down list of saved Custom Reports.

e Click on Analyzers > Log Analyzer to view the current log.

@ NOTE: The Log Analyzer entries display raw log information for every connection. Depending on
the amount of traffic, this can quickly consume a large amount of space in the database. It is highly
recommended to be careful when choosing the number of days of information to be stored.

Viewing the Log Analyzer

The log displays information specific to either a particular report or overall system information, depending on
the path used to reach the log, either from the individual report level or from the Log Analyzer entry on the
Reports tab. Entries in the Analyzer log vary, according to the relevant report type. You can customize the log
entries by using the following options:

Show/Hide Log Columns

Use the Show/Hide Columns function to hide columns that you do not want to display in the Analyzer Log. Just
click the Configure the Log Analyzer icon, then select the columns that you want to display and deselect the
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ones that you do not want to display. By configuring the displayed columns, the Log Analyzer gives a more clean,
concise, and meaningful way to view the logs, instead of displaying unnecessary columns that take up valuable

real estate.
Log Analyzer 4 Feb0D1, 2013 00:00 to Feb 01, 2013 23:59 | | & | =
[+ 2| 2] ] I—LoadCusmmReport— |v‘
Log Analyzer
Time Initiate Initiate User Src Por SrcInt Respor DstPoi DstInt Respon URL Servici S ssage
Select the columnss to be displayed
1 Feb1,201.. 10.0.204 WNTXG64- 32767 W1 224.0.0.25355 udp/5355 a..
f = [ select Al F
3 Febi,201.. 10.0.201GDUO-2A 1837 %1 239,255, 1900 udp/1300 pa.. |
[ mitiator 1P
3 Feb1,201.. 93.248.2 1839 %1 239,255, 1900 udp/1300 pa..
[ 1nitiator Host
4 Feb1,201.. 192.168. 1838 X1 239,255, 1900 udp/1900 | [ yser pa...
5 Feb1,201.. 10.0.39."MVATTIC 32767 %1 239,255, 1300 udp/1300 [ srcport pa...
6 Feb1,201.. 10.0.204 32767 X1 239,255, 1900 udp/1900 [ src Interface pa...
. R der I
7 Feb1,201.. 10.0.07.IALAGA-S! 76T %L 239,755, 1900 udpf1200 I Responder pa...
3 Feb1,201.. 10.0.59.:MUY-H35 32767 i 239,755, 1300 udpf1300 [ ok | [ Cancel | pa...
9 Feb 1,201, 10.0.204 WN7X64- 32767 %L 224.0.0.:5355 udp/5355 o pa...

@ | NOTE: “Serial number” column and “Time” column are not part of the list to be configured because they
are necessary for any displays.

Row-Based Expansion

Instead of showing all the column information at once, the row-based expansion simplifies the screen and gives
on-demand information through a single click.

Log Analyzer
| +
Log Analyzer
Time
1 Feb 1, 2013 13:45:31
2 Feb 1, 2013 13:45:31
b Initiabor Host: GDUO-241149
» Responder IF: 239,255,255,250

¥ Responder Hosk: Nja
¥ Duration: Mis

3 Feb 1, 2013 13:45:31
4 Feb 1, 2013 13:45:31
] Feb 1, 2013 13:45:31

Initiator IP
10.0.204.209

10,201,218

10.0.59.11
10.0.204.209

10.0.204, 209

4 Feb01, 2013 00:00 to Feb 01, 2013 23:59 |

b Src Pork: 2218

¥ Dst Paork: 1900

¥ Service: udpf1900
k WPN Palicy: MJA

URL

==

35)_.i x| | [—LoadCustomReport— |v]

e

Category Message
LDP packet dropped
b Src Inkerface: ¥1
v Dst Interface: MiA
b Sess) MG

UDP packet dropped
UDP packet dropped

Connection Closed

=l
=1

4] (4] 2 of3,523pagesizliﬂ]

Click on each row to drop-down the hidden column information.

@ | NOTE: This feature is only available after you sort the columns using the show/hide function.
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Full Screen Mode

Switch to full screen mode by clicking the Full Screen Mode toggle icon. This populates the entire browser
screen with the Log Analyzer page, hiding the tree control and reports panels.

LedtH i

“' "I.I"PHF_ Turn N Full Screen I'u'Fnde_
i e

Session-Based Configurations

All column configurations for the Log Analyzer are recorded in each session. This is so that within the session,
users can have the desired/configured tabular view of the Log Analyzer at all times.

Priority

The log event messages are color-keyed according to priority. Red is the highest priority, followed by yellow for
Alerts. Messages without color keys are informational, only. The color categories are:

e Alert: Yellow

e Critical: Red

e Debug: White

e Emergency: Red
e Error: White

e Info: White

e Notice: White

e Warning: White

Color keys allow you to immediately focus on the priority level of the message, and filter data accordingly.

Filtering the Analyzer Log

The Log Analyzer allows you to add filters to view user-or incident-specific data. The Log Analyzer can be
reached either by drilling down in individual reports, or from the Analyzers item under the Reports tab.

To view the Analyzer Log, complete the following steps:

1 Select a SonicWall appliance from the TreeControl pane.
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2

3

Click to expand the Analyzer tree and click on Log Analyzer. The saved Log Analyzer report page displays.

Log Analyzer 4 Feb01,201300:00 to Feb 01, 2013 23:59 | .
|T| !El | % | E ’—Load Custom Repart - |Y|
Log Analyzer I E

Time | Initiaty Initiatt User Src Por SrcInt Rﬁpﬂd DstPnl Dstlnt Respoi URL Serv')u; Sess | Durat'nj VPH Po (ategc Message
1 Feb1,2013... 10.0.BLf 5353 X1 204,0.0.25353 udp/5353 UDP pa...
2 Feb1,2013... 10.0.81% 137 X1 10.0.14.:137 X1 udp/nethi UDP pa... 1
3 Feb1,2013... 10.0.81f iHr M 10.0.14.:137 X1 udp/nethi Comne...
4 Feb1,2013... 10.0.203 RFARZAC 5353 X1 224.0.0.:5353 udp/5353 UDP pa...
5 Feb1,2013... 10.0.204 KDANG-O 32767 K1 239.255. 1300 udp/1900 UDFP pa...
6 Feb1,2013.. 10.0.201GDUQ-2A 3814 X1 239,255, 1800 udp/1800 UDP pa...
7 Feb1,2013... 192.168. 3815 X1 239,255.. 1300 udp/1800 LD pa...
8 Feb1,2013... 10.0.16.:MPAN-D1 32767 X1 239,255, 1800 udp/1800 UDP pa...
9 Feb1,2013... 98.248.2 3|15 XL 239,255, 1800 udp/1800 UDP pa...

1] |41 of3,25?pﬂges|£ll [EJ

« Report generated for timezone: Central Standard Time
= Report owner: System@LoczlDomain

@ NOTE: Because system logs have a large number of entries, it is advisable to constrain the number
of entries displayed on the page. Saved system logs are limited in the number of rows that are
saved. If saving to PDF, a maximum of 2500 rows are saved. If saving to Excel, a maximum of 10,000
rows are saved.

To add afilter, click on the + in the Filter Bar and specify the desired filter item and parameters.

Available filters include filters for Application, Category, DST Interface, DST Port, Duration, Initiator Country,
Host, or IP address, Interface, Message, Priority, Responder country, IP, or Name, Service, Session, Src Interface,
Src Port, URL, User, or VPN Policy. This full list is available from the Log Analyzer Entry.

If you are viewing the log in the Log Analyzer view for a specific application entry, only those filters specific to
that entry are available.

Log views are drillable, and adds filters as column entries are drilled. Click an entry of interest to add a filter and
further constrain the information displayed.

Log Analyzer Use Case

1
2
3

In the following use case, we sort and filter the captured event information to evaluate threats targeted
toward the X0 default interface.

On the Reports tab, click Analyzers > Log Analyzers.

Log Analyzer 4 Feb 01,2013 00:00 to Feb 01, 2013 23:59 | | & |
|T ST [—Lnad Custom Report - |v]
Log Analyzer L E

In the Log Analyzer, click on the + to add a filter, and select the Interface filter.
Type in X1 to specify the default interface filter.
Click Go.
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The Log Analyzer is filtered on the X1 port interface.

Log Analyzer 4 Feb01,2013 00:00 to Feb 01,2013 23:59 | | =
[ + Interface = 1 % B x H ’—Load Custom Repart - ]v|
Log Analyzer 3 =

| Time Initiat¢ Initiate User SrcPoi SrcInt Respor DstPoi DstInt Respor URL | Servici Sess | Duratic VPN Po Catege Message

i Febi,2013... 10.0.204YSOMASL 32767 X1 233,255, 1900 udp/1900 UoP pa... |
2 Feb1,2013... 10.0.203 RFARZAC 32767 X1 239,255, 1900 udp/1300 UDP pa...
3 Feb1,2013... 10.0.15.: 32767 ¥ 239,255, 1900 udp/1300 UDP pa...
4 Feb1,2013... 10.0.98.:5TI-1565 32767 %1 239,255, 1900 udp/1800 UDP pa...
5 Feb1,2013... 10.0.204PHUL-485 2767 KL 233,255, 1300 udp/1300 UDP pa...
& Feb1,2013.. 192.168. 044 K 233,255, 1300 udp/1300 UDP pa...
7 Feb1, 2013 ... 10.0.701GDUO-2A 043 ¥ 233,355, 1800 udp/1300 UDP pa...
8 Feb1,2013.. 98.248.2 4045 X1 239,255, 1900 udp/1300 UDP pa...
9 Feb1,2013... 10.0.14.: 32767 X1 233,255, 1900 udp/1300 UDP pa...

144 1 of2,956 pages[®] [#1]

This allows you to begin debugging, or further investigate the use of the database.

More information can also be found by using Universal Scheduled Reports.

Configuration Settings

Configuration settings allow you to set up certain parameters for how data is displayed in Reports. You can set
up currency cost per Megabyte for the Summarizer, or add filters for the Log Analyzer reports.

Setting Up Currency Cost for Summarizer

The Data Usage page contains a Cost per connection entry.

You can set what currency and the cost per Megabyte, by completing the following steps:

1 Click Configuration > Settings on the Reports tab.

Summarizer Settings for Data Usage Reports

Type Of Currency: U.5.Dollars (USD) -

Cost Per Mega Byte Data Use: USD 0,01

2 Select the currency of the desired country and the cost per MB.

3 Click Update. The cost is immediately reflected on the Data Usage page.

Adding Syslog Exclusion Filters

Exclusion Filters restrict what information is used to generate Reports. This is achieved by filtering out syslogs
(based on the criteria specified in the Syslog Filter screen) from being uploaded to the Reports database. These
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filtered syslogs are, however, stored in the file system and archived, thus ensuring that all syslogs are available
for audit trailing purposes. Excluding data from being uploaded to the Reporting database in this way can be
useful in maintaining confidentiality regarding use history, or eliminating data corresponding to certain users
who are not of interest. For instance, you might use an Exclusion Filter to eliminate data from the company CEO.
This screen is used to specify syslog filters for the unit selected in the TreeControl. A similar screen exists for
system wide syslog filtering, in the Console Panel’s Reports > Syslog Filter screen

To add an Exclusion filter,

1 Click on Configuration > Syslog Filter.
The Syslog Exclusion Filter page appears. This page allows you to view what filters are currently applied,
edit, add, or remove filters.

2 To configure and add an Exclusion Filter, click Add. The Add Filter menu appears.

[

[ & Add - Google Chrome
7 10.203.23.11:85/sgms/editUnitFiltersp?

Add

Sysloa Field Name: |
Operator: | =
Syslog Filter Value: |
Level: Unit

Comment: Syslog Fifter. |

3 Specify the field you want to modify, and select an operator and value.
4 Add a comment to help identify the filter.

5 Click Update.
The Reports are now filtered according to the selected criteria. Exclusion Filter settings are picked up by the
Summarizer at specified regular intervals.
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Viewing SMA Reports

This chapter describes how to view SonicWall Analyzer Secure Mobile Access Reports. SMA reporting includes
reports for the Web Access Firewall (WAF) and summarization for SMA appliances using Secure Mobile Access
(SMA).

This chapter contains the following sections:
e SMA Reporting Overview on page 114
e Using and Configuring SMA Reporting on page 115
e Viewing SMA Summary Reports on page 117
e Viewing SMA Unit-Level Reports on page 118
e Viewing SMA Analyzer Logs on page 133

e Custom Reports on page 135

SMA Reporting Overview

This section provides an introduction to the Secure Mobile Access (SMA) reporting feature. SonicWall SMA
appliances are protected by the user portal on the Web Application Firewall (WAF). This section contains the
following subsections:

e SMA Reports Tab on page 114

e Whatis SMA Reporting? on page 114

e Benefits of SMA Reporting on page 115

e How Does SMA Reporting Work? on page 115

After reading the Analyzer SMA Reporting Overview section, you understand the main steps to be taken in order
to create and customize reports successfully.

For a general introduction to reporting, see SonicWall Analyzer Reporting Overview on page 56.

SMA Reports Tab

The SMA tab gives you access to the Secure Mobile Access (SMA) Reports section of the Analyzer management
interface. Reporting supports both graph and non-graph reports, and allows you to filter data according to what
you wish to view.

What is SMA Reporting?

Secure Mobile Access (SMA) reporting allows you to configure and design the way you view your reports and
the manner in which you receive them. This feature offers various types of static and dynamic reporting in which
you can customize the way information is reported.

SonicWall Analyzer SMA reporting provides a visual presentation of User connectivity activity, Up_Down status,
and other reports related to remote access. With SMA reporting, you are able to view your reports in enhanced
graphs, create granular, custom reports, create scheduled reports, and search for reports using the search bar
tool.
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Custom reports are also available in SMA reporting. SonicWall appliances managed with SMA provide Resource
Activity reports for tracking the source, destination, and other information about resource activity passing
through a SonicWall SMA device that can then be saved as a Custom report, for later viewing.

Custom Reports can be created through an intuitive, responsive interface for customizing the report layout and
configuring content filtering prior to generating the report. Two types of reports are available: Detailed Reports
and Summary Reports. Both provide detailed information, but are formatted to meet different needs. A Detailed
Report displays the data in sortable, resizable columns, while a Summary Report provides top level information
in graphs that you can click to drill down for detailed information. By customizing the report, you can then save
it for later viewing and analysis.

After you set up a Custom Report that meets your needs, you can save the report for later viewing, then manage
it through the Custom Reports Manage Reports entry, or export the report as a PDF or CSV (Excel) file.

Benefits of SMA Reporting

SMA reports provide visibility into the resource use by logged in users, leading to policies that enhance the user
experience and the productivity of employees. The following capabilities contribute to the benefits of the SMA
reporting feature:

e SMA Detail Level Reports can track events to the minute or second of the day for forensics and
troubleshooting

e [nteractive charts allow drill-down into specific details

e Table structure with ability to adjust column width of data grid
e |Improved report navigation

e Report search

e Scheduled reports

How Does SMA Reporting Work?

Syslog information for SonicWall remote appliances is sent to the Analyzer syslog collector and uploaded to the
Reports Database by the summarizer. The frequency of upload is nearly real-time: data is uploaded to the
Reports database as soon as the Syslog Collector closes the file. The file is closed and ready for upload as soon as
it reaches 10,000 MB per file or if the file has been open for three minutes, whichever comes first.

This database is saved using a date/time suffix, and contains tables full of data for each appliance. All the syslog
data received by SonicWall Analyzer is available in the database.

SMA Reporting supports scheduled reports to be sent on a daily, weekly, or monthly basis to any specified email
address.

Using and Configuring SMA Reporting

This section describes how to use and configure SMA reporting. See the following subsections:
e Viewing Available SMA Report Types on page 116
e Configuring SMA Scheduled Reports on page 117

SonicWall Analyzer 8.3 Administration Guide 115



Viewing Available SMA Report Types

To view the available types of reports for SMA Web Application Firewalls (WAF), complete the
following steps:

1 Login to your Analyzer management console.
2 Click the SMA tab.

The following types of reports are available:

Global Level Reports
e Data Usage
e Summary: connections per SMA appliance
o WAF
e Summary: connections listed by appliance for one day (default)
e General

e Status: number of units in the system and their Analyzer license status

Unit Level Reports

Clicking on hyperlinks in the Unit Level Reports takes you to the Analyzer Log, where you can view more
information.

e Data Usage
e Timeline: total connections listed by hour
e Users: connections listed by user
e User Activity
e Details: a detailed report of activity for the specified user
e Access Method
e Summary: connections per connection protocol (HTTPS, NetExtender, etc)
e Users: top users by protocol
e Authentication

e User login: authenticated user logins by time and IP protocol. User Login reports combine admin
users with all other users in the same report.

e Failed login: Failed login attempts with initiator IP address.

e Timeline: total threats detected per appliance

e Threats Detected: top threats detected per day

e Threats Prevented: top threats prevented per day

e Apps Detected: top applications detected per day

e Apps Prevented: top applications blocked per day

e Users Detected: number of concurrent users per day

e Users Prevented: number of blocked users prevented per day
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e Connections

e Timeline: a summary of offloaded connections under the group node per SMA appliance, listed
for one day.

e Applications: offloaded connections by application

e Users: offloaded connections by user
e Analyzers

e Log Analyzer: logs of all activity
e Configuration: menus allow setting Report display options

e Log Analyzer Filter: applies filters to the system logs uploaded to the reporting database
e Events: these menus allow setting options

e Alert Settings: provides search functions, adding or removing Alerts

e Current Alerts: displays current applicable Alerts.Custom

NOTE: You can use the Date Selector to select reports covering other intervals than those listed
here.

®

Configuring SMA Scheduled Reports

SMA reports are scheduled through the Universal Scheduled Reports interface. Additionally, you can configure
alerts and filter the syslog.

To configure SMA scheduled reports and summarization, click on the Schedule Report icon. The Universal
Schedule Report menu comes up. For more information on scheduling and configuring reports, refer to the
section on Universal Scheduled Reports.

Navigating Through Detailed SMA Reports

SMA reports display either summary or unit views, displayed in a Data Container. Information can be viewed in
either chart (timeline or pie chart) form, or tabular (grid) format. The list of available reports allows you to
navigate to a high-level or specific view. Data can be filtered by time constraints or data filters.

Drillable reports give access to additional information by clicking on hyperlinks to go to the Detail view. For
some reports, you can go directly to the detail views by clicking Details in the Policies/Reports pane.

Data filtering can be applied either by using the Filter Bar, drilling down through hyperlinked data, or applying a
filter to a drillable data column.

Viewing SMA Summary Reports

The SMA group level Summary report displays all SMA interfaces under that group level node, along with the
total number of threats detected on the specified day.

The SMA Summary report is available for Data Usage, Web Application Firewall (WAF), and Connections. It
shows the number of connections handled by the SMA appliances on the specified day or interval. The grid-level
reports lists each appliance by name, along with the number of connections.

To view the Data Usage Summary report, complete the following steps:

1 Click the SMA tab.
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2 Select the global icon.

3 Expand the Data Usage, WAF, or Connections tree and click Summary. The Summary page displays.

Top Users 4 Dec06,201100:00 to Dec 06, 2011 23:59 |- B e =
(3 3 % [ [esscsompeot- |-
Users s
B usanagala
W bginty
B bprasad
¥ jescalera
B dtelehowski
M hpan
W st
B Others
, User | C i v
o P —
2 bainty 24 l:|
3 bprasad 22 I'
4 jescalera 22 l,]
5 dtelehowski 2 B
6 hpan 18 l:|
7 sti 12 [|
8 skatagiri 1z [
9 akalyanaraman 10 m
10 dsounderra 8 I]
11mazo 8
12 tharutyunoy s B
13atran s |
14lvera 7 i
15 kechaganti 6 I_]
16 jsiip &
17 idunne 2 |
18 pakumar 6
Total 376

For more information, click on an individual appliance in the TreeControl menu. More settings, as well as more
detailed information, is available at the Unit View level.

Viewing SMA Unit-Level Reports

Unit View reports provide detail about Data Usage, Access Method, Authentication, WAF Access, Connections,
and Uptime and Downtime. You can also view the results from the Analyzers or saved Custom Reports.

Topics:
e Viewing Unit-Level Data Usage Reports on page 119
e Viewing SMA Top Users Reports on page 119
e Viewing SMA Authentication User Login Report on page 123
e Viewing SMA Authentication Failed Login Report on page 124
e Viewing Web Application Firewall (WAF) Reports on page 125

e Viewing Connection Reports on page 130
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Viewing Unit-Level Data Usage Reports

To view Unit-Level Data Usage Reports, complete the following steps:
1 Click the SMA tab.
2 Select the desired Unit.
3 Expand the Data Usage entry and click Timeline to display the Report.
4

The graph displays the number of connections to the selected SMA appliance during the desired interval.
The current 24 hours is displayed by default.

Web Application Firewall Timefine 4 Sep 28,2011 00:00 to Sep 28,201123:59 | SR
] TR s [
Timeline 5]

25 [ [
E 20
H 15
i .
g 104 B Connections
Y os
[ = : : i = = : = = - >
& & & & & e
I Time 4 Connections )
1 S5ep 28, 2011 10:00 1 )
2 sep 78,2011 1400 :
Total 3

« Report generated for timezone: Pacdfic Standard Time
« Report owner: System @Localliomain

The timeline contains the following information:
e Hour — when the sample was taken.
e Connections — number of connections to the SMA appliance

5 To change the interval of the report, use the left arrow to click back a day at a time, or click on the Time
Bar to access the Interval menu drop-down calendar.

6 After selecting a date, click Search. The Analyzer Reporting Module displays the report for the selected
day.

® | NOTE: The date setting stays in effect for all similar reports during your active login session.

Viewing SMA Top Users Reports

The Top Users report displays the users who used the most connections on the specified date.

To view the Top Users report, complete the following steps:
1 Click the SMA tab.
2 Select the SMA appliance.
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3 Expand the Data Usage tree and click Users. The Top Users page displays.

Top Users Detected 4 Sep 28,2011 00:00 to Sep 28,2011 23:59 | =Rk
B TWE
users &)=

B skrishnamurthy - Mozilla/5.0 {Windows NT 5. 1) Applew...
B jzarsen - Mozilla/5.0 (Windows NT 5.1; rv:2.0.1) Gec...

User Agent | Detections v
1 skrishnamurthy Mozilla/5.0 (Windows NT 5.1) Apple\Webkit/535. 1 (KHTML, like Gec... 2 I|
2 iaarsen Mozila/5.0 (Windows NT 5.1; rv:2.0. 1) Gecko,/20100101 Firefox/4... 1 tl

Total 3

« Report generated for imezone; Padfic Standard Time
» Report owner: System @LocalDomain

4 The pie chart displays the percentage of connections used by each user.
The table contains the following information for all users:
e Users — the user name
e Connections — number of connection events or “hits”

By default, the Analyzer Reporting Module shows yesterday’s report, a pie chart for the top six users, and
a table for all users. To change the date of the report, click the Start field to access the drop-down
calendar.

5 To display a limited number of users, use the Search Bar fields.

@ NOTE: This report allows you to drill down by user. Clicking on a user in either the chart or grid view
takes you to the Log Analyzer.

Viewing User Activity Logs
Web User Activity logs allow you to filter results to view only the activity of a specific user.
The User Activity Analyzer provides a detailed report listing activity filtered by user. If a user report has been
saved previously, bringing up the User Activity Analyzer displays a list of saved reports under the Filter Bar.
To create a new report, use the Filter Bar as described in the following steps:

1 Click the Firewall tab.

2 Select a SonicWall appliance.
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3 Click on User Activity > Details to bring up the User Activity Analyzer. The User Activity Analyzer
generates a Detail report based on the user name.

» General . §
» Data Usage User Activity Details | 3un12, 20150000 to Jun 12, 2015 2359 | a ®
» Applications . 1=
v User Activity + | |LBW = Type a Uiser Mo ‘| @) | % Load Custom Report -
Detalis %

¥ Wel Activity ﬁj Enter & user name in the

s Filter filter above and dickon
b Web 13 the "Go™ button to
* VPN Usage generate the report,
¥ Intrusions

Use the "LIKE" operator
» Botnet i combination with the
k Geo-IP wiklcard character ™" to
¥ Gateway Vinmses ptchmtil user
Mames,

» Spyware
* Attacks
*# Authentication
» Custom Reports
b Analyzers
» Configuration

If no user activity reports were saved, only the Filter Bar displays, with the User filter pre-selected. You
can enter a specific user name, or use the LIKE operator wildcards (*) to match multiple names.

4 Enter the name of the user into the field and click Go (arrow) to generate the report

The customized User Activity Details report displays a timeline of events, Initiators, Responders, Services,
Applications, Sites visited, Blocked site access attempted, VPN access policy in use, user authentication,
Intrusions, Initiator Countries, and Responder Countries associated with that particular user.

Data for a particular user might not be available for all of these categories.

Viewing Access Method Reports

Access Methods provide an overview of the protocols used to access the net. They are available as a summary
pie chart or in a Top User report, both of which provide additional information on the access protocol of the
specified user through the Log Analyzer.

Viewing the Access Summary Report

The Access Summary report provides an overview of the types of access protocols used. Clicking on a
hyperlinked protocol entry takes you to the Log Analyzer view for more details.
To view the Summary Report, complete the following steps:

1 Click the SMA tab.

2 Select an SMA appliance.
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3 Expand the Access Method tree and click Summary. The Access Method Summary page appears.

Access Method Summary 4 Dec05,201100:00 to Dec 05, 2011 2359 | = | m| =
| +| )] .?‘ !@| Load Custom Report - _\
Access Methods E]

B NetExtender
W HTTP
W HTTPS
M ROPSACtiveX
W s5H
Protocol | ¢ : v
v o D
2 i v
3 HITPS g |
4 RDPSActiveX &
5 55H e |
Total 198

» Report generated for timezone: Padfic Standard Time
« Report owner: System @ ocalDomain

4 Click on a section of the pie chart to obtain more details, or hover the mouse over an item on the
Protocol column and right click Add Filter to narrow the results to a particular access protocol. The
results display in the Log Analyzer report.

Viewing the Top Users Access Report

To view the Top Users Access Report, complete the following steps:
1 Click the SMA tab.

2 Select an SMA appliance.
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3 Expand the Access Method tree and click Users. The Top Users report appears.

Top Users 1 Dec05, 2011 00:00 to Dec 05, 2011 23:59  * =LAk
+] ® [xE
Users 5jLl=HE

B thuergis

B akalyanaraman
B smadugula

B beonley

B jsijp

W gtsang

B st

W Others

| user | Connections v
1 M 1 ] ]
2 akalyanaraman
3 smadugula

4 beonley
L
5]
7
8

|§I§E;

dtelehowski
9 saiver
10 iokazaki
11 borasad
12 rgupta
13 rchia
14 sneugarten
15 hnguyen
16 atran
17 nrajavasireddy

18 thenninger
Total

8= o o R R EE B e

In the chart view, you can click on either the pie chart or user list to obtain more information from the Log
Analyzer. Results are filtered by user, and the setting added to the filter bar.

Alternatively, you can hover your mouse over a user in the User column of the grid view, then right click to filter
results. For full details on that user, drill down by clicking on the user name in the column.

Viewing SMA Authentication User Login Report

The Authentication Summary report shows an overview of user logins and login attempts and disconnections by
time, user, IP address, type of connection/disconnection, and amount of time the connection was established.
Authentication reports are only available at the unit level.
To view SMA Authentication User Login Reports, complete the following steps:

1 Click the SMA tab.

2 Select an SMA appliance.
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3 Expand the Authentication tree and click User Login. The Authenticated User Login report appears.

Pulicies | | Reports Authenticated User Logins 4 Sep 28 2011 00:00 to Sep 78, 2011 23:58 | = F’I?,

» Data Usoge — -
¥ User Activity [+] 3|6 |l | LesdcustomAegort- | v

* Accews Method

* Authentication User Logins 5]
e Login
Failed Login Time Duration Message
» WAF 1 Sep 28, 211 00:02:23 00075 tietEutender decornected
¥ Lonceching 1 Sep 18, 2011 00:02:23 00H07SS Lser logged out
Ayt 3 Sep I8, 2111 00:08:48 00:21:7 it dmrormeched
» UpjDowm J —_——
* Configuration 4 Sep 28, 2011 D0:0B:54 001701 (S e discarn:
» Events 5 Sep 28, 2111 00:05:52 Lizer login succesafil
» Custom Reports & Sep 28, 2011 00:1:03 DOmIs eiExtender disconnectsd
7 Sep 28, 2011 00:10:04 00:00:12 Lser ogosd out
8 Sep 28, A1 00:10:41 00172 i e disrormected
9 Sep 28, 011 M0:147 024757 Liser autg | ouk
10 Sep 28, 2011 [0:12:48 03006: 07 Liser auta locged ouf

441 of 0pegeslh (1)

¢ sEndard Tme

@ | NOTE: All reports appear in the appliance’s time zone.

The user login report shows the login for users that logged on to the SMA appliance during the specified day.
The Report contains the following information:

e Time — the time that the user logged in

e User — the user name

e I|nitiator IP — the IP address of the user’s computer

e Message — the type of connection/disconnect

e Duration — the duration of the user login session

Viewing SMA Authentication Failed Login Report

The Authentication Failed Login report shows an overview of user logins and login attempts and disconnections
by time, user, IP address, type of connection/disconnection, and amount of time the connection was
established. Authentication reports are only available at the unit level.
To view SMA Authentication Failed Login Reports, complete the following steps:

1 Click the SMA tab.

2 Select an SMA appliance.
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3 Expand the Authentication tree and click User Login. The Authenticated User Login report appears.

Policies |  Reports Failed Logins | Sep 28,2011 00:00 to Sep 28, 2011 23:59 | = | m
» Dala Usage i |
et o e
* Acgess Hethod
T Authentication Failed Logins E
Ussi Lagin
Failed Logn | Time * User
» WAF L SeoEs, 201L07i15:38 lanaescnicial com
¥ Lonmectmns 2 Sen 38, 2001 110032 randrews
: E::m 3 Se I8, 2011 12:5:29 mechmiz
b Coiiisiin 4 Sen 18, 2011 15:23:25 thueigis
b Events 5 Seo 28, 20L1 1610447 fng
» Custom Reporks & Se0 I8, 2011 16:04:55 ding
7 Sen I3, 2011 18:08:49 2chen
8 Sen 28, 2011 18:08:45 zohen
9 Sen I8, 2011 18:08:55 zehen
10 5ep 28, 2011 18:08:57 Icen
11 5ep 28, 2011 23:52:00 nkang

4 =l 1 of 1pagss » =1

@ | NOTE: All reports appear in the appliance’s time zone.

The failed login report shows the login attempts for users that attempted to log on to the SMA appliance during
the specified day.

The Report contains the following information:
e Time — the time that the user logged in
e User — the user name
e |nitiator IP — the IP address of the user’s computer

e Message — about the type of failed attempt

Viewing Web Application Firewall (WAF) Reports

The Web Application Firewall (WAF) Summary report contains information on the number of connections
incurring Application Firewall activity logged by a SonicWall appliance during each hour of the specified day, or
at the global level, for all SonicWall appliances for the day.

The Web Application Firewall provides the following Reports:
e Timeline
e Threats Detected
e Threats Prevented
e Apps Detected
e Apps Prevented
e Users Detected
e Users Prevented

Clicking on the hyperlinks in these reports takes you to the Log Analyzer view, for more details.

To view reports, complete the following steps:

1 Click on the SMA tab and either GlobalView for the group or by individual appliance in the TreeControl
view on the left tab of the interface.
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2
3

Click Reports on the middle tab.

Select the WAF entry to expand it and click on the Report you want to view.

Viewing Connections Timeline

The WAF Connections timeline displays connections to the web firewall over time.

To view the Web Application Firewall Summary report, complete the following steps:

1
2

Click the SMA tab.
Select a SonicWall appliance.
Click Connections > Timeline.

The Timeline displays the unit level summary report containing Offloaded Connections information for
an individual SMA system.

|| Policies | | Reports | offloaded Connections Timeline 4 Oct31,201100:00 to Oct 31, 2011 23:59 | | E =S
| » Bandwidth = — =
e | [ o
i b
i Timeline B
¥ Connections
Timeline
| Applications
Users
» Up/Down
¥ Analyzers B Connections
» Saved Reports

o & .
f Peak G pe c Peak mi
1 DQet31, 2011 00:00 1 32 123 8 0.01
2 Oct31,201101:00 1 39 8.25 o 0.01
3 Oct31, 201102:00 1 13 0.0% = 0
4 Oct31 201103:00 1 12 0.07 1 0
5 Oct 31, 2011 0400 1 % 0.06 0 0
6 Oct31 201105:00 1 8 0.06 1 0
7 Oct 31, 2011 06:00 k. 5 0.08 a 0
8 Oct31, 201107:00 1 12 2,88 o 0.01
9 Qct31, 201108:00 1 17 373 o 0.01
100ct 31, 2011 09:00 1 10 3.41 o 0.01
110ct 31, 2011 10:00 1 20 3.68 a 0.01
120ct 31, 2011 11:00 1 X 3.73 1 0.01
13 Oct 31, 2011 12:00 1 18 3.72 0 0.01
140ct 31, 2011 13:00 1 15,341 7.97 2 0.01
Total 14

Click on the hyperlinks available in this report to go to the Log Analyzer.

Viewing WAF Top Threats Detected

The Threats Detected report displays the threats detected, according to signature, classification, and severity.

To view the Web Application Firewall Top Threats Detected report, complete the following steps:

1

2
3
4

Click the SMA tab.

Select a SonicWall appliance.
Click the Reports tab.

Click WAF > Threats Detected.
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The Top Threats Detected screen shows the top threats detected by the firewall, and gives details on the Threat
Signature, Threat Classification, Threat Severity, in addition to total threats detected.

Top Threats Detected 4 Sep 28, 2011 00:00 to Sep 28, 2011 23:59 | SR
= 5 x| [emcmonreper -]
s ELEE

B Email Injection Attack - Command Execution--05 Comma. ..
I 10000 - 10000 - 10000

| Signature | Severity | v
1 Email Injection Attack Command Execution—05 Commanding HIGH 2 Il
2 10000 10000 10000 £ -]
Total 3

« Report generated for timezone: Pacific Standard Time
=+ Report owner: System@LocalDomain

Click on the hyperlinks available in this report to go to the Log Analyzer.

Viewing WAF Top Threats Prevented

To view the Web Application Firewall Top Threats Prevented report, complete the following steps:
1 Click the SMA tab.
2 Select a SonicWall appliance.
3 Click on the Reports tab.
4 Click WAF > Threats Prevented.

The Top Threats Prevented view shows Top Threats detected and prevented by the web firewall, with details on
the Threat Signature, Threat Classification, Threat Severity, in addition to total threats detected.

Top Threats Prevented 4 Sep29,201100:00 to Sep 29, 2011 23:59 |- Sk
[+] 5 % H [toasonren 7]
Threats El

B Cross-site Scripting (X55) Attack - Client-side Atta...

! Sii ! Severity ! ¥
1 Cross-site Scripting (X55) Attadc Client-side Attacks—Cross-site Scripting HIGH : I
Total 1

« Report generated for timezone: Pacfic Standard Time
« Report owner: System@LocalDomain
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Viewing WAF Top Applications Detected

To view the Web Application Firewall Top Applications Detected report, complete the following

steps:

1 Click the SMA tab.

Select a SonicWall appliance.

2
3 Click the Reports tab.
4

Click WAF > Applications Detected.

The Top Applications Detected report lists applications with the most number of threats detected by the WAF
process. It displays the Application IP, URI and the Detections in order of the number of detections.

Top Applications Detected

| Application IP
R—
2 10.203.23.130
Total

« Report generated for imezone: Pacfic Standard Time
« Report owner: System@LocalDomain

4 Sep 28,2011 00:00 to Sep 28, 2011 23:59

| URIL

sonicdts. eng. sonicwall,com: 443 process_bug.asp

sonicdts. eng. sonicwall, com: 443 fupdate_bug.asp?jobid=01652697

b =ik Ak
=2 i_i_i EI ’—Lna_d_l;us_hmeepoj_'t— |v|
(8 (u[=[5]

B 10.203.23.180 - sonicdts. eng. sonicwall, com: 443 fproce. .,
W 10.203,23, 180 - sonicdts, eng. sonicwall, com: 443/updat. ..

Click on the hyperlinks available in this report to go to the Log Analyzer.

Viewing WAF Top Applications Prevented

To view the Web Application Firewall Top Applications Detected report, complete the following

steps:
1 Click the SMA tab.

Select a SonicWall appliance.

2
3 Click the Reports tab.
4

Click WAF > Applications Detected.
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The Top Applications Prevented report lists applications with the most number of threats prevented by the Web
Application Firewall. It displays the Application IP, URI and the preventions in order of the number of threats
prevented by the firewall.

Top Applications Detected 4 Sep 28,2011 00:00 to Sep 28, 2011 23:55 | = e | =
[+] 3 (x| H [-owcustomreport- [~ ]
Applications =]

B 10.203.23.180 - sonicdts.eng.sonicwall. com: 443 fproce. .,
W 10.203,23, 180 - sonicdts,eng.sonicwall. com: 443 /updat. ..

| Application 1P | URI | i v
1 10.203.23.180 sonicdts. eng. sonicwall, com: 443 process_bug.asp 2 Il
2 10.203.23.180 sonicdts.eng. sonicwall.com: 443/update_bug.asp?jobid=01652597 i ﬂ

Total 3

Click on the hyperlinks available in this report to go to the Log Analyzer.

Viewing WAF Top Users Detected

The Top Users Detected report lists the top authenticated users from whom threats have been detected by the
Web firewall. It displays the User Name, User Agent and the Detections in order of the number of detections.

The Top Users report displays the users who made the most VPN connections on the specified date.

To view the Top Users report, complete the following steps:
1 Click the SMA tab.
2 Select a SonicWall appliance.
3 Click the Reports tab.
4 Click WAF > Users Detected. The Top Users page displays.

Top Users Detected 4 Sep 28,2011 00:00 to Sep 28, 2011 23:59 | = e =
M+ = IE'|I ”_—l_oadCustEDWt'
Users 5] [(u[==]

B skrishnamurthy - Mozilla/5.0 {Windows NT 5.1) AppleW...
B jzarsen - Mozilla5.0 (Windows MNT 5.1; rv:2.0.1) Gec...

User  Agent e .
1 skrishnamurthy Mozlla/5.0 (Windows NT 5.1) ApplewebKit/s35.1 (HTML, lke Gec... 2 [ |
2 jaarsen Mozilla/5.0 (Windows NT 5.1; rv:2.0.1) Gecko/20100101 Firefox/4... 1 -:|

Total 3

» Report generated for timezone; Padfic Standard Time
» Report owner: System @LocalDomain
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5 The pie chart displays the VPN connections for the top VPN users.

6 The table contains the following information by default:

e Users — the user’s login. You can drill down to learn the IP address of the user.

e Agent — the User agent and version being used.

e Detections — the number of VPN connections in order of number of detections.

e MBytes — the number of megabytes transferred.

7 By default, the Analyzer Reporting Module shows yesterday’s report, a pie chart, and the ten top users.
To change the date of the report, use the Search Bar and click the Start or End field to access the
drop-down calendar, or click More Options for report display settings.

Viewing WAF Top Users Prevented

To view the Web Application Firewall Top Users Prevented report, complete the following steps:

1 Click the SMA tab.

2 Select a SonicWall appliance.
3 Click the Reports tab.
4

Click WAF > Users Prevented.

The Top Users Prevented report lists the top authenticated users from whom threats have been prevented by
the SonicWall web firewall. It displays their user name, user agent, and preventions, in order of the number of

preventions.

| Policies | Reports

Users Detected
Threats Prevented
Apps Prevented

b Connections

» Up/Down

» Analyzers

b Saved Reports

Mozilla/4.0 {compatible; MSIE 8.0; Windows NT &.1; WOWES; Trid...

= Report generated for timezone: Padific Standard Time

Top Users Prevented 4 Sep20,201100:00 to Sep 29, 2011 23:59 R A=

» Bandwidth — 1
i | [ TR E—n
» Authentication - |
v war users 5

Timeline

Threats Detected

Apps Detected

W Unknown - Mozilla/4.0 (compatible; MSIE 8.0; Windows...

| Preventions

Click on the hyperlinks available in this report to go to the Log Analyzer.

Viewing Connection Reports

Connection reports show the number of connections, as well as throughput data, application and user data.
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Viewing the Offloaded Connection Timeline

The Offloaded Connection Summary report lists the total connections made for all offloaded applications for
one day, displayed per hour per day. The grid section displays peak connections per second, peak throughput,
average connections per second, and average throughput per hour.

To view the Offloaded Connections Timeline report, complete the following steps:

1

2
3
4

Click the SMA tab.

Select a SonicWall appliance.
Click the Reports tab.

Click Connections > Timeline.

The Offloaded Connections Summary report displays.

|| Policies | | Reports | Offloaded Connections Timefine 4 Oct31,201100:00 to Oct 31, 2011 2359 ik sl
» Bandwidth — oy =
> Acces Hethod [+] DI
» Authentication
_ F WAF Timeline @
| ¥ Connections
| Tmelne
| Applications
Users
¥ Up/Down
» Analyzers

B Connections

» Saved Reports

\b@ @.63

| pe C Peak Ml
1 Oct31,201106:00 1 32 123 3 0.01
2 Oct31, 20110100 1 39 8.25 0 0.01
3 Dct 31, 201102:00 1 13 0,09 1 0
4 Qct 31, 2011 03:00 1 12 0.07 1 0
5 Oct 31, 2011 04:00 B 7 0.06 0 0
6 Oct 31, 2011 05:00 1 8 0.06 1 ]
7 Oct 31, 2011 06:00 1 5 0.0 0 il
8 Oct 31, 2011 07:00 £ 12 2.68 0 0.01
9 Qct 31, 2011 08:00 1 17 3.73 o 0.01
10 Oct 31, 2011 09:00 1 10 3.41 0 0.01
11 0ct 31, 2011 10:00 1 20 3.68 o 0.01
12 Oct 31, 2011 11:00 3 23 373 1 0.01
13 Oct 31, 2011 12:00 L 18 372 0 0.01
14 Oct 31, 2011 13:00 1 15,341 7.7 b 0.01

Total 14

Viewing the Offloaded Connections Top Applications Report

The Top Applications report lists those applications having the most offloaded connections, as well as
information about the application and throughput.

To view the report, complete the following steps:

1
2
3

Click the SMA tab.
Select a SonicWall appliance.

Click on the Reports tab.
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4 Click Connections > Applications.

Top Applications <4 Dec07, 2011 00:00 to Dec 07, 2011 23:59 | = | gl | |
Applications @ mEg

B 10.203.8.15 - sonicweb. sonicwall. combackend Lists/T...
[ 10.203.9.15 - sonicweb. sonicwall. com backend/default. ..
B 10.203.9.15 - sonicweb,sonicwall. com backend

0 10.203.9.15 - sonicweb . sonicwall. com/backend Picture. ..
W 10.203.9.15 - sonicweb, sonicwall. combackend Picture. ..

| Application IP | URI | Connections v
1 .10-.553.9.1.5 .sonicweb‘sonicwall.mm,ﬂ:ad(endﬂJstszasksfacﬁve.aspx 1 -II
2 10.203.9.15 sonicweb, sonicwall. com backend fdefault. aspx 8 .j
3 10.203.9.15 sonicweb. soricwall,.com/backend s N
4 10.203.9.15 sonicweb. sonicwall. com backend Picture % 20Library Backend _2009_200w.jpg b l]
5 10.203.9.15 sonicweb, sonicwall. com backendPicture % 20Library/Backend %:20Deployment3:20. .. 7 l:|
Total 40

« Report generated for tmezone: Padfic Standard Time
= Report owner: Sys LocalDomain

The report displays the IP address of the application, the URI, and how many connections were
established. The report is drillable on the application IP address to obtain the Log Analyzer report.

Viewing the Offloaded Connections Top Users Report

The Top Users report lists the users who have the most offloaded connections It displays the User Name, User
agent, and connections, in order of number of offloaded connections. The report drills down to the Top
Applications, filtered by User Name.
To view the report, complete the following steps:

1 Click the SMA tab.

2 Select a SonicWall appliance.

3 Click the Reports tab.
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4 Click Connections > Users.

Top Users <4 Dec07,2011 00:00 to Dec 07, 2011 23:59 | B | B2 | bl
B 2 (%@ (s [
i 5

B usanagala - Mogzilla/5.0 {compatible; MSIE 9.0; Winde...
B mtung - Mozila/4.0 {compatible; MSIE 8.0; Windows N...
B johnl - Mozilla/5.0 {(Windows NT 5.2; rv:8.0.1) Gecko...
¥ ragnihotri - Mozilla/5.0 (Windows NT 6. 1; WOWG4) App...
B mtung - Microsoft Office Protocol Discovery

| user | Agent | Connections v
I -usanagala Mozilla/5.0 {compatible; MSIE 9.0; Windows NT &, 1; Trident/5.0) - 262 il
2 miung Mozila/4.0 {compatible; MSIE 8.0; Windows NT &. 1; WOW6G4; Tridentf4.0; GTB7.2; ... 94 ﬂ
3 johnl Mozila/5.0 (Windows NT 5.2; rv:8.0.1) Gecko/20100101 Firefox/8.0.1 19 [|
4 ragnihotri Mozilla/5.0 {Windows NT 6. 1; WOW&4) AppleWebkit/535.2 (KHTML, like Gecka) Chr... 17 I]
5 miung Microsoft Office Protocol Discovery 1 [l
Total 393

« Report generated for tmezne: Pacific Standard Time
» Report owner: System@

1@ ocalDomain

The report drills down to the Top Applications, filtered by User Name.

Viewing SMA Analyzer Logs

Topics:
e Saving System Log Reports on page 133
e Syslog Exclusion Filter on page 134

Analyzer logs contain detailed information from the system logs on each transaction that occurred on the SMA
appliance.

The Log Analyzer allows advanced users to examine raw data for status and troubleshooting information. The
Analyzer logs contain detailed information from the system logs on each transaction that occurred on the
specified SonicWall appliance. These logs can be filtered or drilled down to further narrow the focus of the
information, allowing analysis of data about alerts, traffic, bandwidth consumption, and so on. The Log Analyzer
is only available at the individual unit level.

The SMA Log Analyzer contains information about Initiator and Responder IP addresses, Status Messages, User
and Services used, as well as the time and duration of the session.

You can filter the log on IP address, Message, User, or Service.

Clicking hyperlinks on SMA Reports takes you the Analyzer Log view of the information. Log information can be
saved by using Save on the Filter Bar for a specific report. This report then appears in the list of Custom Reports.

For more information on the Log Analyzer, refer to Using the Log Analyzer on page 108.

Saving System Log Reports

To load the report for later viewing, either:

1 Click Load Custom Report and select from the drop-down list of saved Custom reports.
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2 Click on Analyzers > Log Analyzer.

@ NOTE: The Log Analyzer entries display raw log information for every connection. Depending on
the amount of traffic, this can quickly consume a large amount of space in the database. It is highly
recommended to be careful when choosing the number of days information is stored. For more
information, see Configuring SMA Scheduled Reports on page 117 and Universal Scheduled
Reports.

You can also click on the print icon to save a log to PDF of Excel format.

NOTE: Saved system logs are limited in the number of rows that are saved. If saving to PDF, a maximum of
2500 rows are saved. If saving to Excel, a maximum of 10,000 rows are saved.

Viewing the Analyzer Log for an SMA Appliance

To view the Log, complete the following steps:
1 Click the SMA tab.
2 Select an SMA appliance.

3 Expand the Analyzer tree and click on Log Analyzer. The saved Log report page displays.

Syslog Exclusion Filter
Filters allow you to fine-tune what information is displayed in Reports. Filters allow you to narrow search results
and view subsets of report data.

Use this screen to manage the volume of syslog uploaded to the reporting database. The factory default filters
are configured to upload only the syslog needed to generate the reports. This can be fine tuned further, but it
required advanced knowledge of the syslog and consequently should be performed by experts only. Adding a
wrong filter could lead to receiving a Report Could Not Be Generated message.

To add a filter, complete the following steps:

1 Click on Configuration > Filters.

The Syslog Exclusion Filter page comes up. This page allows you to view filters currently applied, add
filters, or remove filters.
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2 To configure and add a filter, click Add Filter. The Add Filter menu comes up.

Syslog Exclusion Filter
[7] syslog Field Name Operator Syslog Filter Value Level
Mo filters configured

v AddFilter /0 Delete Filter(s)

Mote:

*The Syslog Exclusion Filter applies only to the syslogs uploaded to the reporting database.
All syslogs continue to be stored in the file system without any filtering.

* Exclusion Filter Settings will be picked up by the Summarizer every: 00 hour(s): 15 min(s).

’
(@ Add Filter - Mozilla Firefox

| ' 10.0.89.251:85/sgms/editUnitFilterjsp? iy

Add Filter

Syslog Field Mame:
Operator: = -

Syslog Filter Value:

Level: IUnjt |

| Update | | Reset

Configure

3 Specify the field you want to modify, and select an operator and value. Click Update.

Custom Reports

You can configure a report with customized filters, then save it for later viewing and analysis. Saving a Report
allows you to view it later, by loading it through the Custom Reports interface. Custom Reports can either be

saved directly, or configured through the Universal Scheduled Reports. You can either load the report through
the Custom Report drop-down on the Search Bar, or click Reports > Custom and choose from the list of saved

Custom reports.

Custom Reports are available at the unit level for all appliances visible on the SMA tab. The Log Analyzer must

be enabled for the appliance.

The Manage Reports screen (Custom Reports > Manage Reports) allows you to view what Custom Reports are

available and delete reports from the system.

HManage Custom Reports
Custom Reports

Log Analyzer

SRA User Activity

Email Injection Repa

WNH*
ooEO

Delete Selected Reports.

For more information on Custom Reports, refer to Custom Reports on page 108.
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Console

e Configuring Log Settings

e Configuring Console Management Settings
e Managing Reports in the Console Panel

e Using Diagnostics

e Granular Event Management

e Configuring User Settings

e Using Analyzer Help
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7

Configuring Log Settings

This chapter describes how to configure Log Settings. This includes adjusting settings on deleting log messages
after a certain period of time, and setting criteria for viewing logs.

This chapter includes the following sections:
e Configuring Log Settings on page 137

e Configuring Log View Search Criteria on page 138

Configuring Log Settings

In the Console > Log > Configuration screen, you can delete or archive Analyzer log messages. The Archive
process archives the data to the “archivedLogs” directory as per the Archive Log Schedule, before the data is
deleted from the database.

@ | NOTE: For UMH deployments, to offload the archived log files to a local drive, login to the /appliance
management interface, then navigate to the System > File Manager page.

Delete Analyzer Log Messages

Logs help track activities in this system. These activities are associated either directly or indirectly to user initiated actions, or
based on system initiated actions. These logs are important for audit trailing and compliance purposes, as well as for
troubleshooting system operation.

Logs, that no longer require to be stored in the system can be deleted manually. This is a one-time action and will be executed
based on the date selected for deletion.

Delete Logs Older Than: May ¥ \ / ‘20 v ] / [2{)15 v |

Update

Archive Analyzer Log Messages

Logs that no longer require to be stored in the system can be exported in CSV/HTML format and be offloaded from the

database. The archive process will first archive the data to archivedl ogs directory as per "Archive Log Schedule” and the data
will then be deleted from the database.

Note: For non-window deployments: To offload the archived log files to the local drive, navigate to the Appliance > Systems >
File Manager screen.

¥ Enable Archive

Archive Analyzer Log Messages for: 12;| months

Maximum Log Message Files: E|

Delete Data Every: [Saturda',,-r v | at |1? "} : [OE] '|
Archive Format: ® csv Onmm

Update

To configure Log settings, select between the following options:

e Delete Logs Older Than — Select the month, day, and year, and then click Update.
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e Enable Archive — Select this check box to enable Analyzer log message archiving.
e Archive Analyzer log messages for — Select the number of months to archive log messages.

e Maximum Log Message Files — Select the maximum number of monthly archive files kept in the
achivedLogs folder.

e Delete Data Every — Select a reoccurring day and time to delete data.

e Archive Format — Select the type of format to archive the Analyzer log messages. Choose between CSV
or HTML.

e Update — Click Update after your settings are selected.

NOTE: The archive process first archives the data to the archivedlLogs directory as per “Archive Log
Schedule” and then the data is deleted from the database.

Configuring Log View Search Criteria

SonicWall Analyzer log keeps track of changes made within the Analyzer management interface, logins, failed
logins, logouts, password changes, scheduled tasks, failed tasks, completed tasks, raw syslog database size,
syslog message uploads, and time spent summarizing syslog data.

To view the SonicWall Analyzer log, complete the following steps:

1 Click the Console tab, expand the Log tree, and click View Log. The View Log page displays.

¥ Log Search Criteria
Configuration . —
View Log Select Time of logs: From: | To: p
» Management (mm/ddfyyyy) (mmydd/yyyy)
* Reports SonicWALL Node: | Analyzer User:
: f‘“"“"“ Message contains: Severity: | All (Alert, Warning and FYT) ¥ |
» User Settings 1 Mateh case ® Exact Phrase Al Words O Any
» Help Word
+/" Start Search +, Clear Search 1, Export Logs
Search Results.
" Show Messages Per Screen: 10 | (Range: 10-100)
<Displaying 1-10> Next>
* pate ™ Message Severity  SonicWALL  GMSUser UserlP
1 May 20, 2015 Wed [04:40:40 PM]  Report data summarized, processed in 1,0 minutes, INFO 10.203.23.11
30 Report data summarization started. All files have been
2 May 20, 2015 Wed [04:30:40 PH] B O e INFO 10.203.23.11
3 May 20, 2005 Wed [04:25:30 PM]  Report data summarized. processed in 1.0 minutes. INFO 10.203.23.11
4 24 Report data summarization started. All files have been 202,23,
May 20, 2015 Wed [04:24:30 PM] quelsed for processing, INFO 10,203.23.11
5 May 20, 2015 Wed [04:10:38 PM]  Report data summarized. processed in 1.0 minutes. TNFO 10.202.23.11
i Report data summarization started. All files have been
6 May 20, 2015 Wed [04:09:38 PM] p i for processing. INFO 10.203.23.11
7 May 20, 2015 Wed [03:56:49 PM]  Changes made to firewall locally INFO SM 6600 432,152
8 May 20, 2015 Wed [03:55:36 PM]  Report data summarized. processed (n 1.0 minutes. INFO 10.203.23.11
9 May 20, 2015 Wed [03:54:36 PM] Report data summarlzation started. All files have been INFO 10,203.23.11

quesed for processing.
May 20, 2015 Wed [03:40:35 PM]  Report data summarized. processed In 1.0 minutes, INFO
=

10 10.203.23.11
<Displaying 1-10> Next

2 Each log entry contains the following fields:
e #—specifies the number of the log entry.
e Date—specifies the date of the log entry.
e Message—contains a description of the event.
e Severity—displays the severity of the event (Alert, Warning, or FYI).

e SonicWall—specifies the name of the SonicWall appliance that generated the event (if
applicable).

e User@IP—specifies the user name and IP address.
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3 To narrow the search, configure some of the following criteria:

@ | TIP: You can press Enter to navigate from one form element to the next in this section.

e Select Time of logs — displays all log entries for a specified range of dates.
e SonicWall Node — displays all log entries associated with the specified SonicWall appliance.
e Analyzer User — displays all log entries with the specified user.

e Message contains — displays all log entries that contain the specified text. This input field
provides an auto-suggest functionality that uses existing log message text to predict what you
want to type. It fills in the field with the suggested text and you can either press Tab to accept it or
keep typing. Different suggestions appear as you continue to type if log messages match your
input.

e Severity — displays log entries with the matching severity level:
e All (Alert, Warning, and FYl)-where FYl mean “For Your Information”
e Alert and Warning
e Alert

e Select the Match case check box to make the SonicWall Node, User, and Message contains search
fields case sensitive.

e Select one of Exact Phrase, All Words, or Any Word.

e Exact Phrase matches a log entry that contains exactly what you typed in the Message
contains field

e All Words matches a log entry that contains all the words you typed in the Message
contains field, but the words can be non-consecutive or in any order

e Any Word matches a log entry that contains any of the words you typed in the Message
contains field

4 To view the results of your search criteria, click Start Search. To clear all values from the input fields and
start over, click Clear Search. To save the results as an HTML file on your system, click Export Logs and
follow the on-screen instructions.

5 To configure how many messages are shown per screen, enter a new value between 10 and 100 in the
Show Messages Per Screen field. (default: 10). Click Next to display the next page, or click Previous to
display the preceding page.

6 To jump to a specific message, enter the message number in the Go to Message Number field.
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Configuring Console Management
Settings

This chapter describes the settings available on the Console panel in the Management section. The following
sections are found in this chapter:

e Configuring Management Settings on page 140
e Configuring Management Alert Settings on page 143
e Configuring Management Sessions on page 144

e Configuring Management Schedules on page 144

Configuring Management Settings

On the Console > Management > Settings page, you can configure email settings, set the system debug level,
synchronize model codes information, and configure password security settings.

This section describes the following Settings topics:
e GMS Settings on page 140
e Configuring Email Settings on page 140
e Configuring System Debug Level on page 142
e Enforcing Password Security on page 142
e Show Legacy Reports on page 142
e Synchronizing Model Codes on page 142

e Managing Sessions on page 144

GMS Settings

The GMS Settings allow you to show or hide the SMA tab. This section is only visible to administrators
@LocalDomain, such as Super Admins.

Configuring Email Settings

An SMTP server and an email address are required for sending Analyzer reports.

If the Mail Server settings are not configured correctly, you cannot receive important email notifications, such
as:

e System alerts for your SonicWall Analyzer deployment performance
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e Availability of product updates, hot fixes, or patches

e Scheduled Reports

To configure these email settings, complete the following steps:
1 Click the Console tab.

2 Expand the Management tree and click Settings. The Settings page displays.

GMS Settings
Enable Appliances to be managed: ¥ Firewall 2 SMA

Note: All servers in this deployment have to be restarted for this change to take effect.

SMTP Server Address: |

SMTP Port: 25

Sender e-Mail Address: |

Administrator e-Mail Address: |

L) UseTLS

g Use Authentication

User: | |

Password: | |

Note: To change the recipient email addresses, please use the Console > Management > Alert Settings Screen

4 Enforce Password Security
Number of days to force password change: 90

+/ Sync Model Codes information now

Update | | Reset

3 Enable or disable any SMA appliances to be managed. (Firewall is enabled by default). The deployed
servers must be restarted after any changes are made in order for them to take effect.

4 Type the IP address of the Simple Mail Transfer Protocol (SMTP) server into the SMTP Server field. This
server can be the same one that is normally used for email in your network. Type in the SMTP Port
number to use for email service.

5 Click Use TLS if you would like to use Transport Layer Security (TLS) for your mail server connectivity, such
as for Gmail or Office365. TLS ensures privacy between you and communicating applications on the
Internet, and that no third-party can eavesdrop or tamper with your messages.

6 If the SMTP server in your deployment is set to use authentication, click Use Authentication. This option
is necessary for all outgoing GMS emails to properly send to the intended recipients. Enter the username
in the User field, and enter/confirm the password in the Password and Confirm Password fields. This is
the username/password that is used to authenticate against the SMTP server.
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Enter the email account name and domain that appears in messages sent from the SonicWall Analyzer
into the Sender e-Mail Address field.

Enter the email account name and domain that appears in messages sent from SonicWall Analyzer into
the Administrator e-Mail Address field. You can use User Authentication for this user by checking the
box.

When finished in the Settings page, click Update. To clear the screen settings and start over, click Reset.

Configuring System Debug Level

SonicWall Analyzer provides the System Debug level option to control the debug messages sent to the log file.

To configure this setting, complete the following steps:

1

2

Select a debug level from the System Debug level drop-down list. The range is 0-3 where a level of 0
provides no debug log messages and a level of 3 provides the maximum number of debug messages.

When finished in the Settings page, click Update. To clear the screen settings and start over, click Reset.

Enforcing Password Security

SonicWall Analyzer supports enforced password rotation for enhanced security compliance.

To enable and configure enforced password rotation, complete the following steps:

1
2

Select the Enforce Password Security check box.

In the Number of days to force password change field, enter a value. The default is 90. SonicWall
Analyzer prompts the administrator to change the admin account password after the specified number
of days.

When finished in the Settings page, click Update. To clear the screen settings and start over, click Reset.

Show Legacy Reports

After the upgrade to Analyzer 8.0, new reports can only be generated using the new Analyzer reporting
infrastructure. Old ViewPoint reports can be viewed under legacy reports session (it is not possible to view both
8.0 and pre-8.0 reports in the same session). Reports generated by pre 8.0 releases of SonicWall Analyzer are
still available for viewing. Analyzer 8.0 Reporting is not compatible with earlier versions, but reports generated
by earlier versions are still accessible under the Analyzer reporting Infrastructure.

To view legacy reports, complete the following steps:

1
2
3

Select Show Legacy Reports.
Log out of SonicWall Analyzer.

Log back in to SonicWall Analyzer using administrator credentials.
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Synchronizing Model Codes

The Sync Model Codes feature accommodates new SonicWall product introductions without the need for
Analyzer update. When SonicWall updates the corporate server (MySonicWall) with a new product code, it then
becomes available to Analyzer. The task is scheduled to run every 24 hours and is also available manually.

To synchronize model codes immediately, complete the following steps:

1 On the Console > Management > Settings page, click Sync Model Codes information now. A short time
later the page is updated to display the synchronization status at the top.

Configuring Management Alert Settings

The Alert Settings page specifies which email addresses receive email alerts and notifications during specific
times.
To configure the alert notification settings, complete the following steps:

1 Click the Console tab, expand the Management tree and click Alert Settings. The Alert Settings page
displays.

Alert Settings

F User Settings
E-Mail Alert Recipient Schedule

¥ Log
¥ Management Mote: You can enter multiple email addresses separabed by semicolon (")
Settings Weekday:
Alert Settings Schedule 1: |prasad@sonicwall.com | |DD v| ta |DB “ | hours
Sessions Schedule 2: |prasad@sonicwall.com | [08 s |ta [16 5] hours
» Reports
) i . Schedule 3: |prasad@sonicwall.com | | 16 v| ta |DD .v,| hours
b Diagnostics
» Events Weskend:
» Help Saturday |prasad@sonicwall.com |

Sunday |prasad@sonicwall .com |

E-Mail Alert Format Preference.

O
Conkains text, colors, images and links, Only compatible with HTML capable email software,

C Plain Text
Contains all the details in plain bext, Compatible with all email saftware.

& Plain Text (Simple)
Contains a short message in plain text. Ideal For Pagers, SMS {Short Message Service) and similar
applications,

| Update | | Reset

2 Configure the email address(es) that receive notifications and the times that they receive them:

e Schedule 1 — Specifies who receives notifications during the first weekday schedule. Enter one or
more email addresses (separated by commas) and specify the start and end time for the shift.

e Schedule 2 — Specifies who receives notifications during the second weekday schedule. Enter
one or more email addresses (separated by commas) and specify the start and end time for the
shift.

e Schedule 3 — Specifies who receives notifications during the third weekday schedule. Enter one
or more email addresses (separated by commas) and specify the start and end time for the shift.

e Saturday — Specifies who receives notifications on Saturday. Enter one or more email addresses
(separated by commas) and specify the start and end time for the shift.
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e Sunday — Specifies who receives notifications on Sunday. Enter one or more email addresses
(separated by commas) and specify the start and end time for the shift.

3 Select whether the email alert is to be sent as HTML, Plain Text, or Plain Text (Pager). The Pager setting
sends a very short email to ensure that the email is not cut off by the character limits of some pagers.

4 When you are finished, click Update. The settings are saved.

Configuring Management Sessions

The Sessions page of the Management section of the Console allows you to view session statistics for currently
logged in users and to end selected sessions.

Managing Sessions

On occasion, it might be necessary to log off other user sessions.

To do this, complete the following steps:

1 Click the Console tab, expand the Management tree and click Sessions. The Sessions page displays.

Current Sessions

@ User Mame  IP Address Login Time Last Access Time Domain Name
| adrnin 10.0.92.22  Wed Jul 16 16:37:14 PDT 2008 ‘wed Jul 16 16:50:09 PDT 2008 LocalDomain
| admin 10.0.92.22  WedJul 16 17:28:55 FDT 2008 Wed Jul 16 17:29:49 PDT 2008 LocalDomain
D adrmin 10.0.200:149  Wed Jul 16 14:09:35 POT 2008 Wed Jul 16 15:00:17 PDT 2003 LocalDaomain
&l adrmin 10,50, 16,70 Wed Jul 16 19:50:16 POT 2008 ‘Wed Jul 16 19:50:52 PDT Z008 Localliomain
[E] adrnin 10.0.92,22  Thu Jul 17 16:05:53 PDT 2008 Thu Jul 17 16:10:10 PDT 2008 LocalDaomain
admin 10:50.16:120 . Thu Jul 17 15:54:05 PDT 2008 Thu Jul 17 17:07:20 PDT 2008 LocalDomain

End selected sessions

Current Sessions
@ User NMame IP Address Login Time Last Access Time Domain Hame
admin 10,50,16,165  FriJul 18 15:17:08 PDT 2008  Fri Jul 18 16:12:01 PDT 2008 LocalDomain

End selected sessions

2  When more than one session is active, a check box is displayed next to each row. Select the check box of
each user to log off and click End selected sessions. The selected users are logged off.

Configuring Management Schedules

The Schedules page of the Management section of the Console allows you to view schedule group statistics for
currently logged in users. The Group Schedules table displays all your predefined and custom schedules. In the
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Group Schedules table, there are four default group schedules from which to choose: Daily 24x7, Weekdays
24x7, 8x5 Work Hours, and Weekend Hours.

Search: [Name v [equois 7] | [ sewch || cex |
LI+ Name Description Enabled Configure
Cw 2407 2457 schedule @ "G

] Monday 24 hes Monday 24 hrs schedule @ Fdv
[ Tuesday 24 brs Tuesday 24 hrs schedule =) G
[ wednesday 24 hrs Wednesday 24 hrs schedule @ o= )
O thursday 24 hrs Thursday 24 hrs schedule @ &G
[ Friday 24 hrs Friday 24 hrs schedule @ d =
O saturday 24 hrs Saturday 24 hrs schedule @ Vol =)
[ sunday 24 tws Sunday 24 hrs schedule @ i,
[l v weskdays 24 tes Wesekdays: 24 hour schedule @ a7
[ monday 24 hrs Monday 24 hvs schedule @ G
[ Tuesday 24 hrs Tuesday 24 hrs schedule @ Pk = |
[ wednesday 24 hrs Wesdnesday 24 his schedule @ Pod =)
[ thursday 24 hrs Thussday 24 hrs schedule @ i ]
[ Friday 24 hrs Friday 24 hrs schedule @ 2l =]
O~ as Workdays: business hour schedule & i)
[ monday business hrs Monday business hes schedule ) 55
[ Tuesday business hws Tuesday business hrs schedule @ A
[ Wednesday business hrs Wednesday business hrs schedule <] 24~ |
[ Thursday business his Thursday business his schedule @ =]
[ Friday business hrs Friday business hrs schedule @ 51
O~ weekend Weskend: 24 hour schedule @ g
[ saturday 24 hrs Saturday 24 hrs schedule @ 8 ]
[7] sunday 24 hes Sunday 24 hrs schedule & i ]
" Add Schedule Group

A group schedule can include multiple day and time increments for rule enforcement with a single schedule. If a
schedule includes multiple day and time entries, a right-arrow button appears next to the schedule name.

Clicking the Expand > icon expands the schedule to display all the day and time entries for the schedule.

You can modify these group schedules by clicking the Edit icons in the Configure column to display the Edit
Schedule Group window.

Edit Schedule Group: 29x7
Name: 24x7
Domain:  LocalDomain ¥ |
Dhescription: 1247 schedule
visible to Nan-Administratrs: (&)
Dicable: 5]
Schedides:
Change Order Defaudt Schedule A Friday 24 hrs -
Database Backup Monday 24 hrs
Friday business hrs Saturday 24 hrs
Maondeay business his Sunday 24 his
Schedule: admin Thurcday 24 hrs
Schedule: Itadmin Tussday 24 hrs
Schedule: prasad ‘Wednesday 24 hrs
Schedule: tastadmin
Thursday business hrs
Tuesday bush firs ¥ =
e ] Loe L o<
[ update || meset |
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Adding Schedule Groups

To create a schedule group, complete the following steps:

1 Onthe Console > Management > Schedules page, click Add Schedule Group. The Add Schedule Group
page is displayed.

Add Schedule Group
Name: | |
Domain:
Description: |
Visible to Non-Administrators: (¥
Disable: [
Schedules:

Change Order Default Schedule
Database Backup

Friday 24 hrs

Friday business hrs

Monday 24 hrs

Monday business hrs

Saturday 24 hrs

Schedule: admin
Schedule: itadmin
Schedule: prasad ¥ "
RSN [ SIS, —
| Update “ Reset |

Enter a descriptive name for the group schedule in the Name field.
Enter a group schedule description in the Description field.

Click Visible to Non-Administrators if you would like to make the schedule viewable by the public.

v A~ W N

By clicking once on the desired Schedule time descriptions, use the arrow keys to move them into the
right field. These are the parameter that will be used in your schedule group range.

6 Click Update to group the entries into one named schedule.

Deleting Schedule Groups

To delete a schedule group, complete the following steps:
1 Select the check box next to the name of the group you would like to delete.

All subordinate check boxes are selected when you click the Schedule Name. Expand the group arrow if
you would like to delete individual entries from the group.

2 Click Delete Schedule Group(s)/Remove Schedule(s) from Group.

3 Confirm the deletion by clicking OK on the window that appears.

SonicWall Analyzer 8.3 Administration Guide 146



Managing Schedules

The Schedules table displays all your predefined and custom schedules. In the Schedules table, there are several
default schedules you can use or modify.

Schedules Ttems!i  [to10(of19) ! H
Search: | Name v Equale ¥ | | sexch || Clewr
O name Description Enabled Domain Configure
Schedule: admin Schadule for user: admin 7 LaocalDomain 7,
Database Backup Schedule for data backup LocalDomain 4
[ Monday 24 hee Monday 24 hrs schedule LocalDomaln =)
| Monday business hrs Maonday business hrs schedule LocalDomsin 'ﬁ
[ Tuesday 24 hrs Tuesday 24 hrs schedule LocalDomaln s,
[ Tuesday business hrs Tussday business hrs schedule LocalDomain A,
[ wednesday 24 hrs Wednesday 24 hrs scheduie LocalDomain 45
I:l Wednesday business hrs Wednesday business hrs schedule LocalDomain 4 6
[ Thursday 24 hrs Thursday 24 hrs schedule LocalDomain 'S
= Thursday business brs Thursday business hrs schadule LocalDomaln y 61
% AddScheduls % Delte Schedule(s)

You can modify these schedules by clicking the Edit icons in the Configure column to display the Edit Schedule
window.
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Adding Schedules

To create a schedule, complete the following steps:

1 Onthe Console > Management > Schedules page, click Add Schedule. The Add Schedule page is
displayed.

Add Schedule

Name: |

Domain: LocalDomain v

Description: |

Visible to Non-
Administrators:

Disable:

O00®

Invert:

Schedule:

) One-time occurrence

Date: | (mmj/dd/yyyy)
Time: | H) I (24 hr. format)

® Reccurrence

() mon [ Tue U wed UJ Thu

Day(s): . . -
U ri U sat L) sun B Al

Start Time: : (24 hr. format)

End Time: : (24 hr. format)

v Add

Schedule List:

+/ Delete %/ Delete All

[ Update ” Reset

Enter a descriptive name for the schedule in the Name field.

Enter a schedule description in the Description field.

Click Visible to Non-Administrators if you would like to make the schedule viewable by the public.
Click Disable to take the schedule offline but still available for use later when activated.

Click Invert to

N o o AN

Select one of the following radio buttons for Schedule:

e One-time occurrence — For a one-time schedule at the configured Date and Time.
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e Recurrence — For schedules that occur repeatedly during the same configured hours and days of
the week, with no start or end date. When selected, the fields under Recurring become active,
and the fields under Once become inactive.

8 For a One-time Occurrence, configure the starting date and time by entering the Month, Day, and Year
(mm/dd/yyyy) and the Hour, and Minute in the fields. The time is represented in 24-hour format.

9 If the fields under Recurrence, select the check boxes for the days of the week to apply to the schedule
or select All.

10 Under Recurrence, type in the time of day for the schedule to begin in the Start Time field. The time
must be in the 24-hour format, for example, 17:00 for 5 p.m.

11 Under Recurrence, type in the time of day for the schedule to stop in the End Time field. The time must
be in the 24-hour format, for example, 17:00 for 5 p.m.

12 Click Add.
13 Click Update to add the schedule to the Schedule List.

Deleting Schedules

You can delete custom schedules, but you cannot delete the default Work Hours, After Hours, or Weekend
Hours schedules.
To delete individual schedule objects that you created, perform the following steps:

1 To delete existing days and times from the Schedule List, select the row and click Delete Schedule(s). Or,
to delete all existing schedules, click the check box next to Name and then click Delete Schedule(s).
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Managing Reports in the Console Panel

This chapter describes how to configure reporting settings on the Console panel. These include how often the
summary information is updated, the number of days that summary information is stored, and the number of
days that raw data is stored.

The following sections are included in this chapter:
e Summarizer on page 150
e Syslog Exclusion Filter on page 153
e Email/Archive on page 154
e Managing Legacy Reports on page 155

Summarizer

This section contains the following subsections:
e About Summary Data in Reports on page 150
e Configuring the Data Deletion Schedule Settings on page 150
e Configuring Data Storage on page 151
e Configuring Hostname Resolution on page 152
e Configuring the Packet Data Viewer on page 152

e Configuring Email/Archive Settings on page 154

About Summary Data in Reports

These reports are constructed from the most current available summary data. In order to create summary data,
the Analyzer Reporting Module must parse the raw data files.

When configuring Analyzer Reporting using the screens on the Console panel under Reports, you can select the
amount of summary information to store. These settings affect the database size, be sure there is adequate disk
space to accommodate the settings you choose.

Additionally, you can select the number of days that raw syslog data is stored. The raw data is made up of
information for every connection. Depending on the amount of traffic, this can quickly consume an enormous
amount of space in the database. Analyzer creates a new two GB database for raw syslog data everyday. Be very
careful when selecting how much raw information to store.

Configuring the Data Deletion Schedule Settings

Syslog files sent from SonicWall appliances are stored on the system, and are consolidated into the syslog
database. The Summarizer processes the syslog data and stores the processed data in the summary database.
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After the configured period of syslog storage, the syslog data can be periodically deleted from the system. This is
necessary, as the syslog files and database can consume a lot of space on the file system.

This section of the Summarizer page also provides a way to delete summarized data for a certain date. For
example, if summarized data is kept for a long time, such as 90 days, then you could use this option to remove
some summarized data from a particular date within the 90 day period if the stored data was becoming too
large.

TIP: Run your database maintenance jobs soon after the completion of the scheduled tasks configured on
this page for summarizing data and deleting old syslog data.

Analyzer requires large amounts of disk space for raw data storage. In previous versions, the maximum raw
syslog database size was 2 GB. Analyzer now provides enhanced database capacity by creating a new 2 GB
database everyday. Each file name includes the date it was created for easy reference. Raw syslog data is used to
create Custom Reports for Firewall and SMA appliances.

To configure the syslog and summarized data deletion settings, complete the following steps:

1 On the Console panel, navigate to Reports > Summarizer.

Data Deletion Schedule

Delete Data Every: | Saturday at @E - ﬁ

2 Under Data Deletion Schedule, select the day and time for deletion in the hour and minute widget.
Syslog data is deleted at this time only after being stored for the number of days configured. You specify
how long to keep the date in Data Storage Configuration. This field allows you to specify the data
address of the Summarizer, how long to keep reporting data (in months), and how long to keep the raw
syslog data (in months)

3 Click Update to the right of this field.

Configuring Data Storage

To set the amount of time that reporting data and raw syslog data is stored, complete the following
steps:

1 Click the Summarizer at: drop-down menu, then select the desired summarizer IP address.

Data Storage Configuration

Keep Reporting Data for: I—D__l_Ei months

Keep Raw Syslog Data Files for: I_OIE] months

2 Click the Keep Reporting Data for drop-down menu, then select the number of months to archive the
data. Reporting data can be archived for a minimum of one month and a maximum of 36 months.

3 Click the Keep Raw Syslog Data Files for drop-down menu, then select the number of months to archive
the data files. To disable the archiving of raw syslog data files, set the value to zero. The maximum
amount of time to store raw syslog data files is 36 months.

@ TIP: If you would like to store data for longer than 36 months, you can create scheduled scripting to
move data that has been processed and stored in “//syslog/ArchivedSyslog/*.zip ...” to a mapped
network shared folder for long-term storage.
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Configuring Hostname Resolution

Hostname Resolution in the Reports > Summarizer page is configured for source IP addresses with missing
hostnames while inserting the data in the database. This means that the reports shows both the initiator IP
address and the initiator hostname in the reports whenever applicable.

Private IP Hostname Resolution Configuration
Enabled Reverse Hostname Resolution: [
Lookup thread count: |£:i =)
Scan every: |E Minutes &
Refresh Resolved Hostname Cache every: |.E[-J-__v-il Minutes -
Enable Public IP Host-name Resolution @[]

Time out value for Resolution ;| 100 im\_—_‘! milisecond

Update

e Enabled Reverse Hostname Resolution — Reverse hostname resolution is disabled by default, enable
this option for Analyzer to lookup for missing hostnames.

@ NOTE: Enabling hostname lookup increases the time taken to process syslogs. All syslogs that need
resolution are processed separately in parallel to normal syslog processing. This might slow down
summarizer and increase memory and consume more CPU cycle. Also the memory and CPU are
also be impacted further by changing the default configurations of Lookup thread count, Scan
every, Refresh Resolved Hostname Cache every. Any changes to the Hostname Resolution
Configuration take effect during the next summarizer run.

e Refresh Resolved Hostname Cache every — The hostname that is looked up for an IP address is cached.
This time indicates how long the hostname is kept in the cache, after that, it again looks up the hostname
for that IP address.

e Scan Every — Analyzer dumps syslogs with missing hostnames to a particular folder. This time indicates
how long it waits to scan the folder for new files.

e Lookup thread count — Signifies how many threads are processing the lookup in parallel. The larger the
number, the faster the processing.

@ | NOTE: Increasing this number also increases the load on the summarizer instance.

e Update — Click this button when you are finished configuring the settings.

e Enable Public IP Host-name Resolution — Public IP hostname resolution is disabled by default, enable
this option for Analyzer to lookup for missing public IP hostnames.

e Time out value for resolution — Select the timeout period (in milliseconds) if the hostname is not
resolved.

Configuring the Packet Data Viewer

In Console > Reports > Summarizer, you can enable or disable the Packet Data Viewer for signature alerts by
clicking the check box.
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Syslog Exclusion Filter

The Syslog Exclusion Filter allows you to select what fields and operators to use for filtering the syslog database.
It is picked up by the Summarizer every 15 minutes and applied to the global syslog settings.

The Syslog Exclusion Filters function in a manner similar to applying an exclusion filter to a single Firewall or
SMA appliance, but are applied to all Analyzer appliances, or all appliances in a Firewall or SMA group.
To add a filter, complete the following steps:

1 Click Reports > Syslog Filter.

Syslog Exclusion Filter

] Syslog Field Name Operator Syslog Filter Value Level Configure
i = m = a8 Appliance

F & 597 Appliance

ET: mi = 1157 Appliance

O proto = udp/nethios-ns Appliance

] proto = udp/dns Appliance

O m = 700 Appliance

O m = a02 Appliance

| m = a7 Appliance

O m = 305 Appliance

] pri = T Appliance & 6"

o addFilter 7 Delete Filter(s)

Mote:
* The Syslog Exdusion Filter applies only to the syslogs uploaded to the reporting database.
All syslogs continue to be stored in the file system without any filtering.
* Exclusion Filter Settings will be picked up by the Summarizer every: 00 hour{s): 15 min{s).
*To add/modify a Syslog Exdusion Filter at unit level, please navigate to Firewall/SRA > Unit Level = Reports = Filter Settings.

2 Click Add a Filter. The Add Filter menu comes up.

o W

Syslog Field Name: pri
Operator: =—v
Syslog Filter Value: 7 f
|| Level: Eﬁm
Appliance Type: Frewal - |
| update || meset |

3 Select the syslog field name, and an operator and value, for the field you wish to exclude. Then select the
level of Deployment: Appliance, Agent, or full Deployment.

If you select Appliance, you are prompted for the type of appliance: Firewall or SMA. If you select Agent,
you are prompted to select from a list of SGMS agents.

4 Click Update.

You can also click on the pencil in the Configure column to edit an existing filter setting. If no values
appear in the Configure column, the filter is a default system filter. These defaults cannot be configured
or deleted.

Syslogs are stored in the database without filtering, so the filters in the Syslog Exclusion Filter apply only
to values displayed in Reports.
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Email/Archive

The Console > Reports > Email/Archive page provides global options for setting the time and interval for
emailing/archiving scheduled reports, and global settings for the Web server, logo, and PDF sorting options.

Mext Scheduled Email/Archive Time

Email/ Archive Time Settings

(mmjdd yyyy hh:min) 12/13/2011 R AR L

Send Weelly Reports Every  Monday - Update
Send Monthly Reports Every 7 = ofthe Month

Mote: Weekly reports are generated for Monday-Sunday of the week, and Monthly Reports are
generated for the 1-30/31 of the month.

Logo Settings

Logo currently inuse:  cover_logo.gif

Logo File: Bmw_sg_l m

Storage Configuration

USR -Days to Store: 15

Configuring Email/Archive Settings

To configure Email/Archive and Web server settings, complete the following steps:

1
2

Click the Console tab, expand the Reports tree and click Email/Archive. The Email/Archive page displays.

To set the next archive time, enter the date and time in the Next Scheduled Email/Archive Time fields
and click Update.

To specify the day to send weekly reports, select the day from the Send Weekly Reports Every list box
and click Update.

To specify the date to send monthly reports, select the date from the Send Monthly Reports Every list
box and click Update.

If the Web server address, port, or protocol has changed since SonicWall Analyzer was installed, the new
values are automatically appear in the Email/Archive Configuration section. These settings can be
modified on the System Interface, and cannot be modified here.

Under Logo Settings, you can select a logo to be used on reports. By default, the SonicWall logo is used.
To select another logo, click Browse next to the Logo File field or type the path and filename into the
field, and then click Update.

Under Storage Configuration, select how many days to store Universal Scheduled Reports (USR) then click
Update.

USR schedules are managed under the Dashboard Tab. For more information on USR scheduling, refer to Using
the Universal Scheduled Reports Application on page 31.

NOTE: High-traffic systems can generate reports that consume large amounts of memory, disk space and
CPU time. Set your Number of Days to Archive and Scheduled Archive Time accordingly.
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Managing Legacy Reports

Reports generated by pre-8.0 releases of SonicWall Analyzer are still available for viewing, but require careful
management. SonicWall Analyzer 8.0 Reporting is not compatible with earlier versions, but reports generated
by earlier versions are still accessible under the current reporting structure.

Because it is not possible to view both 8.0 and pre-8.0 reports in the same session, we advise creating a separate
Login for accessing Legacy reports. This allows switching back and forth, as you can only view 8.0 or pre-8.0
reports in a session. By creating a separate login, you can switch between viewing modes.

1 Create a new User or Administrator login. An Administrator login (with a name like Admin_Legacy) is
recommended, as this login has full privileges. For more information on configuring Legacy reports for
new user, refer to the Console Management section.

2 Login to the Management > Users > Action Permissions tab.

3 Set flag in the check box for Show Legacy Reports.
® | NOTE: This check box is only available if SonicWall Analyzer 7.0 Reports exist in the system.

2, all Users General  Screen Permissions  Unit Permissions  Action Permissions
» ‘2 Administrators
#  End Users - Units
ol Gilest Heaie [wladd Uit [w]Madify Unit [wDelete Unit
1 Operators
[w]Renams Unit [w]Login ko Unit [v[Madify Properties

[vIRe-assign Agents

— Wiews
Manage View
[w]change wiew

- Dashboard
[w]5how Universal Dashboard
[wlshow Universal Scheduled Reparts

- Others
[w|Enable L1
[ Ishow 'sSwitch ink
[w]use web Services

Enable Legacy Report Checkbox hiowy Legacy {pre GM3 7.00 Reports

" Update ” ~#Reset

4 Log out, log back in using the new Login created in Step 1.
If Legacy Reports are no longer needed, you can delete them.

5 Go to Reports > Summarizer.
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6 Under the Data Deletion Schedule, you see a box for Delete 6.0 Reporting Data Immediately. Click
Delete to delete the Legacy reports.

Data Deletion Schedule
Delete Data Every:  Saturday w| 3t |19 | & (00 = Update
Delete GMS 6.0 Reparting Data Immediately:

@ NOTE: If you delete pre-8.0 reporting data, the Legacy data check boxes under the Action
Permissions and Summarizer tabs are no longer available, going forward.
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Using Diagnostics

This chapter describes the diagnostic information that SonicWall Analyzer provides and summarizer status
information.

This chapter includes the following sections:
e Configuring Debug Log Settings on page 157

e Summarizer Status on page 158

Configuring Debug Log Settings

Setting debug levels allows for faster troubleshooting of potential application issues. This action creates debug
log files on all the systems in this deployment and could hamper application performance and also fill up disk
space. You should reset to “No Debug” for normal operation as soon as the potential issue has been resolved.

NOTE: The debug level should only be set based on guidance from SonicWall Technical Support.The higher
the debug level, the more the system resources that are used up to generate debug data and in turn lower
the overall system performance.

To set the debug level when instructed by SonicWall Technical Support, complete the following
steps:

1 Click the Console tab, expand the Diagnostics tree and click Debug Log Settings. The Debug Log Settings
page displays.

Debug Log Settings

Setting debug levels allows for faster troubleshooting of potential application issues, This action creates debug log files
on all the systems in thiz deployment and could hamper application performance and also fill up disk space. You should
reset to Mg Pebu for normal operation as soon as the potential issue has been resolved.
Mote:

- The debug level should anly be set based on guidance from Dell SonicWALL Technical Support

- The higher the debug level, the mare the system resources that will be used up to generate debug data and in turn
lower the overall system performance.

System Debug Level:

Level 1 {Codepath)
Level 2 {Simple)
Level 3 (Logic)
Level 4 (Detailed)
Level 5 {(Highly Detailed}

Update | | Reset

2 Click the System Debug Level drop-down, then select one of the following:
e Level 1 (Codepath)
e Level 2 (Simple)
e Level 3 (Logic)
e Level 4 (Detailed)
e Level 5 (Highly Detailed)
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3 Click Update.

Summarizer Status

The Summarizer Status page displays overall summarizer utilization information for the deployment including

database and syslog file statistics, and details on the current status of the summarizer.

‘Summarizer Status Over 7 days

Summarizer Utilization

4

10.203.23.64
— Estimated Capacity (million  Average Load (million Reporting Database Raw Data Directory Estimated Cache  Backup Directory
syslog/day) syslog/day) Size Size Size Size
10.203.23.64 125,59 s 4.05GB0f 47.92GBon 0.47GBof47.99GBon 20GEof47.99GBon oo o
disk C: disk C: disk C:
Deployment Status
OK

Please visit the GMS web site for more information on how to manage your deployment.
Note: The average load and estimated capacity are spedific to the deployment and could vary across systems,

¥ Details For Summarizer At 10.203.23.64

¥ Summarizer Utilization

Average Summarizer Utilization: 4%
Peak Summarizer Utiization: 5%
Estimated Capacity (milion syslog/day): 126.59
Average Load (millon syslog/day): 4.56
Average Run Time Per Day: oh:51m:52s
Average Syslog Summarized (milion/day): 4.56
§7,908.82

Average Syslog Summarized Per Minute:

¥ Data File Information

Data File Type  File Stats Oldest
Reporting Database 4,145.15 ME
Backup Flles 12.75 MB
Unprocessed Files 0 Files - 0 M8
Archived Flles 23Files - 478,91 M8 5un Sep 28 10:09:45 POT 2013

Invalid Log Files 0 Files - 0 MB

¥ Summarizer Process Details
Summarizer is idle.

LastRunTime:  10/04/2013 13:28:58
NextRun Time:  10/04/2013 13:43:58

¥ Syslogs sent by appliances that are not under Reporting and Management
¥ Serial # of appliances for Summarizer 10.203.23.64
0017C52E5D38

COEAE415D4C4
000681125408

¥ Serial # of appliances that are misconfigured

None of the appliance is misconfigured

Note:

*Lagin to the appiiance and disable the syslogs

*If you dent have access to the appliance use the rules to the gateway to black the serials
=To Fix the misconfigured serials, login to the appliance and change the GMS Settings

* The serials listed here refresh every 12 hours

Status

OK

The Summarizer Status screen provides performance metrics for your network administrator to plan, design,

and expand your Analyzer server deployment. This feature has information on the Syslog Collector and
Summarizer metrics. The metrics displayed are daily averages collected over the last seven days.

You can receive alert emails when Summarizer Status shows any abnormalities.

To reach the Summarizer Status screen, navigate to the Console panel of Analyzer and then to Diagnostics >

Summarizer Status.

The Summarizer Status page is divided into a section showing the overall deployment-wide summarizer status

and sections with details for each summarizer. See the following sections:
e Summarizer Status Over 7 Days on page 159

e Details for Summarizer at <IP Address> on page 159

e Syslogs sent by appliances that are not under Reporting and Management on page 161
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Summarizer Status Over 7 Days

The Summarizer Status Over 7 Days section displays overall summarizer utilization information for the
deployment including database and syslog file statistics. Results are calculated over the last 7 days.

Summarizer Status Over 7 days
Summarizer Utilization
18 % '
10.0.82.25L
= e Estimated Capacity (milion Average Load (milkon Reporting Raw Data Estimatod Cache Backup Directory St
syshog/day) syshg/day) Database Size Directory Size Size Size
25,7 58 of 2,053.61 39.56 GB of 20 GB of 2,053,561
10.0.89.251 143.16 29.41 ca 3.053.61 G8 8 62.67 GA ax
Deployment Status
Ok
Flease wisit the GMS web stz for mare Information on how to manage your deployment.
Nate: The average load and estimated capacity are spedfic to the deployment and could vary across systems,

Summarizer Utilization

The top Summarizer Utilization section shows the average utilization of the summarizer over the applicable time
period. The Dial Charts show the percent of total capacity used by the Summarizer. The following metrics are
also displayed in the Summarizer Utilization section:

e Summarizer: Displays the IP address of the Summarizer.

e Estimated Capacity (million syslog/day): The estimated capacity of the system. This is calculated by
taking the (average load per day) and dividing it by the (time spent), assuming that the Summarizer was
to constantly summarize 24 hours (as in the case of a dedicated Summarizer).

e Average Load (million syslog/day): The number of incoming syslogs per day.

e Reporting Database Size: Displays the size of the reporting database in gigabytes.

e Raw Data Directory Size: Displays the size of the raw syslog directory in gigabytes.

e Estimated Cache Size: Displays the estimated size of the cache in gigabytes.

e Backup Directory Size: Displays the size of the backup directory in gigabytes.

e Status: Displays the status of the Summarizer. There are three different status notifications:
e OK: The system is operating normally.
e High Capacity: The average load is greater than 90 percent of capacity.

e Low Disk Space: There is less that 5GB of space left on the disk.

Deployment Status

The Deployment Status tells you how the deployment should be sized if it is not performing well. You might
need to reassign some units to a different agent, add another agent, or add more disk space.

Details for Summarizer at <IP Address>

This sections details the Summarizer Utilization for the applicable IP address.
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Summarizer Utilization

The Summarizer Utilization section for a specific summarizer shows not only the information at deployment
level, but also provides granular details of the summarizer’s operation and current status for each individual

summarizer.

¥ Summarizer Utilization
Average Summarizer Utilization:
Peak Summarizer Utilization:
Estimated Capacity (million syslog/day):
Average Load (million syslog/day):
Average Run Time Per Day:
Average Syslog Summarized (million/day):
Average Syslog Summarized Per Minute:

18%

19%
143.09
24,41
4h:5m:36s
24,41
99,369

e Average Summarizer Utilization: The average percentage of Summarizer utilization.

e Peak Summarizer Utilization: The percentage of peak Summarizer utilization.

e Estimated Capacity (million syslog/day): The estimated capacity of the system. This is calculated by
taking the (average load per day) and dividing it by the (time spent), assuming that the Summarizer was
to constantly summarize 24 hours (as in the case of a dedicated Summarizer).

e Average Load (million syslog/day): The number of incoming syslogs per day.

e Average Run Time Per Day: The total amount of time spent generating summarization statistical data
and results over the time period of one day.

e Average Syslog Summarized (million/day): The total number of syslogs summarized, displayed in
millions per day.

e Average Syslog Summarized Per Minute: The average number of syslogs summarized per minute over
the applicable time period.

@ NOTE: Not all syslogs are summarized. Some syslogs are discarded based on criteria defined at the
Console > Reports > Syslog Filter and Unit > Reports > Configuration > Syslog Filter pages.

Data File Information

This section displays syslog file details for the selected summarizer.

Archived Files
Bad Files

¥ Data File Information

Data File Type File Stats Oldest
Reporting Database 26,326.56 MB
Backup Files 84,656.19 MB
Unprocessed Files 1 Files - 2.41 MB Thu Jun 21 15:22:52 PDT 2012

3105 Files - 36,241 MB Wed Feb 01 00:24:15 PST 2012
1863 Files - 4,581.35 MB Wed Feb 08 12:50:57 PST 2012

The Data File Information table is divided into three columns:

e Data File Type: The type of files being reported on.

There are five main data file types:

Reporting Database Files: The files in the reporting database.

Backup Files: The backup snapshot.

Unprocessed Files: The data files in the summarizer’s processing queue.

Archived Files: The processed data files.

Bad Files: Data files with processing errors.

e File Stats: The number of syslog files in the category and their size in Megabytes.
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e Oldest: The date and time on the oldest file in the category.

Summarizer Process Details

The Summarizer Process Details section shows what tasks the summarizer is performing at the moment the
Console > Diagnostics > Summarizer Status page displays. Refresh your browser display or leave the page and
return to it to update the information.

If the summarizer is currently running, the page displays the thread, appliance identifier, file being used, and
state of the summarizer.

¥ Summarizer Process Details

Number of threads currently running: 1

Thread File State Started at

1_.20120621_222317_to_20120621_222343.unp
(Thu Jun 21 15:23:17 PDT 2012 -- Thu Jun 21 15:23:43 PDT 2012)

0 Summarizing file||Thu Jun 21 15:23:46 PDT 2012

If the summarizer is currently idle, the page displays the last run time and next run time.

¥ Summarizer Process Details
Summarizer is idle.

Last Run Time:  01f26/2012 15:06:23
Mext Run Time:  01/26/2012 15:21:23

Syslogs sent by appliances that are not under Reporting and
Management

Appliances that are no longer managed by Analyzer might still send syslog messages, impacting the
performance of the summarizer. The syslogs from such appliances are dropped and not stored in
archivedSyslogs or badSyslogs folders.

This feature displays a list (refreshed every 12 hours) of the appliances that are still sending syslogs messages
even though they are no longer managed Analyzer, as well as appliances that are incorrectly configured:

¥ syslogs sent by appliances that are not under Reporting and Management
¥ Serial # of appliances for Summarizer 127.0.0.1

123412341234
234234234234

¥ Serial # of appliances for Summarizer 12.12.12.1
Mone

¥ Serial # of appliances that are misconfigured
123412312312

Yote:

* Login to the appliance and disable the syslogs

* If you dont have access to the appliance use the rules to the gateway to block the serials
*To Fix the misconfigured serials, login to the appliance and change the GMS Settings

* The serials listed here refresh every 12 hours

If your Analyzer has a list of appliances in these fields, try the following to correct the issue:
e Loginto the appliance and disable the syslogs.
e If you do not have access to the appliance, use the rules to the gateway to block the serial numbers.

e To fix the misconfigured appliances, log in to the appliance and change the Analyzer settings.
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11

Granular Event Management

This chapter describes how to configure and use the Granular Event Management (GEM) feature in a Analyzer
environment.

This chapter contains the following sections:
e Granular Event Management Overview on page 162
e Using Granular Event Management on page 163
e Configuring Granular Event Management on page 164

e Viewing Current Alerts on page 173

Granular Event Management Overview

Granular Event Management (GEM) provides a customized and controlled manner in which events are managed
and alerts are customized and enabled. On the Console panel, GEM allows you to systematically configure each
sub-component of your alert in order for the alert to best accommodate your needs.

The GEM alert has multiple sub-components, some of which have further subcomponents. It is not necessary to
configure all sub-components prior to creating an alert.

e Severities: Severity is used to tag an alert as Critical, Warning, Information, or a custom severity level.
You can create your own preferred severities and assign the order of importance to them from lowest
to highest. When using a custom severity, you must define it before creating a threshold that uses it.

e Thresholds: A threshold defines the condition that must be matched to trigger an event and send an
alert. Each threshold is associated with a Severity to tag the generated alert as critical, warning, or
information.

One or more threshold elements are defined within a threshold. Each threshold includes the following
elements:an Operator, a Value, and a Severity. When a value is received for an alert type, the GEM
framework examines threshold elements to find a match for the specified condition. If a match is found
(one or more conditions match), the threshold with the highest severity containing a matching element
is used to trigger an event.

e Schedules: You can use Schedules to specify the day(s) and time (intervals) in which to generate an alert.
You can also invert a schedule, which means that the schedule is the opposite of the time specified in it.
For example:

e Generate an alert during weekdays only, or weekends only, or only during business hours.

e Do not generate an alert during a time period when the unit, network, or database are down for
maintenance.

What is Granular Event Management?

The purpose of Granular Event Management is to provide all the event handling and alerting functionality for
Analyzer. The Analyzer management interface provides screens for centralized event management on the
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Console panel, including screens for Events > Threshold, Schedule, and Alert Settings. The panel also provides
an Events > Alert Settings screen where you can enable or disable alerts.

You can enable or disable an alert at the global or unit level in Analyzer. At the global level, the alert is then
applied to all units. Whenever you add a new unit to Analyzer, the alerts set at the global level are applied to the
new unit.

Benefits

Granular Event Management offers a significant improvement in control over the way different events are
handled. You now have more flexibility when deciding where and when to send alerts, and you can configure
event thresholds, severities, schedules, and alerts from a centralized location in the management interface
rather than configuring these on a per-unit basis.

How Does Granular Event Management Work?

The Granular Event Management framework provides customized event handling for specific alerts about
database and database log size, and security service subscription licenses. For a list of the predefined alerts, see
Using Granular Event Management on page 163.

Using Granular Event Management

For convenience and usability, a number of default settings are predefined for severities, schedules, thresholds,
and alerts. You can edit the predefined values to customize the settings for thresholds and schedules. The
predefined defaults for the Console panel are as follows:

GEM Predefined Default Objects

Panel Screens Predefined Default Objects
Console Events > Schedule Schedule Groups:
° 24x7
e  Weekdays 24 hours
e 38x5
e Weekend

e Schedules:

e Schedule: admin

e Database Backup

e Monday 24 hours

e Monday business hours

e Tuesday 24 hours

e Tuesday business hours

e Wednesday 24 hours

e Wednesday business hours

e Thursday 24 hours

e Thursday business hours

Console Event > Alert Settings Database Info
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GEM Predefined Default Objects (Continued)

Panel Screens Predefined Default Objects

Console Events > Schedule Schedule Groups:

e Database Size Status

e System Files Backed-Up
Status

e Disk Space Utilization Status

About Alerts

The Events > Alert Settings screens are available in the Console and Firewall panels. You can enable or disable
alerts on these screens.

The GEM framework provides different types of alert types for the respective areas of the Analyzer application:
e Firewall panel: Alert settings for Reporting

e Console panel: Alert settings for the Analyzer application

GEM Alert Types
Panel location Available Alert Types
Console Backed up Syslog Files
New Firmware Availability
Bandwidth Usage (Billing Cycle)
Bandwidth Usage (Daily)
Firewall Anti Virus License

CFS License

Warranty License

Anti Spyware License

Intrusion License
VPN Tunnel Status
Agent Quota Reached

Agent Unsuccessful Backups

Appliance Capacity Status
CPU Status

Configuring Granular Event Management

To set up the GEM environment after installing Analyzer, start with the Events screens on the Console panel. You
should examine the Threshold and Schedule screens and make any necessary configuration changes. Then you
can enable alerts in the Events screens on the Console panel and Firewall panel.

See the following section:

e Configuring Events on the Console tab on page 165
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Configuring Events on the Console tab

In the Events screens on the Console tab, you can configure the frequency of subscription expiration and task
failure notifications, as well as severities, thresholds, schedules, and alerts for handling events.

See the following sections:
e Configuring Event Thresholds on page 165
e Configuring Event Schedules on page 166

e Enabling or Disabling Alerts on the Console Panel on page 169

Configuring Event Thresholds

In the Events > Threshold screen, you can view existing event thresholds and configure their elements, and add
custom thresholds. A threshold defines the condition for which an event is triggered. Predefined thresholds
have names similar to predefined Alert Types. Each threshold can contain one or more threshold elements. An
element consists of an Operator, a Value, and a Severity.

The following tasks are described in this section:
e Editing an Threshold Element on page 165
e Enabling/Disabling Thresholds and Threshold Elements on page 166

Editing an Threshold Element
To edit an existing element of a Threshold, complete the following steps:

1 Onthe Events > Threshold screen, click the 4 Edit icon located in the Configure column in the element
row.

The Edit Threshold pop-up window displays:

Edit Threshold Element for Database Size Status

e P | |
Operator: | is greater than or equal to ﬁ;l

Yalug: 25000 |

Description: Excesds 25000 ME |
Severty:  [CHEEE | cricdl [
Disable: 4|

| Update | | Reset |

2 Inthe Operator field, select from the drop-down menu the type of operator to apply to your threshold
element.

Edit Threshold Element for Database Size Status

Operator: s greater than or equal bo %

Yalle; is not equal to |

Description; |15 1255 than tl
& i less than or equal to —

Severity: is greater than

Disable: is equal to {match case)
is equal to {ignore case)
is not equal to

contains
does not conkain

3 Inthe Value field, enter the value for your threshold element.

4 In the Description field, enter the description for your threshold element.
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5 In the Severity field, select the severity priority from the drop-down menu. These are color coded for
your easy reference on the Events > Threshold screen.

Edit Threshold Element for Database Size Status

Operator: | is greaker than or equal ko 22|

Yalue: 25000 |

Description: [Exceeds 25000 MB |
Severity:  [ETiEEAI]
Disable: Bl 5

Crifical

| Update | | Reset |

6 To disable the threshold element, click the Disable check box. See Enabling/Disabling Thresholds and
Threshold Elements on page 166.

7 Click Update.

Enabling/Disabling Thresholds and Threshold Elements

The GEM feature provides a Disable check box that allows you to disable or enable thresholds or individual
elements within that threshold. If it is needed again, you can simply enable it.

You can disable a threshold by disabling all its elements. You can also disable individual elements within a
threshold.

To enable or disable Thresholds and/or their elements, complete the following tasks:

1 On the Console panel, navigate to the Events > Threshold screen. On this screen, you are able to view
existing Thresholds. You can also view existing elements within those thresholds by clicking the expand
button by a threshold. You have the following two options for the enabling/disabling feature:

® You can enable or disable a Threshold by disabling/enabling all the elements that exist within it.

e You can enable/disable the individual elements within a Threshold.

2 To enable or disable a threshold and/or elements, click Edit , Which is on the element level.

3 Select Disable to disable the element or de-select Disable to enable the element.

Edit Threshold Element for Unit Status

Operator: is greater than 8|

Yalue: |3 |

Description: |Exceeds 3 missed heartbeats |

Severity:  FEREEal |-£ritical

Disable: %

| Update | | Resat |

4 Click Update.

Configuring Event Schedules

The next component on the Console panel is Events > Schedule. In this screen, you can add, delete, or configure
schedules and schedule groups.

Schedule groups are one or more schedules grouped within an object. Administrators and Owners can edit
these objects. Other users should be able to view or use them only if Visible to Non-Administrators is selected.

The following tasks are described in this section:

SonicWall Analyzer 8.3 Administration Guide 166



e Adding an Event Schedule on page 167
e Editing an Event Schedule on page 168
e Editing an Event Schedule on page 168
e Adding an Event Schedule Group on page 168

e Deleting a Schedule or Schedule Group on page 169

Adding an Event Schedule

In Events > Schedules you can add, delete, or configure schedules. You see your schedules and schedule groups,
their descriptions, and whether they are enabled. You can also individually delete one schedule or schedule
group at a time by selecting the trash-icon on the right side for each row. For quick reference, you can hover
your mouse over the descriptions to quickly view the type of schedule and the days and times when it is active.
To add an event schedule, complete the following steps:

1 On the Events > Schedules screen, click Add Schedule.

2 Inthe Name field, enter a name for the schedule.

3 In the Domain field, click the drop-down list and select a name. This function is for Super Admins only.
4 In the Description field, add a description for the schedule.
5

Select Visible to Non-Administrators if you want the schedule to be visible and usable by
non-administrators.

6 To temporarily disable a schedule, select Disable.
7 Click Invert to create a schedule that is “off” during the dates and times that you specify.
8 Inthe Schedule field, you can create one or more schedules. For each schedule, configure either:
e One Time Occurrence
e Fill in the Date and Time fields.
e Recurrence

e Fill in Days, Start Time, and End Time fields.
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9 Click Add to add this schedule to the Schedule List text box.

Add Schedule

Mame: |

Domain: | LocalDomain [

Description: |
Visible ko
Mor-Administrators:
Disable:

B0 0E

Irvvert:

Schedule:
© One-time accurrence

Date: (o ddfyyyyd

Time: | _| (24 br, Format)

® Reccurrence
Day(sk [ mon [ Tue [ wed [ Tha
Ori Osat Oson Oai
Start Time: J 3 I:_-l (24 br, Format)

End Time: _] z I:I {24 br, Format)

dd

| %

Schedule List:

v pelete ¥ pelete all

| Update | | Reset |

10 To delete an entry from the Schedule List text box, select the entry that you want to delete, and then
click Delete. Click Delete All to delete all entries.

11 Click Update when you are finished.

Editing an Event Schedule

To edit an existing schedule, click the Edit icon on the right side of the Events > Schedule screen. The screen and
procedure for editing are the same as those for adding a schedule. See Adding an Event Schedule Group on page
168.

Adding an Event Schedule Group

You can combine several schedules into a schedule group on the Events > Schedule screen.

To add a schedule group, complete the following steps:
1 On the Events > Schedule screen, click Add Schedule Group.
2 Enter the name of your schedule group in the Name field.
3 Enter a description of your schedule group in the Description field.
4

Click Visible to Non-Administrators to allow this schedule group to be viewed and used by non
administrators.

5 Click Disable to temporarily disable the schedule group.
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6 Inthe Schedules field, select the schedule(s) to add to your schedule group, and then use the arrow
buttons to move the selected schedule into or out of the group. To move multiple schedule groups
and/or schedules all at once, hold the CTRL button on your keyboard while making your selections.

Add Schedule Group

Mame: |

Dormain: LocalDomain (5]

Description: |

Visible to Mon-Administrators:

Disable: [l
Schedules:
Friday 24 hrs _||
Friday business hrs EJ

Monday 24 hrs
Monday business hrs
Saturday 24 hrs
Schedule: admin
Schedule: AngelaM

Schedule: test
Schedule: testl
Schedule: test1008 al]
TSN [ =S W—
| Update | | Reset |

7 Click Update.

Editing an Event Schedule Group

To edit an existing schedule group, click the Edit icon on the right side of the Events > Schedule screen. The
screen and procedure for editing are the same as those for adding a event schedule group. See Adding an Event
Schedule Group on page 168.

Deleting a Schedule or Schedule Group

You can delete schedules or schedule groups, or you can remove schedules from schedule groups.

@ NOTE: Deleting a Schedule or Schedule Group that is in use is not permitted. A message displays when this
action is performed.

To delete an event schedule, schedule group, or remove a schedule from a schedule group, complete
the following steps:

1 Navigate to the Events > Schedule screen.

2 Click the check boxes of the schedule groups or schedules that you want deleted. When you click the
schedule group check box, the schedules within that schedule group are deleted as well.

3 Toremove a schedule from a schedule group, click the expand button on the schedule group, and select
the schedules you wish to remove within that group.

4 To delete the selected schedule group(s) or remove the selected schedules from a group, click Delete
Schedule Group(s)/Remove Schedules from Group.

5 To delete the selected schedule(s), click Delete Schedule(s).

Enabling or Disabling Alerts on the Console Panel

The Console > Events > Alert Settings screen provides predefined alerts that apply to Analyzer as a whole. You
can hover your mouse over these to display information about them or click the arrow to display more
information about the alert. You can enable or disable these alerts by selecting or clearing the check box in the
Enable column for the alert, then clicking the Enable/Disable Alert(s) link.
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Add Alert

In the Add Alert panel you can enter an alert name and description, select the options for visible to
non-administrators and disable, and enter the polling interval.
To add an alert, complete the following steps:
1 Navigate to the Events > Alert Settings page.
Click the Add Alert link.
Enter a name and description for your alert.

2
3
4 Enable Visible to Non-Administrators if you want your Alert to be visible to non-administrators.
5 Enable the Disable check box to disable this Alert.

6

Enter a Polling Interval value (in seconds: 60-86400)

Alert Type
In the Alert Type panel you can select an alert type from the provided list and view the definitions of each alert
type.
To configure an Alert Type, complete the following steps:
1 Click the Alert Type drop-down list and select an alert type.

Most of the Alert Types require you to edit content. Editing Contents allows you to pick additional
information, in a granular fashion, on which the alerting has to be performed.

®

NOTE: When an alert type is selected, a description for that alert is displayed in the Alert Type
panel.

2 Click the Edit Content link. The Edit contents for alert type: Data usage (Daily) pop-up window displays.
3 Click the Threshold drop-down list and select a threshold.

®

NOTE: You can create a new threshold on-the-fly by clicking the icon. Only one new threshold can
be created in this feature.

4 Click Update. To reset the settings, click Reset.

Destination / Schedule

In the Destination / Schedule panel you can add up to five destinations and set a schedule for each.

To add a destination and set a schedule, complete the following steps:
@l NOTE: Every selected destination is required to have a schedule set.

1 Click the Add Destination link under the Destination/Schedule section. The Destination field designates
where you want alerts to be sent. You have a maximum number of five destinations.

Destination / Schedule
Destination {max: 5)
el admi :
| Ernail - Admin
Email - Adhoc
| Email - User
gEmaiI - Appliance user

| Trap listener - Adhoc

[ User Interface - SonicTodsa

Schedule
| -~ Chonse schedule —— > )

o add
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2 Click the Schedule drop-down list, then select a schedule type. The Schedule field designates the
frequency of when you want alerts to be sent to the destination(s).

Destination / Schedule

Destination {mas: 5 Schedule
|—Email - Admin b - Choose schedule

"‘xf Add Destination = groups
24%7
Weekdays 24 hrs

x5

 weie

Schedule: admin
Database Backup
Monday 24 hrs

Monday business hrs =
Tuesday 24 hrs

Tuesday business hrs
Wednesday 24 hrs
- Wednesday business hrs
Dane | Thursday 24 brs
' Thursday business hrs
Friday 24 hrs

Friday business hrs
| Saturday 24 brs ]

3 Click Update to finish adding an alert.
Enabling/Disabling Alerts
To enable or disable an alert, complete the following steps:

Enabling a Alert
1 Select Enabled of the alert(s) you wish to enable.

2 Click Enable/Disable Alert(s) link. A confirmation window displays. Click OK to enable/disable.

The page at http://10.0.14.251: 85 says: E|

‘fou are about to enable/disable the following alerts:
Unit Status - Disabled

Do ywou wank ko conkinue?

Cancel

Disabling an Alert

1 Deselect Enabled of the alert(s) you wish to disable.

2 Click the Enable/Disable Alert(s) link. A confirmation window displays. Click OK to enable/disable.

The page at http://10.0.14.251: 85 says: E|

‘fou are about to enable/disable the following alerts:
Unit Status - Disabled

Do ywou wank ko conkinue?

Cancel

Deleting Alerts

To delete an alert, complete the following steps:

1 Select the check box(s) of the Alert(s) you wish to delete.
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2 Click the Delete Alert link. A confirmation window displays.

The page at http://10.0.14.251:85 says: rz|

‘fou are about to delete the Following alerts:
Uit Status

Do wou wank ko conkinue?

Cancel

3 Click OK to delete.

NOTE: You can also delete an alert by clicking the Delete icon under the Configure section of the
alert you wish the delete.

Editing Alerts

After an alert is created, you can go back and edit it at any time.

To edit an alert, complete the following steps:

1 Click the Configure icon of the alert you wish to edit.

Alerts Search

Search: | Name v|  |Equals v | | | Search | | Clear |

Alerts

[ v Name Alert Type Interval Destination,/Schedule Enabled Eonﬁg_ure

[CIv unit status Unit Status S mins. 1 entry found 7 @
Missed heartbeat count Threshold: Uit Skatus @

o nddalere Enable/Disable Alert{s} H pelete Alert{s)

The Edit Alert page displays.

Edit Alert: Unit Status

Mame: :Unit Status
Description: |M0nit0r Up{Down Status For a Unit
Wisible ko Mon-Administrators:
Disable: |
) ! Bz it 5

Polling Interval: |300 (in seconds: &0 - B64007)

Alert Type
Alert Type: {_Ll_n_i_t_S_EqELls h %f Edit Content [Edited]

Description: Tracks a Units UpfDown status, The value that the threshold will use is Mumeric, This value is the
nurmber of missed heartbeats that should be counted ko mark a unit as down,

Destination / Schedule

__Destination {max: 5) Schedule
| Email - &drmin » | Schedule: admin » =
+/ Add Destination
Update | | Reset

2 Refer to the section Add Alert on page 170 and follow the configuration procedures to edit your existing
alert.
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Viewing Current Alerts

You can view a list of current alerts on the Events > Current Alerts page of the panel. Select a global view or unit
to view current alerts for your selection.

Alert Listing
Severity Unit Name Description
Warning Test 4060 The Intrusion subscription has not been activated for this device
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Configuring User Settings

This chapter describes how to configure the user settings that are available in the Console panel on the User
Settings > General page that provides a way to change the Analyzer administrator password, the Analyzer
inactivity Timeout, and pagination settings.

Change Analyzer Password

Current Analyzer Password: I:I

Miscellaneous Settings

Analyzer Inactivity Timeout: Minutes (-1 = never times out)

Auto Save Dashboard Settings: Minutes {-1:Auto Save not enabled or Range:[1..60])

Mew Analyzer Password; I:I
Confirm MNew Password: I:I

Max Rows Per Screen; Range: [10..100] {Applicable to non-reporting related paginated screens only)

| Update | | Reset

To configure the user settings that are available in the Console panel on the User Settings > General
page, complete the following steps:

1
2

Enter the existing SonicWall Analyzer password in the Current Password field.
Enter the new SonicWall Analyzer password in the New Password field.

Reenter the new password in the Confirm New Password field.

@ | NOTE: Password fields are grayed out for users on a Remote Domain.

The Inactivity Timeout period specifies how long SonicWall Analyzer waits before logging out an inactive
user. To prevent someone from accessing the SonicWall Analyzer Ul when SonicWall Analyzer users are
away from their desks, enter an appropriate value in the Inactivity Timeout field. You can disable
automatic logout completely by entering a “-1” in this field. The minimum is five minutes and the
maximum is 120 minutes.

Select a value between 10 and 100 in the Max Rows Per Screen field. This value applies only to
non-reporting related paginated screens.

When you are finished, click Update. The settings are changed. To clear all screen settings and start over,
click Reset.

@ NOTE: The maximum size of the SonicWall Analyzer User ID is 24 alphanumeric characters. The
password is one-way hashed and any password of any length can be hashed into a fixed 32
character long internal password.
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Using Analyzer Help

To access the Analyzer online help, click Help in the top-right corner of the Analyzer user interface.

SonicWall Analyzer online help provides context-sensitive conceptual overviews, configuration examples, and
trouble shooting tips.

This contains the following sections:
e About Analyzer on page 175
e Tips and Tutorials on page 175

About Analyzer

The Console > Help > About page displays the version of Analyzer being run, who the Analyzer is licensed to,
database information, and the serial number of Analyzer.

To access the Analyzer online help, click Help in the top-right corner of the Analyzer user interface.

Tips and Tutorials

Tips and tutorials are available in some pages of the user interface, and are denoted by a “Lightbulb” icon:

Console

£ ahout:blank v

Tips and Tutorials

Esi kB 5275: Marne Resolution in Reports
@ KB 6372: How to get the Summarizer caught
up

Ef kB 6661 Displayving GYC user info in YiewPoint
f reports

Ji4 Online Help

10,
&3

149
3

Internet F1o00% v o
g @ .

To access tips and tutorials:
1 Navigate to the page where you need help.

2 If available, click the Lightbulb icon in the upper right corner of the window. Tips, tutorials, and online
help are displayed for this topic.
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UMH

e Using the UMH System Interface
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14

Using the UMH System Interface

This chapter content describes the Universal Management Host (UMH) system interface, one of the two
management interfaces available for SonicWall Analyzer. The SonicWall Analyzer UMH system interface contains
similar configuration settings for Microsoft Windows and Virtual Appliance deployments.

The SonicWall Analyzer Virtual Appliance UMH interface contains the following settings that are not applicable
to Windows deployments:

System > Status

System > Licenses
System > Administration
System > Settings
System > Diagnostics

System > Backup/Restore

NOTE: Microsoft Windows deployments can skip these settings as they only apply to Virtual
Appliance deployments.

This section includes the following subsections:

Overview of the UMH System Interface on page 177

Configuring UMH System Settings on page 179

Configuring UMH Network Options (Virtual Appliance) on page 198
Configuring UMH Deployment Options on page 200

Overview of the UMH System Interface

The SonicWall Analyzer UMH system interface is used for system management of the SonicWall Analyzer
instance, including registration and licensing, setting the administrator password, configuring network and
database settings, selecting the deployment role, and configuring other system settings.
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When installing SonicWall Universal Management Suite on a host, a Web server is installed to provide the
system management interface. The system interface is available by default at http://localhost/appliance/ after

restarting the system.

v = System .
Status R T
Licenses General
Administration MName SonicWALL Universal Management Host
Settigs Serial Number 004010287836
3 Version 8.2 (Build: 8217.1275 - Thursday October 13, 2016 05:24:34 AM POT)
Diagnastics License Licensed for Analyzer
Backup/Restare Role Analyzer
L4 1 Deployment System
Host Name WIN-IDRSN2ZFENTE
IPvd Address 10.206.23.252
Current Time Oct 13, 2016 02:44:34 PM PDT
Operating System Windows Server 2012 (amd64-6.2)
CPU Intel Xeon (2.90 GHz)
2 Cores (4 Logical CPUs)
RAM 8080 MB
Available Disk Space on
Install Drive 190.53 GB (of Total 200.00 GB)
Syslogs Drive 100.53 GB (of Total 200.00 GB)
Getting Started
SonicWALL technical documentation Gelfing Starfed Guides are available at the
MySonicWALL.com Download Center and the Product Guide Library.

Switching to the Application Interface

@

To switch between the System interface and the SonicWall Analyzer application interface, click Switch =*%" in

the top right corner of the interface.

Viewing Online Help and Tips

To display context sensitive help for the current page, click Help "% in the top right corner of the interface.

Help can change to the Tips button " if the current page has any context sensitive tips or video tutorials.
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Clicking Tips displays dynamic links for white papers, videos, knowledge base articles, other references, and
Online Help.

{= Tips and Tutorials - Microsoft I... l:|@|[z|
E, about:blank b

Tips and Tutorials

Eal KB 7308: How to install ViewPaint Service Pack

i1} Online Help
Tips and Tutorials

@ KB 4722: Transfer ViewPoint to new hardware
- on a different machine (SOL Server or MSDE)
@ KB 6214: Transfer ViewPoint to new hardware
on a different machine (MySOL)
@ KB 6512: Change location of WiewPoint
- Database {SOL Server or MSDE)

14 Online Help

Internst FA00% v
L 5e

Logging Out of the UMH System Interface
)

To log out of the SonicWall Analyzer UMH system interface, click Logout “*==4% in the top right corner of the
interface.

Configuring UMH System Settings

This section describes the tasks you can do on the System pages of the SonicWall Analyzer UMH system
interface. The SonicWall Analyzer UMH system interface contains similar configuration settings for Microsoft
Windows and Virtual Appliance deployments. The SonicWall Analyzer Virtual Appliance UMH interface contain
the following settings that are not applicable to Windows deployments. Microsoft Windows deployments can
skip these settings as they only apply to Virtual Appliance deployments:

e System >Time
e System > File Manager
e System > Shutdown
See the following sections:
e Switching to the Application Interface on page 178
e Viewing Online Help and Tips on page 178
e Logging Out of the UMH System Interface on page 179
e Viewing System Status on page 180
e Managing System Licenses on page 180
e Upgrading from Analyzer to GMS on page 181
e Configuring System Time Settings (Virtual Appliance) on page 191
e Configuring System Administration Settings on page 191
® Managing System Settings on page 192
e Using System Diagnostics on page 193
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e Using System File Manager (Virtual Appliance) on page 195
e Using System Backup/Restore on page 196
e Using System Shutdown (Virtual Appliance) on page 198

Viewing System Status

The System > Status page provides the general information about the installation, including the name which
identifies the system as a SonicWall Universal Management Host, the serial number of the SonicWall Analyzer
instance, the software version, licensing status, and the system role. For SonicWall Analyzer, the role is always
“Analyzer.”

v = System .
Status R T
Licenses General
Administration MName SonicWALL Universal Management Host
Settigs Serial Number 004010287836
3 Version 8.2 (Build: 8217.1275 - Thursday October 13, 2016 05:24:34 AM POT)
Diagnastics License Licensed for Analyzer
Backup/Restare Role Analyzer
4 g Deployment System
Host Name WIN-IDRSN2ZFENTE
IPvd Address 10.206.23.252
Current Time Oct 13, 2016 02:44:34 PM PDT
Operating System Windows Server 2012 (amd64-6.2)
CPU Intel Xeon (2.90 GHz)
2 Cores (4 Logical CPUs)
RAM 8080 MB
Available Disk Space on
Install Drive 190.53 GB (of Total 200.00 GB)
Syslogs Drive 100.53 GB (of Total 200.00 GB)
Getting Started
SonicWALL technical documentation Gelfing Starfed Guides are available at the
MySonicWALL.com Download Center and the Product Guide Library.

Under System, the host name of the computer is listed, along with the time and other information about the
host computer.

At the bottom of the page, a link is provided to access the Getting Started Guide that takes you to the Online
Help table of contents.

Managing System Licenses

The System > Licenses page provides buttons for managing, refreshing, and uploading licenses. The page
displays the status of Analyzer and Global Management System licenses. The Global Management System
license status shows the status of your SonicWall GMS Free Trial, if activated. If you choose to upgrade to
SonicWall GMS, this page shows Global Management System as fully licensed.

The value in the Count column indicates the number of appliances for which this SonicWall Analyzer or
SonicWall GMS instance is licensed for reporting or management. For SonicWall Analyzer, this value is usually
“unlimited,” but for SonicWall GMS, the base license is either for 10 nodes or 25 nodes, and additional node
licenses can be purchased in various increments.
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The Expiration column indicates the expiration date of the license. If no date is shown, the license is perpetual,
and does not expire.

v & system
Status License Management
e Last SonicWALL Registration Site contact: Oct 13 2016 11:13AM Serial Number: 004010287836
Administration Security Service Status Count Expiration
Setfings Global Management System Not Licensed
Diagnostics Analyzer Licensed Unlimited
Backup/Restore
" "‘ Deployment Manage Licenses | I Refresh Licenses ” Upload Licenses
Hover over the buttons for more information on the actions

To display the MySonicWall login page, click Manage Licenses. You can purchase licenses and obtain license
keysets on MySonicWall.

Click Refresh Licenses to refresh the license status on this page.

To upload a new license, click Upload Licenses and browse to a license file on your computer.

Upload Licenses
Serial Number: 004010287826

License File: Choose File | No file chosen

[ upad ][ cancal

Upgrading from Analyzer to GMS

SonicWall Analyzer installations have the option of upgrading to SonicWall GMS without reinstalling. You can
start a 30-day Free Trial of SonicWall GMS by clicking a button or link in either the Analyzer or Universal
Management Host interface and following a simple procedure. When you are ready to finalize the upgrade, your
SonicWall reseller can provide you with the license key for a seamless transition to SonicWall GMS.

When five or more registered devices are connected to SonicWall Analyzer reporting, Try GMS Free - 30 Days
appears next to the tabs at the top of the SonicWall Analyzer management interface.

Try GMS Free
g0 Tatt
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You can also start the Free Trial by clicking Manage Licenses on the System > Licenses page of the Universal
Management Host interface, and then clicking the Try link.

b |?-i Syskem
License Management
Status .

: Setial Number: 00401022FDDC
Licenses

Administration Security Service Status Free Trial Manage Service Count Expiration
Settings Global Management System Mot Licensed Try Upgrade
Diagnastics WiewPoint Licensed Unlimited

b ;', Deployment:

Return ko License Summary

For details on enabling the SonicWall GMS Free Trial and purchasing the SonicWall GMS upgrade license, see the
following sections:

e Enabling the GMS Free Trial from Analyzer on page 182

e Enabling the GMS Free Trial from the UMH Interface on page 184
e Completing the Free Trial Upgrade on page 185

e Configuring Appliances for Analyzer Management on page 187

e Purchasing a SonicWall GMS Upgrade on page 189

Enabling the GMS Free Trial from Analyzer

When five or more devices are connected to SonicWall Analyzer reporting, Try GMS Free - 30 Days appears next
to the tabs at the top of the SonicWall Analyzer management interface.

To find out how many devices your SonicWall Analyzer installation is handling, log in to MySonicWall and
navigate to the My Products page. Click on the link for your SonicWall Analyzer installation to get to the Service
Management page, and scroll to the bottom. You see the list of appliances under Associated Products.

To enable the 30-day SonicWall GMS Free Trial from the SonicWall Analyzer management interface,
complete the following steps:

1 Inthe SonicWall Analyzer management interface, click Try GMS Free - 30 Days next to the tabs at the top
of the page.

Try GMS Free .
20 Tar

2 The Analyzer Upgrade Tool launches and guides you through the process of installing the Free Trial or
Upgrade. The tool displays the Upgrade Requirements — Licensing screen. Before migrating to GMS,
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ensure that all appliances under Analyzer reporting are registered to the same MySonicWall account.
Follow the steps provided in the screen, and then click Proceed.

Upgrade Reguirements - Licensing

WiewPoink to GMS 5,1 upgrade {GMS Free Trial or Full License), requires that all appliances in your ViewPoint software be registered ko
the same MySonicWALL account, IF appliances are not migrated prior to this upgrade, GMS will be missing essential functionality such
as the ability to license services and perform Firmware upgrades. IF this is the case, please abort the upgrade and consolidate all the
appliances in your ViewPoint software into the same MySonicWALL account Following the steps below, Otherwise, click "Proceed" to
continue.

1. Gather the MySonicWALL login info For the appliance and log into the account,
2. After logging into MySonicWaLL, navigate to the "My Products™ screen and locate the appliance.

Important: Make note of the serial number and authentication code For fufure reference.

Locate the "delete” button option in the "Service Management” screen in the specific MySonicWaLL account and select it
Click. on "Confirm Deletion” prampt.

This appliance is now ready For migration to GMS 5.1,

BRI

Repeat steps 1 thru 4 for the rest of the appliances under ViewPoint as needed,

| Proceed | | Cancel |

3 The Upgrade Requirements — System screen displays the recommended operating system, database,
and hardware system requirements. Click Proceed.

Upgrade Reguirements - Systemn

Please check the recommended system requirements below ko make sure your system is qualified for upgrading to be an all-in-one GMS
system, Click "Proceed” to start the upgrade procedure,

Recommended System Requirements

Operating System Microsoft® Environment: Windows 2000 Server (SP4), Windows 2000
Professional (SP4), Windows ¥P Professional (SP2), Windows 2003 Server (SP2)

Database Microsoft® Environment: Microsoft SGL Server 2000 (SP4) and Microsoft SOL

Server 2005 {SP2) on either Windows 2000 Server (SP4) or 2003 Server (SP1)

Hardware %86 Environment; Minimurm 3 GHz processor dual-core CPU Intel processor, 2 GB

RAM, and 300 GE disk space

Current System Information

Operating System Windaws %P (x86-5.1)
CPU 2,327 GHz
RAM 2,005 GB
Procesd I | Cancel
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4 The Analyzer Upgrade Tool displays the login screen for MySonicWall. Enter your MySonicWall
credentials and click Submit.

WiewPoint Upgrade Tool

Step 1. Upgrade the License
Use the license upgrade screen provided below to upgrade the license from Viewpoint ko GMS

mySonic\WALL.com Login

mySonic\WALL . com is a one-stop resource For registering all your SonicWALL Internet Security Appliances and
managing all your SonicWALL security service upgrades and changes. mySonicWaLL provides you with an easy to
use interface to manage services and upgrades For multiple SonicWwALL appliances, For more information on
mySonicWaLL please visit the FAG. IF vou do not have a mySonicWall account, please click here to create one.

Please enter your existing mySonicWALL.com username {or email address) and password below;

Email Address(User Mame: | |

Passward: | |

Did you Forget your User Mame or Password? Go to https: (hwens, mysonicwall,com For help,

5 Inthe next Analyzer Upgrade Tool page, click the Try link in the Free Trial column for Global Management
System.

Wiewpoint Upgrade Tool

Step 1. Upgrade the License
Use the license upgrade screen provided below ko upgrade the license from Yiewpaoint to GMS

Security Service Status Free Trial  Manage Service Count Expiration
Global Management System Mot Licensed Try Uparade
WiewPaink Licensed Unlimited

6 From this point, the upgrade process continues with the same steps for access from either the SonicWall
Analyzer interface or the Universal Management Host interface.

Continue the procedure by completing the following section.

Enabling the GMS Free Trial from the UMH Interface

To enable the 30-day Free Trial of SonicWall GMS from the Universal Management Host interface on
your SonicWall Analyzer system, complete the following steps:

1 Inthe Universal Management Host interface, navigate to the System > Licenses page and click Manage
Licenses.

v [ System
=
License Management
Status
Serial Mumber: 00401022FDDC

Licenses

Adrministration Security Service Status Count Expiration
Settings Global Management System Mot Licensed

Diagnastics WiewsPoint Licensed Unlimited

k ? Deployrment

‘ Manage Licenses || Refresh Licenses H Upload Licenses |

2 If you are not already logged into MySonicWall, the MySonicWall login screen is displayed. Enter your
MySonicWall credentials in the appropriate fields and log in.
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3 On the next page, click the Try link in the Free Trial column for Global Management System.
il System
License Management
Skatus
e Serial Mumber: 00401022FDDC
Adrinistration Security Service Status Free Trial Manage Service Count Expiration
Settings Global Management System Mok Licensed Ty Upgrade
Diagniostics VigsPoint Licensed Unlirnited
> “, Deployment
4 From this point, the upgrade process continues with the same steps for access from either the SonicWall

Analyzer interface or the Universal Management Host interface.

Completing the Free Trial Upgrade

This procedure provides the common upgrading steps for access from either the SonicWall Analyzer interface or

the Universal Management Host inte
of the two preceding sections:

rface. To get to this point in the process, follow the steps described in one

Enabling the GMS Free Trial from Analyzer on page 182
Enabling the GMS Free Trial from the UMH Interface on page 184

To continue the upgrade, complete the following steps:

1

In the Analyzer Upgrade Tool page, click Continue.

Wiewpoint Upgrade Tool

Step 1. Upgrade the License

Global Management System Free Trial

Use the license upgrade screen provided below ta upgrade the license from Yiewpaint ta GRS

Thank vou for your interest in Global Management System.

If wou choose o purchase Global Management System subscription, you may do so at any time during ar after the krial.

Cancel

2 The next screen provides a summary of GMS and Analyzer status. Verify that the Try link for the Free Trial

is gone and only the Upgrade

link remains. The Expiration column displays the expiration date of your

Free Trial. You can click Upgrade at any time during the Free Trial to purchase the SonicWall GMS

upgrade. Click Proceed.

Wiewpoint Upgrade Tool

Step 1. Upgrade the License

Security Service Status
Global Management System Free Trial
WiewPoink Licensed

Below is the summary of the upgraded licenses, Please click the "Proceed” button to continue to the next step

Free Trial Manage Service Count Expiration
Upgrade 15 25 Jul 2009
Urilimited
Proceed

3

In the next Analyzer Upgrade Tool page, you begin the configuration for SonicWall GMS in step 2 of the

upgrade process. This page displays two sections:
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Automatic Configuration

Contains a list of SonicWall firewall or CSM appliances in your Analyzer installation. These appliances are
automatically configured for SonicWall GMS management.

Manual Configuration

Contains a list of SonicWall or SSL-VPN appliances in your Analyzer installation. You must manually configure
these appliances for SonicWall GMS management. See Configuring Appliances for Analyzer Management on

page 187 for detailed instructions on enabling SonicWall GMS management on these appliances.

4 When ready, click Proceed.

YWiewPoint Upgrade Tool

Step 2, GMS Configuration

Twn setinms ae mmbedinChis sU=p, utn Caniguiaton” Fs0s ool Ue apphances Lol aie autn oo’ guadlke (o suppat GHS.
T il s heduled L ks v 1] D comatled velimn pioomeds Do Ui real step, ' Flangal Configunalion” Fsts oo applares amd
info maban Lo Melpuses manally configuee Uiose appkarcss Lo suppail GHES.

Automatic Configuration

Following list showes all the UTM appliances currently in the systern, These
appliances can be automatically configured to support GMS |

Appliance Marne Appliance Serial Mumber
NS4 240 0017C5265510
MSA 5500 0017C51Ca55C

| Manual Configuration

Following list shows all the non-UTM appliances currently in the systemn, These
appliances need ranual configuration to support GMS |

Appliance Marme 2ppliance Serial

Eng Test 0006B1275C34

Canfiguaian Infoimation

5 When the configuration finishes, the Analyzer Upgrade Tool displays the completion dialog box. Click

Close to log out of the console and restart the system.

Wiewpoint Upgrade Tool

‘fou have complete the upgrade procedure.

please click "Close" button to logout the console and reboot the box
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6 The Analyzer login page appears and requests that you reboot the system. Reboot the system. If a reboot
is not done, you could encounter problems with the correct IP Address appearing.

SonicWALL Global Management System Login

A GMS Free tfj_a!i-upgfade-piagéduﬁé i;’\':ﬂmﬁlété.
! Please reboat the system

User jl |

Password | |

7 After rebooting, log in with your Analyzer credentials.

When you log in, you see a button displaying the number of days left in your Free Trial at the top of the
page.

8 On the System > Status page for connected appliances, you can view the log entries for task
synchronization and automatic addressing mode, related to the Analyzer configuration.

™ 2 system Status Informati
Status AR
Licenses General
Administration Name SanicWALL Universal Management Host
Settings Serial Number 0040102687836
£ Version 8.2 (Build: 8217.1275 - Thursday October 13, 2016 05:24:34 AM PDT)
Diagnostics Licensa Licensed for Analyzer
Backup/Restore Role Analyzer
L4 e Deployment System
Host Name WIN-TDRSN2FENTB
1Pv4 Addrass 10.206.23.252
Current Time Oct 13, 2016 02:44:34 PM PDT
Operating System Windows Server 2012 (amd64-6.2)
CPU Intel Xeon (2.90 GHz)
2 Cores (4 Logical CPUs)
RAM 8080 MB
Available Disk Space on
Install Drive 180.53 GB (of Total 200.00 GB)
Syslogs Drive 190.53 GB (of Total 200.00 GB)
Getting Started
SonicWALL technical documentation Geffing Started Guides are available at the
MySonicWALL.com Download Center and the Product Guide Library.

Configuring Appliances for Analyzer Management

To manually configure the appliances listed in the Manual Configuration section of the Analyzer
Upgrade Tool page, complete the following steps for each appliance:

1 Inthe SonicWall Analyzer management interface, click the tab at the top of the page that corresponds to
the type of appliance, such as SSL-VPN.

2 Inthe left pane, right-click one of the listed appliances and select Modify Unit.
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3

4
5

In the Modify Unit screen in the right pane, copy the appliance IP address in the Managed Address

section to your clipboard, or make a note of it.

= MyReportsYiew {LocalDo Lnit Marne: |Eng
23 Eng )
#3 Eng Corp Serial Numbey: |DDDGBIZ?8F48
23 Eng Test
Managed Address: '+ Determine automatically
\® Specify manually:  [10.128.1.2
[ laventai S5L-¥PN appliance
Login Mame:  [admin
Password: I**********
Management Mode; If
HTTPS Port:  [443
St Encryption Key: |
SA Authentication Key: |
Agent IP Address: | 192 168 252,12
Standby Agent IP: | Mone
| oK | | SiCancel
4
Click Cancel.

In the left pane, right-click the same appliance and select Login to Unit > Using HTTPS.

@ Globalview
@ corp sslvpn
D sshvpn 1.2
0 sslvpn 1 2

¥ General
Status
* Bandwidth

S5 Eind...

» Resources
» Authentication

-"'XJJ Refresh

» Configuration

=[e Rename Unit...
= Add Uni...

& Madify Unit,..
=% Delete

B Login bo Unit

* Log Viewer

r Using HTTPS ’\L
s
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6 Inthe appliance management interface, navigate to the System > Administration page.

=l Eng it Status GMS Frea Trial 30 Days Left | User: admin@LocalDomain | Administrators
=) MyReportsView {LocalDomain
5 Eng OnicWALL - Yirtual Office - Mozilla Firefox
£3 Eng Corp .
https:ff10.128.1.2jcg-binfmanagement L
o [ 8 Wretpsusy fegi-binjmanag %
= -
¥ S System Lackaut Period (minukes): IS _I
Status
Licerises GMS Settings
Tirne:
¥ Enable GMs Management
Seftings
Adrinistration GMS Hast Mame ar 1P Address: I
Certificates GM3 Swslog Server Port: I51 4
Monits
SR Heartbeat Interval (seconds): |BD
Diagnostics r
Rt Send Heartbeat Status Messages Only
3 g Metwork Mote: GMS 4.0 o later is required ko remotely manage this SSL-YPN appliance.
-~ .
3
I;_!_B Fortdls : Global Portal Settings
o M nerevtenie  — =
L] b Status: Ready

7 Under GMS Settings, select Enable GMS Management, or verify that it is selected.

8 Inthe GMS Host Name or IP Address field, paste or type the appliance IP address that you obtained from
the Modify Unit screen in Step 3

9 Click Accept at the top of the appliance interface screen.
10 Click Logout in the top right corner of the appliance interface screen.

11 Repeat these steps for each appliance listed in the Manual Configuration section of the Analyzer Upgrade
Tool page.

Purchasing a SonicWall GMS Upgrade

You can purchase an upgrade to SonicWall GMS at any time during the 30-day Free Trial.

To purchase the SonicWall GMS license, complete the following steps:

1 Inthe SonicWall GMS interface, click GMS Free Trial X Days Left, where X is the number of days left in
the Free Trial.

ult Page (GMS Free Trial 30 Days Left

2 On the Buy GMS page, click | want to upgrade to GMS now.

Buiy GMS

Free Trial / Upgrade options
Use the following options to buy a GMS license or to end the GMS Free trial

® I want to upgrade to GMS now
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3 The Console > Licenses > Product Licenses page is displayed. Click Manage Licenses.

Product Licenses GMS Free Trial 30 Days Left | User: admin@LocalDomain | Administratars

¥ User Settings
» Log License Summary
b Tasks Last SonickwALL Registration Site contact: Apr 02 2005 03:14PM Serial Number: 00401022FDDC
* Management Security Service Status Count Expiration
» Reports j

N ~ Global Management System Free Trial 15 02 May 2009
¥ Diagnostics . .
b Events WiewPaint Licensed Unlimited
¥ Licenses

Procuct Licenses Manage Licenses | ‘ Refresh Licenses || Upload Licenses

Activation Codes

Deplayments
¥ Help

4 Inthe next page, in the Manage Service column for Global Management System, click Upgrade.

Product Licenses GMS Free Trial 30 Days Left | User: admin@Llocal

License Summary

Last SonicW'ALL Registration Sike contack: Apr 02 2009 03:14FM Serial Mumber;
Security Service Status Free Trial Manage Service Count Expiration
Global Management Svstem Free Trial Upgrade 15 0z May 2009
VigwPaint Licensed Unilimited

| Return to License Surmmarsy

5 The next page has Serial Number and Authentication Code fields for SonicWall GMS. You must contact
your SonicWall reseller to complete the purchase and obtain the 12-character serial number and
authentication code. Type in the values to the Serial Number and Authentication Code fields.

License Summary
Last SonicWALL Registration Site contack: Apr 02 2009 03:14PM Serial Mumber: o oo o =

Enter your new 12 character Software Serial Mumber and Authentication Code

Serial Murnber: I
Authentication Code: I I What is this?
Frigndly Mame: I

GMS upgrade keys:

(Required if current Yiewpaint installation is larger than retail upgrade

6 Enter a descriptive name for the SonicWall GMS installation into the Friendly Name field. This name
appears in your MySonicWall account.

7 If your SonicWall Analyzer installation currently handles more than 10 appliances, when you upgrade to
SonicWall GMS, you need to purchase additional SonicWall GMS license(s) to manage the extra
appliances. The standard “10-node” SonicWall GMS license provided with the Free Trial supports up to
10 managed appliances. Enter the license keys for any additional SonicWall GMS licenses into the GMS
upgrade keys text box, one key per line.

8 Click Submit. The License page is displayed, showing that SonicWall GMS is now licensed.

SonicWall Analyzer 8.3 Administration Guide 190



Configuring System Time Settings (Virtual Appliance)

The System > Time page allows you to automatically configure the date and time using NTP servers.

v & system -
Status
Licenses Time (hh:mm:ss): |_.L_1E - |L’|__33 : I_Sll = !
Time
Administration Date: [ganuary [-] [20[-] [=2012[-]
Settings ; : -
Diagnostics TimeZone: | (GMT-08:00) Pacific Time (US & Canada); Tijuana EI
File Manager Set time automatically using NTP
Backup Restore
Shutdown o
’ Q: Network =
L4 $ Deployment -
== Add NTP Server
Mote: Automatically adjusts dock for daylight saving time
| Update | | Resat |

To manually select the time, under Systems Time select the Time, Date, and Time zone.

To automatically set the time using an NTP server, select Set time automatically using NTP. Next, select the Add
NTP Server icon, and enter the IP address or domain name of the NTP server. Click Update to submit your
system time configuration changes. Alternatively, click Reset to reset the system time to factory defaults.

Configuring System Administration Settings

The System > Administration page allows you to configure the system behavior for administrative login
sessions.

v System

Status Host Settings
; 5 | : ;
Licenses Inactivity Timeout: -1 | Minute(s) (-1 = never times out)
Administration
Settings Enhanced Security Access (ESA)
Diagnostics :
v i
BrickusfRisstons Enforce Password Security |
Number of failed login attempts before user can be locked out; |6
> * Deployment 2 g ‘—‘
User lockout minutes: {30 ‘
Number of days to force password change: !90
Administator Password
Administrator Name: admin
Current Password: I..........

New Password:

Confirm Password: !.u.............. |

| updste || Reset |

Under Host Settings, enter the number of minutes of inactivity allowed before the session is logged out. A
setting of -1 allows an unlimited amount of inactivity without being logged out.
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Under Enhanced Security Access, you can configure the number of failed login attempts before the admin
account is locked out, and the number of minutes that the lockout lasts. You can also configure the number of
days before the admin account password must be changed.

Under Administrator Password, you can change the administrator password for the SonicWall Analyzer
application. Enter the current password for the system administrator (or root) account into the Current
Password field, and then enter the new password into both the New Password and Confirm Password fields.

After making any changes on this page, click Update. To revert the fields on the page to their default settings,
click Reset.

Managing System Settings

The System > Settings page provides a way to upload new SonicWall Analyzer software or service packs to the
system. Click Browse to browse to the file you wish to upload, and then click Apply.

¥ E System
Status Service Pack/Hotfix
Licenses Upload the Service Pack/Hoffix file in order to update the system.
Administration Current Version: 8.2 (Build: 8217.1275 - Thursday October 13, 2016 05:24:34 AM PDT) (Click here for histary)
Settings

Diagnostics Upload file: Choose File | No file chosen
Backup/Restore
Apply

> e Deployment

The page shows the current version of SonicWall UMS, and provides a History link that displays the history of all
hotfixes and firmware updates that were applied to the system.

The Reinitialize Appliance to Factory Settings section allows the administrator to reset all UMH system settings
to factory defaults. Click Reinitialize to reset to factory defaults. A pop-up message displays for the
administrator to confirm this process.

The page at 10.203.23.66:85 says: s

This action will reinitialize the appliance to Factory defaults,
All updated configurations on this appliance will be reverted ko
defaults,

Mote: The appliance will automatically restart For the initialization
totake effect.
The initialization process could take upto 15 minutes o complete,

Do yiou wank bo conkinue?

i Ok d[ Caniel J

Click OK, the system reboots and the reinitialization process takes 10-15 minutes to complete. After the
reinitialization process is complete, the administrator needs to log back in to the management interface to
confirm the system settings are now restored to factory defaults.
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Using System Diagnostics

The System > Diagnostics page is used to set log levels, test connectivity to servers, generate Tech Support
Reports, and to search and download system log files.

- uaem . "
g Debig Log Settings
Licenses Setting debug levels afaws for faster of potentsal Essues, This action creates detug iog files on all the Analyzer systems in this deployment and could hamper appiication
Administration performance and also il up disk spoace. You should reset to Mo Debug for normal operation as scon s the potentlal ksue has beon resched,
Settings Noke:
- The: debusg lewel shoukd onfy be set based on guidance from Dell SonlcWALL Technical Support
Diagnostics = The higher the debug level, the more the system resources that will be used up to generate debug data and In tum lower the overall system performance,
Backup/Restor
i i System Debug Level: | Level 5 (Highly Detailed) ¥
b peployment
Test Connectivity
' Database Connectivity -
& License Manager Connectivity
License Manager host: Ecensemanager sonicwall.com
SMTP Server Connecthvity -
Cusrently configured SMTP Server: at port: 25
& Ping
! Probe Test
Download SystemfLog Files
- Technical Support Report (TSR)
¥ Lo
Sechle ° ¥
Application Logs
DbgApplianceD.log [7,069.43 KB] [10/13/2016 03:19:55] i
DbgAppliance 1 log [9,763.7 KB] {10/10/2016 03:41:06] [ |
DbgVPschedulert dog [9.81 KB] [10/13/3016 02:57:51] it
Infobeight log [63.87 KB] [10/13/2016 02:58:05]
mysaler [173.66 KB] [10/13/2016 11;13:03]
pg_Data_permissions.log [120.91 KB] [10/13/2016 02:57:02)
phaselupgrade.log [135.86 KB] [10/13/2016 02:57:02]
phase2_147S7BT966184 log [9.76 KB] [10/06/2016 02:09:57]
. phaced 1475877744188 000 [1J6 KB) [10/07/201603:023] %)
There are 31 filles bo view In this category.
Export Logs

Under Debug Log Settings, select the log level from the System Debug Level drop-down list. Select from the
following system debug verbosity levels:

e No Debug

e Level 1 (Codepath)

e Level 2 (Simple)

e Level 3 (Logic)

e Level 4 (Detailed)

e Level 5 (Highly Detailed)

The No Debug level setting provides no debug information, and the Level 5 (Highly Detailed) setting provides the
maximum debug information.

In the Test Connectivity section, select one of the following radio buttons and then click Test to verify
connectivity to that server:

e Database Connectivity — Tests connectivity to the database server configured on the Deployment >
Roles page.

e License Manager Connectivity — Type the host name or IP address into the License Manager Host field
and click Test to test connectivity to that server.

e SMTP Server Connectivity — Tests connectivity to the SMTP server configured on the Deployment >
Settings page.
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In the Download System/Log Files section, you can enter a filter, or search value, into either of the Search Filter
fields, and then press Enter, to locate log entries of interest. Click Export Logs to save the log files to a file on
your computer.

v & gistem ) License Manager Connectivity +
Status License Manager host: licensemanager.sonicwall.com
Licenses SMTP Senver Connectivity -
Administration Currently configured SMTP Server: at port: 25
Settings ;
Backup/Restore

O Pprobe Test | ¥

L4 ‘,. Deployment

Download System/Log Files
=) Technical Support Report (TSR)

4 |Logs
Search Filter: * ’ :
‘Application Logs a
DboAppliance0.log [7,069.43 KB] [10/13/2016 03:19:55]
DbgAppliancel.log [9,765.7 KB] [10/10/2016 03:41:06]
DbgVPScheduler0.log [9.81 KB] [10/13/2016 02:57:51]
Infobright.log [63.87 KB] [10/13/2016 02:58:05]
mysql.err [173.66 KB] [10/13/2016 11:13:03]
pg_Data_permissions_log [120.91 KB] [10/13/2016 02:57:02]
phaselupgrade log [125.86 KB] [10/13/2016 02:57:02]
phase?_1475787066184 log [0.76 KB] [10/06/2016 02:00:57]
phase2_1475877744188.log [1.26 KB] [10/07/2016 03:02:34] =

There are 31 files to view in this category.

Export Logs

To generate a TSR (Technical Support Report), select Technical Support Report (TSR), and then click Export Logs.
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Using System File Manager (Virtual Appliance)

The System > File Manager page provides access to the file system. Copy files or export files to these folders.
Administrators often use this page to export system settings preference files (etc/prefs) to another directory
location for backup archiving.

hd |;_-I System
Status
Licenses
Time
Administration
Settings
Diagnostics
File Manager
Backup/Restore
Shutdown

» Q_ Hetwork
L4 g Deployment

File System

[[] select Folder: | Select one - SearchFﬂter:!

| »

Select one

fetcfmibs

fetc/Prefs
fetc/Prefs/old
[Firmware
fFirmware/Current
[Firmware/Old

fLogs

Jmysql/data
fsyslogs
fayslogsfarchivedSyslogs
fsyslogs badSyslogs
(Temp
fTomcatfconf
fTomcat/logs

E oma%temE

fete Select Folder dropdown above.

— ]

| Export || Delete

To complete a file set export, select a folder from the drop-down menu. The page refreshes and displays the
contents of the selected folder. Individual files can be exported or deleted. Click Selected Folder to select all the
files for this folder. For managing a batch of files, select multiple files from the list and click Export or Delete.

Administrators can also use the file manager to import files, such as, third-party MIB files to the directory folder
for multiple-vendor solution interoperability. To import or to upload a file, select a folder from the drop-down
menu. The page refreshes and displays the contents of the selected folder. In the top-right corner of the page,
click the plus icon to upload a file. Next, click Choose File to open the file management dialog box. In the file
management dialog box, navigate to the file you would like to upload and click Open. The selected file is now
displayed next to Choose File. Click Upload to complete the file manager import.

vi= System
Status
Licenses

Time

Administr ation
Settings
Ciagnoskics
File Manager
BackupfRestore
Shutdaown

» g Metwork
L4 !3 Deployment

File System

=] Select Folder: |,|'etc,|'mibs -_V| Search Filer: | *.*

e

O aventail | y
¥ aventaillGServer |
D aventailSecurityHistor

[ aventaiservicatealth [ -
O aventailSystemHealth |7
I aventailSystemInfo [
D HOST-RESOURCES-M
[ rEC1213-MIB [ L0041
D SMMP-COMMUNITY MIE
D ShL-COMMOMN-MIB.MIE | 0l o
D ShIWL-SSLYPN-MIG, MIE |+ f21/2011 07
D SOMICWALL-FIREWALL-IP-STATISTICS-MIB. MIE |
D SOMNICWALL-FIREWALL-TRAP-MIE.MIE |
D SOMICWALL-GMS-TRAP-MIE.MIE |
D SONICWALL-SMIMIB [ 55 K]

[

AT PATLEATIPAT L EATIPAT AT
AddIQdIIIIII DD D
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Using System Backup/Restore

The System > Backup/Restore page helps you schedule and create immediate snapshots of configuration and
data on your system. Note that a minimum of 10GB of free disk space is required to perform a backup/restore
operation. Navigate to the System > Status page to verify available disk space.

You can also off-load the backup/reporting data through web services by downloading a Java-based Ul tool. This
tool helps you setup configurations that can be used to automatically download backup snapshots to a remote
location in a reoccurring schedule.

v g cten
- bystem v
Sl Manage Backups
Licenses This section helps you schedule the creation of snapshots of configuration and data on your system. Please check the minimum free disk space
Administration requirement for a backup type before enabling it. Navigate to System > Status to check available disk space.
Settings You can also offload the backup data through web services by downloading a Java-basad UL tool. The tool will help you setup configurations that
Diagnostics can be used to autormatically download scheduled backup snapshots to a remote location in @ recurment manner. This tool can also be used to
offlioad reparting data such as archived syslog files, archived scheduled reports.
‘Backup/Restore
» | Download Auto Export Toal |
e Deployment Click here to see restore history,
# Mgallable Snapshots Type Date Product Version Size —
1 & Ana|m|—_3‘2_1_2015_10_12_[)4_35_Vp_ﬂl0p_zipﬁpﬂ|katk)n 2016/10/1204 35 Analyzer 8.2 1.87Me |+

| Download Snapshot I Restore Snapshot I

Wate: Download file limit: 2GB. Please use Suto Export tool to download larger snapshots.
Inimediate Backup/Restore

Create a new snapshot file and download it immediately: Backup Now
Upload a snapshiot file and use It to restore data: | Choose Fila | No file chosen

Note: Upload file limit: 2GB.
Scheduled Backup Settings

| Enable Basic Backups -

Backup schedule: Daily at [22 7| : [o0 ¥
! Enable Application Backups =

Backup schedule: |W’eekiy v an |Fr1da\-I ."-I 07 .'{j at |_25"‘| : |Eib v
| Enable Complete Backups -

Backup schedule: [ Monthly ¥ | on [Sunday Y| 07 Y| at |23 v | (oo ¥

Backup srapshots te directory: D\GMSVPYbackup

Free disk space required: 31 GB (Available: 190.45 GB)
Auto disk space management: =)
MNote:

e Only 1 snapshat per backup type will be saved. Old snapshets will be delated on successful completion of backup process.

* 0n enabling auto disk space management, In case of disk space shortage, the last backup file(s) that was offloaded will be deleted prior to
the start of new backup run,

® 0ld snapshots will riot be deleted if the backup directory Is changed, please delete them manually,
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Manage Backups
Manage backups

Name

Description

Download Auto Export Tool

Helps you setup configurations that can be used to
automatically download scheduled backup snapshots
to a remote location in a recurrent manner. It also
allows the user to offload reporting data such as
archived syslog files and archived scheduled reports to
a remote location

Click here to see restore history link

Displays the restored snapshots.

Available Snapshots list

Displays all the available snapshots with type, date,
product, version, and size information for each.

Download Snapshot

Downloads a snapshot of the current system
configurations.

Restore Snapshot

Restores a backup snapshot, the snapshot is uploaded
to your local storage and then used to restore data.

Immediate Backup/Restore

Immediate Backup/Restore

Name Description

Backup Now Creates a new basic, application, or complete
snapshot file.

Choose File Selects a snapshot file from your local file system to

upload to the Analyzer server.

Restore Now

Restores using the selected snapshot file.

Scheduled Backup Settings
Scheduled Backup Settings

Name

Description

Enable Basic Backups check box

Backs up files that are essential for the system
configuration and addUnit.xml files on a daily basis.

Daily At drop down lists

Selects the hour and minute for the backup schedule.

Enable Application Backups check box

Backs up basic data, database, firmware images, and
HM recordings on a monthly or weekly schedule.

Backup Schedule: drop down lists

Selects the week or month, day, hour, and minute for
the backup schedule.

Enable Complete Backups check box

Backs up application backup data, reporting database,
and archived scheduled reports from the default
archive directory on a monthly or weekly schedule.

Backup Schedule drop down lists

Selects the month or week, day, hour, and minute for
the backup schedule.

Backup Snapshots to Directory text field

Backs up snapshots to the directory that is entered
into the text field.
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Scheduled Backup Settings (Continued)

Name

Description

Free disk space required

Indicates the space required to perform the backup,
and how much space is available for use on the
resource. If available disk space is less than the
estimated free disk space required, the backup
process will not start. However, if the auto disk space
management feature is enabled, the backup process
deletes the previous backup files to free the disk space
required for the backup process to begin if the
following conditions are satisfied:

Auto disk space management

Select to allow Analyzer to manage the disk space and
backup requirements. Auto disk space management is
a configurable option provided for you to automate
recovering disk space by deleting previous backup files
in case of a disk space shortage for the backup
process. If there is sufficient disk space for the backup
process to run, this feature does not have any impact.

Update Settings

Updates the current configured settings.

Using System Shutdown (Virtual Appliance)

The System > Shutdown page allows you to restart or shut down the appliance. Click Restart to reboot the
system. To stop all the services and database processing, click Shutdown.

¥ F!—l System
Status
Licenses
Time
Administration
Settings
Diagnostics
File Manager
Backup/Restore
Shutdown

’ g Network

> Q Deployment

Shutdown
Warning! This action will disconnect all users.

This action takes about 3 minutes,
Remember that if you made any changes to the settings, you'll need to apply them before you restart or shutdown,

Restart | | Shutdown

Configuring UMH Network Options (Virtual
Appliance)

This section describes the tasks you can do on the Network pages of the SonicWall Analyzer UMH system

interface.

See the following sections:

e Configuring Network Settings (Virtual Appliance) on page 199

e Configuring Network Routes (Virtual Appliance) on page 199
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Configuring Network Settings (Virtual Appliance)

This section provides network settings configuration procedures for host, networking, and search suffixes. To
configure host settings, enter host and domain name information. To configure networking settings, enter host
IP address, subnet mask, default gateway, and optionally enter DNS server IP addresses. Click Update to apply
the host and networking settings changes. Click Reset to restore these settings to factory defaults.

Search suffixes provide the ability to automatically append a DNS suffix. For example, when you ping “sonicwall”
it automatically goes to “sonicwall.engineering.” To configure Search Suffixes, click Add to include multiple
search suffixes, and to remove Search Suffixes, click the check box next to the Search Suffixes list, and click
Delete.

=1
4 F!' System
Host
. g Metwork
Settings  Mame: ianalyzer??ﬂ | example: hostname
Rout
e Domain: |sonicwall.-:om | example: domain, com
L3 3‘ Deployment
Metworking
Host IP address: | 10.203.23.66 |
Subnet mask: 258, 755.0.0 |
Default gateway: [10.203.23.1 |
DNS server 1: [10.50.128.53 |
DNS server 2: [10.50,128.52 |
DS server 3 | |
| Update || Reset
[ Search Suffizes Configure
[ aglabal,sonicval. com £y
Add | | Celete

Configuring Network Routes (Virtual Appliance)

This section provides configuration procedures to add network routes. To add a network route, enter a
destination network IP address, network mask, and gateway, and click Add. To edit the default network route,
click the configure icon. When multiple network routes are added to the list, selecting the check box at the
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top-left corner of the page selects all the added network routes. Click Delete to remove a network route from
the list.

@ | NOTE: The default network route cannot be deleted.

L4 ii System
Nebwork Routes

i Q; Network
it | Destination Network MNetwork Mask Gateway IP Configure
ettings
Routes | default 10,205.23.1 &
* e Bedinwmenk Add | | Delete

¥ Untitled - Google Chrome

| @ 10.203.23.66:85/appliancefaddRoute. jsp

Add Route

Drestination Metwark: | |

Metwork Mask: | |

Gateway Address: | |

Add | | Cancel |

Configuring UMH Deployment Options

This section describes the tasks you can do on the Deployment pages of the SonicWall Analyzer UMH system
interface.

See the following sections:
e Configuring the Deployment Role on page 201
e Configuring Deployment Settings on page 201
e Configuring Web Server Settings on page 202
e Configuring SMTP Settings on page 203
e Configuring SSL Access on page 203

e Controlling Deployment Services on page 204
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Configuring the Deployment Role

In a SonicWall Analyzer installation, the Deployment > Roles page provides a way to configure the syslog port
and the database settings, and to test database connectivity.

> = System
Host Role Configuration
s 9; Network
Single Server Configuration
b g Deployment c d
Roles ® Analyzer Details
Settings Syslog Server Port: 3003
Services
Database Configuration
Database Type: MY SOL
Database Host: lacalhost
Database Port: 3306
Database User:
Database Passwaord:
Confirm Database Password: l:l
Database Driver: |c0m.mysql.jdbc.Driver |
Database URL: [idbe:mysal:flacalhast:3306 || Test Connectiviey
| Update | | Reset |

To set the syslog port, enter the port number into the Syslog Server Port field.

Under Database Configuration, to provide credentials with which SonicWall Analyzer accesses the database,
enter the account user name into the Database User field, and enter the account password into both the
Database Password and Confirm Database Password fields. Additionally, you can enter a Database Driver file
name and the Database URL for an explicit directory path location.

To test connectivity to the database server, click Test Connectivity. A pop-up message displays the database
connectivity status.

/i, Database connection successfully created,

Successfully created connection for URL:

jdbcisglserver: [{127.0.0. 1;instanceMame =SMWL

Database Type: M5_DB

Database Host: 127.0.0. 1SNWL

Database Port: 0

Database Lser: sa

Database URL: jdbcisglserver: [{127.0.0. 1jinstanceMame =SMWL

Close

When finished, click Update to apply the changes. To revert the fields on the page to their default settings, click

Reset.

Configuring Deployment Settings

This section describes the UMH Deployment > Settings page, used for Web port, SMTP, and SSL access
configuration.
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The Deployment > Settings page is identical in both the UMH management interfaces.

> E‘ System
Web Server Settings
> 9,= Network
HTTP port: |35
bt g Deployment 0%
—_—
Roles HTTPS port: s |
Settings Enable HTTPS redirection: 1
Services 3
Public IP: |10,205.23.62
| Update | | Reset
SMTP Configuration
SMTP server: imail.sonicwall.com
SMTP port: :_25 |
[T Use Authentication
User: ! [
Password: |
Confirm Password: ! |
Sender address{From): va.ss@sonicwall.com |
Administrator address(To): ! | Test Connectivity
| Update | | Reset |
551 Access Configuration
@ pefault
This selection allows you to keep the default certificate that comes with the application for use by the
Analyzer Web Server for SSL access. Filename for the keystore used is ‘gmsvpserverks',
© custom
This selection allows you to upload a custom certificate for use by the Analyzer Web Server for S5L
access, The original filename of the certificate imported will be replaced with ‘gmsvpservercustomks' in the
local file system,
Keystore/Certificate file: Choose File | Mo file chosen
Keystore/Certificate password:
| View | | Lipdate | | Reset

See the following sections:
e Configuring Web Server Settings on page 202
e Configuring SMTP Settings on page 203
e Configuring SSL Access on page 203

e Controlling Deployment Services on page 204

Configuring Web Server Settings

Web Server Settings configuration is largely the same on any role:
1 Navigate to Deployment > Settings > Web Server Settings in the /appliance management interface.

2 To use a different port for HTTP access to SonicWall Analyzer, type the port number into the HTTP Port
field. The default port is 85.

If you enter another port in this field, the port number must be specified when accessing the appliance
management interface or SonicWall GMS management interface. For example, if port 8080 is entered
here, the appliance management interface would be accessed with the URL: http://<IP
Address>:8080/appliance/.
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To use a different port for HTTPS access to the SonicWall Analyzer, type the port number into the HTTPS
Port field. The default port is 443.

If you enter another port in this field, the port number must be specified when accessing the appliance
management interface or SonicWall GMS management interface. For example, if port 4430 is entered
here, the appliance management interface would be accessed with the URL: https://<IP
Address>:4430/appliance/.

Click Enable HTTPS Redirection to redirect HTTP to HTTPS when accessing the Analyzer management
interface.

In the Public IP text-field, enter the public IP or FQDN of the outside web services.

When you are finished configuring the Web Server Settings, click Update.

Configuring SMTP Settings

The SMTP Configuration section allows you to configure an SMTP server name or IP address, a sender email
address, and an administrator email address. You can test connectivity to the configured server.

To configure SMTP settings, complete the following steps:

1
2
3

0 N o !

Navigate to the Deployment > Settings page under the SMTP Configuration section.
Type the FQDN or IP address of the SMTP server into the SMTP server field.

Click Use TLS if you would like to use Transport Layer Security (TLS) for your mail server connectivity, such
as for Gmail or Office365. TLS ensures privacy between you and communicating applications on the
Internet, and that no third-party can eavesdrop or tamper with your messages.

If the SMTP server in your deployment is set to use authentication, click the Use Authentication check
box. This option is necessary for all outgoing Analyzer emails to properly send to the intended recipients.
Enter the username in the User field, and enter/confirm the password in the Password and Confirm
Password fields. This is the username/password that is used to authenticate against the SMTP server.

Type the email address from which mail is sent into the Sender address field.
Type the email address of the system administrator into the Administrator address field.
To test connectivity to the SMTP server, click Test Connectivity.

To apply your changes, click Update.

Configuring SSL Access

The SSL Access Configuration section allows you to configure and upload a custom Keystore/Certificate file for
SSL access to the GMS appliance, or select the default local keystore.

To configure SSL access, complete the following steps:

1
2

Navigate to the Deployment > Settings page under SSL Access Configuration section.

Select Default to keep, or revert to, the default settings, where the default GMS Web Server certificate
with 'gmsvpserverks' keystore is used.

Select Custom to upload a custom keystore certificate for GMS SSL access.

In the Keystore/Certificate file field, click Browse to select your certificate file.

@ | NOTE: Your custom file is renamed to ‘gmsvpservercustomks’ after upload.
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5 Type the password for the keystore certificate into the Keystore/Certificate password field.
6 Click View to display details about your keystore certificate.

7 Click Update to submit your changes.

Controlling Deployment Services

The Deployment > Services page provides a list of the services that are running on your system as part of
SonicWall Analyzer. It also provides a way to stop or start any of the services.

» Igl System e
ost Role
» Q_ Network
Host Role: Analyzer Details

. a_,; Deployment

Roles Host Services

Settings

’ J |:| Service Name Current State
Services

[ SonicswaLL Universal Management Suite - Update Manager  Started (Enabled)
[ SonicswaLL Universal Management Suite - Syslog Collector  Skarted (Enabled)
[ sonicwall Universal Management Suite - Web Server Started {Enabled)
[] sonicwwaLL Universal Management Suite - Scheduler Started {Enabled)
] sonicwwaLL Universal Management Suite - Reports Database  Started (Enabled)
] SonicsWaLL Universal Management Suite - Reports Scheduler  Started (Enabled)
[ SonicwwaLL Universal Management Suite - Reports SummarizerStarted (Enabled)
[ sonicwwaLL Universal Management Suite - Database Started (Enabled)

| Dizable/stop | | Enable)3kart | | Restark |

To stop a service that is currently Enabled, select the check box for that service and then click Disable/Stop.

To start a service that is currently Disabled, select the check box for that service and then click Enable/Start.

To restart a service that is either Enabled or Disabled, select the check box for that service and then click
Restart.
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Upgrading

This appendix is designed to help you upgrade SonicWall Analyzer. If you have not used SonicWall Analyzer
before, you might want to familiarize yourself with SonicWall Analyzer concepts and features.

This appendix contains the following sections:
e Upgrading to Analyzer 8.3 on page 206
e Upgrading SonicWall ViewPoint 6.0 to Analyzer 8.3 on page 207
e Upgrading from Analyzer to GMS on page 209

e Miscellaneous Procedures and Tips on page 218

Upgrading to Analyzer 8.3

This section provides procedures for upgrading an existing SonicWall Analyzer 8.0 or newer installation to
Analyzer 8.3. Analyzer can be configured for a single server or in a distributed environment on multiple servers.
Analyzer 8.1 can be installed as a fresh install or as an upgrade from Analyzer 8.0. If you wish to perform a fresh
install of Analyzer 8.3, refer to the SonicWall Analyzer Getting Started Guide that relates to your Analyzer
deployment.

Upgrading Considerations

CAUTION: If you are upgrading to 8.3 and still have CDP appliances under management, those
appliances will automatically be removed from Analyzer.

CAUTION: If you have a Windows-32 bit Analyzer Server currently in your deployment, you must first
migrate or decommission those servers, before upgrading to 8.3.

Consider the following before upgrading to Analyzer 8.3:

e "The 40GB Analyzer Virtual Appliance should be installed in non-production environments only.
Examples of non-production environments include those for Proof of Concept (POC), pilot, and demo
deployments. Only the 250GB and 950GB virtual appliances are supported in production environments.
It is not possible to upgrade a 40GB virtual appliance to a 250GB or 950GB virtual appliance. You need to
download the 250GB or 950GB virtual appliance if you are planning to use this software now or in the
future for a production environment.

® In non-production environments, the amount of syslog data collected by the virtual appliance may
exceed the 40GB limit, in which case SonicWall will be unable to support the 40GB virtual appliance.

e You must disable the User Account Control (UAC) feature on Windows before running the Analyzer
installer. In addition, disable Windows Firewall or your personal firewall before running this installer.

e Analyzer can only be configured for a single server.
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Upgrading Procedure

To upgrade to Analyzer 8.3, complete the following steps:
1 Navigate to www.mysonicwall.com.
2 Download the Analyzer 8.3 software.
SW_gmsvp_win_eng_8.3.XXXX.yyYyy.exe

3 After the file has downloaded, double-click the file and follow the onscreen instructions. The Installer
detects any previous installations of Analyzer. Click Install to proceed with the installation.

4 If you see a Windows Security Alert for Java, click Unblock. The installer displays a progress bar as the
files are installed. Wait a few minutes for the installer to finish installing.

5 After the files are installed, whether or not the system has a Personal Firewall such as Windows Firewall
enabled, a dialog is displayed notifying you to either disable the firewall or manually open the syslog and
SNMP ports, and to ensure that these ports are open on your network gateway or firewall if you plan to
use HTTPS Management mode for managing remote appliances (instead of Analyzer Management
Tunnel or Existing Tunnel modes). Click OK. Be sure to adjust the settings as recommended.

6 After the version file is installed, reboot the system to complete the installation.

Upgrading the Analyzer virtual appliance

The Analyzer Virtual Appliance can be upgraded from 8.2 to 8.3. To upgrade the Analyzer Virtual Appliance from
a version earlier than 7.2, you need to upgrade to major versions of Analyzer until you reach 7.2, then you can
upgrade to Analyzer 8.3. For SonicWall Analyzer Virtual Appliance deployments, upgrading from the Analyzer
8.0 release to the Analyzer 8.3 release can be performed on the System > Settings page.

In a distributed environment, shut down all Analyzer servers except the one that is running the database. Then
upgrade the Console/AIOP first and then the other servers. You must upgrade all Analyzer servers in your
deployment to the same version of SonicWall Analyzer 8.3. You cannot have some servers running version 8.2
and others running 8.3.

For a fresh install of the Analyzer 8.3 64-bit Virtual Appliance, refer to the SonicWall Analyzer Virtual Appliance
Getting Started Guide.

To upgrade, complete the following:

1 Download the Analyzer 8.3 file from www.mysonicwall.com to your workstation:
SW_gmsvp_vm_eng_8.3.XXXX.YyyYyy.gmsvp-updater.64bit.sh
Log in to the /appliance (System) interface of the Analyzer server.

Navigate to the System > Settings page.

Click Browse, navigate to the location where you saved the above file, and select it.

v b~ W N

Click Apply to begin the firmware upgrade installation.

The Virtual Appliance reboots at the end of the installation process.

Upgrading SonicWall ViewPoint 6.0 to Analyzer 8.3

The SonicWall Analyzer cannot be directly upgraded from ViewPoint 6.0 to Analyzer 8.3, but it can be upgraded
from Analyzer 7.0. To upgrade the SonicWall Analyzer from a version earlier than 7.0, you need to upgrade to
major versions of Analyzer until you reach 7.0, then you can upgrade to 8.3.
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To upgrade major versions of SonicWall Analyzer, use the Universal Management Suite installer and
complete the following steps:

1 Logon to your SonicWall Analyzer management computer as administrator (Windows). Launch the
SonicWall Universal Management Suite installer, by double-clicking the file
SW_gmsSVp_win_eng_X.X.XXXX.XXXX.eXxe (where “XxXxX” represent the exact version
numbers). It might take several seconds for the InstallAnywhere self-extractor to initialize.

2 Inthe Introduction screen, click Next.

3 Inthe License Agreement screen, select the radio button next to | accept the terms of the License
Agreement. Click Next.

4 When the installer detects that a previous version of Analyzer/ViewPoint is currently installed on the
system, a notification is displayed. Click Install to continue the upgrade.

5 Theinstaller begins installing the files, using the existing installation folder, IP address to which SonicWall
Services bind for capturing syslog and SNMP packets, and Web port settings.

6 The Installer displays the installation progress during the few minutes required. Upon completion,
whether or not the system has Windows Firewall enabled, a dialog is displayed notifying you to either
disable the firewall or manually open the syslog and SNMP ports, and to ensure that these ports are
open on your network gateway or firewall. Click OK.

Syslogs/SNMP Capture

@ Firewall and AntiVirus Scanning

Ifyou hawe a Personal Firewall sofbware running on this system,
pleaze disable it for proper functioning of this product. Alternativealy,
wou should enable ports for Syslogs chypically 514, Syslog
Fomvarding chypically 21007) and SHMP traps (bwpically 162) on the
Personal Firewall. '

Alzo, ifyou plan to enable any remaote appliance for HTTRS
Management, you will nead to configure the FirewalliG ateway in
front of thiz systemn to fonmard UDP Syslog (port 514 and SMMP (port
162) packets to thiz system.

Othenize, this Univerzal Management system will not receive any
Syzlogs and SMMP traps for its proper functioning.

AntiVirus Scanning: If you have Antivirus sofhvare running on this
system, ywou will need to exclude the folders aszociated with thiz
product from being scanned by the Antivirus softuare.

7 The Important Registration Information screen provides the URL for access to the SonicWall Analyzer
Universal Management Host system interface after upgrade completion, as well as information about
registration.

The default URL for accessing the interface from the local system is:
http://localhost:80/

The default credentials are:

User name —admin

Password — password

@ NOTE: To register for a SonicWall Analyzer installation, log in to the Universal Management Host
system interface, then click Register in the top-right corner. The License Management page
displays, enter the word “ANALYZER” in the Serial Number field and leave the Authentication Code
fields blank. Enter a name into the Friendly Name field, then click Submit. For complete
instructions, refer to the latest SonicWall Analyzer Getting Started Guide for your deployment.

8 Click Next.
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9 The final installer screen contains the path of the installation folder, and warns you that the Universal
Management Suite Web page is launched next. Click Done.

In the SonicWall Analyzer login page, enter the same credentials for User and Password that you had in
your earlier version prior to the upgrade.

Upgrading from Analyzer to GMS

SonicWall Analyzer installations have the option of upgrading to SonicWall GMS without reinstalling. You can
start a 30-day Free Trial of SonicWall GMS by clicking a button or link in either the Analyzer or Universal
Management Host interface and following a simple procedure. When you are ready to finalize the upgrade, your
SonicWall reseller can provide you with the license key for a seamless transition to SonicWall GMS.

When five or more registered devices are connected to SonicWall Analyzer reporting, Try GMS Free - 30 Days
appears next to the tabs at the top of the Analyzer management interface.

Try GMS Free
g0 Tatt

You can also start the Free Trial by clicking Manage Licenses on the System > Licenses page of the Universal
Management Host interface, and then clicking the Try link.

¥ ‘?‘ System
License Management
Status .

U Serial Number: 00401022FDDC
icenses

Adrministrakion Security Service Status Free Trial Manage Service Count Expiration
Settings Global Management System Mot Licensed Iry Upgrade
WiewPaint Licensed Urilimited

Diagnostics

4 ", Deployment

Return ko License Summary

For details on enabling the SonicWall GMS Free Trial and purchasing the SonicWall GMS upgrade license, see the
following sections:

e Enabling the GMS Free Trial from Analyzer on page 209

e Enabling the GMS Free Trial from the UMH Interface on page 212
e Completing the Free Trial Upgrade on page 212

e Configuring Appliances for GMS Management on page 215

e Purchasing a SonicWall GMS Upgrade on page 217

Enabling the GMS Free Trial from Analyzer

When five or more devices are connected to SonicWall Analyzer reporting, Try GMS Free - 30 Days appears next
to the tabs at the top of the Analyzer management interface.

To find out how many devices your SonicWall Analyzer installation is handling, log in to MySonicWall and
navigate to the My Products page. Click on the link for your SonicWall Analyzer installation to get to the Service
Management page, and scroll to the bottom. You see the list of appliances under Associated Products.
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To enable the 30-day SonicWall GMS Free Trial from the Analyzer management interface, complete
the following steps:

1

2

In the Analyzer management interface, click Try GMS Free - 30 Days next to the tabs at the top of the
page.

Try GMS Free
20 Tar

The Analyzer Upgrade Tool launches and guides you through the process of installing the Free Trial or
Upgrade. The tool displays the Upgrade Requirements — Licensing screen. Before migrating to GMS,
ensure that all appliances under Analyzer reporting are registered to the same MySonicWall account.
Follow the steps provided in the screen, and then click Proceed.

Upgrade Reguirements - Licensing

‘WiewPoink ko GMS 5,1 upgrade (GMS Free Trial or Full License), requires that all appliances in your YiewPoint software be registered to
the same MySonicWALL account, IF appliances are not migrated prior to this upgrade, GM3S will be missing essential functionality such
as the ability ko license services and perform firmware upgrades. IF this is the case, please abort the upgrade and consolidate all the
appliances in your viewPoink software into the same My SonicWwall account Following the steps below, Otherwise, click "Proceed” to
continue,

1. Gather the MySonicWaLL login info For the appliance and log into the account,
2. After logging into MySoniciwALL, navigate ko the "My Products™ screen and locate the appliance.

Imporfant: Make note of tha saral number and authentication code for fufure referance.
Locate the "deleke” button option in the "Service Management" screen in the specific MySonicwaLL account and select it

Click on "Confirm Deletion” prompt.

This appliance is now ready For migration ko GMS 5.1,

[= R T R S 1

Repeat steps 1 thru 4 for the rest of the appliances under ViewPoint as needed,

Proceed | | Cancel
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3 The Upgrade Requirements — System screen displays the recommended operating system, database,

and hardware system requirements. Click Proceed.

Upgrade Reguirements - System

Flease check the recommendead svstem requirements below ta make sure your system is qualified For upgrading to be an all-in-one GMS
system. Click "Proceed" to start the upgrade procedure.

Recommended System Requirements

Operating System Microsoft® Environment! Windows 2000 Server (SP4), Windows 2000
Professional (SP4), Windows XP Professional (SP2), Windaws 2003 Server (SP2)

Database Microsaft® Environment: Microsoft SQL Server 2000 (SP4) and Microsaft SQL
Server 2005 (SP2) on either Windows 2000 Server (SP4) or 2003 Server (SP1)

Hardware %86 Environment: Minimum 3 GHz processar dual-core CPU Intel pracessar, 2 GB
RAM, and 300 GB disk space

Current System Information

Operating System Windows ¥P (x86-5.1)
CPU 2,327 GHz
RAM 2,008 &6
| Proceed | | Cancel |

4 The Analyzer Upgrade Tool displays the login screen for MySonicWall. Enter your MySonicWall

credentials and click Submit.

WiewPoint Upgrade Tool

Step 1. Upgrade the License
Use the license upgrade screen provided below to upgrade the license from Yiewpaint to GMS

mySonicWALL.com Login

mySonicWALL.com is & one-stop resource For registering all yvour SonicWaLL Internet Security Appliances and
managing all yvour SonicWALL security service upgrades and changes. mySonicWwALL provides vou with an easy to
use interface ko manage services and upgrades For multiple SonicWaLL appliances, For more information on
mySonicWaALL please visit the EAG, IF vou do nok have a mySonicWall account, please dlick here to create one,

Flease enter vour existing mySonicWALL. com username {or email address) and password below;

Ernail Address/iser Name: | |

Password: | |

Did vou Forget wour User Mame or Password? Go bo https: v, mysonicwall, com For help,
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5 Inthe next Analyzer Upgrade Tool page, click the Try link in the Free Trial column for Global Management
System.

Wiewpoint Upgrade Tool

Step 1. Upgrade the License
Use the license upgrade screen provided below to upgrade the license From Viewpoint ko GMS

Security Service Status Free Trial Manage Service Count Expiration
Global Management System Mot Licensed Try Upgrade
ViewPoint Licensed Unlimited

6 From this point, the upgrade process continues with the same steps for access from either the Analyzer
interface or the Universal Management Host interface. To continue the procedure, complete the steps in
Completing the Free Trial Upgrade on page 212.

Enabling the GMS Free Trial from the UMH Interface

To enable the 30-day Free Trial of SonicWall GMS from the Universal Management Host interface on
your SonicWall Analyzer system, complete the following steps:

1 Inthe Universal Management Host interface, navigate to the System > Licenses page and click Manage
Licenses.

¥ ‘?: System

Status

Licenses

License Management

Serial Mumber: 00401022F0DC

Administration Security Service Status Count Expiration
Settings Global Management System Mot Licensed
Diagnostics VigwPaint Licensed Unlirmited
L 2 Deployrnent
‘ Manage Licenses H Refresh Licenses || Upload Licenses |

2 If you are not already logged into MySonicWall, the MySonicWall login screen is displayed. Enter your
MySonicWall credentials in the appropriate fields and log in.

3 Onthe next page, click the Try link in the Free Trial column for Global Management System.

=
v s Sycrem
-
License Management
Status
. Serial Mumber: 00401022F0D0C
Licenses

Adminiskration Security Service Status Free Trial Manage Service Count Expiration
Settings Glohal Managemerit System Mok Licensed Ty Uparade
ViewPoint Licensed Unlimited

Diagnostics

L5 g Deployrment

Return ko License Surmary

4 From this point, the upgrade process continues with the same steps for access from either the Analyzer
interface or the Universal Management Host interface. To continue the procedure, complete the steps in
Completing the Free Trial Upgrade on page 212.

Completing the Free Trial Upgrade

This procedure provides the common upgrading steps for access from either the SonicWall Analyzer interface or
the Universal Management Host interface. To get to this point in the process, follow the steps described in one
of the two preceding sections:
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e Enabling the GMS Free Trial from Analyzer on page 209
e Enabling the GMS Free Trial from the UMH Interface on page 212

To continue the upgrade, complete the following steps:

1 Inthe Analyzer Upgrade Tool page, click Continue.

Wiewpoint Upgrade Tool

Step 1. Upgrade the License
Use the license upgrade screen provided below to upgrade the license From Viewpaint to GMS

Global Management System Free Trial

Thank you for your interest in Global Management System,

If you choose to purchase Global Management System subscription, you may do so at any time during or after the trial,

Continue Cancel

2 The next screen provides a summary of GMS and Analyzer status. Verify that the Try link for the Free Trial
is gone and only the Upgrade link remains. The Expiration column displays the expiration date of your
Free Trial. You can click the Upgrade link at any time during the Free Trial to purchase the SonicWall GMS
upgrade. Click Proceed.

Wiewpoint Upgrade Tool

Step 1. Upgrade the License
Below is the summary of the upgraded licenses, Please click the "Proceed” button to continue to the next step

Security Service Status Free Trial Manage Service Count Expiration
Global Management System Free Trial Upgrade 15 25 Jul 2009
ViewPoint Licensed Unlimited

Proceed

3 Inthe next Analyzer Upgrade Tool page, you begin the configuration for GMS in step 2 of the upgrade
process. This page displays two sections:

Automatic Configuration — Contains a list of SonicWall firewall or CSM appliances in your Analyzer
installation. These appliances are automatically configured for GMS management.

Manual Configuration — Contains a list of SonicWall or SSL-VPN appliances in your Analyzer installation.
You must manually configure these appliances for GMS management. See Configuring Appliances for
GMS Management on page 215 for detailed instructions on enabling GMS management on these
appliances.
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When ready, click Proceed.

WiewPoint Upgrade Tool

Step 2, G ME Configuration

Twasectoms aieimmbed inLiks step. un Canfiguiaton” Fsts oo Lie appkances Ll aie autn con’iguianke (o suppoit GHE.
T imlatim selemdulee] Lo ks i || e comaled wwien pioossds (o Che o=l step, "Flansal CanfiguiaGon” fsis oot apphano= aml
iffamatian o felp usms manally configaie Lies = appfancs Lo suppail GG,

Automatic Configuration

Followinig list shiows all the UTM appliances currently in the system. These
appliances can be automatically configured to support GMS |

Appliance MHame Appliance Serial Mumber
MSA 240 001763269510
MSA 5500 O017C51Ca550C

Manual Configuration

Falloewinng list shiowes all the non-UTM appliances currently in the systemn, These
appliances need manual configuration to support GMS |

L&ppliance Mame Appliance Serial

Eng Test 0006B1275C34

Canfigualion Infomatian

4 When the configuration finishes, the Analyzer Upgrade Tool displays the completion dialog box. Click
Close to log out of the console and restart the system.

Wiewpoint Upgrade Tool

‘You have complete the upgrade procedure,

please click "Close" button to logout the console and reboot the bosx
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5 The GMS login page appears and requests that you reboot the system. Reboot the system. If a reboot is
not done, you might encounter problems with the correct IP Address appearing.

SonicWALL Global Management System Login

'.& GMS Free trial upgrade procedure is complete,
) Please rebogt the system '

user ||

Password |

Swibch ko system interface

6 After rebooting, log in with your Analyzer credentials.

When you log in, you see a button displaying the number of days left in your Free Trial at the top of the

page.

On the System > Status page for connected appliances, you can view the log entries for task
synchronization and automatic addressing mode, related to the GMS configuration.

|

FSA 240 11 Status

GMS Free Trial 31 'Days Left

‘2 Global¥iew (LocalDomain} .
Policies

Licensed Modes
Administrabar
Tools
Info
Settings
schedules
Management
SNMP
Ch Certificates
Local Certificates

* Network

P Firewall

F Log

> Diagnostics

* Website Blocking

» DHCP

b Users

* ¥PN

b Reports
;—" M5a 240 B Status Information for Unit N
=0 NS4 5500
¥ System Firewall
Status Firewall Model
e Sierial Humber
Cromain

Registration Code
Firmweare Version

CPU

Hardware Failover

Number of LAN IPs alloveed

Network
Inkerfaces

Zones
DHICP Server

Management
Firewall Status

Unit added ko SonicwALL GMS on

Management Mode
Primary Agent
Standby Agent
Tasks Pending
Last Log Enkry

ode: NSA 240

SonicWALL MSA 240 UNL NODE

0017 C5265510

LocalDomain

BPEMMINZ

SonicS Enhanced 5.2.0.1-210 - English
2% 500 MHz Mips64 Ockeon Processor
Disabled

Unlimited

W0, K1, %2, %3, ¥4, W5, K6

w7, %, Mo

LAK, WAN, DMZ, VPN, MULTICAST, WLAR, SSLYPH
Enabled

Up since Wed Jun 24 18:08:04 PDT 2009 {}
Jun 24, 2009 17:458:00 PDT

HTTPS [10,0,94.100 : 443] (Manual)

10,0,92. 111 {Ackive)

Mone

o

successful execution of task: Synchronize un. ..

54 Configuration Information

Defined S4s
Enabled S4s

2
Mone

Configuring Appliances for GMS Management

To manually configure the appliances listed in the Manual Configuration section of the Analyzer
Upgrade Tool page, complete the following steps for each appliance:

1

2

In the GMS management interface, click the tab at the top of the page that corresponds to the type of

appliance, such as SSL-VPN.

In the left pane, right-click one of the listed appliances and select Modify Unit.
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3 Inthe Modify Unit screen in the right pane, copy the appliance IP address in the Managed Address
section to your clipboard, or make a note of it.

B||§||V|ggl| B Modify Unit [X]
=} MyReports¥iew (LocalDa Lnit: Marme: |Eng
23 E
o E:g S Serial Number: [000BE1275F45
23 Eng Test
Managed Address: | Determine automatically
(@ 5pecify manually:  [10.126.1.2
[ Jawentail 55L-VPM appliance
Login Mame: Iadmin
Password: |**********
Management Made:
HTTPS Part:  [443
sS4 Encryption key: |
SA Authentication Key: |
agent IP Address: | 192,168,252, 12
Standby Agent IP: | RMone
| oK | | S Cancel
4
4 Click Cancel.

5 Inthe left pane, right-click the same appliance and select Login to Unit > Using HTTPS.

@ Globalview

0 corp sslvpn ¥ General

D sslvpn 1.2 Status

G b Bandwidth
= '_ ' b Resources
& Bind... b Authentication
-"'f’;u Refresh » Configuration
dle Rename Unit,.,  [* Log Viewer
=5 Add Unit...
&2 Modify Unit...
=% Delete
Login to Unit— » Using HTTRS I\L

L)
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6 Inthe appliance management interface, navigate to the System > Administration page.

= | =] Eng :: Status GMS Free Tial 30 Days Left | Useri admin@LocalDomain | Administrators
= MyReports¥iew {(LocalDomain
5 Eng ISonicWALL - Yirtual Office - Mozilla Firefox
] Eng Corp ‘.
https:f10.128.1.2{cgi-binfmanagement &0
e J 5 Wretpssyy Jcgi-binjmanag %
Help  Logout
— -
w ac System Lockaut Period (minutes): I5 _l
Skakus
Licenses GMS Settings
Tirne: y
I Erable GMs Management
Settings
Administration GMS Host Mame or IP Address: |
Certificates M5 Sysing Server Part: 514
Monitari
PR Heartheat Interval (seconds): |BU
Diagnostics -
Restart Send Heartbeat Status Messages Cnly
[ g_ Mebwork Mote: GMS 4.0 o later is required to remotely manage this S5L-WPN appliance.
~ .
S T
5'_'_6 Fockal 3 Global Portal Settings
v Bl nereande |
q b Status: Ready

7 Under GMS Settings, select the Enable GMS Management check box, or verify that it is selected.

8 Inthe GMS Host Name or IP Address field, paste or type the appliance IP address that you obtained from
the Modify Unit screen in Step 3.

9 Click Accept at the top of the appliance interface screen.
10 Click Logout in the top right corner of the appliance interface screen.

11 Repeat these steps for each appliance listed in the Manual Configuration section of the Analyzer Upgrade
Tool page.

Purchasing a SonicWall GMS Upgrade

You can purchase an upgrade to SonicWall GMS at any time during the 30-day Free Trial.

To purchase the SonicWall GMS license, complete the following steps:

1 Inthe GMS interface, click GMS Free Trial X Days Left, where X is the number of days left in the Free
Trial.

ult Page GMS Free Trial 30 Days Left

2 Inthe Buy GMS page, click | want to upgrade to GMS now.

Buy GMS

Free Trial / Upgrade options
Use the Following options to buy a GMS license or to end the GMS free trial

® [want to upgrade to GMS now
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3 The Console > Licenses > Product Licenses page is displayed. Click Manage Licenses.

Product Licenses GMS Frea Trial 30 Days Left | User: admin@LocalDomain | Administratars

¥ User Settings
License Summary

¥ Log
b Tasks Last SonicWWALL Reqgistration Site contact: Apr 02 2009 03:14PM Serial Number: 00401022FDDC
¥ Management Security Service Status Count Expiration
* Reports f
N ~ Global Management System Free Trial 15 02 May 2008
¥ Diagnostics
b Events WigPoint Licensed Unlirnited
¥ Licenses
Product Licenses Manage Licenses ‘ | Refresh Licenses H Upload Licenses

Activation Codes
Deployments
¥ Help

4 In the next page, in the Manage Service column for Global Management System, click the Upgrade link.

Product Licenses GMS Free Trial 30 Days Left | User: sdmin@Local

License Summary

Last SonichWALL Reqgistration Site contack: Apr 02 2009 03:14PM Serial Murmber:
Security Service Status Free Trial Manage Service Count Expiration
Global Management System Free Trial Upgrade 15 02 May 2009
ViewPoint Licensed Unlimiced

Return Eo License Surmary

5 The next page has Serial Number and Authentication Code fields for GMS. You must contact your
SonicWall reseller to complete the purchase and obtain the 12-character serial number and
authentication code. Type in the values to the Serial Number and Authentication Code fields.

License Summary
Last SonicWALL Registration Site contact: Apr 02 2009 03:14PM Serial Mumber: o ... oo -

Enter wour new 12 characker Software Serial Mumber and Authentication Code

Serial Murnber: I
Authentication Code: I —I What is this?
Friendly Mame: I

GMS upgrade keys:

(Required if current Viewpoink inskallation is larger than retall upgrade

6 Enter a descriptive name for the GMS installation into the Friendly Name field. This name appears in
your MySonicWall account.

7 If your Analyzer installation currently handles more than 10 appliances, when you upgrade to GMS, you
need to purchase additional GMS license(s) to manage the extra appliances. The standard “10-node”
GMS license provided with the Free Trial supports up to 10 managed appliances. Enter the license keys
for any additional GMS licenses into the GMS upgrade keys text box, one key per line.

8 Click Submit. The License page is displayed, showing that GMS is now licensed.

Miscellaneous Procedures and Tips

This section contains miscellaneous Global Management System procedures and troubleshooting tips.
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Miscellaneous Procedures

This section contains information on procedures that you might need to complete. Select from the following:

e [tis highly recommended that you regularly back up the SonicWall Analyzer data. For more information,
see Backing up SonicWall Analyzer Data on page 219.

e SonicWall Analyzer requires Mixed Mode authentication when using SQL Server 2000. To change the
authentication mode, see Changing the SQL Server Authentication Mode on page 219.

e [f you are reinstalling SonicWall Analyzer, preserving the previous configuration settings can save a lot of
time. To reinstall SonicWall Analyzer using an existing SonicWall Analyzer database, see Reinstalling
SonicWall Analyzer Using an Existing Database on page 219.

e [f you need to uninstall SonicWall Analyzer from a server, it is important to do it correctly. To uninstall
SonicWall Analyzer, see Uninstalling SonicWall Universal Management Suite and Its Database on page
220.

Backing up SonicWall Analyzer Data

SonicWall Analyzer stores its configuration data in the SGMSDB database. It is important to back up this
database and the individual SonicWall Analyzer databases (sgmsvp_yyyy mm_dd) on a regular basis.

The Console > Management > Database Maintenance page provides the necessary support for backing up and
restoring the Infobright with Postgres (IB-PG) database that is bundled with SonicWall UMS.

If you are using SQL Server, this can be accomplished by backing up the entire SQL Server using the database
backup tool. When using this tool, there is no need to stop the SonicWall Analyzer services for database backup.
However, make sure that the backup occurs when SonicWall Analyzer activity is the lowest and that the backup
operation schedule does not clash with the SonicWall Analyzer scheduler.

NOTE: It is also recommended to regularly back up the entire contents of the SonicWall Analyzer directory,
the sgmsConfig.xml file.

Changing the SQL Server Authentication Mode

SonicWall Analyzer requires the Mixed Mode authentication mode.

To change the authentication mode from Windows Mode to Mixed Mode, complete the following
steps:

1 Start the Microsoft SQL Server Enterprise Manager.

2 Right-click the appropriate SQL Server Group and select Properties from the pop-up menu.
3 Click the Security tab.

4 Change the Authentication mode from Windows only to SQL Server and Windows.

5 Click OK.

Reinstalling SonicWall Analyzer Using an Existing Database

If you need to reinstall SonicWall Analyzer, but want to preserve the settings in an existing
SonicWall Analyzer database, complete the following steps:

1 Install a new database, using the same username and password that you used for the existing SonicWall
Analyzer database.
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2 Install SonicWall Analyzer using this new database.
3 Stop all SonicWall Analyzer services.

4 Openthe sgmsConfig.xml and web.xml files with a text editor. Change the values for the dbhost and
dburl parameters to match the existing SonicWall Analyzer database.

5 Restart the SonicWall Analyzer services.

6 Uninstall the new database.

Uninstalling SonicWall Universal Management Suite and Its
Database

This section describes how to uninstall SonicWall Universal Management Suite and its components. Select from
the following:

e To uninstall SonicWall Universal Management Suite on the Windows platform, see Windows on page
220.

e To uninstall SonicWall Universal Management Suite databases from Microsoft SQL Server 2000, see MS
SQL Server 2000 on page 220.

Windows

To uninstall SonicWall Universal Management Suite from a Windows system, follow these steps:
1 Click Start, point to Settings, and click Control Panel.
2 Double-click Add/Remove Programs. The Add/Remove Programs Properties window displays.

3 Select SonicWall Universal Management Suite and click Change/Remove. The SonicWall Universal
Management Suite Uninstall program starts.

4 Follow the on-screen prompts.

5 Restart the system. SonicWall Universal Management Suite is uninstalled.

MS SQL Server 2000

To uninstall or remove the SonicWall Universal Management Suite databases in the MS SQL Server
2000, you can execute the following DOS command from any SonicWall Universal Management
Suite server:

osgl -U username -P password -S dbHost IP -q '"drop database SGMSDB"

osgl -U username -P password -S dbHost IP -q "drop database
sgmsvp_yyyy_mm_dd"

Or you can use the MS SQL Server's Enterprise Manager and delete the SGMSDB and sgmsvp__databases.
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License Agreements

You can view the End User License Agreement and all Third-Party Product Licenses in the Console > Help >
About screen of the Analyzer user Interface.

This appendix details the following licensing agreements:

e End User Software License Agreement on page 221

End User Software License Agreement

PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THIS PRODUCT. BY DOWNLOADING, INSTALLING OR USING THIS PRODUCT, YOU ACCEPT AND
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. FOR DELIVERIES OUTSIDE THE UNITED STATES OF AMERICA, PLEASE GO TO
HTTPS://WWW.SONICWALL.COM/LEGAL/EUPA.ASPX TO VIEW THE APPLICABLE VERSION OF THIS AGREEMENT FOR YOUR REGION. IF YOU DO NOT AGREE TO
THE TERMS AND CONDITIONS OF THIS AGREEMENT OR THE APPLICABLE VERSION OF THIS AGREEMENT FOR YOUR REGION, DO NOT DOWNLOAD, INSTALL
OR USE THIS PRODUCT.

This SonicWall End User Product Agreement (the “Agreement”) is made between you, the Customer (“Customer” or “You”) and the Provider, as defined below.
1. Definitions. Capitalized terms not defined in context shall have the meanings assigned to them below:

(a) “Affiliate” means any legal entity controlling, controlled by, or under common control with a party to this Agreement, for so long as such control relationship
exists.

(b) “Appliance” means a computer hardware product upon which Software is pre-installed and delivered.
(c) “Documentation” means the user manuals and documentation that Provider makes available for the Products, and all copies of the foregoing.
(d) “Maintenance Services” means Provider's maintenance and support offering for the Products as identified in the Maintenance Services Section below.

(e) “Partner” means the reseller or distributor that is under contract with Provider or another Partner and is authorized via such contract to resell the Products
and/or Maintenance Services.

(f)  “Provider” means, (i) for the US, Europe, Middle East, Africa, Latin America, and Taiwan, SonicWall Inc., with its principal place of business located at 4
Polaris Way, Aliso Viejo, CA 92656 USA and (ii) for Asia (other than Taiwan) SonicWall International Ltd. City Gate Park Mahon, Cork, Ireland.

(g) “Products” means the Software and Appliance(s) provided to Customer under this Agreement.

(h) “Software” means the object code version of the software that is delivered on the Appliance and any other software that is later provided to Customer as
well as any new versions and releases to such software that are made available to Customer pursuant to this Agreement, and all copies of the foregoing.

2. Software License.

(a) General. Subject to the terms of this Agreement, Provider grants to Customer, and Customer accepts from Provider, a non-exclusive, non-transferable (except
as otherwise set forth herein) and non-sublicensable license to access and use the quantities of each item of Software purchased from Provider or a Partner
within the parameters of the license type (“License Type(s)”) described below in the quantities purchased (“License”). Except for MSP Licenses (as defined
below), Customer shall only use the Software to support the internal business operations of itself and its worldwide Affiliates.

(b) License Types. The License Type for the Software initially delivered on the Appliance is “per Appliance”. Software licensed per Appliance may be used only on
the Appliance on which it is delivered, but without any other quantitative limitations. Software that is purchased on a subscription, or periodic basis is licensed
by User or by Managed Node. A “User” is each person with a unique login identity to the Software. A “Managed Node” is any object managed by the Software
including, but not limited to firewalls, devices, and other items sold by Provider.

(c) Software as a Service. When Customer purchases a right to access and use Software installed on equipment operated by Provider or its suppliers (the “SaaS
Software”), (i) the License for such SaaS Software shall be granted for the duration of the term stated in the order (the “SaaS Term”), as such SaaS Term may be
extended by automatic or agreed upon renewals, and (ii) the terms set forth in the SaaS Provisions Section of this Agreement shall apply to all access to and use
of such Software. If any item of Software to be installed on Customer's equipment is provided in connection with Saa$S Software, the License duration for such
Software shall be for the corresponding SaaS Term, and Customer shall promptly install any updates to such Software as may be provided by Provider.

(d) MSP License.

“Management Services” include, without limitation, application, operating system, and database implementation, performance tuning, and maintenance
services provided by Customer to its customers (each, a “Client”) where Customer installs copies of the Software on its Clients' equipment or provides its Clients
access to the Products. Customer shall be granted a License to use the Software and the associated Documentation to provide Management Services (the “MSP
License”). Each MSP License is governed by the terms of this Agreement and any additional terms agreed to by the parties.

If the Product is to be used by Customer as a managed service provider, then Customer shall ensure that (i) Customer makes no representations or warranties
related to the Products in excess of SonicWall's representations or warranties contained in this Agreement, (ii) each Client only uses the Products and
Documentation as part of the Management Services provided to it by Customer, (iii) such use is subject to the restrictions and limitations contained in this
Agreement, including, but not limited to those in the Export Section of this Agreement, and (iv) each Client cooperates with Provider during any compliance
review that may be conducted by Provider or its designated agent. At the conclusion of any Management Services engagement with a Client, Customer shall
promptly remove any Appliance and Software installed on its Client's computer equipment or require the Client to do the same. Customer agrees that it shall be
jointly and severally liable to Provider for the acts and omissions of its Clients in connection with their use of the Software and Documentation and shall, at its
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expense, defend Provider against any action, suit, or claim brought against Provider by a Client in connection with or related to Customer's Management
Services and pay any final judgments or settlements as well as Provider's expenses in connection with such action, suit, or claim.

(e) Evaluation/Beta License. If Software is obtained from Provider for evaluation purposes or in beta form, Customer shall be granted a License to use such
Software and the associated Documentation solely for Customer's own non-production, internal evaluation purposes (an “Evaluation License”). Each Evaluation
License shall be granted for an evaluation period of up to thirty (30) days beginning (i) five (5) days after the Appliance is shipped or (ii) from the date that access
is granted to the beta Software or the SaaS Software, plus any extensions granted by Provider in writing (the “Evaluation Period”). There is no fee for an
Evaluation License during the Evaluation Period, however, Customer is responsible for any applicable shipping charges or taxes which may be incurred, and any
fees which may be associated with usage beyond the scope permitted herein. Beta Software licensed hereunder may include pre-release features and
capabilities which may not be available in SonicWall's generally available commercial versions of the Software. SonicWall retains the right during the term of the
Evaluation License to modify, revise, or remove SonicWall beta software from Customer's premises. Customer acknowledges that SonicWall owns all
modifications, derivative works, changes, expansions or improvements to beta software, as well as all reports, testing data or results, feedback, benchmarking or
other analysis completed in whole or in part in conjunction with usage of beta software. NOTWITHSTANDING ANYTHING OTHERWISE SET FORTH IN THIS
AGREEMENT, CUSTOMER UNDERSTANDS AND AGREES THAT EVALUATION AND BETA SOFTWARE IS PROVIDED “AS IS”, WHERE IS, WITH ALL FAULTS AND THAT
SONICWALL DOES NOT PROVIDE A WARRANTY OR MAINTENANCE SERVICES FOR EVALUATION OR BETA LICENSES, AND SONICWALL BEARS NO LIABILITY FOR
ANY DIRECT, INDIRECT, INCIDENTAL, PUNITIVE, SPECIAL OR CONSEQUENTIAL DAMAGES RESULTING FROM USE (OR ATTEMPTED USE) OF THE EVALUATION OR
BETA SOFTWARE THROUGH AND AFTER THE EVALUATION PERIOD AND HAS NO DUTY TO PROVIDE SUPPORT TO CUSTOMER FOR SUCH SOFTWARE. BETA
SOFTWARE MAY CONTAIN DEFECTS AND A PRIMARY PURPOSE OF LICENSING THE BETA SOFTWARE IS TO OBTAIN FEEDBACK ON THE BETA SOFTWARE'S
PERFORMANCE AND THE IDENTIFICATION OF DEFECTS. CUSTOMER IS ADVISED TO SAFEGUARD IMPORTANT DATA, TO USE CAUTION AND NOT TO RELY IN ANY
WAY ON THE CORRECT FUNCTIONING OR PERFORMANCE OF THE BETA SOFTWARE AND/OR ACCOMPANYING MATERIALS.

(f) Use by Third Parties. Customer may allow its services vendors and contractors (each, a “Third Party User”) to access and use the Products and
Documentation provided to Customer hereunder solely for purposes of providing services to Customer, provided that Customer ensures that (i) the Third Party
User's access to or use of the Products and Documentation is subject to the restrictions and limitations contained in this Agreement, including, but not limited to
those in the Export Section, (ii) the Third Party User cooperates with Provider during any compliance review that may be conducted by Provider or its designated
agent, and (iii) the Third Party Users promptly removes any Software installed on its computer equipment upon the completion of the Third Party's need to
access or use the Products as permitted by this Section. Customer agrees that it shall be liable to Provider for those acts and omissions of its Third Party Users
which, if done or not done by Customer, would be a breach of this Agreement.

3. Restrictions. Customer may not reverse engineer, decompile, disassemble, or attempt to discover or modify in any way the underlying source code of the
Software, or any part thereof unless and to the extent (a) such restrictions are prohibited by applicable law and (b) Customer has requested interoperability
information in writing from Provider and Provider has not provided such information in a timely manner. In addition, Customer may not (i) modify, translate,
localize, adapt, rent, lease, loan, create or prepare derivative works of, or create a patent based on the Products, Documentation or any part thereof, (ii) resell,
sublicense or distribute the Products or Documentation, (iii) provide, make available to, or permit use of the Products, in whole or in part, by any third party
(except as expressly set forth herein), (iv) use the Products or Documentation to create or enhance a competitive offering or for any other purpose which is
competitive to Provider, (v) remove Software that was delivered on an Appliance from the Appliance on which it was delivered and load such Software onto a
different appliance without Provider's prior written consent, or (vi) perform or fail to perform any other act which would result in a misappropriation or
infringement of Provider's intellectual property rights in the Products or Documentation. Each permitted copy of the Software and Documentation made by
Customer hereunder must contain all titles, trademarks, copyrights and restricted rights notices as in the original. Customer understands and agrees that the
Products may work in conjunction with third party products and Customer agrees to be responsible for ensuring that it is properly licensed to use such third
party products. Notwithstanding anything otherwise set forth in this Agreement, the terms and restrictions set forth herein shall not prevent or restrict
Customer from exercising additional or different rights to any open source software that may be contained in or provided with the Products in accordance with
the applicable open source software licenses which shall be either included with the Products or made available to Customer upon request. Customer may not
use any license keys or other license access devices not provided by Provider, including but not limited to “pirate keys”, to install or access the Software.

4. Proprietary Rights. Customer understands and agrees that (i) the Products are protected by copyright and other intellectual property laws and treaties, (ii)
Provider, its Affiliates and/or its licensors own the copyright, and other intellectual property rights in the Products, (iii) the Software is licensed, and not sold, (iv)
this Agreement does not grant Customer any rights to Provider's trademarks or service marks, and (v) Provider reserves any and all rights, implied or otherwise,
which are not expressly granted to Customer in this Agreement.

5. Title. Provider, its Affiliates and/or its licensors own the title to all Software.

6. Payment. Customer agrees to pay to Provider (or, if applicable, the Partner) the fees specified in each order, including any applicable shipping fees.
Customer will be invoiced promptly following delivery of the Products or prior to the commencement of any Renewal Maintenance Period and Customer shall
make all payments due to Provider in full within thirty (30) days from the date of each invoice or such other period (if any) stated in an order. Provider reserves
the right to charge Customer a late penalty of 1.5% per month (or the maximum rate permitted by law, whichever is the lesser) for any amounts payable to
Provider by Customer that are not subject to a good faith dispute and that remain unpaid after the due date until such amount is paid.

7. Taxes. The fees stated in an order from Provider or a Partner may not include taxes. If Provider is required to pay sales, use, property, value-added or other
taxes based on the Products or Maintenance Services provided under this Agreement or on Customer's use of Products or Maintenance Services, then such
taxes shall be billed to and paid by Customer. This Section does not apply to taxes based on Provider's or a Partner's income.

8. Termination.

(a) This Agreement or the Licenses granted hereunder may be terminated (i) by mutual written agreement of Provider and Customer or (ii) by either party for a
breach of this Agreement by the other party (or a Third Party User) that the breaching party fails to cure to the non-breaching party's reasonable satisfaction
within thirty (30) days following its receipt of notice of the breach. Notwithstanding the foregoing, in the case of MSP Licenses, if Customer or its Client breaches
this Agreement two (2) times in any twelve (12) consecutive month period, the breaching party shall not have a cure period for such breach and Provider may
terminate this Agreement immediately upon providing written notice to the breaching party.

(b) Upon termination of this Agreement or expiration or termination of a License for any reason, all rights granted to Customer for the applicable Software shall
immediately cease and Customer shall immediately: (i) cease using the applicable Software and Documentation, (ii) remove all copies, installations, and
instances of the applicable Software from all Appliances, Customer computers and any other devices on which the Software was installed, and ensure that all
applicable Third Party Users and Clients do the same, (iii) return the applicable Software to Provider together with all Documentation and other materials
associated with the Software and all copies of any of the foregoing, or destroy such items, (iv) cease using the Maintenance Services associated with the
applicable Software, (v) pay Provider or the applicable Partner all amounts due and payable up to the date of termination, and (vi) give Provider a written
certification, within ten (10) days, that Customer, Third Party Users, and Clients, as applicable, have complied with all of the foregoing obligations.

(c) Any provision of this Agreement that requires or contemplates execution after (i) termination of this Agreement, (ii) a termination or expiration of a License,
or (iii) the expiration of a SaaS Term, is enforceable against the other party and their respective successors and assignees notwithstanding such termination or
expiration, including, without limitation, the Restrictions, Payment, Taxes, Termination, Survival, Warranty Disclaimer, Infringement Indemnity, Limitation of
Liability, Confidential Information, Compliance Verification, and General Sections of this Agreement. Termination of this Agreement or a License shall be without
prejudice to any other remedies that the terminating party or a Partner may have under law, subject to the limitations and exclusions set forth in this
Agreement.

9. Export. Customer acknowledges that the Products and Maintenance Services are subject to the export control laws, rules, regulations, restrictions and
national security controls of the United States and other applicable foreign agencies (the “Export Controls”) and agrees to abide by the Export Controls.
Customer hereby agrees to use the Products and Maintenance Services in accordance with the Export Controls, and shall not export, re-export, sell, lease or
otherwise transfer the Products or any copy, portion or direct product of the foregoing in violation of the Export Controls. Customer is solely responsible for
obtaining all necessary licenses or authorizations relating to the export, re-export, sale, lease or transfer of the Products and for ensuring compliance with the

SonicWall Analyzer 8.3 Administration Guide 222



requirements of such licenses or authorizations. Customer hereby (i) represents that Customer, and if Customer is providing services under the MSP License
herein each of its Clients, is not an entity or person to which shipment of Products, or provision of Maintenance Services, is prohibited by the Export Controls;
and (ii) agrees that it shall not export, re-export or otherwise transfer the Products to (a) any country subject to a United States trade embargo, (b) a national or
resident of any country subject to a United States trade embargo, (c) any person or entity to which shipment of Products is prohibited by the Export Controls, or
(d) anyone who is engaged in activities related to the design, development, production, or use of nuclear materials, nuclear facilities, nuclear weapons, missiles
or chemical or biological weapons. Customer shall, at its expense, defend Provider and its Affiliates from any third party claim or action arising out of any
inaccurate representation made by Customer regarding the existence of an export license, Customer's failure to provide information to Provider to obtain an
export license, or any allegation made against Provider due to Customer's violation or alleged violation of the Export Controls (an “Export Claim”) and shall pay
any judgments or settlements reached in connection with the Export Claim as well as Provider's costs of responding to the Export Claim.

10. Maintenance Services.
(a) Description. During any Maintenance Period, Provider shall:

(i) Make available to Customer new versions and releases of the Software, if and when Provider makes them generally available without charge as part of
Maintenance Services.

(i) Respond to communications from Customer that report Software failures not previously reported to Provider by Customer. Nothing in the foregoing
shall operate to limit or restrict follow up communication by Customer regarding Software failures.

(iii) Respond to requests from Customer's technical coordinators for assistance with the operational/technical aspects of the Software unrelated to a
Software failure. Provider shall have the right to limit such responses if Provider reasonably determines that the volume of such non-error related requests for
assistance is excessive or overly repetitive in nature.

(iv) Provide access to Provider's software support web site at https://support.sonicwall.com (the “Support Site”).

(v) For Customers that have purchased Maintenance Services continuously since the purchase of such License, provide the repair and return program
described on the Support Site for the Appliance on which the Software is delivered.

Maintenance Services are available during regional business support hours (“Business Hours”) as indicated on the Support Site, unless Customer has purchased
24x7 Support. The list of Software for which 24x7 Support is available and/or required is listed in the Global Support Guide on the Support Site.

The Maintenance Services for Software that Provider has obtained through an acquisition or merger may, for a period of time following the effective date of the
acquisition or merger, be governed by terms other than those in this Section. The applicable different terms, if any, shall be stated on the Support Site.

(b) Maintenance Period. The first period for which Customer is entitled to receive Maintenance Services begins on the date of the registration of the Product at
Provider's registration portal (the “Registration”) and ends twelve (12) months thereafter (the “Initial Maintenance Period”). Following the Initial Maintenance
Period, Maintenance Services for the Product(s) may then be renewed for additional terms of twelve (12) or more months (each, a “Renewal Maintenance
Period”) For purposes of this Agreement, the Initial Maintenance Period and each Renewal Maintenance Period shall be considered a “Maintenance Period.” For
the avoidance of doubt, this Agreement shall apply to each Renewal Maintenance Period. Cancellation of Maintenance Services will not terminate Customer's
rights to continue to otherwise use the Products. Maintenance fees shall be due in advance of each Renewal Maintenance Period and shall be subject to the
payment requirements set forth in this Agreement. The procedure for reinstating Maintenance Services for the Products after it has lapsed is posted at
https://support.sonicwall.com/essentials/support-guide. Maintenance Services are optional and only provided if purchased separately.

For Saa$ Software, the Maintenance Period is equal to the duration of the applicable SaaS Term. For non-perpetual Licenses or for non-perpetual MSP Licenses,
the Maintenance Period is equal to the duration of the License.

11. Warranties and Remedies.
(a) Software Warranties. Provider warrants that, during the applicable Warranty Period (as defined in subsection (c) below),
(i) the operation of the Software, as provided by Provider, will substantially conform to its Documentation (the “Operational Warranty”);

(ii) the Software, as provided by Provider, will not contain any viruses, worms, Trojan Horses, or other malicious or destructive code designed by Provider
to allow unauthorized intrusion upon, disabling of, or erasure of the Software, except that the Software may contain a key limiting its use to the scope of the
License granted, and license keys issued by Provider for temporary use are time-sensitive (the “Virus Warranty”);

(iii) it will make commercially reasonable efforts to make the SaaS Software available twenty-four hours a day, seven days a week except for scheduled
maintenance, the installation of updates, those factors that are beyond the reasonable control of Provider, Customer's failure to meet any minimum system
requirements communicated to Customer by Provider, and any breach of this Agreement by Customer that impacts the availability of the SaaS Software (the
“Saas Availability Warranty”).

(b) Appliance Warranties. Provider warrants that, during the applicable Warranty Period, the Appliance will operate in a manner which allows the SNWL
Software, respectively, to be used in substantial conformance with the Documentation (the “Appliance Warranty”,).

(c) Warranty Periods. The “Warranty Period” for each of the above warranties (except for E-class appliances which do not include a Software warranty, shall be
as follows: (i) for the Operational Warranty as it applies to Software and the Virus Warranty, ninety (90) days following the initial Registration of the Software; (ii)
for the Operational Warranty as it applies to SaaS Software and the Saa$ Availability Warranty, the duration of the SaaS Term; and (iv) for the Appliance
Warranty, one (1) year following the date the Appliance is registered with Provider.

(d) Remedies. Any breach of the foregoing warranties must be reported by Customer to Provider during the applicable Warranty Period. Customer's sole and
exclusive remedy and Provider's sole obligation for any such breach shall be as follows:

(i) For a breach of the Operational Warranty that impacts the use of Software, Provider shall correct or provide a workaround for reproducible errors in
the Software that caused the breach within a reasonable time considering the severity of the error and its effect on Customer or, at Provider's option, refund the
license fees paid for the nonconforming Software upon return of such Software to Provider and termination of the related License(s) hereunder.

(ii) For a breach of the Operational Warranty that impacts the use of SaaS Software, Provider shall correct or provide a workaround for reproducible errors
in the Software that caused the breach and provide a credit or refund of the fees allocable to the period during which the Software was not operating in
substantial conformance with the applicable Documentation.

(iii) For a breach of the Virus Warranty, Provider shall replace the Software with a copy that is in conformance with the Virus Warranty.

(v) For a breach of the SaaS Availability Warranty, Provider shall provide a credit or refund of the fees allocable to the period during which the SaaS
Software was not available for use.

(e) Warranty Exclusions. The warranties set forth in this Section shall not apply to any non-conformance (i) that Provider cannot recreate after exercising
commercially reasonable efforts to attempt to do so; (ii) caused by misuse of the applicable Product or by using the Product in a manner that is inconsistent with
this Agreement or the Documentation; or (iii) arising from the modification of the Product by anyone other than Provider.

(f) Third Party Products. Certain Software may contain features designed to interoperate with third-party products. If the third-party product is no longer
made available by the applicable provider, Provider may discontinue the related product feature. Provider shall notify Customer of any such discontinuation,
however Customer will not be entitled to any refund, credit or other compensation as a result of the discontinuation.

(g) Warranty Disclaimer. THE EXPRESS WARRANTIES AND REMEDIES SET FORTH IN THIS SECTION ARE THE ONLY WARRANTIES AND REMEDIES PROVIDED BY
PROVIDER HEREUNDER. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, ALL OTHER WARRANTIES OR REMEDIES ARE EXCLUDED, WHETHER
EXPRESS OR IMPLIED, ORAL OR WRITTEN, INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR PURPOSE,
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NON-INFRINGEMENT, SATISFACTORY QUALITY, AND ANY WARRANTIES ARISING FROM USAGE OF TRADE OR COURSE OF DEALING OR PERFORMANCE. PROVIDER
DOES NOT WARRANT UNINTERRUPTED OR ERROR-FREE OPERATION OF THE PRODUCTS.

(h) High-Risk Disclaimer. CUSTOMER UNDERSTANDS AND AGREES THAT THE PRODUCTS ARE NOT FAULT-TOLERANT AND ARE NOT DESIGNED OR INTENDED FOR
USE IN ANY HIGH-RISK OR HAZARDOUS ENVIRONMENT, INCLUDING WITHOUT LIMITATION, THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION,
AIR TRAFFIC CONTROL, LIFE SUPPORT MACHINES, WEAPONS SYSTEMS, OR ANY OTHER APPLICATION WHERE THE FAILURE OR MALFUNCTION OF ANY PRODUCT
CAN REASONABLY BE EXPECTED TO RESULT IN DEATH, PERSONAL INJURY, SEVERE PROPERTY DAMAGE OR SEVERE ENVIRONMENTAL HARM (A “HIGH RISK
ENVIRONMENT”). ACCORDINGLY, (I) CUSTOMER SHOULD NOT USE THE PRODUCTS IN A HIGH RISK ENVIRONMENT, (I1) ANY USE OF THE PRODUCTS BY
CUSTOMER IN A HIGH RISK ENVIRONMENT IS AT CUSTOMER'S OWN RISK, (I1) PROVIDER, ITS AFFILIATES AND SUPPLIERS SHALL NOT BE LIABLE TO CUSTOMER IN
ANY WAY FOR USE OF THE PRODUCTS IN A HIGH RISK ENVIRONMENT, AND (IV) PROVIDER MAKES NO WARRANTIES OR ASSURANCES, EXPRESS OR IMPLIED,
REGARDING USE OF THE PRODUCTS IN A HIGH RISK ENVIRONMENT.

12. Infringement Indemnity. Provider shall indemnify Customer from and against any claim, suit, action, or proceeding brought against Customer by a third
party to the extent it is based on an allegation that the Software directly infringes any patent, copyright, trademark, or other proprietary right enforceable in the
country in which Provider has authorized Customer to use the Software, including, but not limited to the country to which the Software is delivered to Customer,
or misappropriates a trade secret in such country (a “Claim”). Indemnification for a Claim shall consist of the following: Provider shall (a) defend or settle the
Claim at its own expense, (b) pay any judgments finally awarded against Customer under a Claim or any amounts assessed against Customer in any settlements
of a Claim, and (c) reimburse Customer for the reasonable administrative costs or expenses, including without limitation reasonable attorneys' fees, it
necessarily incurs in responding to the Claim. Provider's obligations under this Infringement Indemnity Section are conditioned upon Customer (i) giving prompt
written notice of the Claim to Provider, (ii) permitting Provider to retain sole control of the investigation, defense or settlement of the Claim, and (iii) providing
Provider with cooperation and assistance as Provider may reasonably request in connection with the Claim. Provider shall have no obligation hereunder to
defend Customer against any Claim (a) resulting from use of the Software other than as authorized by this Agreement, (b) resulting from a modification of the
Software other than by Provider, (c) based on Customer's use of any release of the Software after Provider recommends discontinuation because of possible or
actual infringement and has provided a non-infringing version at no charge, or (d) to the extent the Claim arises from or is based on the use of the Software with
other products, services, or data not supplied by Provider if the infringement would not have occurred but for such use. If, as a result of a Claim or an injunction,
Customer must stop using any Software (“Infringing Software”), Provider shall at its expense and option either (1) obtain for Customer the right to continue
using the Infringing Software, (2) replace the Infringing Software with a functionally equivalent non-infringing product, (3) modify the Infringing Software so that
it is non-infringing, or (4) terminate the License for the Infringing Software and (A) for non-Saa$ Software, accept the return of the Infringing Software and
refund the license fee paid for the Infringing Software, pro-rated over a sixty (60) month period from the date of initial delivery of such Software, or (B) for SaaS
Software, discontinue Customer's right to access and use the Infringing Software and refund the unused pro-rated portion of any license fees pre-paid by
Customer for such Software. This Section states Provider's entire liability and its sole and exclusive indemnification obligations with respect to a Claim and
Infringing Software.

13. Limitation of Liability. EXCEPT FOR (A) ANY BREACH OF THE RESTRICTIONS OR CONFIDENTIAL INFORMATION SECTIONS OF THIS AGREEMENT, (B) AMOUNTS
CONTAINED IN JUDGMENTS OR SETTLEMENTS WHICH PROVIDER OR CUSTOMER IS LIABLE TO PAY TO A THIRD PARTY UNDER THE INFRINGEMENT INDEMNITY
SECTION OF THIS AGREEMENT AND CUSTOMER IS LIABLE TO PAY ON BEHALF OF OR TO PROVIDER UNDER THE CONDUCT, EXPORT, MSP LICENSE, AND USE BY
THIRD PARTIES SECTIONS OF THIS AGREEMENT, OR (C) ANY LIABILITY TO THE EXTENT LIABILITY MAY NOT BE EXCLUDED OR LIMITED AS A MATTER OF
APPLICABLE LAW, IN NO EVENT SHALL CUSTOMER OR ITS AFFILIATES, OR PROVIDER, ITS AFFILIATES OR SUPPLIERS BE LIABLE FOR (X) ANY INDIRECT, INCIDENTAL,
SPECIAL OR CONSEQUENTIAL LOSS OR DAMAGE OF ANY KIND OR (Y) LOSS OF REVENUE, LOSS OF ACTUAL OR ANTICIPATED PROFITS, LOSS OF BUSINESS, LOSS OF
CONTRACTS, LOSS OF GOODWILL OR REPUTATION, LOSS OF ANTICIPATED SAVINGS, LOSS OF, DAMAGE TO OR CORRUPTION OF DATA, HOWSOEVER ARISING,
WHETHER SUCH LOSS OR DAMAGE WAS FORESEEABLE OR IN THE CONTEMPLATION OF THE PARTIES AND WHETHER ARISING IN OR FOR BREACH OF CONTRACT,
TORT (INCLUDING NEGLIGENCE), BREACH OF STATUTORY DUTY, OR OTHERWISE.

EXCEPT FOR (A) ANY BREACH OF THE SOFTWARE LICENSE, RESTRICTIONS, OR CONFIDENTIAL INFORMATION SECTIONS OF THIS AGREEMENT, OR ANY OTHER
VIOLATION OF THE OTHER PARTY'S INTELLECTUAL PROPERTY RIGHTS; (B) PROVIDER'S EXPRESS OBLIGATIONS UNDER THE INFRINGEMENT INDEMNITY SECTION
OF THIS AGREEMENT AND CUSTOMER'S EXPRESS OBLIGATIONS UNDER THE CONDUCT, EXPORT, MSP LICENSE, AND USE BY THIRD PARTIES SECTIONS OF THIS
AGREEMENT, (C) PROVIDER'S COSTS OF COLLECTING DELINQUENT AMOUNTS WHICH ARE NOT THE SUBJECT OF A GOOD FAITH DISPUTE; (D) A PREVAILING
PARTY'S LEGAL FEES PURSUANT TO THE LEGAL FEES SECTION OF THIS AGREEMENT; OR (E) ANY LIABILITY TO THE EXTENT LIABILITY MAY NOT BE EXCLUDED OR
LIMITED AS A MATTER OF APPLICABLE LAW, THE MAXIMUM AGGREGATE AND CUMULATIVE LIABILITY OF CUSTOMER AND ITS AFFILIATES, AND PROVIDER, ITS
AFFILIATES AND SUPPLIERS, FOR DAMAGES UNDER THIS AGREEMENT, WHETHER ARISING IN OR FOR BREACH OF CONTRACT, TORT (INCLUDING NEGLIGENCE),
BREACH OF STATUTORY DUTY, OR OTHERWISE, SHALL BE AN AMOUNT EQUAL TO (Y) THE GREATER OF THE FEES PAID AND/OR OWED (AS APPLICABLE) BY
CUSTOMER OR ITS AFFILIATES FOR THE PRODUCTS THAT ARE THE SUBJECT OF THE BREACH OR FIVE HUNDRED DOLLARS ($500.00),EXCEPT FOR ()
MAINTENANCE SERVICES OR A PRODUCT SUBJECT TO RECURRING FEES, FOR WHICH THE MAXIMUM AGGREGATE AND CUMULATIVE LIABILITY SHALL BE THE
GREATER OF THE AMOUNT PAID AND/OR OWED (AS APPLICABLE) FOR SUCH MAINTENANCE SERVICE OR PRODUCT DURING THE TWELVE (12) MONTHS
PRECEDING THE BREACH OR FIVE HUNDRED DOLLARS ($500.00). THE PARTIES AGREE THAT THESE LIMITATIONS OF LIABILITY ARE AGREED ALLOCATIONS OF RISK
CONSTITUTING IN PART THE CONSIDERATION FOR PROVIDER PROVIDING PRODUCTS AND SERVICES TO CUSTOMER, AND SUCH LIMITATIONS WILL APPLY
NOTWITHSTANDING THE FAILURE OF THE ESSENTIAL PURPOSE OF ANY LIMITED REMEDY AND EVEN IF A PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
LIABILITIES OR FAILURES.

Provider's Affiliates and suppliers and Customer's Affiliates shall be beneficiaries of this Limitation of Liability Section and Customer's Clients and Third Party
Users are entitled to the rights granted under the MSP License and Use by Third Parties Sections of this Agreement; otherwise, no third party beneficiaries exist
under this Agreement. Provider expressly excludes any and all liability to Third Party Users, Clients and to any other third party.

14. Confidential Information.

(a) Definition. “Confidential Information” means information or materials disclosed by one party (the “Disclosing Party”) to the other party (the “Receiving
Party”) that are not generally available to the public and which, due to their character and nature, a reasonable person under like circumstances would treat as
confidential, including, without limitation, financial, marketing, and pricing information, trade secrets, know-how, proprietary tools, knowledge and
methodologies, the Software (in source code and/or object code form), information or benchmark test results regarding the functionality and performance of
the Software, any Software license keys provided to Customer, and the terms and conditions of this Agreement.

Confidential Information shall not include information or materials that (i) are generally known to the public, other than as a result of an unpermitted disclosure
by the Receiving Party after the date that Customer accepts the Agreement (the “Effective Date”); (ii) were known to the Receiving Party without an obligation
of confidentiality prior to receipt from the Disclosing Party; (iii) the Receiving Party lawfully received from a third party without that third party's breach of
agreement or obligation of trust; (iv) are protected by Provider in accordance with its obligations under the Protected Data Section below, or (v) are or were
independently developed by the Receiving Party without access to or use of the Disclosing Party's Confidential Information.

(b) Obligations. The Receiving Party shall (i) not disclose the Disclosing Party's Confidential Information to any third party, except as permitted in subsection (c)
below and (ii) protect the Disclosing Party's Confidential Information from unauthorized use or disclosure by exercising at least the same degree of care it uses to
protect its own similar information, but in no event less than a reasonable degree of care. The Receiving Party shall promptly notify the Disclosing Party of any
known unauthorized use or disclosure of the Disclosing Party's Confidential Information and will cooperate with the Disclosing Party in any litigation brought by
the Disclosing Party against third parties to protect its proprietary rights. For the avoidance of doubt, this Section shall apply to all disclosures of the parties'
Confidential Information as of the Effective Date, whether or not specifically arising from a party's performance under this Agreement.

(c) Permitted Disclosures. Notwithstanding the foregoing, the Receiving Party may disclose the Disclosing Party's Confidential Information without the
Disclosing Party's prior written consent to any of its Affiliates, directors, officers, employees, consultants, contractors or representatives (collectively, the
“Representatives”), but only to those Representatives that (i) have a “need to know” in order to carry out the purposes of this Agreement or to provide
professional advice in connection with this Agreement, (ii) are legally bound to the Receiving Party to protect information such as the Confidential Information
under terms at least as restrictive as those provided herein, and (iii) have been informed by the Receiving Party of the confidential nature of the Confidential
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Information and the requirements regarding restrictions on disclosure and use as set forth in this Section. The Receiving Party shall be liable to the Disclosing
Party for the acts or omissions of any Representatives to which it discloses Confidential Information which, if done by the Receiving Party, would be a breach of
this Agreement.

Additionally, it shall not be a breach of this Section for the Receiving Party to disclose the Disclosing Party's Confidential Information as may be required by
operation of law or legal process, provided that the Receiving Party provides prior notice of such disclosure to the Disclosing Party unless expressly prohibited
from doing so by a court, arbitration panel or other legal authority of competent jurisdiction.

15. Protected Data. For purposes of this Section, “Protected Data” means any information or data that is provided by Customer to Provider during this
Agreement that alone or together with any other information relates to an identified or identifiable natural person or data considered to be personal data as
defined under Privacy Laws, and “Privacy Laws” means any applicable law, statute, directive or regulation regarding privacy, data protection, information
security obligations and/or the processing of Protected Data.

Except as permitted herein or to the extent required by Privacy Laws or legal process, Provider shall implement reasonable technical and organizational
measures to prevent unauthorized disclosure of or access to Protected Data by third parties, and shall only store and process Protected Data as may be required
to fulfill its obligations under this Agreement. If Provider complies with Customer's written instructions with respect to the Protected Data, Provider shall have
no liability to Customer for any breach of this Section resulting from such compliance. Provider shall promptly notify Customer of any disclosure of or access to
the Protected Data by a third party in breach of this Section and shall cooperate with Customer to reasonably remediate the effects of such disclosure or access.
Provider further affirms to Customer that it has adequate agreements in place incorporating the EU standard contractual clauses for the transfer of Protected
Data from the European Union ("EU") to a country outside the EU.

Customer hereby (i) represents that it has the right to send the Protected Data to Provider, (ii) consents for Provider to store and use the Protected Data
worldwide for the sole purpose of performing its obligations under this Agreement, (iii) agrees that the Protected Data may be accessed and used by Provider
and its Representatives worldwide as may be needed to support Provider's standard business operations, and (iv) agrees that Protected Data consisting of
Customer contact information (e.g., email addresses, names) provided as part of Maintenance Services may be sent to Provider's third party service providers as
part of Provider's services improvement processes.

16. Compliance Verification. Customer agrees to maintain and use systems and procedures to accurately track, document, and report its installations,
acquisitions and usage of the Software. Such systems and procedures shall be sufficient to determine if Customer's deployment of the Software or, if applicable,
use of the SaaS Software is within the quantities, terms, and maintenance releases to which it is entitled. Provider or its designated auditing agent shall have the
right to audit Customer's deployment of the Software or, if applicable, use of the SaaS Software for compliance with the terms and conditions of this Agreement.
Any such audits shall be scheduled at least ten (10) days in advance and shall be conducted during normal business hours at Customer's facilities. Customer shall
provide its full cooperation and assistance with such audit and provide access to the applicable records and computers. Without limiting the generality of the
foregoing, as part of the audit, Provider may request, and Customer agrees to provide, a written report, signed by an authorized representative, listing
Customer's then current deployment of the Software and/or the number of individuals that have accessed and used Saa$ Software. If Customer's deployment of
the Software or, if applicable, use of the SaaS Software is found to be greater than its purchased entitlement to such Software, Customer will be invoiced for the
over-deployed quantities at Provider's then current list price plus the applicable Maintenance Services and applicable over-deployment fees. All such amounts
shall be payable in accordance with this Agreement. Additionally, if the unpaid fees exceed five percent (5%) of the fees paid for the applicable Software, then
Customer shall also pay Provider's reasonable costs of conducting the audit. The requirements of this Section shall survive for two (2) years following the
termination of the last License governed by this Agreement.

17. SaaS Provisions.

(a) Data. Customer may store data on the systems to which it is provided access in connection with its use of the SaaS Software (the “SaaS Environment”).
Provider may periodically make back-up copies of Customer data, however, such back-ups are not intended to replace Customer's obligation to maintain regular
data backups or redundant data archives. Customer is solely responsible for collecting, inputting and updating all Customer data stored in the SaaS Environment,
and for ensuring that it does not (i) knowingly create and store data that actually or potentially infringes or misappropriates the copyright, trade secret,
trademark or other intellectual property right of any third party, or (ii) use the SaaS Environment for purposes that would reasonably be seen as obscene,
defamatory, harassing, offensive or malicious. Provider shall have the right to delete all Customer data stored in connection with the use of the SaaS Software
thirty (30) days following any termination of this Agreement or any License to Saa$S Software granted hereunder.

Customer represents and warrants that it has obtained all rights, permissions and consents necessary to use and transfer all Customer and/or third party data
within and outside of the country in which Customer or the applicable Customer Affiliate is located (including providing adequate disclosures and obtaining
legally sufficient consents from Customer's employees, customers, agents, and contractors). If Customer transmits data to a third-party website or other
provider that is linked to or made accessible by the SaaS Software, Customer will be deemed to have given its consent to Provider enabling such transmission
and Provider shall have no liability to Customer in connection with any claims by a third party in connection with such transmission.

(b) Conduct. In connection with the use of SaaS Software, Customer may not (i) attempt to use or gain unauthorized access to Provider's or to any third-party's
networks or equipment; (ii) permit other individuals or entities to copy the SaaS Software; (iii) provide unauthorized access to or use of any Saa$S Software or the
associated access credentials; (iv) attempt to probe, scan or test the vulnerability of the SaaS Software, the SaaS Environment, or a system, account or network
of Provider or any of Provider's customers or suppliers; (v) interfere or attempt to interfere with service to any user, host or network; (vi) engage in fraudulent,
offensive or illegal activity of any nature or intentionally engage in any activity that infringes the intellectual property rights or privacy rights of any individual or
third party; (vii) transmit unsolicited bulk or commercial messages; (viii) intentionally distribute worms, Trojan horses, viruses, corrupted files or any similar
items; (ix) restrict, inhibit, or otherwise interfere with the ability of any other person, regardless of intent, purpose or knowledge, to use or enjoy the Saa$
Software (except for tools with safety and security functions); or (x) restrict, inhibit, interfere with or otherwise disrupt or cause a performance degradation to
any Provider (or Provider supplier) facilities used to provide the SaaS Environment. Customer shall cooperate with Provider's reasonable investigation of SaaS
Environment outages, security issues, and any suspected breach of this Section, and shall, at its expense, defend Provider and its Affiliates from any claim, suit,
or action by a third party (a “Third Party Claim”) alleging harm to such third party caused by Customer's breach of any of the provisions of this Section.
Additionally, Customer shall pay any judgments or settlements reached in connection with the Third Party Claim as well as Provider's costs of responding to the
Third Party Claim.

(c) Suspension. Provider may suspend Customer's use of Saa$S Software (a) if so required by law enforcement or legal process, (b) in the event of an imminent
security risk to Provider or its customers, or (c) if continued use would subject Provider to material liability. Provider shall make commercially reasonable efforts
under the circumstances to provide prior notice to Customer of any such suspension.

18. General.

(a) Governing Law and Venue. This Agreement shall be governed by and construed in accordance with the laws of the State of California, without giving effect
to any conflict of laws principles that would require the application of laws of a different state. Any action seeking enforcement of this Agreement or any
provision hereof shall be brought exclusively in the state or federal courts located in the Santa Clara County, California. Each party hereby agrees to submit to the
jurisdiction of such courts. The parties agree that neither the United Nations Convention on Contracts for the International Sale of Goods, nor the Uniform
Computer Information Transaction Act (UCITA) shall apply to this Agreement, regardless of the states in which the parties do business or are incorporated.

(b) Assignment. Except as otherwise set forth herein, Customer shall not, in whole or part, assign or transfer any part of this Agreement, the Licenses granted
under this Agreement or any other rights, interest or obligations hereunder, whether voluntarily, by contract, by operation of law or by merger (whether that
party is the surviving or disappearing entity), stock or asset sale, consolidation, dissolution, through government action or order, or otherwise without the prior
written consent of Provider. Any attempted transfer or assignment by Customer that is not permitted by this Agreement shall be null and void.

(c) Severability. If any provision of this Agreement shall be held by a court of competent jurisdiction to be contrary to law, such provision will be enforced to the
maximum extent permissible by law to effect the intent of the parties and the remaining provisions of this Agreement will remain in full force and effect.
Notwithstanding the foregoing, the terms of this Agreement that limit, disclaim, or exclude warranties, remedies or damages are intended by the parties to be
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independent and remain in effect despite the failure or unenforceability of an agreed remedy. The parties have relied on the limitations and exclusions set forth
in this Agreement in determining whether to enter into it.

(d) Use by U.S. Government. The Software is a “commercial item” under FAR 12.201. Consistent with FAR section 12.212 and DFARS section 227.7202, any use,
modification, reproduction, release, performance, display, disclosure or distribution of the Software or Documentation by the U.S. government is prohibited
except as expressly permitted by the terms of this Agreement. In addition, when Customer is a U.S. government entity, the language in Subsection (ii) of the
Infringement Indemnity Section of this Agreement and the Injunctive Relief Section of this Agreement shall not be applicable.

(e) Notices. All notices provided hereunder shall be in writing and may be delivered by email, in the case of Provider to legal@sonicwall.com and in the case of
Customer to the email address Provider has on file for Customer. All notices, requests, demands or communications shall be deemed effective upon delivery in
accordance with this paragraph.

(f) Disclosure of Customer Status. Provider may include Customer in its listing of customers and, upon written consent by Customer, announce Customer's
selection of Provider in its marketing communications.

(g) Waiver. Performance of any obligation required by a party hereunder may be waived only by a written waiver signed by an authorized representative of the
other party, which waiver shall be effective only with respect to the specific obligation described therein. Any waiver or failure to enforce any provision of this
Agreement on one occasion will not be deemed a waiver of any other provision or of such provision on any other occasion.

(h) Injunctive Relief. Each party acknowledges and agrees that in the event of a material breach of this Agreement, including but not limited to a breach of the
Software License, Restrictions or Confidential Information Sections of this Agreement, the non-breaching party shall be entitled to seek immediate injunctive
relief, without limiting its other rights and remedies.

(i) Force Majeure. Each party will be excused from performance for any period during which, and to the extent that, it is prevented from performing any
obligation or service as a result of causes beyond its reasonable control, and without its fault or negligence, including without limitation, acts of God, strikes,
lockouts, riots, acts of war, epidemics, communication line failures, and power failures. For added certainty, this Section shall not operate to change, delete, or
modify any of the parties' obligations under this Agreement (e.g., payment), but rather only to excuse a delay in the performance of such obligations.

(j) Equal Opportunity. Provider is a federal contractor and Affirmative Action employer (M/F/D/V) as required by the Equal Opportunity clause C.F.R. §
60-741.5(a).

(k) Headings. Headings in this Agreement are for convenience only and do not affect the meaning or interpretation of this Agreement. This Agreement will not
be construed either in favor of or against one party or the other, but rather in accordance with its fair meaning. When the term “including” is used in this
Agreement it will be construed in each case to mean “including, but not limited to.”

() Legal Fees. If any legal action is brought to enforce any rights or obligations under this Agreement, the prevailing party shall be entitled to recover its
reasonable attorneys' fees, court costs and other collection expenses, in addition to any other relief it may be awarded.

(m) Entire Agreement. This Agreement is intended by the parties as a final expression of their agreement with respect to the subject matter thereof and may
not be contradicted by evidence of any prior or contemporaneous agreement unless such agreement is signed by both parties. In the absence of such an
agreement, this Agreement shall constitute the complete and exclusive statement of the terms and conditions and no extrinsic evidence whatsoever may be
introduced in any proceeding that may involve the Agreement. Each party acknowledges that in entering into the Agreement it has not relied on, and shall have
no right or remedy in respect of, any statement, representation, assurance or warranty (whether made negligently or innocently) other than as expressly set out
in the Agreement. In those jurisdictions where an original (non-faxed, non-electronic, or non-scanned) copy of an agreement or an original (non-electronic)
signature on agreements such as this Agreement is required by law or regulation, the parties hereby agree that, notwithstanding any such law or regulation, a
faxed, electronic, or scanned copy of and a certified electronic signature on this Agreement shall be sufficient to create an enforceable and valid agreement. This
Agreement, may only be modified or amended t by a writing executed by a duly authorized representative of each party. No other act, document, usage or
custom shall be deemed to amend or modify this Agreement.
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SonicWall Support

Technical support is available to customers who have purchased SonicWall products with a valid maintenance
contract and to customers who have trial versions.

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a
day, 365 days a year. To access the Support Portal, go to https://support.sonicwall.com.

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a
day, 365 days a year. In addition, the Support Portal provides direct access to product support engineers through
an online Service Request system.

The Support Portal enables you to:

View knowledge base articles and technical documentation
Download software

View video tutorials

Collaborate with peers and experts in user forums

Get licensing assistance

Access MySonicWall

Learn about SonicWall professional services

Register for training and certification

To contact SonicWall Support, refer to https://support.sonicwall.com/contact-support.

To view the SonicWall End User Product Agreement (EUPA), see https://www.sonicwall.com/legal/eupa.aspx.
Select the language based on your geographic location to see the EUPA that applies to your region.
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